
VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

1

•

•

•

•

•

•

•

•

 

Introducing Veritas System Recovery

This section includes the following topics:

About Veritas System Recovery

The components of Veritas System Recovery

Accessing Help and Support for Veritas System Recovery

Sending your feedback regarding Veritas System Recovery 23

Accessing Veritas QuickAssist (VQA)

Updating Veritas System Recovery with Veritas Update

About Veritas System Recovery
Veritas System Recovery is the gold standard in Windows® system recovery. It allows businesses 

to recover from system loss or disasters in minutes, not hours, or days. Veritas System Recovery 

provides fast, easy-to-use system restoration to help IT administrators meet recovery time 

objectives. You can even perform full bare metal recovery to dissimilar hardware and virtual 

environments for servers, desktops, or laptops. It also provides the ability to recover systems in 

remote, unattended locations using LightsOut Restore.

Veritas System Recovery captures a recovery point of the entire live Windows system. The backup 

includes the operating system, applications, system settings, files, and other items. The recovery 

point can be conveniently saved to various media or disk storage devices including SAN, NAS, 

Direct Attached Storage, RAID, and so forth. When systems fail, you can quickly restore them 

without the need for manual, lengthy, and error-prone processes.

You can manage Veritas System Recovery remotely using one of the following:

Another licensed copy of Veritas System Recovery

Veritas System Recovery Manager

Using the integrated Granular Restore Option, you can quickly restore individual Microsoft® 

Exchange emails, folders, and mailboxes.

See The components of Veritas System Recovery.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

2

The components of Veritas System Recovery
Veritas System Recovery includes two key components: the program itself, and the Veritas System 

Recovery Disk.

Table: Key product components

KEY COMPONENT DESCRIPTION

Veritas System Recovery program (user 
interface)

The Veritas System Recovery program lets you 
define, schedule, and run backups of your 
computer. When you run a backup, recovery 
points of your computer are created. You can 
then use the recovery points to recover your 
entire computer, or individual drives, files, and 
folders.

The Veritas System Recovery also lets you do 
the following:

- Manage the size of the recovery point storage 
(backup destination) so that you can use your 
computer's valuable disk space for other 
purposes.

- Monitor the backup status of your computer 
to make sure that your valuable data is backed 
up on a regular basis.

Veritas System Recovery Disk Microsoft no longer allows redistribution of 
WinPE. Starting from Veritas System Recovery 
16, Veritas no longer ships the Veritas System 
Recovery Disk with the product. A new utility is 
provided using which you can create a Veritas 
System Recovery Disk with the latest Windows 
operating system. The Veritas System 
Recovery Disk is used to start your computer 
in the recovery environment. If your computer's 
operating system fails, use the Veritas System 
Recovery Disk to recover your system drive 
(the drive where your operating system is 
installed).
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KEY COMPONENT DESCRIPTION

See Defining a drive-based backup .

See Backing up files and folders .

See Recovering a computer .

See About Veritas System Recovery.

Accessing Help and Support for Veritas System Recovery
To learn more about Veritas System Recovery, visit the Help and Support page. The Help and 

Support page provides access to the product's Help system and the User's Guide. It also includes 

access to the Veritas Knowledge Base where you can find troubleshooting information.

To access Help & Support

Start Veritas System Recovery.

On the Help menu, click Help and Support.

See About Veritas System Recovery.

Sending your feedback regarding Veritas System Recovery 23
Please take a moment to share your feedback and ideas with Veritas regarding Veritas System 

Recovery 23.

To send feedback

Do one of the following:

Click Share Your Ideas in the upper-right corner of the Veritas System Recovery 23 

window.

On the Help menu, click Share Your Ideas.

See About Veritas System Recovery.
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Accessing Veritas QuickAssist (VQA)
Veritas QuickAssist (VQA) is a diagnostics tool that collects technical data. VQA is a tool that is 

loaded on a computer experiencing a problem so that it can be scanned. Scans can be run against 

the system for common issues as well as installation requirements. VQA enables self-diagnosis 

attempts, and if this does not resolve the issue, the tool has the ability to collect and upload data 

for a support case.

To access Veritas QuickAssist (VQA)

Start Veritas System Recovery.

On the Help menu, click Veritas QuickAssist.

The Veritas QuickAssist utility is launched. To view the Help for the utility, click Help > View Help.

See About Veritas System Recovery.

Updating Veritas System Recovery with Veritas Update
You can receive software updates for your version of the product over an Internet connection. 

Veritas Update connects to the server and automatically downloads and installs updates for each 

Veritas product that you own.

If you have multiple Veritas products on your computer, that use the Symantec LiveUpdate server, 

you need to retain Symantec LiveUpdate. If you are certain that only Veritas System Recovery 23 

and later is installed on your computer, you can uninstall Symantec LiveUpdate.

“ ”
Note: When you upgrade to Veritas System Recovery 23 and later, Veritas Update is used. If 

Symantec LiveUpdate is already available on your computer, it does not get uninstalled.

“ ”
Run Veritas Update as soon as you install the product. You should continue to run Veritas Update 

periodically to obtain program updates.

To update Veritas System Recovery with Veritas Update

On the Help menu, click Run Veritas Update.
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In the Run Veritas Update - Welcome window, the available Service Pack updates for Veritas 

System Recovery 23 and later are displayed.

Click Check for Updates.

The Select the Service Pack window is displayed.

Select the Service Pack that you want to install.

The Release notes display information about the Service Pack that you selected.

Click Install Update.

On the Install the Service Pack window, click Update to proceed with the installation.

Ensure that no jobs are running and then close the Veritas System Recovery console. During the 

installation the Veritas System Recovery services are stopped.

“ ”
Note: You cannot uninstall the Service Pack after it is installed.

“ ”
When the installation is complete, restart your computer.

See Installing Veritas System Recovery.
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Installing Veritas System Recovery

This section includes the following topics:

System requirements for Veritas System Recovery

Supported file systems, disk types, disk partition schemes, and removable media

Feature availability in Veritas System Recovery

About the trial version of Veritas System Recovery

Installing Veritas System Recovery

Uninstalling Veritas System Recovery

System requirements for Veritas System Recovery Manager

Installing Veritas System Recovery Manager

System requirements for Veritas System Recovery
Before you install Veritas System Recovery, ensure that your computer meets the system 

requirements. Review the Readme file on the installation DVD for any known issues.

The following table lists the system requirements for Veritas System Recovery to function properly.

Table: Minimum system requirements

COMPONENT MINIMUM REQUIREMENTS

Operating system You can find a list of compatible operating 
systems, platforms, and

applications at the following URL:

https://www.veritas.com/content/support/
en_US

RAM The minimum memory required for Veritas 
System Recovery is 4 GB.

https://www.veritas.com/content/support/en_US
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COMPONENT MINIMUM REQUIREMENTS

Available hard disk space The following list indicates the hard disk space 
requirements for Veritas System Recovery and 
other items\:

- When you install the entire product: 
Approximately 2 GB is required for a full install, 
depending on the language of the product you 
select.

- Recovery points: Sufficient hard disk space 
on a local hard disk or network server for 
storing recovery points. The size of recovery 
points depends on the amount of data you 
have backed up and the type of recovery point 
that is stored.

- LightsOut Restore: 2 GB

DVD-ROM drive or USB drive The drive must be capable of being used as 
the startup drive from Unified Extensible 
Firmware Interface (UEFI) and BIOS-based 
computers.

Software The following Microsoft .Net Framework 
versions are required for installing and using 
Veritas System Recovery\:

- Microsoft .NET Framework 4.7 or later: 
Required to run and use Veritas System 
Recovery.

- Microsoft Visual C++ 2008 SP1 
Redistributable

- Microsoft Visual C++ 2010 x64/x86 
Redistributable

- Microsoft Visual C++ 2012 Redistributable

- Microsoft Visual C++ 2013 Redistributable
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COMPONENT MINIMUM REQUIREMENTS

- By default, Windows 8.1/Windows Server 
2012R2 operating systems and above versions 
are installed with .Net version 4.7 or later

If you want to restore emails using the 
Granular Restore Option , you must have 
Microsoft Outlook 2007, 2010, or 2013 
installed.

See Supported file systems, disk types, disk partition schemes, and removable media.

Supported file systems, disk types, disk partition schemes, and 
removable media
Veritas System Recovery supports the following file systems, disk types, disk partition schemes, 

and removable media:

Table: File systems, disk types, disk partition schemes, and 
removable media

SUPPORT DESCRIPTION

Supported file systems Veritas System Recovery supports the 
following file systems\:

- FAT16, FAT16X

- FAT32, FAT32X

- Resilient File System (ReFS) Note: Veritas 
System Recovery supports full and incremental 
backups of ReFS volumes.

- NTFS Note: You must decrypt encrypted 
NTFS drives before you attempt to restore 
them. You cannot view the files that are in a 
recovery point for an encrypted NTFS drive.
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SUPPORT DESCRIPTION

Supported disk types and disk partition 
schemes

Veritas System Recovery supports the 
following disk types and disk partition 
schemes\:

- Dynamic disks

- GUID partition table (GPT)

- Master Boot Record (MBR)

- 4K sector (native) disk volumes: Veritas 
System Recovery supports backup of 4K 
sector (native) disk volumes. As the VHDX 
format supports 4Kn disks, Veritas System 
Recovery now uses the VHDX format. Since 
VHDX format is supported on Windows Server 
2012 and later, virtual conversion for 4K sector 
(native) volumes is now supported on Windows 
2012 and later. To check the sector size of the 
disk, run the following command and see the 
BytesPerSector value. For Windows Server 
2012 and later: fsutil fsinfo sectorinfo

Removable media Veritas System Recovery also lets you save 
recovery points to most USB devices, 1394 
FireWire devices, RDX, REV, Jaz, Zip drives, 
and magneto-optical devices.

Supported drive types with Bytes per Sector Value and Bytes per Physical Sector Value

The following table lists the drive types, Bytes per Sector value, Bytes per Physical Sector value 

and whether or not Veritas System Recovery supports them.

Table: Drive types and support

BYTES PER 
SECTOR VALUE

BYTES PER 
PHYSICAL SECTOR 

VALUE

DRIVE TYPE SUPPORTED YES/
NO

4096 4096 4K native Yes
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BYTES PER 
SECTOR VALUE

BYTES PER 
PHYSICAL SECTOR 

VALUE

DRIVE TYPE SUPPORTED YES/
NO

512 4096 Advanced Format 
(also known as 
512E)

Yes

512 512 512-byte native Yes

4096 512 4K emulation Yes

See System requirements for Veritas System Recovery.

Refer to the following notes:

Currently Veritas System Recovery supports drives less than 32TB.

“ ”
Note: Veritas recommends that the system volumes for backup and restore should be less than 

16 TB. If the backup or restore takes more than 72 hours, Veritas recommends that you restore 

the system volumes only using the Veritas System Recovery Disk and then proceed with 

volumes more than 16 TB in Veritas System Recovery.

“ ”

Feature availability in Veritas System Recovery
Veritas System Recovery is packaged to meet various markets. Some features might not be 

available, depending on the product you have purchased. However, all features are documented. 

You should be aware of which features are included with the version of the product you have 

purchased. If a feature is not accessible in the product user interface, it is likely not included with 

your version of the product.

Refer to the Veritas website for information about the features that are included with your version of 

Veritas System Recovery.
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About the trial version of Veritas System Recovery
If you choose to delay installation of the license key, all features in Veritas System Recovery 

remain enabled during the 60-day trial period.

You cannot use Veritas System Recovery Disk, a component of Veritas System Recovery, during 

the trial period.

You need a valid license key to use the following key features of Veritas System Recovery Disk:

Back Up My Computer wizard

Recover My Computer wizard, which lets you use Restore Anyware to restore a virtual disk 

(.vmdk, .vhd, v2i, or vhdx) back to a physical computer that has different hardware.

The trial period of Veritas System Recovery product begins when you install the software.

If you use the product in trial mode, it expires after 60 days. However, all features are enabled until 

the end of the trial period, at which time you must purchase the product or uninstall it. You can 

purchase a license at any time (even after the trial period expires) without reinstalling the software.

See Activating Veritas System Recovery after the trial period.

Installing Veritas System Recovery
Before you begin, you should review the system requirements for installing Veritas System 

Recovery.

See System requirements for Veritas System Recovery.

“ ”
Note: During the installation process, you might be required to restart the computer. You should 

ensure proper functionality of the computer after it restarts. To do so, log on again using the same 

user credentials that you used to log on when you installed Veritas System Recovery.

“ ”
The Veritas System Recovery installation program lets you install Veritas System Recovery 

Manager. You can either install Veritas System Recovery Manager while installing Veritas System 

Recovery or install it later by running the installation program again.
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See Installing Veritas System Recovery Manager.

To install Veritas System Recovery

Log on to your computer using either the Administrator account or an account with 

administrator privileges.

Insert the Veritas System Recovery product DVD into the media drive of the computer.

The installation program should start automatically.

If the installation program does not run, type the following command at a command prompt:

<drive>:\browser.exe

Replace \<drive\> with the drive letter of your media drive.

On the DVD browser panel, click Installation, and then clickInstall Veritas System Recovery

to start the installation.

On the License Agreement panel, read the license agreement, and then click I accept the 

terms in the license agreement.

Click Next.

On the Installation Type panel, select either Typical InstallationorCustom Installation, and 

then clickNext.

A typical installation installs all of the features of Veritas System Recovery. A custom installation 

allows you to install selected features.

If you selected Custom Installationin step 6, select the options that you want to install, and 

then clickNext.

If you selected Typical Installation in step 6, proceed to step 8.
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SYSTEM RECOVERY DISK CREATION 
UTILITY

VERITAS DOES NOT SHIP THE VERITAS 
SYSTEM RECOVERY DISK WITH THE 

PRODUCT. INSTEAD, VERITAS SYSTEM 
RECOVERY PROVIDES AN OPTION TO 

CREATE A VERITAS SYSTEM RECOVERY 
DISK FOR ALL COMPUTERS IN YOUR 

ENVIRONMENT. YOU CAN USE THIS DISK TO 
RECOVER ANY OTHER COMPUTER IN YOUR 

ENVIRONMENT.

THE VERITAS SYSTEM RECOVERY DISK 
CREATION UTILITY IS INSTALLED BY 

DEFAULT ON ALL THE COMPUTERS ON 
WHICH YOU INSTALL VERITAS SYSTEM 
RECOVERY 23. YOU NEED TO CREATE A 
VERITAS SYSTEM RECOVERY DISK ONLY 

ON A COMPUTER WITH THE LATEST 
WINDOWS OPERATING SYSTEM IN THE 
ENVIRONMENT AS A RECOVERY DISK 

CREATED ON AN OLDER VERSION OF THE 
OPERATING SYSTEM CANNOT RECOVER 

THE LATEST OPERATING SYSTEM.

Backup and Recovery Service Installs the primary service that is required to 
back up or recover your computer.

Recovery Point Browser Enables you to browse, mount, copy, verify, 
and restore files and folders using recovery 
points.

User Interface Installs the product user interface that is 
required for interacting with the Veritas System 
Recovery Service.

Agent Deployment This option appears when you expand the 
User Interface option.

Allows the computer on which you have 
installed Veritas System Recovery to deploy 
the Veritas System Recovery Agent to other 
computers. The Veritas System Recovery 
Agent is required for remote recovery 
management.
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SYSTEM RECOVERY DISK CREATION 
UTILITY

VERITAS DOES NOT SHIP THE VERITAS 
SYSTEM RECOVERY DISK WITH THE 

PRODUCT. INSTEAD, VERITAS SYSTEM 
RECOVERY PROVIDES AN OPTION TO 

CREATE A VERITAS SYSTEM RECOVERY 
DISK FOR ALL COMPUTERS IN YOUR 

ENVIRONMENT. YOU CAN USE THIS DISK TO 
RECOVER ANY OTHER COMPUTER IN YOUR 

ENVIRONMENT.

THE VERITAS SYSTEM RECOVERY DISK 
CREATION UTILITY IS INSTALLED BY 

DEFAULT ON ALL THE COMPUTERS ON 
WHICH YOU INSTALL VERITAS SYSTEM 
RECOVERY 23. YOU NEED TO CREATE A 
VERITAS SYSTEM RECOVERY DISK ONLY 

ON A COMPUTER WITH THE LATEST 
WINDOWS OPERATING SYSTEM IN THE 
ENVIRONMENT AS A RECOVERY DISK 

CREATED ON AN OLDER VERSION OF THE 
OPERATING SYSTEM CANNOT RECOVER 

THE LATEST OPERATING SYSTEM.

Granular Restore Option This option appears when you expand the 
User Interface option.

Lets you open recovery points and restore 
Microsoft Exchange mailboxes, folders, and 
individual messages. You can also restore 
unstructured files and folders.

The Granular Restore Option now supports 
Exchange Server 2013. You can take backups 
and recover the files of Exchange Server 2013.

Veritas Update Keeps your Veritas software up to date with the 
latest product updates.

On the Destination Folder panel, select a folder where you want to install Veritas System 

Recovery, and then click Next.

To troubleshoot a problem in Veritas System Recovery after it is installed, it is recommended that 

you run the SupportGather.exe utility. This utility gathers the existing log information and also runs 

the partinfo.exe and SMEdump.exe utilities to gather additional log information. This log 
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information is in clear text. The log file and the .exe utilities are located in the \<VSR Installation 

folder\>/Utility folder.

“ ”
Note: Veritas recommends that only privileged users or an administrator can access the Utility 

folder. Veritas recommends using AppLocker or Software Restriction Policies (SRP) to allow 

execution of only signed binaries in Veritas System Recovery. You can enable the SRP or 

AppLocker options on your Windows operating system.

“ ”
See http://technet.microsoft.com/en-us/library/hh994614.aspx, to learn more about the SRP and 

Applocker options.

“ ”
Note: Veritas recommends that you place binaries and libraries in theVeritas System Recovery 

installation folder. Only privileged users or an administrator should have the rights to access the 

installation folder.

“ ”
If you select the Typical installation, in the Installation Warning panel, select theI have read 

the warningcheck box, and then clickNext.

See Creation Options.

On the Installation Review panel, review the Veritas System Recovery installation summary, 

and then click Install.

The progress status of the installation process is displayed on the Progress panel.

After the installation completes, the Product Activation panel is displayed.

On the Product Activation panel, two options are displayed.

Select either the Proceed with TrialorActivate Product with Purchased License, and then 

clickNext.

http://technet.microsoft.com/en-us/library/hh994614.aspx
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The Proceed with Trial version is the default option and allows the product to be used for a trial 

period of 60 days.

The Activate Product with Purchased License option, requires you to browse and provide a 

valid license file(.slf).

“ ”
Note: You can browse to the license file available on a network share or locally.

“ ”
Click Next to proceed.

After the activation completes, remove the product DVD from the media drive, and then click 

Finish to close the installation wizard.

Restart your computer.

If you choose not to restart your computer at this time, you cannot run Veritas System Recovery 

until after you restart your computer.

See Activating and setting up Veritas System Recovery after installation.

Activating and setting up Veritas System Recovery after installation
After you complete Veritas System Recovery installation and restart your computer, the Veritas 

System Recovery setup wizard starts automatically. Using the setup wizard you can license or 

activate your product. You can then run Veritas Update to check for product updates, and then 

configure your first backup.

To complete the installation of Veritas System Recovery

In the Welcome panel, click Next.

The Welcome page might appear the first time that you run Veritas System Recovery.

If the Proceed with Trial version option was chosen for product activation, do one of the 

following:

Click I have a license.
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“ ”
Note: You can find the license key by Accessing VEMS athttps://www.veritas.com/content/

support/en_US/article.100048764. You must use it when you install Veritas System 

Recovery.

“ ”
Click Install License later to delay the activation of your license. After the trial period ends, 

the product will no longer work.

See About the trial version of Veritas System Recovery.

If Veritas System Recovery is a trial version and you want to purchase a license key, visit the 

following website:

http://veritas.force.com/public

If you have a Volume Incentive Program (VIP) Activation key, enter it in the appropriate spaces 

as it appears on your certificate.

Click Next.

Do any of the following:

Click Run Veritas Update to check for any product updates since the product shipped.

Click Launch Easy Setup to open the Easy Setup window when you complete the install 

process. (This option is not available in the server versions of Veritas System Recovery.)

Click Finish.

See Activating Veritas System Recovery after the trial period.

Activating Veritas System Recovery after the trial period
If you do not activate Veritas System Recovery before the trial period ends, the software stops 

working. However, you can activate the product at any time after the trial period expires.

To activate Veritas System Recovery after the trial period

On the Help menu, click Enter License Key.

Click I have a license.

http://veritas.force.com/public
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“ ”
Note: You can find the license key by Accessing VEMS athttps://www.veritas.com/content/

support/en_US/article.100048764

“ ”
Browse to provide a valid license file(.slf).

Click Next, and then clickFinish.

After Veritas System Recovery is installed, a folder is created with the metadata and the 

configuration data. The following folder contains the metadata and the configuration data, such as 

job configuration data, Veritas System Recovery logs, backup job history:

C:\Program Data\Veritas\Veritas System Recovery

The following folder contains the license file.

C:\Program Data\Veritas Shared\Licenses

“ ”
Note: Veritas recommends that only privileged users or an administrator have the rights to access 

this folder. If a non-administrative user is configured to use Veritas System Recovery with the 

Security Configuration Tool, add the user to this folder's access control list. This is application data 

and so it needs to be protected to avoid tampering.

“ ”
See About the trial version of Veritas System Recovery.

Uninstalling Veritas System Recovery
When you upgrade Veritas System Recovery from a previous version of the product, the install 

program automatically uninstalls the previous versions. If required, you can manually uninstall the 

product.

Follow your operating system's instructions on how to uninstall software.
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See Activating Veritas System Recovery after the trial period.

System requirements for Veritas System Recovery Manager

Table: Minimum system requirements for Veritas System 
Recovery Manager

COMPONENT DESCRIPTION

Operating system The following Microsoft Windows 64-bit 
operating systems are supported\:

- Microsoft Windows 8.1

- Microsoft Windows 8.1 Update

- Microsoft Windows 10

- Microsoft Windows 11

- Microsoft Windows Server 2012

- Microsoft Windows Server 2012 R2

- Microsoft Windows Server 2012 R2 Update

- Microsoft Windows Server 2016

- Microsoft Windows Server 2019

- Microsoft Windows Server 2022

See the Veritas System Recovery Software 
Compatibility List (SCL) for more information.

Available hard disk space 25 MB

Software Microsoft.NET Framework 4.7

Microsoft Windows screen resolution 1024 x 768 pixels (recommended)

See Installing Veritas System Recovery Manager.
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Installing Veritas System Recovery Manager
Before you begin, you should review the system requirements for installing Veritas System 

Recovery Manager.

See System requirements for Veritas System Recovery Manager.

To install Veritas System Recovery Manager

Log on to your computer using either the Administrator account or an account with 

administrator privileges.

Insert the Veritas System Recovery product DVD into the media drive of the computer.

The installation program should run automatically.

If the installation program does not run, type the following command at a command prompt:

<drive>:\browser.exe

Replace \<drive\> with the drive letter of your media drive.

On the DVD browser panel, under More Useful Links, click Install Veritas System Recovery 

Manager.

Follow the on-screen instructions to complete the installation.

After you complete the installation, you must configure the Windows Firewall exceptions before you 

start Veritas System Recovery Manager.
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Ensuring the recovery of your computer

This section includes the following topics:

Creating a new Veritas System Recovery Disk

Customizing an existing Veritas System Recovery Disk

About restoring a computer from a remote location by using LightsOut Restore

Testing the Veritas System Recovery Disk

Creating a new Veritas System Recovery Disk
As Microsoft no longer allows redistribution of WinPE, Veritas System Recovery 23 does not 

include a Veritas System Recovery Disk on a DVD media or as an ISO downloadable from the 

web. Veritas System Recovery 23 provides a new utility that is called System Recovery Disk 

Creation Utility using which you can create a system recovery disk on your computer. As a 

recovery disk is required to restore images created with Veritas System Recovery 23, it is 

imperative that you create a recovery disk using this utility. To restore the system volume images 

that are created using Veritas System Recovery 23, you need to create a Veritas System Recovery 

Disk using this utility. Veritas recommends that you create a recovery disk using this utility at the 

earliest. By default this utility is installed with Veritas System Recovery 23. Veritas recommends 

that you test the recovery disk on the computer on which you want the use it.

The System Recovery Disk Creation Utility provides two options to create a Veritas System 

Recovery Disk based on the disaster recovery needs. Using the Typical option, you can create a 

recovery disk on Windows 8.1 and later desktop operating systems, and Windows Server 2012 

and later server operating systems. Using the Advanced option, you can create a recovery disk on 

Windows Server 2012 and later server operating system, and Windows 8.1 and later desktop 

operating systems. This option requires the download and installation of the Windows Assessment 

and Deployment Kit (ADK) to create the Veritas System Recovery Disk. The Windows ADK can 

only be installed on Windows Server 2012 and later server operating systems, and Windows 8.1 

and later desktop operating systems.

“ ”
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Note: The Veritas System Recovery Disk Creation Utility only runs on Windows 8.1 and later 

operating systems.

“ ”
Veritas recommends that the recovery disk is created on the latest operating system available, 

such as Windows 10, Windows 11, Windows 2019, or Windows Server 2022. The Veritas System 

Recovery Disk can then be used to recover images of that operating system and all previous 

operating systems. However, a recovery disk created on an older operating system cannot be used 

to recovery later operating systems. For example, a Veritas System Recovery Disk created on 

Windows 2012 cannot be used to recover Windows 2019 images.

The Veritas System Recovery Disk Creation Utility allows creation of a 64-bit recovery disk on a 

USB thumb drive, as an ISO file, or in the LightsOut Restore format. If the Advanced option is 

used, Veritas recommends using the latest version of the Windows ADK that is available. A 

recovery disk created with an older version of the Windows ADK can only restore operating system 

supported by that ADK. For example, a Veritas System Recovery Disk created using Windows ADK 

for Windows 8.1 (Windows 8.1/2012 R2 kernel) can be used to recover Windows 8.1/2012 R2 and 

earlier operating systems. It cannot be used to recovery later operating systems, such as Windows 

10/2016/2019.

A license key is not required to create a Veritas System Recovery Disk. A license key is required if 

additional drivers need to be added, or if specifying the startup or network options.

To create a Veritas System Recovery Disk, you can launch the Create Veritas System Recovery 

Disk Wizard in the following ways:

Launch Veritas System Recovery 23, go to the Tasks menu and click Create New Recovery 

Disk.

On the Windows taskbar, click Start > All Programs > System Recovery Disk Creator.

In the Veritas System Recovery Disk Status dialog box, click Create Now.

“ ”
Note: TheCreate Nowbutton is displayed in theVeritas System Recovery Disk Statusdialog box 

when you launch Veritas System Recovery 23 and is available only until you create the Veritas 

System Recovery Disk. Note: If you are connected to a remote computer, theVeritas System 
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1.

1.

Recovery Disk Creation Wizardis not available in Veritas System Recovery 23. You cannot 

create a Veritas System Recovery Disk.

“ ”
To create a new Veritas System Recovery Disk

On the Tasks menu, click Create New Recovery Disk.

The Veritas System Recovery Disk Creation Wizard is displayed.

In the Welcome panel, review the information, and then click Next.

See Welcome Panel.

In the Creation Options panel, select the disk creation option (TypicalorAdvanced) to create 

the Veritas System Recovery Disk and clickNext.

FEATURE DESCRIPTION TYPICAL ADVANCED

Uses Windows ADK for 
Windows Server 2022

No Yes

You require an Internet 
connection to download 
Windows ADK.

See Download and install 
Windows Assessment and 
Deployment Kit (ADK) .

Platform support Creates a 64-bit recovery 
disk depending on the 
operating system installed 
on your computer.

Creates 64-bit recovery 
disks on the same 
computer.

To create a 64-bit recovery 
disk, use this option on a 
64-bit computer.

Windows operating systems 
that can be recovered

The computer's operating 
system on which you create 
the Veritas System 

All versions of Windows 
supported by the product.
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FEATURE DESCRIPTION TYPICAL ADVANCED

Recovery Disk and all 
earlier versions.

See Veritas System 
Recovery Disk recovery 
matrix .

Use this option on the latest 
operating system to recover 
all Windows operating 
systems.

Languages available in the 
recovery environment

The language of your 
operating system.

One or more of the 8 
supported languages 
selected during Veritas 
System Recovery Disk 
creation.

Temporary disk space 
required on local system

Approximately 500 MB Approximately 500 MB for 
each recovery disk that you 
create. More space is 
required for each additional 
language that you select.

An additional 3.5 to 5 GB 
disk space is required to 
install Windows ADK.

PowerShell Cmdlets support 
in recovery environment (for 
example, Storage Space 
Creation Cmdlets)

Not Available Available

Time required for creation 
(approximately)

10 minutes 20 minutes

If you select more than one 
language, approximately 10 
minutes are added for each 
language.

Can be customized on other 
operating systems

Yes Yes

See Veritas System 
Recovery Disk 
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1.

FEATURE DESCRIPTION TYPICAL ADVANCED

customization support 
matrix .

See Creation Options.

In the Languages panel, select the languages that should be available in the recovery 

environment, and then click Next.

See Languages Options.

“ ”
Note: The Languages panel is only available if you select theAdvancedcreation option.

“ ”
In the Veritas System Recovery Disk Storage Media/Destination panel, select the destination to 

save the recovery disk, and then click Next.

DISK LABEL LETS YOU SPECIFY THE NAME THAT YOU 
WANT TO USE FOR THE

VERITAS SYSTEM RECOVERY DISK 
LABEL.

Select the platform of the recovery disk This option is only displayed if you select the 
Advanced option to create a Veritas System 
Recovery Disk.

Select the 64-bit platform for which you want 
to create the Veritas System Recovery Disk.

Select a drive to create a Veritas System 
Recovery Disk on a USB device

Lets you save your new Veritas System 
Recovery Disk to a USB device.

Select the media drive in which you have 
inserted in the USB device.

The existing data on the USB device is not
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DISK LABEL LETS YOU SPECIFY THE NAME THAT YOU 
WANT TO USE FOR THE

VERITAS SYSTEM RECOVERY DISK 
LABEL.

formatted during Veritas System Recovery 
Disk

creation. If you have a recovery disk created 
on the same USB drive, the new recovery 
disk overwrites the older recovery disk.

Note: Veritas recommends that only 
privileged users or an administrator should 
have the rights to access the USB folder. 
Veritas also recommends that the recovery 
media files be managed only by trusted 
users. This is to ensure that the files are 
always safe and no one can tamper with 
them.

If you attach an unsupported volume to your 
computer, the Show Unsupported Devices 
link is displayed. When you click the link, the 
Unsupported Devices dialog box with a list of 
the unsupported volumes and the reason for 
the unsupported volume is displayed.

A Veritas System Recovery Disk does not 
support the super formatted USB disk.

Save the Veritas System Recovery Disk as 
an ISO file

Lets you save your new Veritas System 
Recovery Disk as an ISO file.

Click Browse and specify the path where you

want to save the ISO file.

You can manually burn the saved ISO file to 
a CD/DVD/Blu-ray.

See Veritas System Recovery Disk Storage Media/Destination Options.
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In the Licensed Features panel, enter the license key of the product and then click Next.

USE THE LICENSE FILE THAT IS 
ACTIVATED ON THIS COMPUTER

ENABLES THE COLD BACKUP FEATURE 
IN THE RECOVERY ENVIRONMENT USING 

THE PRODUCT LICENSE FILE THAT IS 
PROVIDED.

Use the following license file Enables the cold backup feature in the new 
Veritas System Recovery Disk by browsing 
to the product

license file.

Prompt for a license file Prompts you for a product license file at the

time you want to enable features in the

Veritas System Recovery Disk.

See Licensed Features Options.

In the Storage and Network Drivers panel, review the list of any storage or network drivers to 

be included, add, or remove storage and network drivers, and then click Next.

STORAGE AND NETWORK DRIVERS LETS YOU REVIEW THE LIST OF ANY 
STORAGE OR

NETWORK DRIVERS TO BE INCLUDED.

Add Lets you add additional drivers.

The location that you specify should contain

the fully extracted installation package for

the driver you add. If you have more than

one missing storage or network driver, you

can click Add for each missing driver.

See Adding a Storage or Network Driver .
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1.

STORAGE AND NETWORK DRIVERS LETS YOU REVIEW THE LIST OF ANY 
STORAGE OR

NETWORK DRIVERS TO BE INCLUDED.

Remove Deletes the drivers from the driver list that is 
displayed on the wizard.

Reset Resets the list to the original list of storage 
and network drivers that is detected on the 
computer on which the Veritas System 
Recovery Disk creation utility is run.

See Storage and Network Drivers Options.

In the Startup Options panel, select the time zone, display language, keyboard layout language 

for the Veritas System Recovery Disk, and then click Next.

TIME ZONE SETS THE TIME ZONE TO USE FOR THE 
VERITAS SYSTEM RECOVERY DISK.

Display language Sets the default display language for the 
Veritas System Recovery Disk.

Keyboard layout Lets you select the default keyboard layout

to use when you boot from the Veritas 
System Recovery Disk.

See Startup Options.

In the Network Options panel, select the dynamic or static IP, save the Windows firewall 

settings to the Veritas System Recovery Disk, and then click Next.
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1.

AUTOMATICALLY START NETWORK AUTOMATICALLY STARTS NETWORK 
SERVICES WHEN YOU RECOVER THE

SERVICES COMPUTER THROUGH LIGHTSOUT 
RESTORE. SELECT THIS OPTION IF YOU 
WANT TO ENABLE NETWORK SERVICES 

IN A RECOVERY ENVIRONMENT.

Dynamic IP Connects to a network without the need for 
additional

network configuration. You can click this 
option if you

know there is a DHCP server available on 
the network

at the time you restore.

Static IP Connects to a network with a particular 
network

adapter and specific address settings. You 
should select

this option only if you know there is no DHCP 
server (or the

DHCP server is unavailable) when you want 
to recover data.

Use Windows firewall settings Applies the local computer's firewall settings 
to the recovery environment. For example, if 
you turn on the firewall for your local 
computer and then select this option, the 
firewall settings are applied for the recovery 
environment too.

See Network Options.

In the Setup LightsOut Restore panel, select the Enable LightsOut Restorecheck box to 

enable the LightsOut Restore boot option and boot menu display time, and then clickNext.
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BOOT MENU LABEL INDICATES THE TITLE THAT APPEARS

ON THE WINDOWS BOOT MENU FOR 
LIGHTSOUT

RESTORE.

Display boot menu for seconds Specifies how long you want the

boot menu to display.

The default is 10 seconds.

See Setup LightsOut Restore Options.

In the Summary panel, review all of the options that you selected, and then click Finish.

The Progress panel displays the progress status and the approximate time that is required to 

create theVeritas System Recovery Disk. The Result panel displays a success result if the recovery 

disk is created successfully or a failed result if the recovery disk is not created successfully.

When a Veritas System Recovery Disk creation fails or is stopped, the recovery disk creation 

process is stopped. In some cases some files are left mounted in a temporary (folder name, 

SymSrdTemp) location and the files cannot be deleted. The WimCleaner.exe utility unmounts any 

such mounted system files and deletes the temporary folder (SymSrdTemp). Veritas System 

Recovery provides the 32-bit version of the WimCleaner.exe utility.

The utility is at the following location: <VSRInstallPath>\Utility\WimCleaner.exe . You can 

double-click the exe file to run the utility or use the command prompt to run the utility.

“ ”
Note: Veritas recommends that you test the recovery disk after it is created. It ensures that you 

can use the Veritas System Recovery Disk to start your computer and can access the drive that 

contains your recovery points.

“ ”
See Testing the Veritas System Recovery Disk.

Click Close to close the wizard.
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•

Welcome Panel
The Welcome panel in the Veritas System Recovery Disk Creation Wizard provides information 

about the types of recovery disks that you can create and the format of the recovery disks.

You can create a 64-bit Veritas System Recovery Disk, using the Typical or Advanced creation 

option. If you select the Advanced option, you can create a multilingual Veritas System Recovery 

Disk. For the multilingual disk, you must download and install the Windows Assessment and 

Deployment Kit (ADK).

Veritas System Recovery does not support restore of BIOS-based system recovery points on 

UEFI-based computers or vice versa.

A Veritas System Recovery Disk can be created in the following format:

USB disk

ISO file (local or network location)

Creation Options
In the Creation Options panel, on the Veritas System Recovery Disk Creation Wizard, use one of 

the following options to create the Veritas System Recovery Disk:

Typical

A Veritas System Recovery Disk created using this option is sufficient for your usual recovery 

needs.

The option uses the Windows recovery environment available on your computer to create a Veritas 

System Recovery Disk. Using this option you can create a 64-bit recovery disk on a 64-bit 

computer. The recovery disk is created in the language of the operating system from which the disk 

is created, and is one of the 8 languages that Veritas System Recovery 23 supports. Veritas 

recommends creating a Veritas System Recovery Disk on the latest operating system in your 

environment, such as Windows 10/2016/2019. The recovery disk can then be used to recover 

images of Windows 10/2016/2019 operating system and all earlier operating systems.

The Typical option is only available on the operating systems on which the Windows recovery 

environment is also available. You can refer to the following link to view a list of the operating 

systems that use the Windows recovery environment.

http://technet.microsoft.com/en-us/library/ff715587.aspx

http://technet.microsoft.com/en-us/library/ff715587.aspx
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•

•

•

•

•

•

•

•

•

•

•

•

•

The customization features are also available during the trial period of Veritas System Recovery 23 

and after the product license is activated.

See Non-availability of the Typical option.

Advanced

If you require to create a multilingual recovery disk or need a PowerShell support in your recovery 

environment, use the Advanced option to create a Veritas System Recovery Disk.

You can also create 64-bit recovery disks on the same computer. You must have Windows ADK 

installed on your computer to use the Advanced option to create a Veritas System Recovery Disk.

The Typical and Advanced creation options are supported on the following operating systems:

Windows 8.1

Windows 10

Windows 11

Windows Server 2012

Windows Server 2012 R2

Windows Server 2016

Windows Server 2019

Windows Server 2022

Using the following customization features, you can customize a Veritas System Recovery Disk as 

per your requirements:

Select the language.

Add or remove network and storage drivers.

Specify the default network settings.

Specify the default license information.

Select the time zone, display language, and keyboard layout.

The following table lists a comparison of the features available for each option.
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Table: Disk Creation Options

FEATURE DESCRIPTION TYPICAL ADVANCED

Uses Windows ADK for 
Windows Server 2022

No Yes

You require an Internet 
connection to download 
Windows ADK.

See Download and install 
Windows Assessment and 
Deployment Kit (ADK) .

Platform support Creates a 64-bit recovery 
disk depending on the 
operating system installed on 
your computer.

Creates 64-bit recovery disks 
on the same computer.

To create a 64-bit recovery 
disk, use this option on a 64-
bit computer.

Windows operating systems 
that can be recovered

The computer's operating 
system on which you create 
the Veritas System Recovery 
Disk and all earlier versions.

All versions of Windows 
supported by the product.

See Veritas System Recovery 
Disk recovery matrix .

Use this option on the latest 
operating system to recover 
all Windows operating 
systems.

Languages available in the 
recovery environment

The language of your 
operating system.

One or more of the 8 
supported languages 
selected during Veritas 
System Recovery Disk 
creation.

Temporary disk space 
required on local system

Approximately 500 MB Approximately 500 MB for 
each recovery disk that you 
create. More space is 
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FEATURE DESCRIPTION TYPICAL ADVANCED

required for each additional 
language that you select.

An additional 3.5 to 5 GB disk 
space is required to install 
Windows ADK.

PowerShell Cmdlets support 
in recovery environment (for 
example, Storage Space 
Creation Cmdlets)

Not Available Available

Time required for creation 
(approximately)

10 minutes 20 minutes

If you select more than one 
language, approximately 10 
minutes are added for each 
language.

Can be customized on other 
operating systems

Yes Yes

See Veritas System Recovery 
Disk customization support 
matrix .

Veritas System Recovery Disk recovery matrix

You can recover an operating system using a Veritas System Recovery Disk that is created with 

the Typical or Advanced creation options. The following table provides a list of operating systems 

that can be recovered using the Veritas System Recovery Disk.

Veritas recommends that you create a Veritas System Recovery Disk on Windows 10/2016/2019. If 

u do not have a Windows 10/2016/2019 operating system, you can create the recovery disk on the 

most latest operating system that you have in your environment. If u create a Veritas System 

Recovery Disk on an older operating system, you can only recover the operating system on which 

you created the recovery disk or older operating system. The host operating system is the 

operating system on which you create the Veritas System Recovery Disk. Refer to following 

recoverability matrix.
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Table: Recoverability matrix for Veritas System Recovery Disk created using 

theTypicaloption

HOST OPERATING SYSTEM OPERATING SYSTEM THAT CAN BE 
RECOVERED (YES/NO)

- Windows 2012

Windows 11/2022 Yes

Windows 10/2016/2019 Yes

Windows 8.1/2012 R2 Yes

Windows 2012 Yes

Veritas recommends that you use Windows ADK for Windows Server 2022 to create a recovery 

disk using the Advanced option.

A recovery disk created using Windows ADK for Windows 8.1 cannot be used to recover the 

Windows 10/2016/2019 and later operating system. Refer to the following recoverability matrix.

Table: Recoverability matrix for Veritas System Recovery Disk created using 

Windows ADK

HOST OPERATING SYSTEM ADK VERSION USED OPERATING SYSTEM THAT 
CAN BE RECOVERED (YES/

NO)

Windows 2012, Windows 
8.1/2012 R2, Windows 
10/2016/2019,

- Windows 2012

Windows 11, Windows 2022

Windows 2012, Windows 
8.1/2012 R2, Windows 
10/2016/2019,

Windows ADK for Windows 
Server 2022 (Deployment 
Tool and Windows 
Preinstallation Environment)

Yes

Windows 11, Windows 2022
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HOST OPERATING SYSTEM ADK VERSION USED OPERATING SYSTEM THAT 
CAN BE RECOVERED (YES/

NO)

Windows 2012, Windows 
8.1/2012 R2, Windows 
10/2016/2019,

Windows ADK for Windows 
10, version 2004 
(Recommended)

Yes

Windows 11, Windows 2022

Windows 2012, Windows 
8.1/2012 R2, Windows 
10/2016/2019,

Windows ADK for Windows 
8.1 Update

Yes

Windows 11, Windows 2022

Veritas System Recovery Disk customization support matrix

You can customize a Veritas System Recovery Disk created using the Typical or Advanced 

creation option on other operating systems to have drivers installed on those computers available 

in the recovery environment for retargetting. You can also customize, the recovery environment's 

startup options, network options. The following tables provide a list of operating systems on which 

you can customize the Veritas System Recovery Disk.

Table: Customization support matrix for base Veritas System Recovery Disk created 

using theTypicaloption

VERITAS SYSTEM RECOVERY DISK 
CREATED ON HOST OPERATING SYSTEM

CAN BE CUSTOMIZED ON OPERATING 
SYSTEM (YES/NO)

- Windows 2012

Windows 11/2022 Yes

Windows 10/2016/2019 Yes

Windows 8.1/2012 R2 Yes

Windows 2012 Yes



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

37

Table: Customization support matrix for a Veritas System Recovery Disk created 

using theAdvancedoption

VERITAS SYSTEM RECOVERY DISK 
CREATED USING WINDOWS ADK

CAN BE CUSTOMIZED ON OPERATING 
SYSTEM (YES/NO)

- Windows 2012

Windows ADK for Windows Server 2022 
(Deployment Tool and Windows Preinstallation 
Environment)

Yes

Windows ADK for Windows 10, version 2004 Yes

Windows ADK for Windows 8.1 Update Yes

“ ”
Note: A Veritas System Recovery Disk created using Windows ADK for Windows 8.1 can only 

recover Windows 8.1 /Windows Server 2012R2 and earlier operating systems.

“ ”

Non-availability of the Typical option

Veritas System Recovery

When you use Veritas System Recovery to create a Veritas System Recovery Disk, the Typical 

option is not enabled if the Windows Recovery Environment is not available or disabled on your 

computer. You can only create a recovery disk using the Advanced option.

Download and install Windows Assessment and Deployment Kit (ADK)
Using the Windows Assessment and Deployment Kit (ADK) you can create a Veritas System 

Recovery Disk using the Advanced option or setup Lights Out Restore for 64-bit platforms. You can 

create the advanced Veritas System Recovery Disk for any of the available languages.

“ ”
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Note: If Windows ADK is not installed, when you clickNexton the Environment Options page of the 

Veritas System Recovery Disk Creator wizard, an error message is displayed. You can continue to 

create the Veritas System Recovery Disk only after you download and install Windows ADK 

successfully.

“ ”
The following information describes the version of Windows ADK that you need to select along with 

steps to download and install the ADK.

Select the version of Windows ADK

Veritas recommends that you create the Veritas System Recovery Disk using the latest version of 

Windows ADK that is available (Windows ADK for Windows Server 2022). You can perform a 

seamless recovery of the latest Microsoft operating systems using a Veritas System Recovery 

Disk.

Windows ADK for Windows 8.1 Update, Windows 10 version 2004, Windows ADK for Windows 

Server 2022 can be installed on the following operating systems:

Table

OPERATING 
SYSTEMS

WINDOWS ADK FOR 
WINDOWS 8.1 

UPDATE

WINDOWS ADK FOR 
WINDOWS 10, 
VERSION 2004

WINDOWS ADK FOR 
WINDOWS SERVER 

2022

Windows 8.1 Yes Yes Yes

Windows 10 No Yes Yes

Windows 11 No Yes Yes

Windows Server 
2012

Yes Yes Yes

Windows Server 
2012 R2

Yes Yes Yes

Windows Server 
2016

No Yes Yes



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

39

1.

1.

OPERATING 
SYSTEMS

WINDOWS ADK FOR 
WINDOWS 8.1 

UPDATE

WINDOWS ADK FOR 
WINDOWS 10, 
VERSION 2004

WINDOWS ADK FOR 
WINDOWS SERVER 

2022

Windows Server 
2019

No Yes Yes

Windows Server 
2022

No Yes Yes

Starting with Windows ADK for Windows Server 2022 and Windows Preinstallation Environment 

(PE) is released separately from the Assessment and Deployment Kit (ADK) and need to be 

downloaded manually.

Download and install Windows ADK (Deployment Tool and Windows Preinstallation Environment)

Download and run the Windows ADK for Windows Server 2022.

“ ”
Note: Windows ADK is a Microsoft product and if any errors are reported when you download 

and install the ADK, contact Microsoft support.

“ ”
The Download and Install the Windows ADK page is displayed.

Download the setup files for Windows ADK and for Windows PE add-on for ADK using the 

available links.

“ ”
Note: This page also displays the disk space that is required for the ADK kit and the disk space 

available on your computer.

“ ”

https://docs.microsoft.com/en-us/windows-hardware/get-started/adk-install?ocid=tia-235208000
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2.

3.

4.

1.

2.

1.

1.

1.

2.

1.

After the download is complete, verify that the adksetup.exe  file and the Installers folder 

have been downloaded to the computer.

Copy the downloaded files and folder to the computer on which you want to install ADK.

Start adksetup.exe  from the copied folder.

The Specify Locationpage is displayed. By default,Install the Windows Assessment and 

Deployment Kit to this computer is selected.

Click Browse and select the installation path.

Click Next.

The Windows Kits Privacypage is displayed. By default,Yes is selected.

Determine if you want to join the program, and then click Next.

The License Agreement page is displayed.

Click Accept.

The Select the features you want to install page is displayed.

Select only the Deployment Tools check box.

“ ”
Note: This page also displays the disk space that is required for the features and the disk 

space available on your computer.

“ ”
Click Install.

The Installing features page is displayed. You can view the installation progress of the features.

When the installation is complete, for the Windows Preinstallation Environment, run 

adkwinpesetup.exe .

The Specify Locationpage is displayed. By default,Install the Windows Assessment and 

Deployment Kit to this computer is selected.

Click Browse and select the installation path.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

41

2.

1.

1.

1.

2.

1.

Click Next.

The Windows Kits Privacypage is displayed. By default,Yes is selected.

Determine if you want to join the program, and then click Next.

The License Agreement page is displayed.

Click Accept.

The Select the features you want to install page is displayed.

Select only the Windows Preinstallation Environment (Windows PE) check box.

Click Install.

The Installing features page is displayed. You can view the installation progress of the features.

When the installation is complete, click Close.

To continue creating the advanced Veritas System Recovery Disk, click Next on the Veritas 

System Recovery Disk Creation Wizard.

Languages Options
The Languages panel, on the Veritas System Recovery Disk Creation Wizard is only available 

when you select the Advanced option to create a Veritas System Recovery Disk.

The default language is selected based on a computer's locale. If Windows ADK for Windows 

Server 2022, Windows ADK for Windows 10 version 2004, or 8.1 is installed on your computer, you 

can select any combination of the 8 supported languages.

If multiple administrators use the Veritas System Recovery Disk, you can create the recovery disk 

in multiple languages. If you select multiple languages to create the Veritas System Recovery Disk, 

more time may be required to create the recovery disk.

Veritas System Recovery Disk Storage Media/Destination Options
In the Veritas System Recovery Disk Storage Media/Destination, on the Veritas System Recovery 

Disk Creation Wizard, select the destination to save the Veritas System Recovery Disk on a USB 

disk or as an ISO file.

The Veritas System Recovery Disk Storage Media/Destination panel also displays the disk space 

available on the selected drive of your computer. For example, C drive. You can select multiple 

destination media. If you select the ISO option, you can also save the Veritas System Recovery 
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Disk to a network destination. When you specify a network destination, you must enter a valid user 

name and password to access the network.

For a USB media, both the NTFS and FAT32 file systems are supported. If you need to create a 

USB Veritas System Recovery Disk that needs to boot on both BIOS and UEFI (firmware) 

computers, then you must create the recovery disk on a FAT32 USB drive.

“ ”
Note: You cannot create multiple Veritas System Recovery Disks on the same media.

“ ”
Veritas System Recovery does not support using a lower version of a Veritas System Recovery 

Disk to restore a newer version of an operating system. For example, you cannot use a Veritas 

System Recovery Disk created on Windows 8.1 to restore a Windows 10 operating system. You 

cannot restore a Veritas System Recovery Disk created using Windows ADK for Windows 8.1 to 

restore a Windows 10 or Windows 11 operating system.

In the Create Veritas System Recovery Disk Wizard, if you select the Typical or Advanced option, 

you can create a 64-bit Veritas System Recovery Disk on your computer.

When you select the Advanced option, you can create 64-bit Veritas System Recovery Disk as ISO 

files on your computer. The ISO files are stored in the same folder.

The following table describes the options on the Veritas System Recovery Disk Storage Media/

Destination panel.

Table: Veritas System Recovery Disk Storage Media/Destination options

OPTION DESCRIPTION

Disk label Lets you specify the name that you want to use 
for the

Veritas System Recovery Disk label.

Select the platform of the recovery disk This option is only displayed if you select the 
Advanced option to create a Veritas System 
Recovery Disk.
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OPTION DESCRIPTION

Select the 64-bit platforms for which you want 
to create the Veritas System Recovery Disk.

Select a drive to create a Veritas System 
Recovery Disk on a USB device

Lets you save your new Veritas System 
Recovery Disk to a USB device.

Select the media drive in which you have 
inserted in the USB device.

The existing data on the USB device is not

formatted during Veritas System Recovery 
Disk

creation. If you have a recovery disk created 
on the same USB drive, the new recovery disk 
overwrites the older recovery disk.

Note: Veritas recommends that only privileged 
users or an administrator should have the 
rights to access the USB folder. Veritas also 
recommends that the recovery media files be 
managed only by trusted users. This is to 
ensure that the files are always safe and no 
one can tamper with them.

If you attach an unsupported volume to your 
computer, the Show Unsupported Devices link 
is displayed. When you click the link, the 
Unsupported Devices dialog box with a list of 
the unsupported volumes and the reason for 
the unsupported volume is displayed.

Veritas System Recovery Disk on a USB is not 
supported for the following disks or drives:

- FAT (FAT16) and exFAT formatted drives.

- Dynamic disk.
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OPTION DESCRIPTION

- Hidden volumes (no drive letter is assigned to 
the USB volume).

- USB is write-protected.

- USB is protected using an encryption 
software (such as, BitLocker, TrueCrypt, SEP) 
at the disk or the volume level.

- USB drives that are on extended partitions.

- USB disk is formatted to GPT layout.

- U3 USB devices.

- Native 4K disk greater than 2TB.

A Veritas System Recovery Disk does not 
support the super formatted USB disk.

Save the Veritas System Recovery Disk as an 
ISO file

Lets you save your new Veritas System 
Recovery Disk as an ISO file.

Click Browse and specify the path where you

want to save the ISO file.

Firmware support matrix for Veritas System Recovery Disk created on USB drive (Thumb/HDD)

The maximum size of the USB drive (Thumb/HDD) should be up to 2 terabytes.

Table: Firmware support matrix

FIRMWARE SUPPORT FS TYPE SUPPORTED CLUSTER SIZE

BIOS bootable USB Veritas 
System Recovery Disk

FAT32 Up to 8K

BIOS bootable USB Veritas 
System Recovery Disk

NTFS 4K
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FIRMWARE SUPPORT FS TYPE SUPPORTED CLUSTER SIZE

Both BIOS + UEFI bootable 
USB Veritas System 
Recovery Disk

FAT32 Up to 8K

Licensed Features Options
In the Licensed Features panel, on the Veritas System Recovery Disk Creation Wizard, the license 

key that you enter is added to the Veritas System Recovery Disk and is also used to enable the 

cold backup feature of the recovery disk.

The following table describes the options on the Licensed Features panel.

Table: Licensed Feature options

OPTIONS DESCRIPTION

Use the license file that is activated on this 
computer

Enables the cold backup feature in the 
recovery environment using the product 
license file that is provided.

Note: By default, this option is not available 
when you create a Veritas System Recovery 
Disk using the Veritas System Recovery 
Management Solution Mode.

Use the following license file Enables the cold backup feature in the new 
Veritas System Recovery Disk by browsing to 
the product

license file.

Prompt for a license file Prompts you for a product license file at the

time you want to enable features in the

Veritas System Recovery Disk.

Note: By default, this option is selected when 
you create a Veritas System Recovery Disk 
using the Veritas System Recovery 
Management Solution Mode.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

46

“ ”
Note: During the trial mode when you create a Veritas System Recovery Disk, all customization 

options are available. After the trial mode is over, you can create a Veritas System Recovery Disk, 

without customization options (for example, adding drivers, startup options, and so on). 

Customizing a Veritas System Recovery Disk is a licensed feature.

“ ”

Storage and Network Drivers Options
The Storage and Network Drivers panel, on the Veritas System Recovery Disk Creation Wizard, 

displays the list of storage and network drivers available on your local computer. The drivers are 

added to the recovery disk and loaded as required when you boot into recovery environment using 

theVeritas System Recovery Disk. These drivers are also used for dissimilar hardware restore.

“ ”
Note: All the storage and network drivers that are available on your computer are displayed.

“ ”
The following table describes the options on the Storage and Network Drivers panel.

Table: Storage and Network Driver options

OPTION DESCRIPTION

Storage and network drivers Lets you review the list of any storage or

network drivers to be included.

Add Lets you add additional drivers.

The location that you specify should contain

the fully extracted installation package for
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OPTION DESCRIPTION

the driver you add. If you have more than

one missing storage or network driver, you

can click Add for each missing driver.

See Adding a Storage or Network Driver .

Remove Deletes the drivers from the driver list that is 
displayed on the wizard.

Reset Resets the list to the original list of storage and 
network drivers that is detected on the 
computer on which the Veritas System 
Recovery Disk creation utility is run.

Adding a Storage or Network Driver

In the Add Storage and Network Driver dialog box, on the Veritas System Recovery Disk Creation 

Wizard, click Browse and select the .inf file of the driver, which is to be added to theVeritas System 

Recovery Disk.

You need to provide a suitable driver that is compatible with the version of WinPE that you use to 

create a Veritas System Recovery Disk. Drivers that are not compatible with the version of WinPE 

used to create this recovery disk, do not load when you boot into recovery environment using the 

Veritas System Recovery Disk.

If you create a Veritas System Recovery Disk using the Typical option, the version of WinPE is the 

same as the version of the local operating system. If you create a Veritas System Recovery Disk 

using Windows ADK for Windows 8.1 Update, Windows 10 version 2004, or Windows ADK for 

Windows Server 2022; you need to provide a Windows 2012, Windows 8.1/2012 R2, or Windows 

10/2016/2019 compatible driver.

If you are customizing an existing Veritas System Recovery Disk, the version of WinPE is 

mentioned in the SymInfo.xml  file at the root of the Veritas System Recovery Disk media. All the 

drivers that are added using this wizard are available when you boot into the recovery disk and are 

used for HIR (Restore Anyware). Even if you add a driver that is not compatible with the WinPE 

version of a recovery disk, it is added to the Veritas System Recovery Disk. This incompatible 

driver is only used when you boot into the recovery environment.
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Startup Options
In the Startup Options panel, on the Veritas System Recovery Disk Creation Wizard, the options 

that you select when you create a Veritas System Recovery Disk are applied when you boot into 

the recovery disk.

The following table describes the options on the Startup Options panel.

Table: Startup Options

OPTION DESCRIPTION

Time zone Sets the time zone to use for the Veritas 
System Recovery Disk.

Display language Sets the default display language for the 
Veritas System Recovery Disk.

Keyboard layout Lets you select the default keyboard layout

to use when you boot from the Veritas System 
Recovery Disk.

Network Options
In the Network Options panel, on the Veritas System Recovery Disk Creation Wizard, the selected 

network options are used when you want to recover images from a network location. To recover 

images over a network location, you need to access the remote network location. The network 

options are applicable when you boot into theVeritas System Recovery Disk.

The following table describes the options on the Network Options panel.

Table: Network Options

OPTION DESCRIPTION

Automatically start network Automatically starts network services when 
you recover the

services computer through LightsOut Restore. Select 
this option if you want to enable network 
services in a recovery environment.
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Dynamic IP Connects to a network without the need for 
additional

network configuration. You can click this option 
if you

know there is a DHCP server available on the 
network

at the time you restore.

Static IP Connects to a network with a particular 
network

adapter and specific address settings. You 
should select

this option only if you know there is no DHCP 
server (or the

DHCP server is unavailable) when you want to 
recover data.

Use Windows firewall settings Applies the local computer's firewall settings to 
the recovery environment. For example, if you 
turn on the firewall for your local computer and 
then select this option, the firewall settings are 
applied for the recovery environment too.

Setup LightsOut Restore Options
In the Setup LightsOut Restore panel, on the Veritas System Recovery Disk Creation Wizard, the 

LightsOut Restore option creates a copy of your recovery environment on your local computer's 

hard drive. The LightsOut Restore option lets you boot into a recovery environment same as a 

Veritas System Recovery Disk stored on an external USB media.

The following table describes the options on the Setup LightsOut Restore panel.
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1.

1.

1.

Table: Setup LightsOut Restore options

OPTION DESCRIPTION

Boot menu label Indicates the title that appears

on the Windows boot menu for LightsOut

Restore.

Display boot menu for seconds Specifies how long you want the

boot menu to display.

The default is 10 seconds.

Customizing an existing Veritas System Recovery Disk
Veritas recommends that you customize a Veritas System Recovery Disk, even if driver validation 

succeeds, and your Veritas System Recovery Disk appears to work. You can customize a Veritas 

System Recovery Disk, which is available on a USB device and DVD (manually burned). A custom 

Veritas System Recovery Disk contains your computer's current network and storage device 

drivers. It helps to ensure that in an emergency you can get to the recovery points that are required 

to restore your computer.

A customized Veritas System Recovery Disk can also be used as a source for creating another 

custom Veritas System Recovery Disk.

To launch the Customize Existing Veritas System Recovery Disk Wizard go to the Tasks menu and 

click Customize Existing Recovery Disk.

To customize an existing Veritas System Recovery Disk

On the Tasks menu, click Customize Existing Recovery Disk.

The Customize Veritas System Recovery Disk Wizard is displayed.

In the Welcome panel, review the information, and then click Next.

See Welcome Panel.

In the Recovery Disk Sourcepanel, select the source Veritas System Recovery Disk and then 

clickNext.
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1.

IF YOU KNOW THE PATH TO THE SOURCE 
VERITAS SYSTEM RECOVERY DISK

TYPE THE PATH IN THE VERITAS SYSTEM 
RECOVERY DISK MEDIA LOCATION FIELD.

If you do not know the path to the source 
Veritas System Recovery Disk

Do the following in the order listed\:

- Click Browse .

- Click Veritas System Recovery Disk ISO 
File to locate the path for the ISO image file, 
or click Veritas System Recovery Disk Folder 
to locate the path for the disk on other 
media.

- On the Open dialog box, navigate to the 
location of the appropriate ISO image file, 
media drive, or folder.

- Click Open .

See Recovery Disk Source Options.

In the Veritas System Recovery Disk Storage Media/Destination panel, select the destination to 

save the recovery disk, and then click Next.

DISK LABEL LETS YOU SPECIFY THE NAME THAT YOU 
WANT TO USE FOR THE

VERITAS SYSTEM RECOVERY DISK 
LABEL.

Select a drive to create a Veritas System 
Recovery Disk on a USB device

Lets you save your new Veritas System 
Recovery Disk to a USB device.

Select the media drive in which you have 
inserted in the USB device.

Note: The existing data on the USB device is 
not formatted during Veritas System 
Recovery Disk creation. If you have a 
recovery disk created on the same USB 
drive, the new recovery disk overwrites the 
older recovery disk.
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1.

DISK LABEL LETS YOU SPECIFY THE NAME THAT YOU 
WANT TO USE FOR THE

VERITAS SYSTEM RECOVERY DISK 
LABEL.

Note: Veritas recommends that only 
privileged users or an administrator should 
have the rights to access the USB folder. 
Veritas also recommends that the recovery 
media files be managed only by trusted 
users. This is to ensure that the files are 
always safe and no one can tamper with 
them.

See How to add new drivers or driver 
versions to the Veritas System Recovery 
Disk .

If you attach an unsupported volume to your 
computer, the Show Unsupported Devices 
link is displayed. When you click the link, the 
Unsupported Devices dialog box with a list of 
the unsupported volumes and the reason for 
the unsupported volume is displayed.

Save the Veritas System Recovery Disk as 
an ISO file

Lets you save your new Veritas System 
Recovery Disk as an ISO file.

Click Browse and specify the path where you

want to save the ISO file.

You can manually burn the ISO file to a CD/
DVD/Blu-ray.

See Veritas System Recovery Disk Storage Media/Destination Options.

In the Licensed Featurespanel, enter the license of the product and then clickNext.
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1.

USE THE LICENSE FILE THAT IS 
ACTIVATED ON THIS COMPUTER

ENABLES THE COLD BACKUP FEATURE 
IN THE RECOVERY ENVIRONMENT USING 

THE PRODUCT LICENSE FILE THAT IS 
PROVIDED.

Use the following license file Enables the cold backup feature in the new 
Veritas System Recovery Disk by browsing 
to the product

license file.

Prompt for a license file Prompts you for a product license file at the

time you want to enable features in the

customized Veritas System Recovery Disk.

See Licensed Features Options.

In the Storage and Network Driverspanel, review the list of any storage or network drivers to 

be included, add or remove storage and network drivers, and then clickNext.

STORAGE AND NETWORK DRIVERS LETS YOU REVIEW THE LIST OF ANY 
STORAGE OR

NETWORK DRIVERS TO BE INCLUDED.

Add Lets you add additional drivers.

The location that you specify should contain

the fully extracted installation package for

the driver you add. If you have more than

one missing storage or network driver, you

can click Add for each missing driver.

Remove Deletes the drivers you do not need.

Reset Resets the list to the original list of drivers 
that is detected on the computer.
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1.

1.

See Storage and Network Drivers Options.

In the Startup Options panel, select the time zone, display language, keyboard layout language 

for theVeritas System Recovery Disk, and then click Next.

TIME ZONE SETS THE TIME ZONE TO USE FOR THE 
VERITAS SYSTEM RECOVERY DISK.

Display language Sets the default display language for the 
Veritas System Recovery Disk.

Keyboard layout Lets you select the default keyboard layout

to use when you boot from the Veritas 
System Recovery Disk.

See Startup Options.

In the Network Optionspanel, select the dynamic or static IP, save the Windows firewall 

settings to the Veritas System Recovery Disk, and then clickNext.

AUTOMATICALLY START NETWORK 
SERVICES

SELECT THIS OPTION IF U WANT TO 
ENABLE NETWORK SERVICES IN A 

RECOVERY ENVIRONMENT. NETWORKING 
STARTS AUTOMATICALLY WHEN YOU 

RECOVER THE

COMPUTER THROUGH LIGHTSOUT 
RESTORE.

Dynamic IP Connects to a network without the need for 
additional

network configuration. You can click this 
option if you

know there is a DHCP server available on 
the network

at the time you restore.

Static IP Connects to a network with a particular 
network
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1.

AUTOMATICALLY START NETWORK 
SERVICES

SELECT THIS OPTION IF U WANT TO 
ENABLE NETWORK SERVICES IN A 

RECOVERY ENVIRONMENT. NETWORKING 
STARTS AUTOMATICALLY WHEN YOU 

RECOVER THE

COMPUTER THROUGH LIGHTSOUT 
RESTORE.

adapter and specific address settings. You 
should click

this option if you know there is no DHCP 
server (or the

DHCP server is unavailable) when you 
recover.

Use Windows firewall settings Applies the local computer's firewall settings 
to the recovery environment. For example, if 
you turn on the firewall for your local 
computer and then select this option, the 
firewall is turned on for the recovery 
environment.

See Network Options.

In the Summary panel, review all of the options that you selected, and then click Finish.

The Progress panel displays the progress status and the approximate time that is required to 

create theVeritas System Recovery Disk. The Result panel displays a success result if the recovery 

disk is created successfully or a failed result if the recovery disk is not created successfully.

“ ”
Note: Veritas recommends that you test the recovery disk after it is created. It ensures that you 

can use the Veritas System Recovery Disk to start your computer and can access the drive that 

contains your recovery points.

“ ”
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1.

•

•

See Testing the Veritas System Recovery Disk.

Click Close to close the wizard.

More Information

Adding a Storage or Network Driver

Welcome Panel
The Welcome panel on the Customize Veritas System Recovery Disk Wizard provides information 

about this wizard and the format of the recovery disk that you can create.

You can use this wizard to add the missing storage or network drivers in the Veritas System 

Recovery Disk. The wizard also identifies and compares the drivers in your current recovery disk 

with those available on your computer and lets you add the missing drivers. You can also update 

the startup and network options of the recovery disk.

Veritas System Recovery does not support restore of BIOS-based system recovery points on 

UEFI-based computers or vice versa.

The Veritas System Recovery Disk can be created in the following formats:

USB disk

ISO file (local or network location).

After you review the information, click Next.

Recovery Disk Source Options
In the Recovery Disk Source panel, on the Customize Veritas System Recovery Disk Wizard, do 

one of the following:

Table: Recovery Disk Source Options

OPTION DESCRIPTION

If you know the path to the source Veritas 
System Recovery Disk

Type the path in the Veritas System Recovery 
Disk media location field.

If you do not know the path to the source 
Veritas System Recovery Disk

Do the following in the order listed\:

- Click Browse .



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

57

OPTION DESCRIPTION

- Click Veritas System Recovery Disk ISO File 
to locate the path for the ISO image file or click 
Veritas System Recovery Disk Folder to locate 
the path for the disk on other media.

- On the Open dialog box, navigate to the 
location of the appropriate ISO image file, 
media drive, or folder.

- Click Open .

Veritas System Recovery Disk Storage Media/Destination Options
In the Veritas System Recovery Disk Storage Media/Destination panel, on the Customize Veritas 

System Recovery Disk Wizard, select the destination to save the Veritas System Recovery Disk on 

a USB disk or as an ISO file.

The Veritas System Recovery Disk Storage Media/Destination panel also displays the disk space 

available on the selected drive of your computer. For example, C drive. You can select multiple 

destination media. If you select the ISO option, you can also save the Veritas System Recovery 

Disk to a network destination. When you specify a network destination, you must enter a valid user 

name and password to access the network.

For a USB media, both the NTFS and FAT32 file systems are supported. If you need to create a 

USB Veritas System Recovery Disk that needs to boot on both BIOS and UEFI (firmware) 

computers, then you must create the recovery disk on a FAT32 USB drive.

“ ”
Note: You cannot create multiple Veritas System Recovery Disks on the same media.

“ ”
Veritas System Recovery does not support using a lower version of a Veritas System Recovery 

Disk to restore a newer version of an operating system. For example, you cannot use a Veritas 

System Recovery Disk created on Windows 8.1 to restore a Windows 10 operating system. You 
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cannot restore a Veritas System Recovery Disk created using Windows ADK for Windows 8.1 to 

restore a Windows 10 and Windows 11 operating systems.

The following table describes the options on the Veritas System Recovery Disk Storage Media/

Destination panel.

Table: Veritas System Recovery Disk Storage Media/Destination options

OPTION DESCRIPTION

Disk label Lets you specify the name that you want to use 
for the

Veritas System Recovery Disk label.

Select a drive to create a Veritas System 
Recovery Disk on a USB device

Lets you save your new Veritas System 
Recovery Disk to a USB device.

Select the media drive in which you have 
inserted in the USB device.

Note: The existing data on the USB device is 
not formatted during Veritas System Recovery 
Disk creation. If you have a recovery disk 
created on the same USB drive, the new 
recovery disk overwrites the older recovery 
disk.

Note: Veritas recommends that only privileged 
users or an administrator should have the 
rights to access the USB folder. Veritas also 
recommends that the recovery media files be 
managed only by trusted users. This is to 
ensure that the files are always safe and no 
one can tamper with them.

See How to add new drivers or driver versions 
to the Veritas System Recovery Disk .

If you attach an unsupported volume to your 
computer, the Show Unsupported Devices link 
is displayed. When you click the link, the 
Unsupported Devices dialog box with a list of 
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the unsupported volumes and the reason for 
the unsupported volume is displayed.

Veritas System Recovery Disk on a USB is not 
supported for the following disks or drives:

- FAT (FAT16) and exFAT formatted drives.

- Dynamic disk.

- Hidden volumes (no drive letter is assigned to 
the USB volume).

- USB is write-protected.

- USB is protected using an encryption 
software (such as, BitLocker, TrueCrypt, SEP) 
at the disk or the volume level.

- USB drives that are on extended partitions.

- USB disk is formatted to GPT layout.

- U3 USB devices.

- Native 4K disk greater than 2TB.

A Veritas System Recovery Disk does not 
support the super formatted USB disk.

Save the Veritas System Recovery Disk as an 
ISO file

Lets you save your new Veritas System 
Recovery Disk as an ISO file.

Click Browse and specify the path where you

want to save the ISO file.

Firmware support matrix for Veritas System Recovery Disk created on USB drive (Thumb/HDD)

The maximum size of the USB drive (Thumb/HDD) should be up to 2 terabytes.
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Table: Firmware support matrix

FIRMWARE SUPPORT FS TYPE SUPPORTED CLUSTER SIZE

BIOS bootable USB Veritas 
System Recovery Disk

FAT32 Up to 8K

BIOS bootable USB Veritas 
System Recovery Disk

Both BIOS + UEFI bootable 
USB Veritas System 
Recovery Disk

4K

Both BIOS + UEFI bootable 
USB Veritas System 
Recovery Disk

FAT32 Up to 8K

How to add new drivers or driver versions to the Veritas System Recovery Disk

Whenever new drivers or driver versions are added to your computers, you must add them to the 

Veritas System Recovery Disk. If your Veritas System Recovery Disk is on a USB device, you can 

update it rather than creating a new one.

To update an existing Veritas System Recovery Disk on a USB device, run the Customize Veritas 

System Recovery Disk Wizard. During Veritas System Recovery Disk customization, the existing 

drivers are retained and only the new drivers are added to the recovery disk.

“ ”
Note: You can add drivers from multiple computers to a single Veritas System Recovery Disk on a 

USB device.

“ ”
See Customizing an existing Veritas System Recovery Disk.

Licensed Features Options
In the Licensed Features panel, on the Customize Veritas System Recovery Disk Wizard, the 

license key that you enter here is added to the Veritas System Recovery Disk and is also used to 

enable the cold backup feature of the recovery disk.

The following table describes the options on the Licensed Features panel.
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Table: Licensed Feature options

OPTION DESCRIPTION

Use the license file that is activated on this 
computer

Enables the cold backup feature in the 
recovery environment using the product 
license file that is provided.

Use the following license file Enables the cold backup feature in the new 
Veritas System Recovery Disk by browsing to 
the product

license file.

Prompt for a license file Prompts you for a product license file at the

time you want to enable features in the

customized Veritas System Recovery Disk.

“ ”
Note: During the trial mode when you create a Veritas System Recovery Disk, all customization 

options are available. After the trial mode is over, you can create a Veritas System Recovery Disk, 

without customization options (for example, adding drivers, startup options, and so on). 

Customizing a Veritas System Recovery Disk is a licensed feature.

“ ”

Storage and Network Drivers Options
The Storage and Network Drivers panel, on the Customize Veritas System Recovery Disk Wizard, 

displays the list of storage and network drivers available on your local computer. The drivers are 

added to the recovery disk and loaded as required when you boot into recovery environment using 

theVeritas System Recovery Disk. These drivers can also be used for dissimilar hardware restore.

“ ”
Note: All the storage and network drivers that are available on your system are displayed.
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“ ”
The following table describes the options on the Storage and Network Drivers panel.

Table: Storage and Network Driver options

OPTION DESCRIPTION

Storage and network drivers Lets you review the list of any storage or

network drivers to be included.

Add Lets you add additional drivers.

The location that you specify should contain

the fully extracted installation package for

the driver you add. If you have more than

one missing storage or network driver, you

can click Add for each missing driver.

Remove Deletes the drivers you do not need.

Reset Resets the list to the original list of drivers that 
is detected on the computer.

More Information

Adding a Storage or Network Driver

Adding a Storage or Network Driver

In the Add Storage and Network Driver dialog box, on the Customize Veritas System Recovery 

Disk Wizard, click Browse and select the .inf file of the driver, which is to be added to theVeritas 

System Recovery Disk.

You need to provide a suitable driver that is compatible with the version of WinPE that you use to 

customize a Veritas System Recovery Disk. Drivers that are not compatible with the version of 
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WinPE used to customize this recovery disk do not load when you boot into recovery environment 

using this Veritas System Recovery Disk.

If you are customizing an existing Veritas System Recovery Disk, the version of WinPE is 

mentioned in the SymInfo.xml  file at the root of the Veritas System Recovery Disk media. All the 

drivers added using this wizard are available when you boot into the recovery disk and are used for 

HIR (Restore Anyware). Even if you add a driver that is not compatible with the WinPE version of a 

recovery disk, it is added to the Veritas System Recovery Disk. This incompatible driver is only 

used when you boot into the recovery environment.

Startup Options
In the Startup Options panel, on the Customize Veritas System Recovery Disk Wizard, the options 

selected when you create a Veritas System Recovery Disk are applied when you boot into the 

recovery disk.

The following table describes the options on the Startup Options panel.

Table: Startup Options

OPTION DESCRIPTION

Time zone Sets the time zone to use for the Veritas 
System Recovery Disk.

Display language Sets the default display language for the 
Veritas System Recovery Disk.

Keyboard layout Lets you select the default keyboard layout

to use when you boot from the Veritas System 
Recovery Disk.

Network Options
In the Network Options panel, on the Customize Veritas System Recovery Disk Wizard, the 

selected options are used when you want to recover images from a network location. To recover 

images over a network location, you need to access the remote network location. The network 

options are applicable when you boot into theVeritas System Recovery Disk.

The following table describes the options on the Network Options panel.
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Table: Network Options

OPTION DESCRIPTION

Automatically start network services Select this option if u want to enable network 
services in a recovery environment. 
Networking starts automatically when you 
recover the

computer through LightsOut Restore.

Dynamic IP Connects to a network without the need for 
additional

network configuration. You can click this option 
if you

know there is a DHCP server available on the 
network

at the time you restore.

Static IP Connects to a network with a particular 
network

adapter and specific address settings. You 
should click

this option if you know there is no DHCP 
server (or the

DHCP server is unavailable) when you 
recover.

Use Windows firewall settings Applies the local computer's firewall settings to 
the recovery environment. For example, if you 
turn on the firewall for your local computer and 
then select this option, the firewall is turned on 
for the recovery environment.
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About restoring a computer from a remote location by using 
LightsOut Restore
Veritas System Recovery LightsOut Restore lets administrators restore a computer from a remote 

location. It works regardless of the state of the computer provided that its file system is intact.

For example, suppose you are on vacation in the Bahamas and a computer on your network in 

Vancouver goes down. You can connect to the computer from your remote location by using your 

server's remote connection capabilities. You can remotely access a Veritas System Recovery Disk 

to start the computer in the recovery environment. You can then use the Veritas System Recovery 

Disk to restore files or an entire system partition.

LightsOut Restore installs a custom version of a Veritas System Recovery Disk directly to the file 

system on the system partition. It then places a Veritas System Recovery Disk boot option in the 

Windows boot menu. Whenever the boot menu option is selected, the computer boots directly into 

the Veritas System Recovery Disk. It uses the files that are installed on the system partition.

LightsOut Restore uses the Windows boot menu, and hardware devices such as RILO and DRAC. 

These features combine to let an administrator remotely control a system during the boot process.

After you configure LightsOut Restore and add the boot menu option, you can use a hardware 

device to remotely connect to the system. After you connect, you can turn on or reboot the system 

into theVeritas System Recovery Disk.

“ ”
Note: If you use Microsoft BitLocker to secure the data on a drive, be aware that LightsOut 

Restore does not work on BitLocked drives. Therefore, if you "BitLock" your system drive, you 

cannot recover the drive using LightsOut Restore.

“ ”
See Configuring LightsOut Restore.

Configuring LightsOut Restore
Before you set up LightsOut Restore, review the following information:

“ ”
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•

•

•

•

•

Note: If you use Microsoft's BitLocker Drive Encryption to encrypt the data on a drive, be aware 

that LightsOut Restore does not work on encrypted drives. You must turn off BitLocker and then 

decrypt the drive before you can use LightsOut Restore on it.

“ ”
Ensure that all of your servers can be managed remotely through a hardware device such as 

RILO or DRAC.

Install Veritas System Recovery on the servers that you want to protect, and then define and 

run backups to create recovery points.

Run the Setup LightsOut Restore Wizard to install a custom Veritas System Recovery Disk 

directly to the computer's local file system.

The wizard creates an entry in the Windows boot menu that can be used to boot into Veritas 

System Recovery Disk .

“ ”
Note: LightsOut Restore works only on the primary operating system. It does not work on multiple-

boot computers (for example, a computer that starts multiple operating systems from the same 

partition). LightsOut Restore is accessible only from the boot menu. If the file system becomes 

corrupt and you cannot access the boot menu, you must boot the computer from theVeritas 

System Recovery Disk. Note: The LightsOut Restore feature requires at least 1 GB of memory to 

run.

“ ”
Use the RILO or the DRAC device to connect to the remote server so you can recover a file or 

system from a remote location. Then you can turn on the system or restart it.

Open the boot menu as the remote server starts, and then select the name that you have given 

to Veritas System Recovery Disk.

The remote server boots into Veritas System Recovery Disk and the connection through RILO or 

DRAC is lost.
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You must run the Setup LightsOut Restore Wizard on the computer that you want to protect. The 

Setup LightsOut Restore Wizard installs a customized version of a Veritas System Recovery Disk 

to the computer's local file system. The wizard creates an entry in the Windows boot menu that you 

use to boot into the Setup LightsOut Restore Wizard.

If you need to edit the configuration settings, you must first uninstall LightsOut Restore from your 

computer and install it again. To uninstall LightsOut Restore, on the Tasks menu, click Remove 

LightsOut Restore.

After the setup is completed, the LightsOut Restore metadata, recovery environment data, and 

scripts are stored at the following location:

<system drive> :SRD.

Where <system drive>  is replaced with the actual drive letter.

“ ”
Note: Veritas recommends that only privileged users or an administrator should have the rights to 

access the folder.

“ ”
To launch the LightsOut Restore Wizard go to the Tasks menu and click Setup LightsOut Restore.

To configure LightsOut Restore

On the Tasks menu, click Set Up LightsOut Restore.

The Setup LightsOut Restore Wizard is displayed.

In the Welcome panel, review the information, and then click Next.

See Welcome Panel.

In the Source Location panel, specify the path or browse to the media drive in which you placed 

theVeritas System Recovery Disk, then click Next.

See Source Location Options.
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IF YOU KNOW THE PATH TO THE SOURCE 
VERITAS SYSTEM RECOVERY DISK

TYPE THE PATH IN THE VERITAS SYSTEM 
RECOVERY DISK MEDIA LOCATION FIELD.

If you do not know the path to the source 
Veritas System Recovery Disk

Do the following in the order listed\:

- Click Browse .

- Click Veritas System Recovery Disk ISO File 
to locate the path for the ISO image file or click 
Veritas System Recovery Disk Folder to locate 
the path for the disk on other media.

- On the Open dialog box, navigate to the 
location of the appropriate ISO image file, 
media drive, or folder.

- Click Open .

“ ”
Note: This panel is only displayed if your computer cannot use the local files to identify the source 

location of the media.

“ ”
In the Licensed Features panel, enter the license of the product and then click Next.

USE THE LICENSE FILE THAT IS 
ACTIVATED ON THIS COMPUTER

ENABLES THE COLD BACKUP FEATURE 
IN THE RECOVERY ENVIRONMENT USING 

THE PRODUCT LICENSE FILE THAT IS 
PROVIDED.

Use the following license file Enables the cold backup feature in the new 
Veritas System Recovery Disk by browsing 
to the product

license file.
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USE THE LICENSE FILE THAT IS 
ACTIVATED ON THIS COMPUTER

ENABLES THE COLD BACKUP FEATURE 
IN THE RECOVERY ENVIRONMENT USING 

THE PRODUCT LICENSE FILE THAT IS 
PROVIDED.

Prompt for a license file Prompts you for a product license file at the 
time you want to enable features in the 
customized Veritas System Recovery Disk.

See Licensed Features Options.

In the Storage and Network Drivers panel, review the list of any storage or network drivers to 

be included, add or remove storage and network drivers, and then click Next.

STORAGE AND NETWORK DRIVERS LETS YOU REVIEW THE LIST OF ANY 
STORAGE OR NETWORK DRIVERS TO BE 

INCLUDED.

Add Lets you add additional drivers.

The location that you specify should contain 
the fully extracted installation package for the 
driver you add. If you have more than one 
missing storage or network driver, you must 
rerun the Set Up LightsOut Restore wizard 
for each missing driver.

See Adding a Storage or Network Driver .

Remove Deletes the drivers you do not need.

Reset Resets the list to the original list of drivers.

See Storage and Network Drivers Options.

In the Startup Options panel, select the time zone, display language, keyboard layout language 

for LightsOut Restore, and then click Next.
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TIME ZONE SETS THE TIME ZONE TO USE INSIDE 
LIGHTSOUT RESTORE.

Display language Sets the default display language for 
LightsOut Restore.

Keyboard layout Lets you select the default keyboard layout 
to use when you run LightsOut Restore.

See Startup Options.

In the Network Options panel, select the dynamic or static IP, save the Windows firewall 

settings for LightsOut Restore, and then click Next.

AUTOMATICALLY START NETWORK 
SERVICES

SELECT THIS OPTION IF U WANT TO 
ENABLE NETWORK SERVICES IN A 

RECOVERY ENVIRONMENT. NETWORKING 
STARTS AUTOMATICALLY WHEN YOU 

RECOVER THE

COMPUTER THROUGH LIGHTSOUT 
RESTORE.

Dynamic IP Connects to a network without the need for 
additional network configuration. This option 
is also appropriate if you know there is a 
DHCP server available on the network at the 
time you restore.

Static IP Connects to a network with a particular 
network adapter and specific address 
settings. You should click this option if you 
know there is no DHCP server (or the DHCP 
server may be unavailable) when you 
recover.

Use Windows firewall settings Applies the local computer's firewall settings 
to the recovery environment. For example, if 
you turn on the firewall for your local 
computer and then select this option, the 
firewall is turned on for the recovery 
environment.
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See Network Options.

In the Setup LightsOut Restore panel, enter the LightsOut Restore boot option label and boot 

menu display time, and then click Next.

BOOT MENU LABEL INDICATES THE TITLE THAT YOU WANT 
TO APPEAR ON THE WINDOWS BOOT 

MENU FOR LIGHTSOUT RESTORE.

Time to display boot menu Specifies (in seconds) how long you want the 
boot menu to display.

The default is 10 seconds.

See Setup LightsOut Restore Options.

In the Summary panel, review all of the options that you selected, and then click Finish.

The Progress panel displays the progress status and the approximate time that is required to 

installing LightsOut Restore on your computer. The Result panel in the LightsOut Restore Wizard

displays a success result if LightsOut Restore is installed successfully on your computer. Veritas 

recommends that you test the LightsOut Restore recovery environment. To test LightsOut Restore, 

boot into the LightsOut Restore recovery environment.

Welcome Panel

The Welcome panel on the Setup LightsOut Restore Wizard provides information about the setting 

up LightsOut Restore on your computer. The LightsOut Restore Wizard installs a customized 64-bit 

Veritas System Recovery Disk (based on the operating system of your computer) on the system 

partition of your computer.

After the setup is complete, you can access the customized recovery disk using any remote access 

method.

Veritas System Recovery does not support restore of BIOS-based system recovery points on 

UEFI-based computers or vice versa.

When you enable this feature, the following options are available when you start your computer.

The operating system installed on this computer

Veritas LightsOut Restore

After you review the information, click Next.
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Source Location Options

In the Source Location panel, on the Setup LightsOut Restore Wizard, do one of the following:

Table: Source Location Options

OPTION DESCRIPTION

If you know the path to the source Veritas 
System Recovery Disk

Type the path in the Veritas System Recovery 
Disk media location field.

If you do not know the path to the source 
Veritas System Recovery Disk

Do the following in the order listed\:

- Click Browse .

- Click Veritas System Recovery Disk ISO File 
to locate the path for the ISO image file or click 
Veritas System Recovery Disk Folder to locate 
the path for the disk on other media.

- On the Open dialog box, navigate to the 
location of the appropriate ISO image file, 
media drive, or folder.

- Click Open .

Licensed Features Options

In the Licensed Features panel, on the Setup LightsOut Restore Wizard, the license key that you 

enter is used to enable the cold backup feature of the recovery disk.

The following table describes the options on the Licensed Features panel.

Table: Licensed Features options

OPTIONS DESCRIPTION

Use the license file that is activated on this 
computer

Enables the cold backup feature in the 
recovery environment using the product 
license file that is provided.
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OPTIONS DESCRIPTION

Use the following license file Enables the cold backup feature in the new 
Veritas System Recovery Disk by browsing to 
the product

license file.

Prompt for a license file Prompts you for a product license file at the 
time you want to enable features in the 
customized Veritas System Recovery Disk.

See Configuring LightsOut Restore.

“ ”
Note: If you want to use the customization features, such as driver injection or adding new drivers, 

you need a license.

“ ”

Storage and Network Drivers Options

The Storage and Network Drivers panel, on the Setup LightsOut Restore Wizard displays the list of 

storage and network drivers available on your local computer.

“ ”
Note: All the storage and network drivers that are available on your computer are displayed.

“ ”
The following table describes the options on the Storage and Network Drivers panel.
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Table: Storage and Network Drivers options

OPTIONS DESCRIPTION

Storage and network drivers Lets you review the list of any storage or 
network drivers to be included.

Add Lets you add additional drivers.

The location that you specify should contain 
the fully extracted installation package for the 
driver you add. If you have more than one 
missing storage or network driver, you must 
rerun the Set Up LightsOut Restore wizard for 
each missing driver.

See Adding a Storage or Network Driver .

Remove Deletes the drivers you do not need.

Reset Resets the list to the original list of drivers.

See Configuring LightsOut Restore.

Adding a Storage or Network Driver

In the Add Storage and Network Driver dialog box, on the Setup LightsOut Restore Wizard, click 

Browse and select the .inf file of the driver, which is to be added to theVeritas System Recovery 

Disk.

You need to provide a suitable driver that is compatible with the version of WinPE that you use to 

setup LightsOut Restore on this computer. Drivers that are not compatible with the version of 

WinPE and used to set up LightsOut Restore on this computer do not load when you boot into 

recovery environment from LightsOut Restore.

Startup Options

In the Startup Options panel, on the Setup LightsOut Restore Wizard, the options that are selected 

are applied when you boot into your computer using LightsOut Restore.

The following table describes the options on the Startup Options panel.
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Table: Startup Options

OPTIONS DESCRIPTION

Time zone Sets the time zone to use inside LightsOut 
Restore.

Display language Sets the default display language for LightsOut 
Restore.

Keyboard layout Lets you select the default keyboard layout to 
use when you run LightsOut Restore.

Network Options

In the Network Options panel, on the Setup LightsOut Restore Wizard, the selected options are 

used when you want to recover images from a network location. To recover images over a network 

location, you need to access the remote network location. The network options are applicable 

when you boot into your computer using LightsOut Restore.

Table: Network Options

OPTION DESCRIPTION

Automatically start network services Select this option if u want to enable network 
services in a recovery environment. 
Networking starts automatically when you 
recover the

computer through LightsOut Restore.

Dynamic IP Connects to a network without the need for 
additional network configuration. This option is 
also appropriate if you know there is a DHCP 
server available on the network at the time you 
restore.

Static IP Connects to a network with a particular 
network adapter and specific address settings. 
You should click this option if you know there is 
no DHCP server (or the DHCP server may be 
unavailable) when you recover.
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OPTION DESCRIPTION

Use Windows firewall settings Applies the local computer's firewall settings to 
the recovery environment. For example, if you 
turn on the firewall for your local computer and 
then select this option, the firewall is turned on 
for the recovery environment.

Setup LightsOut Restore Options

In the Setup LightsOut Restore panel, on the Setup LightsOut Restore Wizard, the LightsOut 

Restore option creates a copy of your recovery environment on your local computer's hard drive. 

The LightsOut Restore option lets you boot into a recovery environment same as a Veritas System 

Recovery Disk stored on an external USB media.

The following table describes the options on the Options panel.

Table: LightsOut Restore options

OPTION DESCRIPTION

Boot menu label Indicates the title that you want to appear on 
the Windows boot menu for LightsOut Restore.

Time to display boot menu Specifies (in seconds) how long you want the 
boot menu to display.

The default is 10 seconds.

Testing the Veritas System Recovery Disk
Veritas recommends that you create a Veritas System Recovery Disk immediately after the Veritas 

System Recovery 23 installation is complete and before you start running backup jobs or 

recovering backed-up images. If Windows fails to start or it does not run normally, you can recover 

your computer by using theVeritas System Recovery Disk. The drivers that are included on the 

recovery disk must match the drivers that are required to run your computer's network cards and 

hard disks.

To ensure that you have the drivers required to recover your computer, you can use the Run Driver 

Validation tool. The tool is available with the first Veritas System Recovery Disk that you create. 

The Run Driver Validation is required to identify the need for the custom Veritas System Recovery 
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Disk and to compare hardware drivers on the recovery disk with the drivers required to run your 

computer's network cards and hard disks.

You should run the driver validation test any time you make changes to the network interface cards 

or storage controllers on a computer.

“ ”
Note: The driver validation tool on the Veritas System Recovery Disk does not support wireless 

network adapter drivers.

“ ”
You should test the Veritas System Recovery Disk to ensure that the recovery environment runs 

properly on your computer.

Testing the Veritas System Recovery Disk lets you identify and solve the following types of 

problems:

You cannot start Veritas System Recovery Disk.

See Configuring a computer to start from a USB device or DVD.

You do not have the necessary storage drivers to access recovery points on the computer.

You need information about your system to help you run Veritas System Recovery Disk.

The following table summarizes the steps for testing Veritas System Recovery Disk.

Table: Testing Veritas System Recovery Disk

STEP ACTION DESCRIPTION

Step 1 Run driver validation tool Run the driver validation tool 
to test whether Veritas 
System Recovery Disk works 
with the network cards and 
storage devices on the 
computer. If any drivers are 
not included on the recovery 
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STEP ACTION DESCRIPTION

disk, the Driver Validation 
Results dialog box appears.

The driver validation is added 
to the recovery disk during 
Veritas System Recovery 
Disk creation. To run the 
driver validation tool, insert 
the recovery disk, and go to 
the explorer.

Without access to the correct 
drivers, a device cannot be 
used while you run Veritas 
System Recovery Disk. 
Therefore, if the recovery 
points are stored on a 
network or a local hard drive, 
you might not have access to 
them.

You can find the drivers and 
copy them to a CD or a floppy 
disk. You can also create a 
custom Veritas System 
Recovery Disk.

See Customizing an existing 
Veritas System Recovery 
Disk .

Step 2 Boot your computer using 
Veritas System Recovery 
Disk

Boot your computer using the 
Veritas System Recovery 
Disk.

See Booting a computer by 
using the Veritas System 
Recovery Disk .
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STEP ACTION DESCRIPTION

Step 3 Test the restore Run a mock restore of a 
recovery point that is stored 
either

on a network or locally on a 
computer. Running a mock

restore helps you to test if 
you can restore your backup.
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Getting Started

This section includes the following topics:

How to use Veritas System Recovery

Starting Veritas System Recovery

Configuring Veritas System Recovery default options

Setting up default general backup options

Improving your computer's performance during a backup

Enabling network throttling

Setting default options for the Windows notification area

File types and file extension

Removing or changing the unique name for an external drive

Configuring default FTP settings for use with Offsite Copy

Logging Veritas System Recovery messages

Enabling email notifications for product (event) messages

Setting up your first backup using Easy Setup

Home page

Status page

Tasks page

Tools page

Advanced page

Using Veritas System Recovery RESTful Application Programming Interfaces (APIs)

How to use Veritas System Recovery
Veritas System Recovery helps you in backing up your files, folders, or entire drives. To back up 

your data, you need to define a backup. A backup specifies what data to back up, when to back it 

up, and where to put the backed-up data.

Using Veritas System Recovery includes the following key tasks:
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Defining a backup

Running a backup

Recovering files, folders, or entire drives

Refer to the following figure to understand the relationship of these tasks.

Figure: Using Veritas System Recovery

See Starting Veritas System Recovery.
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Starting Veritas System Recovery
Veritas System Recovery is installed in the Windows program files folder by default. During 

installation, a program icon is installed in the Windows system tray from which you can open 

Veritas System Recovery. You can also open Veritas System Recovery from the Windows Start 

menu.

To start Veritas System Recovery

Depending on the Windows version you are running, use one of the following methods:

On the classic Windows taskbar, click Start > Programs > Veritas System Recovery.

On the Windows taskbar, click Start > All Programs > Veritas System Recovery.

In the Windows system tray, double-click the Veritas System Recovery tray icon.

In the Windows system tray, right-click the Veritas System Recovery tray icon, and then 

click Open Veritas System Recovery.

When you start Veritas System Recovery, the Veritas System Recovery Disk dialog box is 

displayed that lets you know if a recovery disk is created on your computer. A Veritas System 

Recovery Disk is critical for system restore and needs to be created before you start creating and 

running backup jobs. Veritas recommends that you create a recovery disk at the earliest on a 

computer that has the latest version of the Windows operating system.

On the Veritas System Recovery Disk dialog box, click Create Now to launch the Veritas System 

Recovery Disk Creation Wizard. You can also click Tasks > Create New Recovery Disk to launch 

the Veritas System Recovery Disk Creation Wizard.

Configuring Veritas System Recovery default options
The Options dialog box includes several views that let you configure Veritas System Recovery 

default options.

To configure Veritas System Recovery default options

On the Tasks menu, click Options.

Select an option you want to edit, make any necessary changes, and then click OK.

See Setting up default general backup options.

See Improving your computer's performance during a backup.
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See Enabling network throttling.

See Setting default options for the Windows notification area.

See Adding new file types and extensions.

See Renaming file types and extensions.

See Restoring default file types and extensions.

See Deleting a file type and all of its extensions.

See Removing or changing the unique name for an external drive.

See Configuring default FTP settings for use with Offsite Copy.

See Logging Veritas System Recovery messages.

See Enabling email notifications for product (event) messages.

See Configuring Veritas System Recovery to send SNMP traps.

Setting up default general backup options
You can specify the default destination for storing recovery points and file and folder backup data 

that is created when you run a backup. This default location is used if you do not specify a different 

location when you define a new backup.

You can also choose to prepend your computer's name to backup data file names and save each 

backup file to a new subfolder.

To set up general backup options

On the Tasks menu, click Options.

Click General.

Set the options for your backups.

The following table describes the options on the General page. The options you configure here are 

used as default backup options.
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PREPEND COMPUTER NAME TO BACKUP 
DATA FILE NAMES

ADDS THE COMPUTER NAME TO THE 
BEGINNING OF EACH BACKUP DATA FILE 

NAME.

THIS OPTION IS USEFUL IF YOU BACK UP 
MORE THAN ONE COMPUTER TO THE SAME 

DRIVE. FOR EXAMPLE, YOU MIGHT BACK 
UP A LAPTOP AND A DESKTOP COMPUTER 
TO THE SAME USB OR NETWORK DRIVE. 

BY PREPENDING THE COMPUTER NAME TO 
EACH BACKUP DATA FILE NAME, YOU CAN 

MORE EASILY IDENTIFY WHICH BACKUP 
DATA FILES BELONG TO WHICH 

COMPUTER.

Save backup files to a unique subfolder Creates a new subfolder that serves as your 
backup destination.

Note: The new subfolder is given the same 
name as your computer. For example, if your 
computer name is "My_Laptop", the new 
subfolder is named \My_Laptop.

Default backup destination Lets you specify a path to the folder or 
OpenStorage destination where you want to 
store the recovery points.

See Setting a default backup destination .

See Defining a drive-based backup .

Click OK.

Setting a default backup destination

Setting a default backup destination
You can set a default backup destination for your backup jobs using the General options.

To set a default destination

On the Tasks menu, click Options.

Click General.
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In the Default backup destination field, specify a path to the folder where you want to store 

recovery points and file and folder backup data.

If you do not know the path, click Browse to select the location.

If you entered the path to a location on a network, enter the user name and password that are 

required for authentication.

“ ”
Note: You cannot use an encrypted folder as your backup destination. However, you can encrypt 

your backup data to prevent other users from accessing it. To encrypt your backup data, refer to 

theAdvancedoptions when you define or edit a backup.

“ ”
Click OK.

Improving your computer's performance during a backup
If a backup is running on your computer, your computer's performance might slow down. The slow 

down in the computer's performance might be more prominent if it is the one creating an 

independent recovery point. The performance slows down because Veritas System Recovery uses 

your computer's hard disk and memory resources to perform the backup.

You can change the speed of the backup to minimize the effect of Veritas System Recovery on 

your computer while you work.

“ ”
Note: During a backup or recovery, you have the option of overriding this default setting to fit your 

needs at that moment.

“ ”
To adjust the effect of a backup on computer performance

On the Tasks menu, click Options.
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Click Performance.

Do one of the following:

To improve your computer's performance during backup jobs, move the slider bar closer to 

Slow.

To enable backup jobs to run more quickly, move the slider bar closer to Fast.

Click OK.

More Information

Adjusting the speed of a backup

Enabling network throttling
You can limit the effect of a backup on network performance by enabling network throttling.

Many variables affect the network performance. Consider the following points before you use this 

feature:

Table: Variables that affect network performance

VARIABLE DESCRIPTION

Network cards Is your network wired or wireless? What are 
the speeds of your network cards?

Network backbone What is the size of your network pipeline? 
Does it support 10-MB transfer rates, or 1-GB 
transfer rates?

Network server How robust is your server hardware? How fast 
is its processor? How much RAM does it 
have? Is it fast or slow?

Backing up How many computers are scheduled to back 
up at the same time?

Network traffic Are backups scheduled to run when network 
traffic is heavy or light?
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Consider using this feature only when you know what your network can handle. If you schedule 

your backups at staggered intervals and when network traffic is low, you may not need to use this 

feature. Avoid backing up multiple computers at the same time and to the same network 

destination.

Gather the required information about your network's performance and then schedule backups 

accordingly. Enable this feature and set the Maximum network throttling to a setting that matches 

the circumstances.

To enable network throttling

On the Tasks menu, click Options.

Click Performance.

Select Enable network throttling.

In the Maximum network throttling field, enter the maximum amount (in KB) of network 

throughput.

Click OK.

Setting default options for the Windows notification area
You can turn on the Veritas System Recovery icon or turn it off as required. You can choose to 

show only error messages, or to show both error messages and other information, such as the 

completion of a backup.

To adjust default notification area settings

On the Tasks menu, click Options.

Click Tray Icon , and then select the options you want to use for the notification area.

SHOW SYSTEM TRAY ICON DISPLAYS THE VERITAS SYSTEM 
RECOVERY ICON IN THE NOTIFICATION 

AREA.

YOU MUST SELECT THIS OPTION TO 
ENABLE OR DISABLE ANY OF THE 

REMAINING OPTIONS.

Show missed backups Notifies you when a backup was scheduled 
but did not run.
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SHOW SYSTEM TRAY ICON DISPLAYS THE VERITAS SYSTEM 
RECOVERY ICON IN THE NOTIFICATION 

AREA.

YOU MUST SELECT THIS OPTION TO 
ENABLE OR DISABLE ANY OF THE 

REMAINING OPTIONS.

For example, it notifies you when your 
computer was turned off at the time a backup 
was scheduled to run.

Show system tray questions Offers you helpful prompts in the form of 
questions that can help you keep your data 
backed up.

Show status messages Displays the messages about the status of 
backup operations. For example, a backup 
has started, or your backup destination is 
about to get full.

Show error messages Displays the error messages when errors 
occur so that you can resolve any issues that 
might hinder data protection.

Click OK.

File types and file extension
When you define file and folder backups, file types are a quick way to include the files that you use 

the most. For example, if you keep music files on your computer, you can configure a backup to 

include all music files. For example, .mp3, .wav.

The most common file types and extensions are already defined for you. But you can define 

additional file type categories as needed, and then edit them at any time. For example, if you install 

a new program that requires the use of two new file extensions (for example, .pft and .ptp,). You 

can define a new file type and define the two file extensions for that category. Then when you 

define a backup, you can select the new category. When the backup runs, all files that end with .pft 

and .ptp are backed up.

See Adding new file types and extensions.
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See Renaming file types and extensions.

See Restoring default file types and extensions.

See Deleting a file type and all of its extensions.

Adding new file types and extensions
The most common file types and extensions are already defined for you. However, you can add 

additional file type categories as needed.

To add a new file type and extensions

On the Tasks menu, click Options.

Click File Types.

At the bottom of the File typeslist, clickAdd a file type(+).

Type a descriptive name of the new file type category, and then press Enter.

At the bottom of the Extensions forlist, clickAdd an extension(+).

Type an asterisk (*) and a period, followed by the extension of the file type you want to define, 

and then press Enter.

Click OK.

See Renaming file types and extensions.

See Restoring default file types and extensions.

See Deleting a file type and all of its extensions.

See File types and file extension.

Renaming file types and extensions
You can rename existing file types and extensions as needed.

To rename a file type and extensions

On the Tasks menu, click Options.

Click File Types.

Select a file type from the File types list, and then do one of the following:

Click Rename a file type to edit the name of the selected file type.
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Select an extension from the Extensions forlist and clickRename an extension to edit the 

name of the extension.

Click OK.

See Adding new file types and extensions.

See Restoring default file types and extensions.

See Deleting a file type and all of its extensions.

See File types and file extension.

Restoring default file types and extensions
You can restore default file types and extensions as needed.

To restore default file types and extensions

On the Tasks menu, click Options.

Click File Types.

Select a file type from the File types list.

Click either Restore default file types listorRestore default extensions list to restore all 

default file types or extensions.

“ ”
Caution: Any file types and extensions you have set up are removed. You must add them 

again manually.

“ ”
Click OK.

See Adding new file types and extensions.

See Renaming file types and extensions.

See Deleting a file type and all of its extensions.

See File types and file extension.
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Deleting a file type and all of its extensions
You can delete a file type and all its extensions as needed.

To delete a file type and all of its extensions

On the Tasks menu, click Options.

Click File Types.

Select a file type from the File types list, and then do one of the following:

Click the Remove a file type to delete a file type and all its extensions.

Select an extension from the Extensions forlist and clickRemove an extension to edit the 

name of the extension.

“ ”
Note: You cannot delete a default file type. You can delete all but one extension of a default 

file type, and you can add additional extensions to a default file type.

“ ”
Click OK.

See Adding new file types and extensions.

See Renaming file types and extensions.

See Restoring default file types and extensions.

See File types and file extension.

Removing or changing the unique name for an external drive
Veritas System Recovery lets you assign unique names to external drives when you use them as a 

backup destination or an Offsite Copy destination. Assigning unique names helps you to manage 

these destinations and avoid confusion if you use more than one drive. It is especially helpful when 

the assigned drive letter changes each time you plug in the drive.
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The Options dialog box lets you see all of your drive unique names in one view. From this view, 

you can remove or edit existing names. Veritas System Recovery lets you assign a unique name 

when you plug in an external drive in to your computer for the first time.

“ ”
Note: Using a unique name does not change the drive label. The unique name is used only when 

you access a drive from within Veritas System Recovery.

“ ”
For example, you might swap out two different external drives that are used as Offsite Copy 

destinations during any given week. It would be difficult to identify which drive your use at any 

given time based on the drive labels. It becomes more confusing if the previously assigned drive 

letter has changed.

You can associate unique names with each drive when you use them with Veritas System 

Recovery. The unique name that is associated with a drive is displayed in various locations in 

Veritas System Recovery.

“ ”
Note: Placing physical labels on each external drive to help you manage the task of swapping the 

drives is also a good idea.

“ ”
For example, if you assigned the unique name, "Cathy Read" to one drive, and "Thomas Read" to 

a second drive. Their unique names appear in Veritas System Recovery whenever the drives are 

plugged in to your computer.

To remove or change unique name for an external drive

On the Tasks menu, click Options.

Under Destinations, click External Drives.

Select an external drive from the list and then do one of the following:
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Click Remove to delete the unique name that is associated with the external drive.

Click Rename to edit the unique name.

Click OK.

Configuring default FTP settings for use with Offsite Copy
File transfer protocol , or FTP, is the simplest and most secure way to copy files over the Internet. 

Veritas System Recovery serves as an FTP client to copy your recovery points to a remote FTP 

server. You can copy your recovery points to an FTP server as a secondary backup of your critical 

data.

The Options dialog box lets you configure FTP settings to help ensure that your recovery points are 

copied to your FTP server.

To configure default FTP settings for use with Offsite Copy

On the Tasks menu, click Options.

Under Destinations, click Configure FTP.

Select the appropriate options.

CONNECTION MODE: PASSIVE 
(RECOMMENDED)

HELPS PREVENT CONFLICTS WITH 
SECURITY SYSTEMS. THIS MODE IS 

NECESSARY FOR SOME FIREWALLS AND 
ROUTERS. WHEN YOU USE PASSIVE 
MODE, THE FTP CLIENT OPENS THE 

CONNECTION TO AN IP ADDRESS AND 
PORT THAT THE FTP SERVER SUPPLIES.

Connection mode: Active Enables a server to open a connection to an 
IP address and port that the FTP client 
supplies. Use active mode when connections 
or transfer attempts fail in passive mode, or 
when you receive data socket errors.

Limit connection attempts to Indicates the number of times Veritas 
System Recovery tries to connect to an FTP 
server before it gives up. Veritas System 
Recovery can attempt a maximum of 100 
times.
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CONNECTION MODE: PASSIVE 
(RECOMMENDED)

HELPS PREVENT CONFLICTS WITH 
SECURITY SYSTEMS. THIS MODE IS 

NECESSARY FOR SOME FIREWALLS AND 
ROUTERS. WHEN YOU USE PASSIVE 
MODE, THE FTP CLIENT OPENS THE 

CONNECTION TO AN IP ADDRESS AND 
PORT THAT THE FTP SERVER SUPPLIES.

Stop trying to connect after Indicates the number of seconds Veritas 
System Recovery tries to connect to an FTP 
server before it gives up. You can specify up 
to 600 seconds (10 minutes).

Default port Indicates the port of the FTP server that 
listens for a connection.

You should consult the FTP server 
administrator to be sure that the port you 
specify is configured to receive incoming 
data.

Click OK.

Logging Veritas System Recovery messages
You can specify which product messages (errors, warnings, and information) are logged as they 

occur, and where the log file is stored. Product messages can provide useful information about the 

status of backups or related events. They can also provide helpful information when you need to 

troubleshoot.

Two logging methods are available: Veritas System Recovery logging and the Windows application 

log.

To log Veritas System Recovery messages

On the Tasks menu, click Options.

Under Notifications, click Log File.

Select the appropriate log file options.
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SELECT THE PRIORITY AND TYPE OF 
MESSAGES

LETS YOU SELECT THE PRIORITY LEVEL 
AT WHICH MESSAGES SHOULD BE 

LOGGED. YOU CAN CHOOSE TO LOG ALL 
OR NO MESSAGES REGARDLESS OF 

PRIORITY LEVELS.

SELECT ONE OF THE FOLLOWING 
OPTIONS:

- ALL MESSAGES

- MEDIUM AND HIGH PRIORITY 
MESSAGES

- HIGH PRIORITY MESSAGES

- NO MESSAGES

Errors Logs the error messages as they occur.

Warnings Logs the warning messages as they occur.

Information Logs the information messages as they 
occur.

Log file location Lets you specify a path where you want to 
create and store the log file.

If you do not know the path, you can browse 
to the location.

Maximum file size Lets you specify the maximum size (in 
kilobytes) that the log file is allowed to grow.

The file is kept within the limit you set by 
replacing the oldest logged items in the file 
with new items as they occur.

Click OK.

To configure which product events are written to a Windows event log

On the Tasks menu, click Options.

Under Notifications, click Event Log.
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Select the appropriate event log options.

SELECT THE PRIORITY AND TYPE OF 
MESSAGES

LETS YOU SELECT THE PRIORITY LEVEL 
AT WHICH MESSAGES SHOULD BE 

LOGGED. YOU CAN CHOOSE TO LOG ALL 
OR NO MESSAGES REGARDLESS OF 

PRIORITY LEVELS.

SELECT ONE OF THE FOLLOWING 
OPTIONS:

- ALL MESSAGES

- MEDIUM AND HIGH PRIORITY 
MESSAGES

- HIGH PRIORITY MESSAGES

- NO MESSAGES

Errors Logs the error messages as they occur.

Warning Logs the warning messages as they occur.

Information Logs the information messages as they 
occur.

Click OK.

Enabling email notifications for product (event) messages
Email notifications can be sent to a specified email address if there are any errors or warnings that 

occurred when a backup is run.

“ ”
Note: If you do not have an SMTP server, this feature is unavailable to you.

“ ”
Notifications can also be sent to the system event log and a custom log file. The custom log file is 

located in the Agent folder of the product installation.
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If notifications are not delivered, check the setup of your SMTP server to ensure that it functions 

properly.

To enable email notifications for product (event) messages

On the Tasks menu, click Options.

Under Notifications, click SMTP Email.

Select the appropriate options.

SELECT THE PRIORITY AND TYPE OF 
MESSAGES

LETS YOU SELECT THE PRIORITY LEVEL 
AT WHICH MESSAGES SHOULD BE 

LOGGED. YOU CAN CHOOSE TO LOG ALL 
OR NO MESSAGES REGARDLESS OF 

PRIORITY LEVELS.

SELECT ONE OF THE FOLLOWING 
OPTIONS:

- ALL MESSAGES

- MEDIUM AND HIGH PRIORITY 
MESSAGES

- HIGH PRIORITY MESSAGES

- NO MESSAGES

Errors Logs the error messages as they occur.

Warnings Logs the warning messages as they occur.

Information Logs the information messages as they 
occur.

To address (admin@domain.com) Lets you specify the email address (for 
example, admin@domain.com) where 
notifications are to be sent.

From address Lets you specify the email address of the 
sender.

The From address is not mandatory. If you 
do not specify a From address, the name of 
the product is used.

mailto:admin@domain.com
mailto:admin@domain.com
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SELECT THE PRIORITY AND TYPE OF 
MESSAGES

LETS YOU SELECT THE PRIORITY LEVEL 
AT WHICH MESSAGES SHOULD BE 

LOGGED. YOU CAN CHOOSE TO LOG ALL 
OR NO MESSAGES REGARDLESS OF 

PRIORITY LEVELS.

SELECT ONE OF THE FOLLOWING 
OPTIONS:

- ALL MESSAGES

- MEDIUM AND HIGH PRIORITY 
MESSAGES

- HIGH PRIORITY MESSAGES

- NO MESSAGES

SMTP server Lets you specify the path to the SMTP server 
that sends the email notification.

In the SMTP server box:

- Enter mail-server.domain-name  . This 
is applicable for SMTP Authentication.

- Enter smtp://mail-server.domain-

name  . Start with 'smtp://' for None, TLS, and 
SSL encryption.

Authentication or Encryption If you are installing Veritas System Recovery 
for the first time, you can select 
Authentication or Encryption.

Authentication

If you select Authentication , the SMTP 
Authentication option is displayed.

If you are upgrading from Veritas System 
Recovery to Veritas System Recovery 23, by 
default the Authentication option is selected. 
To specify an encryption type instead of 
SMTP authentication, select Encryption .
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SELECT THE PRIORITY AND TYPE OF 
MESSAGES

LETS YOU SELECT THE PRIORITY LEVEL 
AT WHICH MESSAGES SHOULD BE 

LOGGED. YOU CAN CHOOSE TO LOG ALL 
OR NO MESSAGES REGARDLESS OF 

PRIORITY LEVELS.

SELECT ONE OF THE FOLLOWING 
OPTIONS:

- ALL MESSAGES

- MEDIUM AND HIGH PRIORITY 
MESSAGES

- HIGH PRIORITY MESSAGES

- NO MESSAGES

Encryption

If you select Encryption , the Encryption Type 
option is displayed.

If you are upgrading from Veritas System 
Recovery or its versions to Veritas System 
Recovery 23, by default the Encryption 
option is selected. To specify an SMTP 
authentication instead of an encryption type, 
select Authentication .

SMTP Authentication Lets you select the method to authenticate to 
the specified SMTP server. You can select\:

- Anonymous

- Basic

- NTLM (selected by default)

Encryption Type Lets you select the type of encryption for the 
specified SMTP server. You can select\:

- None (selected by default)

- TLS (Transport Layer Security)
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LETS YOU SELECT THE PRIORITY LEVEL 
AT WHICH MESSAGES SHOULD BE 

LOGGED. YOU CAN CHOOSE TO LOG ALL 
OR NO MESSAGES REGARDLESS OF 

PRIORITY LEVELS.

SELECT ONE OF THE FOLLOWING 
OPTIONS:

- ALL MESSAGES

- MEDIUM AND HIGH PRIORITY 
MESSAGES

- HIGH PRIORITY MESSAGES

- NO MESSAGES

- SSL (Secured Socket Layer)

Port Lets you specify the port for authentication or 
encryption that you select.

If you select NTLM or None , the default port 
that is selected is 25.

You can change the port number.

User name Lets you specify the SMTP user name.

Password Lets you specify the SMTP password.

Click OK.

Setting up your first backup using Easy Setup
If you had selected the Launch Easy Setup check box during the setup wizard, the Easy Setup 

window appears the first time you open the Run or Manage Backups window.

“ ”
Note: TheEasy Setupwindow is not available in server versions of Veritas System Recovery.
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“ ”
To set up your first backup using Easy Setup

On the Tasks menu, click Run or Manage Backups.

In the Easy Setup window, either accept the default drive and file and folder backup settings, or 

click any of the settings to edit them.

“ ”
Note: You cannot back up files and folders to cloud storage. Clear theBack Up My 

Documentscheck box to backup to cloud.

“ ”
Click OK.

In the First Backup window, do one of the following:

Select Run first backup according to schedule to run the backup as per the schedule 

that you specified.

Select Run backup now to run the backup immediately.

Click OK.

Home page
The Home page provides a general status about the backup protection of your computer and 

serves as a Dashboard to access the features of Veritas System Recovery. You can do the 

following actions on the Home page:

View the summary of the backup protection status of your computer.

See Icons on the Home page.

Customize the status reporting of a selected drive, or files and folders.

See Customizing the status reporting of a drive (or file and folder backups).

Define a backup.
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See Defining a drive-based backup.

See Backing up files and folders.

Recover a computer or files and folders.

See Recovering a secondary drive.

See About recovering lost data.

View the properties of a defined backup.

See Viewing the properties of a backup job.

View a pie chart of the specified backup destination.

See About backup destinations.

You can also view the Home page from the View menu.

To view the Home page

Start Veritas System Recovery 23.

On the View menu, click Home.

Status page
The Status page lets you monitor the status of your backups. The Status page lists each drive on 

your computer and includes a calendar that contains your backup histories. The calendar lets you 

quickly identify when a backup ran, and what type of backup it was. It identifies your upcoming, 

scheduled backups. It also lists the file and folder backup history if you have defined one or more 

file and folder backups.

“ ”
Note: You can right-click any of the calendar icons to access a context-sensitive menu. These 

menus offer quick access to related tasks. You can also customize the status reporting of a 

selected drive, or files and folders.

“ ”
To monitor backup protection from the Status page, you can do the following:
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On the Status page, review the Backups calendar and verify that the backup appears on the 

date that you ran it.

In the Drives column, select the drive that you want to view.

The status information appears in the bottom half of the Status page.

Move your mouse over a backup icon in the calendar to review the status of the backup.

To move around in the calendar, use one of the following methods:

Click anywhere in the title bar to navigate quickly to a different point in time.

Use the scroll bar at the bottom of the calendar to scroll backward or forward in time.

You can also view the Status page from the View menu.

To view the Status page

Start Veritas System Recovery 23.

On the View menu, click Status.

See About monitoring backups.

See Icons on the Home page.

See Customizing the status reporting of a drive (or file and folder backups).

See Recovering a secondary drive.

See Verifying that a backup is successful.

See What to do when a backup is finished.

Tasks page
The Tasks page provides you the links for backup, recovery, and virtual conversion of your 

computer.

The following tasks are displayed on the Tasks page:

Run or Manage Backups

You can define, edit, run, and delete backups jobs for your computer or files and folders.

See Defining a drive-based backup.
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See Backing up files and folders.

One Time Backup

You can define a backup job only once to create a recovery point without saving the job details.

See Running a one-time backup from Veritas System Recovery.

Recover My Computer

You can recover your computer using a specific recovery point created during backup.

See Recovering a secondary drive.

Recover My Files

You can recover specific files or folders using a recovery point created during backup.

See About recovering lost data.

Run or Manage Virtual Conversions

You can define, edit, run, and delete a virtual conversion job where recovery points are converted 

to virtual disks.

See Defining a virtual conversion job.

One Time Virtual Conversion

You can define a virtual conversion only once without saving the job details.

See Running a one-time conversion of a physical recovery point to a virtual disk.

You can also view the Tasks page from the View menu.

To view the Tasks page

Start Veritas System Recovery 23.

On the View menu, click Tasks.

Tools page
The Tools page provides you links to the tools that let you perform various other tasks.

The following tools are displayed on the Tools page:
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Manage Backup Destination

You can manage the size of your backup destinations using the features available in Veritas 

System Recovery.

See About backup destinations.

Run Granular Restore Option

You can restore emails, mailboxes, email folder, files, and folders using Granular Restore Option.

See About the Veritas System Recovery Granular Restore Option.

Run Recovery Point Browser

You can open files within a recovery point and restore the files using Recovery Point Browser.

See Opening and restoring files within a recovery point browser.

Copy Recovery Point

You can copy recovery points to another location for added security.

See Copying recovery points.

Copy My Hard Drive

You can make a copy of your operating system, applications, and data on a new hard disk.

See Copying one hard drive to another hard drive.

Customize Existing Recovery Disk

You can customize an existing Veritas System Recovery Disk, which is available on a DVD 

(manually burned) or USB device and add missing storage or network drivers to the recovery disk. 

You can customize and save the recovery disk on a USB device or as an ISO file.

See Customizing an existing Veritas System Recovery Disk.

Download OpenStorage Files

You can download the offsite copy files from the Amazon S3 and Microsoft Azure storage to your 

local computer or network drive.

See Using Amazon S3 storage as your Offsite Copy destination.

See Using Microsoft Azure as your offsite copy destination.
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See Using S3-Compatible or Veritas Access as your offsite copy destination.

See Downloading OpenStorage Files.

You can also view the Tools page from the View menu.

To view the Tools page

Start Veritas System Recovery 23.

On the View menu, click Tools.

Advanced page
The Advanced page offers experienced Veritas System Recovery users a single view of the most 

common product features. If you have a good understanding of Veritas System Recovery, you 

might prefer to perform most tasks from the Advanced view.

“ ”
Note: When you refer to the documentation while you use theAdvancedpage, the first one or two 

steps do not apply. The first one or two steps merely indicate where to access each feature from 

the other pages of the user interface. From that point on, follow the remaining steps of each 

procedure.

“ ”
You can view the Advanced page from the View menu.

To view the Advanced page

Start Veritas System Recovery 23.

On the View menu, click Advanced.

Using Veritas System Recovery RESTful Application 
Programming Interfaces (APIs)
Veritas System Recovery 23 continues to support a set of functions that can be hosted as RESTful 

APIs. The API Client uses the HTTP(S) protocol to make an API request to the Veritas System 
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Recovery Server. The server processes the request and sends a response to the client with an 

appropriate HTTP status code indicating success or failure.

The REST API calls from a remote computer only work with a valid CA Authorized certificate or a 

Self-Signed Certificate. Veritas System Recovery 23 now provides the enhanced 

InstallWebAPI.exe utility. Which automatically creates and binds a Self-Signed Certificate while 

installing Veritas System Recovery.

In scenarios, as mentioned in below cases:

Case 1: To use a valid CA Authorized certificate or a Self-Signed Certificate of your choice.

Case 2: To use Veritas System Recovery RESTful Application Programming Interfaces on 

Windows Operating Systems with PowerShell version lesser than 3.0, you have to create a Self-

signed certificate or use a valid CA Authorized certificate and bind the certificate using 

InstallWebAPI Utility.

The following steps should be followed:

On a machine with Veritas System Recovery installed, open the InstallWebAPI Utility using the 

command prompt in the administrator mode.

The InstallWebAPI Utility is located at the following path:

<Veritas System Recovery installation folder>/Agent/

The utility displays the following:

Bind Certificate-View Certificate-Unbind Certificate

Bind the certificate and after it is successful the Veritas WebAPI Services start and you can 

make the REST API calls using a program or interface of your choice from any remote 

machine.

To view a list of the supported APIs, refer to the following link:

https://www.veritas.com/support/en_US/article.100046743

https://www.veritas.com/support/en_US/article.100046743
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Best practices for backing up your data

This section includes the following topics:

About backing up your data

Best practices for backing up data

What to do when a backup is finished

Tips for running defined backups

Backup destinations

Backing up dual-boot computers

Manually validating recovery points

About backing up your data
To back up your computer or your individual files and folders you do the following:

Define a backup.

Run the backup.

See How to use Veritas System Recovery.

When you define a backup, you decide on the following:

What to back up (files and folders, or an entire drive).

Where to store the backup data (backup destination).

Whether or not to use Offsite Copy to copy backup data to remote locations.

When to run the backup (automatically or manually).

What compression levels to specify for recovery points, and whether to enable security settings 

(encryption and password protection).

Which of the many other options you want to use. You can customize each backup according to 

your backup needs.

See Backup destinations.

See Backing up dual-boot computers.
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Best practices for backing up data
Consider the following best practices before you define and run your first backup.

For optimum protection, you should define a drive-based backup and run it on a regular basis. 

A drive-based backup backs up and recovers your computer's system drive. Typically, it is the 

C drive, which includes your operating system. You can also use a drive-based backup to back 

up and recover a specific hard drive, such as a secondary drive, or to recover lost or damaged 

files or folders from a specific point in time.

To protect your personal files, such as photographs, music, or documents, you should define a 

file and folder backup and select the specific files and folders that you want to protect.

Table: Best practices for backing up data

BEST PRACTICE DESCRIPTION

Schedule backups at a time when you know 
your computer is on.

Your computer must be turned on and 
Windows must be running at the time a backup 
occurs. If not, any scheduled backups are 
skipped until the computer is turned on again. 
You then are prompted to run the missed 
backup.

Note: Veritas recommends that you do not 
back up volumes while deduplication is running 
on them. Schedule backups such that 
deduplication and backup do not run at the 
same time.

Use a secondary hard disk as your backup 
destination.

You should store recovery points on a hard 
disk other than your primary hard disk (C). It 
helps ensure that you can recover your system 
in the event that your primary hard disk fails.

See Setting up default general backup 
options .

Consider using external drives as your backup 
destination.

Using an external drive makes your backup 
data more portable. Should you need to 
remove your critical data from a particular 
location, you can quickly grab an external drive 
on your way out the door.
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BEST PRACTICE DESCRIPTION

See How Offsite Copy works .

Give unique names to your external drives to 
help you easily identify them.

You can assign a unique name to each 
external drive. A unique name helps you to 
keep a track of where your backup data is 
stored for each computer you back up. It is 
more useful in situations when the drive letters 
change each time you unplug and plug an 
external drive into your computer. A unique 
name ensures that you always know which 
drive is used when you are running Veritas 
System Recovery.

Using a unique name does not change the 
volume label of a drive. A unique name helps 
you to identify the drive when you use Veritas 
System Recovery.

Once a unique name is assigned, it stays with 
the drive. If you plug the drive into a second 
computer running another copy of Veritas 
System Recovery, the unique name appears.

Note: You might also consider placing a sticky 
label on each drive that matches the unique 
name that you have assigned.

Use Offsite Copy Use Offsite Copy to copy your latest recovery 
points to either a portable storage device or a 
remote server. By copying recovery points to a 
portable hard disk, you can then take a copy of 
your data with you when you leave the office.

See How Offsite Copy works .

Run backups frequently on a regular basis. When you define your backups, schedule them 
to run frequently so that you have recovery 
points that span at least the last two months.

See Editing a backup schedule .
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BEST PRACTICE DESCRIPTION

See Defining a drive-based backup .

Keep personal data on a separate drive than 
the drive on which Windows and your software 
programs are installed.

You should keep your operating system and 
software programs separate from your own 
data. It speeds the creation of recovery points 
and reduces the amount of information that 
needs to be restored. For example, use the C 
drive to run Windows and to install and run 
software programs. Use the D drive to create, 
edit, and store personal files and folders.

For other drive management solutions, go to 
the Veritas website at the following URL: 
https://www.veritas.com/

Verify the recovery point after you create it to 
ensure that it is stable.

While defining a backup, select the option to 
verify that the recovery point is stable and can 
be used to recover lost data.

Delete the corrupt images. When the backup destination is a network 
location, all backup images in the destination 
folder are appended with a .tmp extension 
during the backup. If the backup is successful, 
the images are automatically renamed with .v2i 
(base) and .iv2i (incremental) extensions. If a 
network connection to the destination fails, the 
backup is unsuccessful. The corrupt images 
with the .tmp extension are retained. These 
files are not tracked by Veritas System 
Recovery 23 and can be deleted safely.

When a backup starts to run on your computer, you might notice that the performance of your 

computer slows down. Veritas System Recovery requires significant system resources to run a 

backup. If slowing occurs, you can reduce the speed of the backup to improve computer 

performance until you are finished working.

See What to do when a backup is finished.

https://www.veritas.com/
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What to do when a backup is finished
After a backup is complete, consider the following best practices:

Table: Best practices after a backup is finished

BEST PRACTICE DESCRIPTION

Review the contents of recovery points and file 
and folder backup data.

Periodically review the contents of your 
recovery points to ensure that you back up 
only your essential data.

See “To open and restore files within a 
recovery point” .

Review the Status page to verify that backups 
have happened and to identify any potential 
problems.

Periodically review the Status page. You can 
also review the events log on the Advanced 
page.

The event log records events when they occur, 
backups, and any errors that might have 
occurred during or after a backup.

Note: Backup status and other messages are 
also conveyed in the system tray. So you do 
not need to start the product to identify the 
status of your backups.

See Verifying that a backup is successful .

See “To view the Advanced page” .

Manage storage space by eliminating old 
backup data.

Delete outdated recovery points to make more 
hard disk space available.

Also, reduce the number of file versions that 
are created when you back up your files and 
folders.

See About managing file and folder backup 
data .
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BEST PRACTICE DESCRIPTION

Review the level of protection that is provided 
for each of your computer's drives.

Check the Status page on a regular basis to 
ensure that each drive has a defined backup.

Maintain backup copies of your recovery 
points.

Store backup copies of your recovery points in 
a safe place. For example, you can store them 
elsewhere on a network or you can store them 
on tapes for long-term, off-site storage.

See Copying recovery points .

Delete corrupt images When the backup destination is a network 
location, all backup images in the destination 
folder are appended with a .tmp extension 
during the backup. If the backup is successful, 
the images are automatically renamed with 
a .v2i extension. If a network connection to the 
destination fails, the backup is unsuccessful. 
The corrupt images with the .tmp extension are 
retained. These files are not tracked by Veritas 
System Recovery 23 and can be deleted 
safely.

Tips for running defined backups
Consider the following tips when you run a defined backup:

Veritas System Recovery does not need to be running for a scheduled backup to start. After 

you define a backup, you can close Veritas System Recovery.

The computer that is backed up must be turned on and Windows must be started.

All defined backups are saved automatically so that you can edit them or run them later.

See Running an existing backup job immediately.

See Running a backup to create an alternate type of recovery point.

See Editing backup settings.

Do not run a disk defragmentation program during a backup. Doing so significantly increases 

the time that it takes to create the recovery point and might cause unexpected system resource 

issues.
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If you have two or more drives that are dependent on each other, you should include both 

drives in the same backup. Including both the drives in the same backup provides the safest 

protection.

Include multiple drives in the same defined backup to reduce the total number of backups that 

must be run. Doing so minimizes interruptions while you work.

Use the Progress and Performance feature to reduce the effect of a backup on your computer's 

performance. For example, say a scheduled backup starts while you are in the middle of a 

presentation. You can slow down the backup to give more processing resources back to your 

presentation program.

See Adjusting the speed of a backup.

The power management features on a computer can conflict with Veritas System Recovery 

during a backup.

For example, your computer might be configured to go into hibernation mode after a period of 

inactivity. You should consider turning off the power management features during a scheduled 

backup.

If a backup is interrupted, consider running it again.

If you experience problems while creating a backup, you may need to restart the computer.

See Best practices for backing up data.

See What to do when a backup is finished.

Backup destinations
You should review the following information before you decide where to store recovery points and 

file and folder backup data.

The following table contains the information that you need to consider when selecting a backup 

destination.

Table: Selecting a backup destination

BACKUP DESTINATION INFORMATION TO CONSIDER

Local hard drive, USB drive, or FireWire drive The benefits of this option are as follows\:

(recommended) - Provides for fast backup and recovery.
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BACKUP DESTINATION INFORMATION TO CONSIDER

- Lets you schedule unattended backups.

- Reduces cost because drive space can be 
overwritten repeatedly.

- Allows for off-site storage.

- Reserves hard drive space for other uses.

Although you can save the recovery point to 
the same drive that is backed up, it is not 
recommended for the following reasons:

- As the number or size of recovery points 
grows it consumes more disk space. As a 
result you have less disk space for regular use.

- The recovery point is included in subsequent 
recovery points of the drive, which increases 
the size of those recovery points.

- If the computer suffers a catastrophic failure, 
you may not be able to recover the recovery 
point. You may not be able to recover the 
recovery point even if you save it to a different 
drive on the same hard disk.

Network folder If your computer is connected to a network, 
you can save your recovery points and file and 
folder backup data to a network folder.

Backing up to a network folder typically 
requires that you authenticate to the computer 
that hosts the folder. If the computer is part of a 
network domain, you must provide the domain 
name, user name, and password. For 
example, domain\username.

If you connect to a computer in a workgroup, 
you should provide the remote computer name 
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BACKUP DESTINATION INFORMATION TO CONSIDER

and user name. For example: 
remote_computer_name\username.

OpenStorage Destination The benefits of this option are as follows

- Lets you select an OpenStorage destination 
as the primary destination when you define 
backups and during restore.

- Provides flexibility of maintaining large 
amount of data.

- Increases the accessibility of data from 
anywhere and at any time.

- Helps during disaster recovery situation to 
restore data from the cloud.

See Running an existing backup job immediately.

See Running a backup to create an alternate type of recovery point.

Backing up dual-boot computers
You can back up dual-boot computers, even if you have hidden drives (partitions) in the operating 

system from which you run Veritas System Recovery.

When you run a drive backup, the entire contents of each drive is captured in a recovery point. 

When you restore a drive, the recovered drive can be used to start your computer.

Consider the following points when backing up dual-boot computers:

To boot your computer from a restored system, you must back up, and then restore every drive 

that includes operating system boot information.

Do not create incremental backups of shared data drives if both the following conditions are 

true:

Veritas System Recovery is installed on both operating systems.

Both the operating systems are set to manage the shared drive.
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1.

2.

You might encounter issues if you try to use the Veritas System Recovery LightsOut Restore 

feature on dual-boot systems. It is not supported.

The same is true for the Veritas System Recovery Restore Anyware feature.

See Defining a drive-based backup.

More Information

About backing up your data

Manually validating recovery points
You can validate the recovery points by identifying if any of the recovery points are corrupted. You 

can verify both base and incremental images.

This validation is independent of your backup jobs. At any given point you can validate the older 

recovery points. You can verify recovery points located on a local or network location.

At a time you can specify one recovery point for validation. After the validation is complete, a list of 

corrupted recovery points is displayed.

A PowerShell script is used for this validation of recovery points. This script is available in the 

Veritas System Recovery media. \<media path\>\Docs\Automation\PowerShellscripts

This feature is not available from the Veritas System Recovery user interface and only available 

using the Powershell script.

If you give the path of the first incremental, the script validates the first incremental and then the 

base recovery point and not the second incremental.

For example, in case of a full backup (.v2i) and its incremental backups (.iv2i), if you have one full 

backup and two incremental images, and you give the path of the second incremental for 

validation, the script validates the second incremental and then proceeds to the base recovery 

point.

To manually validate recovery points

Launch the PowerShell command line.

Change the directory to where the PowerShell script is available and enter \

\VERIFYIMAGE.psl  and the location of the recovery point (local or network).
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“ ”
Note: You can also give the path of the PowerShell script and the location of the recovery point 

without changing the directory.

“ ”
If you have specified a network location, provide the username and password after the network 

location.

The script verifies the backup image and lists corrupted images, if any. If none of the backups are 

corrupt, a message is displayed that the backups are validated successfully.
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Backing up entire drives

This section includes the following topics:

Defining a drive-based backup

Compression levels for recovery points

Running a one-time backup from Veritas System Recovery

Running a backup from Veritas System Recovery Disk

How Offsite Copy works

Defining a drive-based backup
A drive-based backup takes a snapshot of your entire hard drive, capturing every bit of information 

that is stored on it for later retrieval. All of your files, folders, desktop settings, programs, and your 

operating system are captured into a recovery point. You can then use that recovery point to 

restore individual files or folders, or your entire computer.

For optimum protection, you should define a drive-based backup and run it on a regular basis.

By default, scheduled independent recovery point file names and recovery point set file names are 

appended with 001.v2i, 002.v2i, and so forth. Incremental recovery point file names within a set are 

appended with \_i001.iv2i, \_i002.iv2i, and so forth. For example, if your base recovery point is 

called CathyReadF001.v2i, the first incremental recovery point is called CathyReadF001_i001.iv2i.

Veritas System Recovery 23 backups are stored in the backup destination as recovery points. 

These recovery points can be used to restore the system back to the point-in-time when the image 

was created.

“ ”
Note: Veritas recommends that you use AES encryption when you define a backup to prevent 

unauthorized access to the files.

“ ”
The following files are intentionally excluded from drive-based backups:
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hiberfil.sys

pagefile.sys

These files contain temporary data that can take up a large amount of disk space. They are not 

needed, and there is no negative effect to your computer system after a complete system recovery.

These file names do appear in recovery points, but they are placeholders. They contain no data.

To define a drive-based backup

On the Tasks menu, click Run or Manage Backups.

In the Run or Manage Backups window, click Define New.

If you have not yet defined a backup, the Easy Setup dialog box appears instead.

Click Back up my computer, and then clickNext.

In the Drives panel, select one or more drives to back up, and then click Next.

SHOW HIDDEN DRIVES LETS YOU SEE ANY HIDDEN DRIVES ON 
YOUR HARD DISK. THE DRIVES ARE 

DISPLAYED IN THE DRIVE SELECTION 
TABLE.

Drive selection table Lets you select one or more drives to include 
in the backup.

“ ”
Note: Veritas System Recovery 23 is able to display the drives from a GPT disk even if one of 

the GPT headers is corrupted or if there is a disk signature collision.

“ ”
If the Related Drives panel appears, set the appropriate option, and then click Next. Otherwise, 

skip to the next step.

“ ”
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Note: When you back up the system drive of a UEFI-based computer, you must back up all the 

related drives. TheRelated Drivespanel lists the EFI System Partition and Windows Recovery 

Environment Partition (Windows 2012) that are critical to successfully restore a UEFI-based 

computer.

“ ”

ADD ALL RELATED DRIVES 
(RECOMMENDED)

LETS YOU SELECT AND INCLUDE ALL 
RELATED DRIVES IN THE BACKUP 

DEFINITION.

Edit the list of selected drives Lets you select or clear the related drives 
that you want or do not want to include in the 
backup definition.

Do not add related drives Lets you deselect (not include) all related 
drives in the backup definition.

On the Recovery point type panel, select the recovery point type that you want the backup to 

create, and then click Next.
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RECOVERY POINT SET (RECOMMENDED) SCHEDULES A BASE RECOVERY POINT 
WITH ADDITIONAL RECOVERY POINTS 

THAT CONTAIN ONLY THE INCREMENTAL 
CHANGES THAT WERE MADE TO YOUR 

COMPUTER SINCE THE PREVIOUS 
RECOVERY POINT.

INCREMENTAL RECOVERY POINTS ARE 
CREATED FASTER THAN THE BASE 

RECOVERY POINT. THEY ALSO USE LESS 
STORAGE SPACE THAN AN INDEPENDENT 

RECOVERY POINT.

NOTE: YOU CAN ONLY HAVE ONE 
RECOVERY POINT SET DEFINED FOR 
EACH DRIVE. THERECOVERY POINT 

SETOPTION IS NOT AVAILABLE IF YOU 
HAVE ALREADY ASSIGNED A SELECTED 

DRIVE TO AN EXISTING BACKUP AND 
SPECIFIEDRECOVERY POINT SETAS THE 

RECOVERY POINT TYPE. THIS OPTION 
ALSO IS UNAVAILABLE IF YOU SELECT 

AN UNMOUNTED DRIVE THAT CANNOT BE 
PART OF A RECOVERY POINT SET.

Independent recovery point Creates a complete, independent copy of the 
drives that you select. This backup type 
typically requires more storage space, 
especially if you run the backup multiple 
times.

On the Backup Destination panel, select the appropriate options.
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Show only hidden drives Select this check box and click Browse to 
only see a list of the hidden drives.

You can select a hidden drive as a location 
where you want to store the recovery points.

The hidden drives are displayed in the 
following format:

DiskNo-PartitionNo\

For example, a hidden drive is displayed as: 
2-3\. Where 2 is the disk number and 3 is the 
partition number.

Note: By default, this check box is not 
selected.
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

For more information on converting a drive to 
a hidden drive and vice versa, refer to the 
following technote:

https://www.veritas.com/content/support/
en_US/article.100045005

Browse Lets you browse to locate a backup 
destination that you want to use.

Browse for OpenStorage Destination Lets you browse to select a cloud storage 
destination that you want to use for backups.

See OpenStorage destination options for 
backups .

https://www.veritas.com/content/support/en_US/article.100045005
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Destination Details Displays the type of destination path. If you 
add a network path it also displays the user 
name.

Recovery points are not automatically 
encrypted.

Veritas recommends that you create 
permissions for the backup destination to 
prevent unauthorized access to any data 
contained in the

recovery points.

For more information, refer to the following 
link:
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

https://technet.microsoft.com/en-us/library/
cc732880(v=ws.11).aspx

Note: Veritas recommends that you use AES 
encryption when defining a backup to 
prevent unauthorized access to any data 
contained in the recovery points.

Edit Lets you enter the user name and password 
for access to the network that is specified in 
the Folder field. This option is available only 
if you selected a backup destination that is 
on a network and if you want to save the 
recovery point on a network share

See Rules for network credentials .

Customize recovery point file names Lets you rename the recovery point.

https://technet.microsoft.com/en-us/library/cc732880(v=ws.11).aspx
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Default file names include the name of the 
computer followed by the drive letter.

You can also save recovery points to a 
unique subfolder.

Enable USB Disk Rotation. Backup files to 
any USB disk inserted at this location

Select this check box to enable the USB disk 
rotation feature for USB disks.

See USB disk rotation .

Add Lets you add up to two Offsite Copy 
destinations.

Offsite Copy automatically copies your latest 
recovery points each time a backup 
completes to either a portable storage 
device, such as an external drive, or to a 
remote server either through a local area 
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

network connection or to a remote FTP 
server.

See How Offsite Copy works .

You cannot use an encrypted folder as your backup destination. You can choose to encrypt your 

backup data to prevent another user from accessing it.

(Optional) If you want to make copies of your recovery points to store at a remote location for 

added backup protection, click Add, select the appropriate options, and then clickOK.

ENABLE OFFSITE COPY TURNS ON THE OFFSITE COPY FEATURE.

Prompt me to start a copy when I attach an 
external Offsite Copy destination drive

Indicates that you want to have recovery 
points automatically copied to external 
Offsite Copy destination drives whenever you 
plug one in to your computer.
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ENABLE OFFSITE COPY TURNS ON THE OFFSITE COPY FEATURE.

Folder, Network Path, FTP address, or 
OpenStorage destination

Lets you specify the destination path of the 
offsite copy.

See Providing the OpenStorage destination 
path .

You can also specify the destination path of a 
hidden drive to store the recovery points.

To specify a hidden drive, enter the location 
in the following format:

DiskNo-PartitionNo\

For example, if the hidden drive location is 
on Disk 2 and Partition 3, you must enter 
2-3\. Where 2 is the disk number and 3 is the 
partition number.

For more information on converting a drive to 
a hidden drive and vice versa, refer to the 
following technote:

https://www.veritas.com/content/support/
en_US/article.100045005

Browse Lets you browse to locate an offsite copy 
destination that you want to use.

Destination Details Displays the type of destination path. If you 
add a network path, an ftp path, or an 
OpenStorage destination, it also displays the 
user name.

Edit Lets you edit the user name or password of a 
specified network path, an ftp path, or an 
OpenStorage destination.

Add an additional Offsite Copy destination Lets you add a second destination, and then 
specify the path to that destination.

https://www.veritas.com/content/support/en_US/article.100045005
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(Optional) If you specify an OpenStorage destination (Amazon S3 or Microsoft Azure storage) 

as the Offsite destination, click OK.

On the OpenStorage Destinationdialog box select the appropriate options, and then clickOK.

“ ”
Note: Although cloud storage is a part of OpenStorage, Veritas System Recovery 23 refers to 

cloud storage as OpenStorage.

“ ”
See OpenStorage destination options for backups.

See Using Amazon S3 storage as your Offsite Copy destination.

See Using Microsoft Azure as your offsite copy destination.

See Using S3-Compatible or Veritas Access as your offsite copy destination.

Click Next.

On the Options panel, set the recovery point options you want, and then click Next.

Recovery point options

NAME INDICATES A NAME FOR YOUR BACKUP.

NOTE: THIS OPTION DOES NOT APPEAR IF 
YOU CREATE A RECOVERY POINT USING 
THEBACK UP MY COMPUTERFEATURE IN 

VERITAS SYSTEM RECOVERY DISK.

Compression Lets you set one of the following compression 
levels for the recovery point\:

- None

- Standard

- Medium

- High



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

131

NAME INDICATES A NAME FOR YOUR BACKUP.

NOTE: THIS OPTION DOES NOT APPEAR IF 
YOU CREATE A RECOVERY POINT USING 
THEBACK UP MY COMPUTERFEATURE IN 

VERITAS SYSTEM RECOVERY DISK.

The results can vary depending on the types of 
files that are saved in the drive.

Verify recovery point after creation Tests whether a recovery point or set of files is 
valid or corrupt.

Limit the number of recovery point sets saved 
for this backup

Limits the number of recovery point that can be 
saved for this backup. You can limit the 
number of recovery points to reduce the risk of 
filling up the hard drive with recovery points. 
Each new recovery point replaces the oldest 
set on your backup destination drive.

The backup destination must contain enough 
free space for the number of recovery points 
the job is set to retain, plus one. For example, 
if the maximum number of recovery points to 
retain is set to 3, the required space in the 
backup destination should be able to hold 4 
recovery point sets. Veritas System Recovery 
23 removes the oldest recovery point set only 
after the successful completion of the current 
backup. This ensures that the number of 
recovery points meets the recovery point 
retention setting.

Note: This option does not appear if you 
create a recovery point using theBack Up My 
Computerfeature in a Veritas System Recovery 
Disk.

Include system and temporary files Includes an indexing support for operating 
system and temporary files when a recovery 
point is created on the client computer.
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NAME INDICATES A NAME FOR YOUR BACKUP.

NOTE: THIS OPTION DOES NOT APPEAR IF 
YOU CREATE A RECOVERY POINT USING 
THEBACK UP MY COMPUTERFEATURE IN 

VERITAS SYSTEM RECOVERY DISK.

Note: This option does not appear if you 
create a recovery point using theBack Up My 
Computerfeature in Veritas System Recovery 
Disk.

Advanced Lets you add security options to the recovery 
point.

Command Files Lets you use command files (.exe, .cmd, .bat) 
during a backup.

See Running command files during a backup .

Description Indicates a description for the recovery point. 
The description can be anything that helps you 
further identify the recovery point's contents.

Advanced options for drive-based backups

DIVIDE INTO SMALLER FILES TO SIMPLIFY 
ARCHIVING

SPLITS THE RECOVERY POINT INTO 
SMALLER FILES AND SPECIFIES THE 

MAXIMUM SIZE (IN MB) FOR EACH FILE.

THIS OPTION IS SELECTED BY DEFAULT 
WHEN YOU SPECIFY A MICROSOFT 

ONEDRIVE LOCATION AS YOUR PRIMARY 
DESTINATION. A RECOVERY POINT THAT IS 
LARGER THAN 10 GB IS AUTOMATICALLY 

SPLIT INTO SMALLER FILES OF LESS THAN 
10 GB. YOU CAN SPLIT THE SIZE OF THE 

RECOVERY POINT INTO SMALLER 
RECOVERY POINTS.

Disable SmartSector™ Copying Copies that are used and unused hard-disk 
sectors. This option increases process time 
and usually results in a larger recovery point.
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DIVIDE INTO SMALLER FILES TO SIMPLIFY 
ARCHIVING

SPLITS THE RECOVERY POINT INTO 
SMALLER FILES AND SPECIFIES THE 

MAXIMUM SIZE (IN MB) FOR EACH FILE.

THIS OPTION IS SELECTED BY DEFAULT 
WHEN YOU SPECIFY A MICROSOFT 

ONEDRIVE LOCATION AS YOUR PRIMARY 
DESTINATION. A RECOVERY POINT THAT IS 
LARGER THAN 10 GB IS AUTOMATICALLY 

SPLIT INTO SMALLER FILES OF LESS THAN 
10 GB. YOU CAN SPLIT THE SIZE OF THE 

RECOVERY POINT INTO SMALLER 
RECOVERY POINTS.

SmartSector technology speeds up the 
copying process by copying only the hard-disk 
sectors that contain data. However, in some 
cases, you might want to copy all sectors in 
their original layout, whether or not they 
contain data.

Ignore bad sectors during copy Runs a backup even if there are bad sectors 
on the hard disk. Although most drives do not 
have bad sectors, the potential for problems 
increases during the lifetime of the hard disk.

Perform full VSS backup Lets you perform a full backup on the VSS 
storage and send a request for VSS to review 
its own transaction log. This option is used for 
Microsoft Exchange Server only.

Exchange VSS determines what transactions 
are already committed to the database and 
then truncates those transactions. Among 
other things, truncated transaction logs help 
keep the file size manageable and limits the 
amount of hard drive space that the file uses.

If you do not select this option, backups still 
occur on the VSS storage. However, VSS does 
not automatically truncate the transaction logs 
following a backup.
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DIVIDE INTO SMALLER FILES TO SIMPLIFY 
ARCHIVING

SPLITS THE RECOVERY POINT INTO 
SMALLER FILES AND SPECIFIES THE 

MAXIMUM SIZE (IN MB) FOR EACH FILE.

THIS OPTION IS SELECTED BY DEFAULT 
WHEN YOU SPECIFY A MICROSOFT 

ONEDRIVE LOCATION AS YOUR PRIMARY 
DESTINATION. A RECOVERY POINT THAT IS 
LARGER THAN 10 GB IS AUTOMATICALLY 

SPLIT INTO SMALLER FILES OF LESS THAN 
10 GB. YOU CAN SPLIT THE SIZE OF THE 

RECOVERY POINT INTO SMALLER 
RECOVERY POINTS.

Note: This option does not appear if you 
create a recovery point using theBack Up My 
Computerwizard feature in Veritas System 
Recovery Disk.

Command files options

COMMAND FILES FOLDER LETS YOU SPECIFY THE LOCATION OF 
COMMAND FILES. YOU CAN ALSO SPECIFY 

A LOCATION ON A PER-JOB BASIS, AS 
WELL AS SPECIFY A LOCATION THAT CAN 

BE SHARED AMONG SEVERAL 
COMPUTERS. IF YOU SPECIFY A NETWORK 

LOCATION, YOU ARE PROMPTED FOR 
NETWORK CREDENTIALS.

NOTE: ALL COMMAND FILES MUST EXIST IN 
THE SPECIFIED FOLDER.

Browse Lets you browse to locate a folder for any 
command files that you want to use.

User name Lets you specify the user name to a command 
file folder that is located in a network path.

Password Lets you specify the password to a command 
file folder that is located in a network path.

Run before snapshot creation Indicates that you can run a command file after 
a backup has started and before a recovery 
point is created. You can run a command 
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COMMAND FILES FOLDER LETS YOU SPECIFY THE LOCATION OF 
COMMAND FILES. YOU CAN ALSO SPECIFY 

A LOCATION ON A PER-JOB BASIS, AS 
WELL AS SPECIFY A LOCATION THAT CAN 

BE SHARED AMONG SEVERAL 
COMPUTERS. IF YOU SPECIFY A NETWORK 

LOCATION, YOU ARE PROMPTED FOR 
NETWORK CREDENTIALS.

NOTE: ALL COMMAND FILES MUST EXIST IN 
THE SPECIFIED FOLDER.

during this stage to prepare for the recovery 
point creation process. For example, you can 
close any open applications that are using the 
drive.

Note: If you use this option, be sure that the 
command file has an error recovery 
mechanism that is built into it. If the computer 
has one or more services that must be stopped 
at this stage, and the command file does not 
contain any form of error recovery, one or more 
of the stopped services may not be restarted. 
For example, stopping a non-VSS aware 
database or a resource-intensive application. 
An error in the command file can cause the 
recovery point creation process to stop 
immediately. No other command files can run. 
SeeHow to use Veritas System Recovery.

Run after snapshot creation Indicates that you can run a command file after 
a snapshot is created. Running a command 
during this stage is a safe point to allow 
services to resume on the drive while 
continuing the recovery point creation.

Because the snapshot takes only a few 
seconds to create, the database is in the 
backup state momentarily. A minimal number 
of log files are created.

Run after recovery point creation Indicates that you can run a command file after 
the recovery point file is created. You can run a 
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COMMAND FILES FOLDER LETS YOU SPECIFY THE LOCATION OF 
COMMAND FILES. YOU CAN ALSO SPECIFY 

A LOCATION ON A PER-JOB BASIS, AS 
WELL AS SPECIFY A LOCATION THAT CAN 

BE SHARED AMONG SEVERAL 
COMPUTERS. IF YOU SPECIFY A NETWORK 

LOCATION, YOU ARE PROMPTED FOR 
NETWORK CREDENTIALS.

NOTE: ALL COMMAND FILES MUST EXIST IN 
THE SPECIFIED FOLDER.

command during this stage to act on the 
recovery point itself. For example, you can 
copy it to an offline location.

Timeout (applies to each stage) Lets you specify the amount of time (in 
seconds) that a command file is allowed to run.

On the Security Options panel, set a password, select a level of encryption for the drive-based 

backup, and then click Next.

USE PASSWORD SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

Password Lets you specify a password for the backup. 
Passwords can include standard characters. 
Passwords cannot include extended 
characters, or symbols. (Use characters with 
an ASCII value of 128 or lower.)

You must type this password before you 
restore a backup or view the contents of the 
recovery point.

Confirm password Lets you retype the password for

confirmation.
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USE PASSWORD SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

AES encryption Encrypts recovery point data to add another 
level of protection to your recovery points.

If

you upgrade from a previous version to 
Veritas System Recovery 23, for older 
backup jobs where only

password protection is defined, you need to 
edit the jobs to select the AES

encryption level. If you do not edit the older 
backup jobs, they continue to run

without AES Encryption. Veritas 
recommends that you edit the job and select 
AES

encryption level.

Note: If theUse Passwordcheck box is 
selected, you must define AES encryption.

Choose from the following encryption levels:

- Standard 128-bit (8+ character password)

- Medium 192-bit (16+ character password)

- High 256-bit (32+ character password)

On the Backup Time panel, select the appropriate options to specify the time and frequency of 

the backup, and then click Next.

“ ”
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Note: Ensure that the time for running a base backup and an incremental backup is not the 

same.

“ ”
Backup Time options for a recovery point set

SCHEDULE RUNS THE BACKUP AUTOMATICALLY 
ACCORDING TO A SPECIFIED START TIME 
AND THE SELECTED DAYS OF THE WEEK.

Default Lets you use the default backup time schedule.

Advanced Sets advanced scheduling options, such as 
setting up event triggers that start the backup 
in response to specific events.

Run more than once per day Sets the time between backups and the 
number of times to back up.

Start a new recovery point set (base) Starts a new recovery point set (base) weekly, 
monthly, quarterly, or yearly.

Custom (Optional) Indicates how frequently a new 
recovery point set should be started.

For example, if you select Monthly , a new 
base recovery point is created the first time the 
backup runs during each new month.

Select event triggers Lets you select events that automatically 
create a recovery point.

Details Shows you information about the backup time 
option you have selected or specified.

Backup Time options for an independent recovery point
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NO SCHEDULE RUNS THE BACKUP ONLY WHEN YOU RUN 
IT YOURSELF, MANUALLY.

Weekly Runs the backup at the time and on the days 
of the week that you specify.

When you select this option, the Select the 
days of the week to protect dialog box 
appears.

Monthly Runs the backup at the time and on the days 
of the month that you specify.

When you select this option, the Select the 
days of the month to protect dialog box 
appears.

Only run once Runs the backup one time on the date and at 
the time you specify.

When you select this option, the Create a 
single recovery point dialog box appears.

Details Indicates information about the backup time 
option you have selected or specified.

Change Schedule - Drive Backup options

SCHEDULE LETS YOU SELECT THE DAYS AND A START 
TIME FOR

WHEN THE BACKUP SHOULD RUN.

Run more than once per day Indicates that you can run the backup more 
than

once a day to protect data that you edit or

change frequently.

Time between backups Specifies the maximum time that should occur

between backups.
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1.

SCHEDULE LETS YOU SELECT THE DAYS AND A START 
TIME FOR

WHEN THE BACKUP SHOULD RUN.

Number of times Specifies the number of times per day that the

backup should run.

Automatically optimize Lets you select how often optimization should

occur to help manage the disk space that is

used by your backup destination.

Start a new recovery point set Indicates how frequently a new recovery point

set should be started

Custom Lets you customize the start time, and the days

of the week or month to run the backup.

Event Triggers - General Lets you select the type of events that

automatically starts a backup.

(Optional) If you want to run the new backup immediately, click Run backup now.

This option is not available if you configured an independent recovery point with the option to run it 

only once.

Review the options you have selected, then click Finish.

When the backup destination is a network location, all backup images in the destination folder are 

appended with a .tmp extension during the backup. If the backup is successful, the images are 

automatically renamed with a .v2i extension. If a network connection to the destination fails, the 

backup is unsuccessful. The corrupt images with the .tmp extension are retained. These files are 

not tracked by Veritas System Recovery 23 and can be deleted safely.

More Information

Compression levels for recovery points
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USB disk rotation
The USB disk rotation feature lets you create a backup destination on multiple USB drives. To use 

this feature, each USB disk must use the same drive letter assigned to the original USB disk 

defined in the backup destination. Select the USB disk to enable the Enable USB Disk Rotation. 

Backup files to any USB disk inserted at this location check box. When you select the check box, 

USB disk rotation is enabled.

As a part of this feature, a warning is displayed when you define a backup and not enough is 

available to complete the backup. The warning is displayed immediately after the backup job starts. 

To continue the backup, you can either insert a new USB disk (at the same mount point) or 

continue to use the existing USB disk, in which case the backup job fails.

See How USB disk rotation works.

How USB disk rotation works

Using the USB disk rotation feature, you can rotate your available USB disks to use as backup 

destinations. Older backups are automatically cleaned up, depending on the number of USB disks 

and the number of recovery points the job is set to retain. When the recovery point set limit is 

reached, older recovery points (base and incrementals) are deleted when the USB disk containing 

the oldest recovery points is inserted. Using this feature, you are not required to edit the backup 

job and change the backup destination to add a new USB disk.

The following table displays an example of how USB disk rotation works when the number of USB 

disks available is 2 and the recovery point set limit is 3.

Table: USB rotation example

DAY USB 1 USB 2 REMARKS

Monday 1.v2i - -

Tuesday 1_001.iv2i - -

Wednesday 1_002.iv2i - -

Thursday - 2.v2i USB rotated

Friday - 2_001.iv2i -

Saturday - - -
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DAY USB 1 USB 2 REMARKS

Sunday - - -

Monday 3.v2i - USB rotated

Tuesday 3_001.iv2i - -

Wednesday - 4.v2i The number of 
recovery points in 
this example are set 
at 3. When you 
attach USB 2 and 
recovery point set 4 
is created, recovery 
point set one cannot 
be deleted as it is on 
USB 1.

When you attach 
USB 1 in the future, 
recovery point set 1 
is deleted 
automatically before 
the backup job starts 
running.

Thursday - 4_001.iv2i -

Friday - 4_002.iv2i -

Saturday - - -

Sunday - - -

Monday - 5.v2i USB rotated and 
recovery point set 2 
is deleted 
automatically.

Tuesday - 5_001.iv2i -
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DAY USB 1 USB 2 REMARKS

Wednesday 6_v2i - USB rotated and 
recovery point set 1 
is deleted 
automatically. After 
recovery point set 6 
is created 
successfully, 
recovery point set 3 
is deleted 
automatically.

Thursday 6_001.iv2i - -

Friday 6_002.iv2i - -

Rules for network credentials
If you connect to a computer on a network, you must provide the user name and password for 

network access, even if you previously authenticated to the network. The Veritas System Recovery 

service runs on the local system account.

When you enter network credentials, the following rules apply:

If the computer you want to connect to is on a domain, provide the domain name, user name, 

and password. For example:

domain\username

If you connect to a computer in a workgroup, provide the remote computer name and user 

name. For example:

remote_computer_name\username

If you have mapped a drive, you may need to supply the user name and password again 

because the service runs in a different context and cannot recognize the mapped drive.

By going to the Tasks menu and selecting Options, you can set a default location. If the default 

location is a computer on a network, you can also click the Edit option and specify the necessary 

network credentials. Then when you create future backup jobs, the dialog will default to the location 
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you specified. Another option would be to create a specific "backup" user account. Then configure 

the Veritas System Recovery service to use this account.

See Defining a drive-based backup.

Running command files during a backup
You can use command files (.exe, .cmd, .bat) during a backup. You can use command files to 

integrate Veritas System Recovery with other backup routines that you might be running on the 

computer. You can also use command files to integrate with other applications that use a drive on 

the computer.

“ ”
Note: You cannot run the command files that include a graphical user interface, such as 

notepad.exe. Running such command files causes the backup job to fail.

“ ”
You can run a command file during any of the following stages during the creation of a recovery 

point:

Run before snapshot creation

Run after snapshot creation

Run after recovery point creation

When you use command files (.exe, .cmd, .bat) during a backup, stop and then restart non-VSS-

aware databases.

To use a Visual Basic script file (.vbs) during a backup, you can create a batch file (.bat) to run the 

script. Veritas System Recovery runs any script using a high privilege account. When the 

command files are to be located at a place other than the default location, the Command Files

folder specifies the location of these files.

“ ”
Note: Veritas recommends that only high privilege users or an administrator have the permission 

to modify a backup script and access theCommand Filesfolder.
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“ ”
For example, you can create a batch file called Stop.bat that contains the following syntax:

Cscript script_filename.vbs

Make sure that Cscript  precedes the file name of the Visual Basic script.

“ ”
Warning: The command files cannot depend on any user interaction or have a visible user 

interface. You should test all command files independently of Veritas System Recovery before you 

use them during a backup.

“ ”
When the backup begins, the command file is run during the specified stage. The backup is 

stopped if an error occurs while a command file is running. Or, the backup is stopped if the 

command file does not finish in the time you specified (regardless of the stage). In either case, the 

command file is terminated (if necessary), and the error information is logged and displayed.

Table: Command files options

OPTION DESCRIPTION

Command files folder Lets you specify the location of command files. 
You can also specify a location on a per-job 
basis, as well as specify a location that can be 
shared among several computers. If you 
specify a network location, you are prompted 
for network credentials.

Note: All command files must exist in the 
specified folder.

Browse Lets you browse to locate a folder for any 
command files that you want to use.
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OPTION DESCRIPTION

User name Lets you specify the user name to a command 
file folder that is located in a network path.

Password Lets you specify the password to a command 
file folder that is located in a network path.

Run before snapshot creation Indicates that you can run a command file after 
a backup has started and before a recovery 
point is created. You can run a command 
during this stage to prepare for the recovery 
point creation process. For example, you can 
close any open applications that are using the 
drive.

Note: If you use this option, be sure that the 
command file has an error recovery 
mechanism that is built into it. If the computer 
has one or more services that must be stopped 
at this stage, and the command file does not 
contain any form of error recovery, one or more 
of the stopped services may not be restarted. 
For example, stopping a non-VSS aware 
database or a resource-intensive application. 
An error in the command file can cause the 
recovery point creation process to stop 
immediately. No other command files can run. 
SeeHow to use Veritas System Recovery.

Run after snapshot creation Indicates that you can run a command file after 
a snapshot is created. Running a command 
during this stage is a safe point to allow 
services to resume on the drive while 
continuing the recovery point creation.

Because the snapshot takes only a few 
seconds to create, the database is in the 
backup state momentarily. A minimal number 
of log files are created.

Run after recovery point creation Indicates that you can run a command file after 
the recovery point file is created. You can run a 
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OPTION DESCRIPTION

command during this stage to act on the 
recovery point itself. For example, you can 
copy it to an offline location.

Timeout (applies to each stage) Lets you specify the amount of time (in 
seconds) that a command file is allowed to run.

See Defining a drive-based backup.

See Running a one-time backup from Veritas System Recovery.

Editing backup options
After you define a backup, you can go back at any time and edit the options you chose when you 

first defined the backup.

To edit backup options

On the Tasks menu, click Run or Manage Backups.

Select the backup you want to edit, and then click Edit Settings.

In the Define Backup Wizard make the changes, complete the steps in the wizard, and then 

click Finish.

See Defining a drive-based backup.

Verifying the integrity of a recovery point
If you selected the Verify recovery point after creation option on the Options panel of the Define 

Backup wizard, the following occurs:

Veritas System Recovery verifies that all of the files that make up the recovery point are 

available for you to open.

Internal data structures in the recovery point are matched with the data that is available.

Also, the recovery point can be uncompressed to create the expected amount of data (if you 

selected a compression level at the time of creation).

“ ”
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Note: The time that is required to create a recovery point is doubled when you use theVerify 

recovey point after creationoption.

“ ”
If you prefer, you can have recovery points automatically verified for integrity at the time they are 

created.

Table: Verifying recovery point options

OPTION DESCRIPTION

Divide into smaller files to simplify archiving Splits the recovery point into smaller files and 
specifies the maximum size (in MB) for each 
file.

This option is selected by default when you 
specify a Microsoft OneDrive location as your 
primary destination. A recovery point that is 
larger than 10 GB is automatically split into 
smaller files of less than 10 GB. You can split 
the size of the recovery point into smaller 
recovery points.

Disable SmartSector™ Copying Copies that are used and unused hard-disk 
sectors. This option increases process time 
and usually results in a larger recovery point.

SmartSector technology speeds up the 
copying process by copying only the hard-disk 
sectors that contain data. However, in some 
cases, you might want to copy all sectors in 
their original layout, whether or not they 
contain data.

Ignore bad sectors during copy Runs a backup even if there are bad sectors 
on the hard disk. Although most drives do not 
have bad sectors, the potential for problems 
increases during the lifetime of the hard disk.

Perform full VSS backup Lets you perform a full backup on the VSS 
storage and send a request for VSS to review 
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OPTION DESCRIPTION

its own transaction log. This option is used for 
Microsoft Exchange Server only.

Exchange VSS determines what transactions 
are already committed to the database and 
then truncates those transactions. Among 
other things, truncated transaction logs help 
keep the file size manageable and limits the 
amount of hard drive space that the file uses.

If you do not select this option, backups still 
occur on the VSS storage. However, VSS does 
not automatically truncate the transaction logs 
following a backup.

Note: This option does not appear if you 
create a recovery point using theBack Up My 
Computerwizard feature in Veritas System 
Recovery Disk.

To verify the integrity of a recovery point

On the Toolspage, clickRun Recovery Point Browser.

Select a recovery point, and then click OK.

In the tree panel of the Recovery Point Browser, select the recovery point.

For example: C_Drive001.v2i.

On the File menu, click Verify Recovery Point.

If the Verify Recovery Pointoption is unavailable, you must first dismount the recovery point. 

Right-click the recovery point and clickDismount Recovery Point.

When the validation is complete, click OK.

See Recovery point encryption.

Viewing the progress of a backup
You can view the progress of a backup while it runs to determine how much time remains until the 

backup completes.
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To view the progress of a backup

While a backup is running, on the View menu, click Progress and Performance.

See Backing up files and folders.

More Information

Defining a drive-based backup

Recovery point encryption
You can enhance the data security by using the Advanced Encryption Standard (AES) option to 

encrypt recovery points that you create or archive. You should use encryption if you store recovery 

points on a network and want to protect them from unauthorized access and use.

You can also encrypt recovery points that were created with earlier versions of Veritas LiveState 

Recovery or Veritas System Recovery. However, encrypting those files makes them readable with 

the current product only.

You can view the encryption strength of a recovery point at any time by viewing the properties of 

the file from the Recovery Point Browser.

Encryption strengths are available in 128-bit, 192-bit, or 256-bit. While higher bit strengths require 

longer passwords, the result is greater security for your data.

The following table explains the bit strength and required password length.

Table: Password length

BIT STRENGTH PASSWORD LENGTH

128 (Standard) 8 characters or longer

192 (Medium) 16 characters or longer

256 (High) 32 characters or longer

You must provide the correct password before you can access or restore an encrypted recovery 

point.

“ ”
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Warning: Veritas Technical Support cannot open an encrypted recovery point. Store the password 

in a secure place. Passwords are case-sensitive. When you access or restore a recovery point that 

is password encrypted, Veritas System Recovery prompts you for the case-sensitive password. If 

you do not type the correct password or you forget the password, you cannot open the recovery 

point.

“ ”
Besides bit strength, the format of the password can improve the security of your data.

For better security, passwords should use the following general rules:

Do not use consecutive repeating characters (for example, BBB or 88).

Do not use common words you would find in a dictionary.

Use at least one number.

Use both uppercase and lowercase alpha characters.

Use at least one special character such as {}(),.<>;:'"?/|\\`~!@#$%^&*()_-+=.

Change the password after a set period of time.

See Backing up files and folders.

See Verifying the integrity of a recovery point.

More Information

Defining a drive-based backup

Compression levels for recovery points
During the creation or copying of a recovery point, compression results may vary, depending on 

the types of files that are saved to the drive you are backing up.

The following table describes the available compression levels.

Table: Compression level options

OPTION DESCRIPTION

None Indicates that no compression is applied to the 
recover point. Use this option if storage space 
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OPTION DESCRIPTION

is not an issue. If the backup is saved to a 
busy network drive, high compression may be 
faster than no compression because there is 
less data to write across the network.

Standard (recommended) Uses low compression for a 40 percent 
average data compression ratio on recovery 
points. This setting is the default.

Medium Uses medium compression for a 45 percent 
average data compression ratio on recovery 
points.

High Uses high compression for a 50 percent 
average data compression ratio on recovery 
points. This setting is usually the slowest 
method.

When a high compression recovery point is 
created, CPU usage might be higher than 
normal. Other processes on the computer 
might also be slower. To compensate, you can 
adjust the operation speed of Veritas System 
Recovery. Adjusting the speed may improve 
the performance of other resource-intensive 
applications that you are running at the same 
time.

See Defining a drive-based backup.

See Copying recovery points.

Running a one-time backup from Veritas System Recovery
You can use One Time Backup to quickly define and run a backup that creates an independent 

recovery point. You use the One Time Backup wizard to define the backup. The backup runs when 

you complete the wizard. The backup definition is not saved for future use. You can use the 

independent recovery point later.
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This feature is useful when you need to back up your computer or a particular drive quickly before 

a significant event. For example, you can run a one-time backup before you install new software. 

Or, you can run it when you learn about a new computer security threat.

You can also use Veritas System Recovery Disk to create one-time cold backups.

To run a one-time backup from Veritas System Recovery

On the Tasks page, click One Time Backup.

Click Next.

Select one or more drives to back up, and then click Next.

“ ”
Note: Veritas System Recovery 23 is able to display the drives from a GPT disk even if one of 

the GPT headers is corrupted or if there is a disk signature collision.

“ ”
If the Related Drives dialog box is displayed, set the appropriate option, and then click Next. 

Otherwise, skip to the next step.

ADD ALL RELATED DRIVES 
(RECOMMENDED)

LETS YOU SELECT AND INCLUDE ALL 
RELATED DRIVES IN THE BACKUP 

DEFINITION.

Edit the list of selected drives Lets you select or clear the related drives 
that you want or do not want to include in the 
backup definition.

Do not add related drives Lets you deselect (not include) all related 
drives in the backup definition.

In the Backup Destinations panel, select the appropriate options.
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

NOTE: BY DEFAULT, THIS CHECK BOX IS 
NOT SELECTED.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Show only hidden drives Select this check box and click Browse to 
only see a list of the hidden drives.

You can select a hidden drive as a location 
where you want to store the recovery points.

The hidden drives are displayed in the 
following format:

DiskNo-PartitionNo\

For example, a hidden drive is displayed as: 
2-3\. Where 2 is the disk number and 3 is the 
partition number.
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

NOTE: BY DEFAULT, THIS CHECK BOX IS 
NOT SELECTED.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Note: By default, this check box is not 
selected.

Browse Lets you browse to locate a backup 
destination that you want to use.

Browse for OpenStorage Destination Lets you browse to select a cloud storage 
destination that you want to use for backups.

See OpenStorage destination options for 
backups .

Destination Details Displays the type of destination path. If you 
add a network path it also displays the user 
name.
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

NOTE: BY DEFAULT, THIS CHECK BOX IS 
NOT SELECTED.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Recovery points are not automatically 
encrypted.

Veritas recommends that you create 
permissions for the backup destination to 
prevent unauthorized access to any data 
contained in the

recovery points.

For more information, refer to the following 
link:

https://technet.microsoft.com/en-us/library/
cc732880(v=ws.11).aspx

https://technet.microsoft.com/en-us/library/cc732880(v=ws.11).aspx
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

NOTE: BY DEFAULT, THIS CHECK BOX IS 
NOT SELECTED.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Note: Veritas recommends that you use AES 
encryption when defining a backup to 
prevent unauthorized access to any data 
contained in the recovery points.

Edit Lets you enter the user name and password 
for access to the network that is specified in 
the Folder field. This option is available only 
if you selected a backup destination that is 
on a network and if you want to save the 
recovery point on a network share.

See Rules for network credentials .

Customize recovery point file names Lets you rename the recovery point.
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

NOTE: BY DEFAULT, THIS CHECK BOX IS 
NOT SELECTED.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Default file names include the name of the 
computer followed by the drive letter.

You can also save recovery points to a 
unique subfolder.

Enable USB Disk Rotation. Backup files to 
any USB disk inserted at this location

Select this check box to enable the USB disk 
rotation feature for USB disks.

See USB disk rotation .

Add Lets you add up to two Offsite Copy 
destinations.
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FOLDER INDICATES THE LOCATION WHERE YOU 
WANT TO STORE THE RECOVERY POINTS.

YOU CAN BROWSE OR ENTER A 
MICROSOFT ONEDRIVE LOCATION AS 

THE PRIMARY DESTINATION.

SEE ABOUT SUPPORT OF ONEDRIVE FOR 
BUSINESS .

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

NOTE: BY DEFAULT, THIS CHECK BOX IS 
NOT SELECTED.

IF VERITAS SYSTEM RECOVERY DETECTS 
THAT THIS LOCATION DOES NOT HAVE 
ENOUGH AVAILABLE SPACE, IT ALERTS 
YOU. YOU SHOULD CHOOSE ANOTHER 

LOCATION THAT HAS MORE SPACE.

Offsite Copy automatically copies your latest 
recovery points each time a backup 
completes to either a portable storage 
device, such as an external drive, or to a 
remote server either through a local area 
network connection or to a remote FTP 
server.

See How Offsite Copy works .

Click Next.

On the Options panel, select the appropriate options, and then click Next

Recovery Point options
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NAME INDICATES A NAME FOR YOUR BACKUP.

NOTE: THIS OPTION DOES NOT APPEAR IF 
YOU CREATE A RECOVERY POINT USING 
THEBACK UP MY COMPUTERFEATURE IN 

VERITAS SYSTEM RECOVERY DISK.

Compression Lets you set one of the following compression 
levels for the recovery point\:

- None

- Standard

- Medium

- High

The results can vary depending on the types of 
files that are saved in the drive.

Verify recovery point after creation Tests whether a recovery point or set of files is 
valid or corrupt.

Limit the number of recovery point saved for 
this backup

Limits the number of recovery point that can be 
saved for this backup. You can limit the 
number of recovery points to reduce the risk of 
filling up the hard drive with recovery points. 
Each new recovery point replaces the oldest 
set on your backup destination drive.

The backup destination must contain enough 
free space for the number of recovery points 
the job is set to retain, plus one. For example, 
if the maximum number of recovery points to 
retain is set to 3, the required space in the 
backup destination should be able to hold 4 
recovery point sets. Veritas System Recovery 
23 removes the oldest recovery point set only 
after the successful completion of the current 
backup. This ensures that the number of 
recovery points meets the recovery point 
retention setting.
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NAME INDICATES A NAME FOR YOUR BACKUP.

NOTE: THIS OPTION DOES NOT APPEAR IF 
YOU CREATE A RECOVERY POINT USING 
THEBACK UP MY COMPUTERFEATURE IN 

VERITAS SYSTEM RECOVERY DISK.

This option appears only if you are creating a 
recovery point set.

Note: This option does not appear if you 
create a recovery point using theBack Up My 
Computerfeature in a Veritas System Recovery 
Disk.

Include system and temporary files Includes an indexing support for operating 
system and temporary files when a recovery 
point is created on the client computer.

Note: This option does not appear if you 
create a recovery point using theBack Up My 
Computerfeature in Veritas System Recovery 
Disk.

Advanced Lets you add security options to the recovery 
point.

Command Files Lets you use command files (.exe, .cmd, .bat) 
during a backup.

See Running command files during a backup .

Description Indicates a description for the recovery point. 
The description can be anything that helps you 
further identify the recovery point's contents.

Advanced options



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

162

DIVIDE INTO SMALLER FILES TO SIMPLIFY 
ARCHIVING

SPLITS THE RECOVERY POINT INTO 
SMALLER FILES AND SPECIFIES THE 

MAXIMUM SIZE (IN MB) FOR EACH FILE.

THIS OPTION IS SELECTED BY DEFAULT 
WHEN YOU SPECIFY A MICROSOFT 

ONEDRIVE LOCATION AS YOUR PRIMARY 
DESTINATION. A RECOVERY POINT THAT IS 
LARGER THAN 10 GB IS AUTOMATICALLY 

SPLIT INTO SMALLER FILES OF LESS THAN 
10 GB. YOU CAN SPLIT THE SIZE OF THE 

RECOVERY POINT INTO SMALLER 
RECOVERY POINTS.

Disable SmartSector™ Copying Copies that are used and unused hard-disk 
sectors. This option increases process time 
and usually results in a larger recovery point.

SmartSector technology speeds up the 
copying process by copying only the hard-disk 
sectors that contain data. However, in some 
cases, you might want to copy all sectors in 
their original layout, whether or not they 
contain data.

Ignore bad sectors during copy Runs a backup even if there are bad sectors 
on the hard disk. Although most drives do not 
have bad sectors, the potential for problems 
increases during the lifetime of the hard disk.

Perform full VSS backup Lets you perform a full backup on the VSS 
storage and send a request for VSS to review 
its own transaction log. This option is used for 
Microsoft Exchange Server only.

Exchange VSS determines what transactions 
are already committed to the database and 
then truncates those transactions. Among 
other things, truncated transaction logs help 
keep the file size manageable and limits the 
amount of hard drive space that the file uses.

If you do not select this option, backups still 
occur on the VSS storage. However, VSS does 
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DIVIDE INTO SMALLER FILES TO SIMPLIFY 
ARCHIVING

SPLITS THE RECOVERY POINT INTO 
SMALLER FILES AND SPECIFIES THE 

MAXIMUM SIZE (IN MB) FOR EACH FILE.

THIS OPTION IS SELECTED BY DEFAULT 
WHEN YOU SPECIFY A MICROSOFT 

ONEDRIVE LOCATION AS YOUR PRIMARY 
DESTINATION. A RECOVERY POINT THAT IS 
LARGER THAN 10 GB IS AUTOMATICALLY 

SPLIT INTO SMALLER FILES OF LESS THAN 
10 GB. YOU CAN SPLIT THE SIZE OF THE 

RECOVERY POINT INTO SMALLER 
RECOVERY POINTS.

not automatically truncate the transaction logs 
following a backup.

Note: This option does not appear if you 
create a recovery point using theBack Up My 
Computerwizard feature in Veritas System 
Recovery Disk.

In the Security Optionspanel, set the password, select the level of encryption for the one-time 

backup, and then clickNext.

USE PASSWORD SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

Password Lets you specify a password for the backup. 
Passwords can include standard characters. 
Passwords cannot include extended 
characters, or symbols. (Use characters with 
an ASCII value of 128 or lower.)

You must type this password before you 
restore a backup or view the contents of the 
recovery point.

Confirm password Lets you retype the password for
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USE PASSWORD SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

confirmation.

AES encryption Encrypts recovery point data to add another 
level of protection to your recovery points.

If

you upgrade from a previous version to 
Veritas System Recovery 23, for older 
backup jobs where only

password protection is defined, you need to 
edit the jobs to select the AES

encryption level. If you do not edit the older 
backup jobs, they continue to run

without AES Encryption. Veritas 
recommends that you edit the job and select 
AES

encryption level.

Note: If theUse Passwordcheck box is 
selected, you must define AES encryption.

Choose from the following encryption levels:

- Standard 128-bit (8+ character password)

- Medium 192-bit (16+ character password)

- High 256-bit (32+ character password)

If appropriate, in the lists, select the command files that you want to run during a particular 

stage in the recovery point creation process. Then, specify the amount of time (in seconds) that 

you want the command to run before it is stopped.
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If you added the command file to the Command Files folder, you may need to click Back, and 

thenNext to see the files in each stage's list.

COMMAND FILES FOLDER LETS YOU SPECIFY THE LOCATION OF 
COMMAND FILES. YOU CAN ALSO SPECIFY 

A LOCATION ON A PER-JOB BASIS, AS 
WELL AS SPECIFY A LOCATION THAT CAN 

BE SHARED AMONG SEVERAL 
COMPUTERS. IF YOU SPECIFY A NETWORK 

LOCATION, YOU ARE PROMPTED FOR 
NETWORK CREDENTIALS.

Browse Lets you browse to locate a folder for any 
command files that you want to use.

User name Lets you specify the user name to a command 
file folder that is located in a network path.

Password Lets you specify the password to a command 
file folder that is located in a network path.

Run before snapshot creation Indicates that you can run a command file after 
a backup has started and before a recovery 
point is created. You can run a command 
during this stage to prepare for the recovery 
point creation process. For example, you can 
close any open applications that are using the 
drive.

Note: If you use this option, be sure that the 
command file has an error recovery 
mechanism that is built into it. If the computer 
has one or more services that must be stopped 
at this stage, and the command file does not 
contain any form of error recovery, one or more 
of the stopped services may not be restarted. 
For example, stopping a non-VSS aware 
database or a resource-intensive application. 
An error in the command file can cause the 
recovery point creation process to stop 
immediately. No other command files can run.

See How to use Veritas System Recovery .
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COMMAND FILES FOLDER LETS YOU SPECIFY THE LOCATION OF 
COMMAND FILES. YOU CAN ALSO SPECIFY 

A LOCATION ON A PER-JOB BASIS, AS 
WELL AS SPECIFY A LOCATION THAT CAN 

BE SHARED AMONG SEVERAL 
COMPUTERS. IF YOU SPECIFY A NETWORK 

LOCATION, YOU ARE PROMPTED FOR 
NETWORK CREDENTIALS.

Run after snapshot creation Indicates that you can run a command file after 
a snapshot is created. Running a command 
during this stage is a safe point to allow 
services to resume on the drive while 
continuing the recovery point creation.

Because the snapshot takes only a few 
seconds to create, the database is in the 
backup state momentarily. A minimal number 
of log files are created.

Run after recovery point creation Indicates that you can run a command file after 
the recovery point file is created. You can run a 
command during this stage to act on the 
recovery point itself. For example, you can 
copy it to an offline location.

Timeout (applies to each stage) Lets you specify the amount of time (in 
seconds) that a command file is allowed to run.

Click Next.

Click Finish to run the backup.

More Information

Compression levels for recovery points

Running a backup from Veritas System Recovery Disk
Using a valid license key, you can create independent recovery points using the Back Up My 

Computer feature in Veritas System Recovery Disk. You can create recovery points of a partition 

without the need to install Veritas System Recovery or its agent. This feature is sometimes known 

as a cold backup or offline backup.
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•

•

•

•

•

•

With a cold backup, all files are closed when the backup occurs. You do not copy any data that 

may be in the middle of being updated or accessed on the desktop or server. Cold backups are 

particularly useful for databases. They ensure that no files are written to or accessed at any time 

during the backup so you have a complete recovery point.

You can also use the Veritas System Recovery Disk to create recovery points if you experience 

any of the following:

A level of corruption prevents you from starting Windows on the computer.

Veritas System Recovery does not function properly while it runs on a Windows operating 

system.

You want to back up the condition of a damaged system before you recover. For example, if a 

computer is severely damaged, you can use the Veritas System Recovery Disk. You can back 

up what remains of the system. Then, you can recover what you can later, after you restore an 

independent recovery point.

“ ”
Note: Recovery points that you create using Veritas System Recovery Disk are restored to 

dissimilar hardware using Restore Anyware.

“ ”
When you want to create a backup fromVeritas System Recovery Disk , you are prompted for a 

valid license key only for the following scenarios:

You create a Veritas System Recovery Disk using the Prompt me for a license file to use the 

Backup My Feature option. The computer does not have Veritas System Recovery installed.

You create a custom Veritas System Recovery Disk on a computer that has an unlicensed 

installation (60-day trial) of Veritas System Recovery. You then use the custom Veritas System 

Recovery Disk to create a backup of a computer. The computer does not have an installation of 

Veritas System Recovery.

See Customizing an existing Veritas System Recovery Disk.

You choose not to add a license key at the time you create the customized Veritas System 

Recovery Disk.

To run a one-time backup from Veritas System Recovery Disk
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If you intend to store the resulting recovery point on a USB device (for example, an external 

hard drive), attach the device now.

Start the Veritas System Recovery Disk on the computer you want to back up.

See Booting a computer by using the Veritas System Recovery Disk.

On the Home panel, click Back Up My Computer, and then clickNext.

On the Welcome panel, click Next.

If you are prompted, on the Specify License File panel, browse to provide a valid license file, 

and then click Next.

On the Drives panel, select one or more drives that you want to back up, and then click Next.

“ ”
Note: Veritas System Recovery 23 is able to display the drives from a GPT disk even if one of 

the GPT headers is corrupted or if there is a disk signature collision.

“ ”
On the Backup Destination panel, set the options you want, then click Next.

FOLDER LETS YOU BROWSE TO AND SPECIFY THE 
LOCATION WHERE YOU WANT TO STORE 

THE INDEPENDENT RECOVERY POINT.

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

Map a network drive Maps a network drive by using the UNC path 
of the computer on which you want to store 
the recovery point.
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FOLDER LETS YOU BROWSE TO AND SPECIFY THE 
LOCATION WHERE YOU WANT TO STORE 

THE INDEPENDENT RECOVERY POINT.

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

For example, \\computer_name\share_name 
or \\IP_address\share_name.

Browse Lets you browse to locate a backup 
destination that you want to use.

Select the Show hidden drives check box to 
see a list of the hidden drives along with the 
list of the other drives.

You can select a hidden drive as a location 
where you want to store the recovery points.

The hidden drives are displayed in the 
following format:

DiskNo-PartitionNo\

For example, a hidden drive is displayed as: 
2-3\. Where 2 is the disk number and 3 is the 
partition number.

Note: By default, this check box is not 
selected.

OpenStorage Destination Lets you select a cloud storage destination 
that you want to use for backups.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

170

6.

FOLDER LETS YOU BROWSE TO AND SPECIFY THE 
LOCATION WHERE YOU WANT TO STORE 

THE INDEPENDENT RECOVERY POINT.

YOU CAN SPECIFY A HIDDEN DRIVE AS A 
LOCATION WHERE YOU WANT TO STORE 

THE RECOVERY POINTS IN THE 
FOLLOWING FORMAT:

DISKNO-PARTITIONNO\

FOR EXAMPLE, IF 2 IS THE DISK NUMBER 
AND 3 IS THE PARTITION NUMBER, YOU 
MUST SPECIFY 2-3\ AS THE LOCATION.

See OpenStorage destination options for 
backups .

Destination Details Displays the type of destination path. If you 
add a network path it also displays the user 
name.

Recovery point file name Lets you edit the recovery point file name.

Rename Lets you rename the recovery point file 
name.

Default file names include the name of the 
computer and then followed by the drive 
letter.

On the Options panel, set the desired backup options and advanced options for the recovery 

point.
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COMPRESSION LETS YOU SET ONE OF THE FOLLOWING 
COMPRESSION LEVELS FOR THE 

RECOVERY POINT\:

- NONE

- STANDARD

- MEDIUM

- HIGH

SEE COMPRESSION LEVELS FOR 
RECOVERY POINTS .

THE RESULTS CAN VARY DEPENDING ON 
THE TYPES OF FILES THAT ARE SAVED IN 

THE DRIVE.

Security Options > Use password Sets a password and enables AES 
encryption on the recovery point when it is 
created.

This option is selected by default.

Security Options > Password Lets you specify a password for the backup. 
Passwords can include standard characters. 
Passwords cannot include extended 
characters, or symbols. (Use characters with 
an ASCII value of 128 or lower.)

You must type this password before you 
restore a backup or view the contents of the 
recovery point.

Security Options > Confirm Password Lets you retype the password for

confirmation.

Security Options > AES encryption Encrypts recovery point data to add another 
level of protection to your recovery points.

If
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COMPRESSION LETS YOU SET ONE OF THE FOLLOWING 
COMPRESSION LEVELS FOR THE 

RECOVERY POINT\:

- NONE

- STANDARD

- MEDIUM

- HIGH

SEE COMPRESSION LEVELS FOR 
RECOVERY POINTS .

THE RESULTS CAN VARY DEPENDING ON 
THE TYPES OF FILES THAT ARE SAVED IN 

THE DRIVE.

you upgrade from a previous version to 
Veritas System Recovery 23, for older 
backup jobs where only

password protection is defined, you need to 
edit the jobs to select the AES

encryption level. If you do not edit the older 
backup jobs, they continue to run

without AES Encryption. Veritas 
recommends that you edit the job and select 
AES

encryption level.

Note: If theUse Passwordcheck box is 
selected, you must define AES encryption.

Choose from the following encryption levels:

- Standard 128-bit (8+ character password)

- Medium 192-bit (16+ character password)

- High 256-bit (32+ character password)
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COMPRESSION LETS YOU SET ONE OF THE FOLLOWING 
COMPRESSION LEVELS FOR THE 

RECOVERY POINT\:

- NONE

- STANDARD

- MEDIUM

- HIGH

SEE COMPRESSION LEVELS FOR 
RECOVERY POINTS .

THE RESULTS CAN VARY DEPENDING ON 
THE TYPES OF FILES THAT ARE SAVED IN 

THE DRIVE.

Verify recovery point after creation Tests whether a recovery point or set of files 
is valid or corrupt.

Description Indicates a description for the recovery point. 
The description can help you further identify 
the recovery point's contents.

Advanced Lets you further add security options to the 
recovery point.

On the Options panel, click Advanced.

On the Advanced options panel, set the advanced backup options you want for the recovery 

point, and then click OK.

DIVIDE INTO SMALLER FILES TO 
SIMPLIFY ARCHIVING

LETS YOU SPLIT THE RECOVERY POINT 
INTO SMALLER FILES AND SPECIFY THE 
MAXIMUM SIZE (IN MB) FOR EACH FILE.

Disable SmartSector™ Copying Lets you copy used and unused hard-disk 
sectors. This option increases process time 
and usually results in a larger recovery point.

SmartSector technology speeds up the 
copying process by copying only the hard-
disk sectors that contain data. However, in 
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DIVIDE INTO SMALLER FILES TO 
SIMPLIFY ARCHIVING

LETS YOU SPLIT THE RECOVERY POINT 
INTO SMALLER FILES AND SPECIFY THE 
MAXIMUM SIZE (IN MB) FOR EACH FILE.

some cases, you might want to copy all 
sectors in their original layout, whether or not 
they contain data.

Ignore bad sectors during copy Lets you run a backup even if there are bad 
sectors on the hard disk. Although most 
drives do not have bad sectors, the potential 
for problems increases during the lifetime of 
the hard disk.

On the Options panel, click Next.

On the Completing the Back Up My Computer Wizard panel, click Finish to run the backup.

When the backup is finished, click Close to return to the main Veritas System Recovery Disk 

window.

How Offsite Copy works
Backing up your data to a secondary hard disk is a critical first step to protecting your information 

assets. But to make certain your data is safe, use Offsite Copy. You enable and configure Offsite 

Copy when you define a new drive-based backup job. Or you can edit an existing backup job to 

enable Offsite Copy.

This feature can copy your latest complete recovery points to the following:

A portable storage device.

A remote server in your network.

A remote FTP server.

An Amazon S3 storage

See How Offsite Copy works for cloud storage.

A Microsoft Azure storage

See How Offsite Copy works for cloud storage.

An S3-Compatible or Veritas Access storage
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See Using S3-Compatible or Veritas Access as your offsite copy destination.

Regardless of the method you use, storing copies of your recovery points at a remote location 

provides a crucial level of redundancy if your office becomes inaccessible. Offsite Copy can double 

your data protection by ensuring that you have a remote copy.

When you enable Offsite Copy, you specify up to two offsite copy destinations. After the backup job 

finishes creating recovery points, Offsite Copy verifies that at least one of the offsite copy 

destinations is available. Offsite Copy then begins copying the new recovery points to the offsite 

copy destination.

The most recent recovery points are copied first, followed by the next newest recovery points. If 

you have set up two offsite copy destinations, Offsite Copy copies recovery points to the 

destination that was added first. If an offsite copy destination is unavailable, Offsite Copy tries to 

copy recovery points to the second destination, if it is available. If neither destination is available, 

then Offsite Copy copies the recovery points the next time an offsite copy destination becomes 

available.

For example, suppose you have configured a backup job to run at 6:00 P.M. and configured an 

external drive as an offsite copy destination. However, when you leave the office at 5:30 P.M., you 

take the drive with you for safekeeping. When the backup job completes at 6:20 P.M., Veritas 

System Recovery detects that the offsite copy destination drive is not available and the copy 

process is aborted. The following morning, you plug the drive back in to the computer. Veritas 

System Recovery detects the presence of the offsite copy destination drive and automatically 

begins copying your recovery points.

Offsite Copy is designed to use very few system resources so that the copying process is done in 

the background. This feature lets you continue to work at your computer with little or no effect on 

system resources.

If an offsite copy destination runs out of disk space, Offsite Copy identifies the oldest recovery 

points and removes them to accommodate the most current recovery points. Offsite Copy then 

copies the current recovery points to the offsite copy destination.

See Defining a drive-based backup.

See Editing backup settings.

Using external drives as your Offsite Copy destination
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You can use an external drive as your offsite copy destination. This method lets you take a copy of 

your data with you when you leave the office. By using two external hard disks, you can be certain 

that you have a recent copy of your data both on site and off site.

For example, suppose on a Monday morning you define a new backup job of your system drive. 

You choose a recovery point set as your backup job type. You set up an external drive (A) as the 

first offsite copy destination, and another external drive (B) as the second offsite copy destination. 

You schedule the backup job to run every midnight except on the weekends. You also enable 

recovery point encryption to protect the data from unauthorized access.

Before you leave the office on Monday evening, you plug in drive A and take drive B home with 

you.

On Tuesday morning, you find that Monday's base recovery point has been successfully copied to 

drive A. At the end of the day, you unplug drive A and take it home for safekeeping.

On Wednesday morning, you bring drive B to the office. You plug in drive B and Veritas System 

Recovery detects that drive B is an offsite copy destination. Veritas System Recovery then 

automatically begins copying Monday night's base recovery point and Tuesday night's incremental 

recovery point. At the end of the day Wednesday, you take drive B home and place it in a safe 

place with drive A.

You now have multiple copies of recovery points stored at two separate, physical locations; your 

original recovery points stored on your backup destinations at the office, and copies of those same 

recovery points stored on your offsite copy destination drives. Your offsite copy destination drives 

are stored in a safe place at your home.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

177

The next morning, Thursday, you take drive A to the office and plug it in. Tuesday and Wednesday 

night's recovery points are then automatically copied to drive A.

“ ”
Note: Consider using the external drive naming feature that lets you provide a unique name to 

each drive. Then place matching physical labels on each external drive to help you manage the 

task of swapping the drives.

“ ”
See Removing or changing the unique name for an external drive.

Each time you plug in either drive A or B, the latest recovery points are added to the drive. This 

method gives you multiple points in time for recovering your computer in the event that the original 

backup destination drives fail or become unrecoverable.

Using external drives as your offsite copy destination ensures that you have a copy of your backup 

data stored at two separate, physical locations.

Using a network server as your Offsite Copy destination

You can specify a local area network server as an offsite copy destination. You must be able to 

access the server that you plan to use. You must either map a local drive to the server, or provide a 

valid UNC path.

For example, suppose that you set up a local external drive as your first offsite copy destination. 

Then you identify a server that is located at a second physical location from your own office. You 

add the remote server as a second offsite copy destination. As backups occur, recovery points are 

copied first to the external hard drive, and then to the remote server.

If the remote server becomes unavailable for a period of time, Offsite Copy copies all recovery 

points that were created since the last connection. If there is no room to hold all of the recovery 

points that are available, Offsite Copy removes the oldest recovery points from the network server. 

In turn, it makes room for the newest recovery points.
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Using an FTP server as your Offsite Copy destination

Using an FTP server as your offsite copy destination is similar to using a network path. You must 

provide a valid FTP path to the FTP server.

You must also provide the correct FTP connection information to Veritas System Recovery for this 

method to work correctly. When Offsite Copy is configured correctly, it copies recovery points to the 

directory that you specified on the FTP server. If the server becomes unavailable for a period of 

time, Offsite Copy copies all recovery points that were created since the last connection. If there is 

no room to hold all of the recovery points that are available, Offsite Copy removes the oldest 

recovery points or recovery point sets from the FTP server. In turn, it makes room for the newest 

recovery points.

See Configuring default FTP settings for use with Offsite Copy.
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Backing up files and folders

This section includes the following topics:

Backing up files and folders

Backing up files and folders
You can back up specific files and folders you want to protect. When you run this type of backup, 

copies are made of the files and folders you chose to back up. The files are converted into a 

compressed format. They are then stored in a subfolder at the location you specify. By default this 

location is the same backup destination that is used for storing recovery points.

The following folders and their contents are excluded by default from file and folder backups:

Windows folder

Program files folder

Temporary folder

Temporary Internet Files folder

These folders are typically not used for storing personal files or folders. The folders are backed up 

when you define and run a drive-based backup of your system drive (typically C).

If you want, you can choose to include these folders when you define the backup.

“ ”
Note: The file and folder backup is intended for less than 10,000 files. If the data to be backed up 

exceeds this amount, Veritas strongly recommends to use the drive-based backup. SeeDefining a 

drive-based backup.

“ ”
To back up files and folders

On the Tasks menu, click Run or Manage Backups.
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In the Run or Manage Backups window, click Define New.

If you have not yet defined a backup, the Easy Setup dialog box appears.

Select Back up selected files and folders, and then clickNext.

On the Select Files and Folders to Back Up panel, select the files and folders that you want to 

include in your backup.

Select Files and Folders to Back Up options

SELECT ALL SELECTS ALL CHECK BOXES IN THE TYPES 
AND FOLDERS COLUMN. SELECTED DATA 

TYPES AND FOLDERS ARE BACKED UP.

Select None Deselects all check boxes in the Types and 
Folders column. Deselected data types and 
folders are not backed up.

Add Folder Lets you specify additional folders to back up.

Add File Lets you specify additional files to back up.

Add File Type Lets you specify additional data file types to 
back up.

Edit Lets you edit the options, settings, or 
properties for a selected data type name or 
folder name in the tables list.

Remove Lets you remove from the tables list a selected 
data type name or folder name that you have 
added.

Default data types and folders are not 
removable from the tables list.

Add Folder options

FOLDER TO BACK UP LETS YOU SPECIFY THE PATH TO A FOLDER 
THAT YOU WANT TO BACK UP.

Browse Lets you browse to a path that contains a 
folder that you want to back up.
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FOLDER TO BACK UP LETS YOU SPECIFY THE PATH TO A FOLDER 
THAT YOU WANT TO BACK UP.

Subfolders Indicates that you want to back up all 
subfolders under the parent folder.

All files Indicates that you want to back up all files in all 
subfolders.

Only files of type Lets you specify the data file types that you 
want to back up.

Add File Type options

NAME SPECIFIES THE NAME OF A DATA FILE TYPE 
AND FOLDER. THE NAME IS ADDED TO THE 

TABLE LIST IN THE SELECT FILES AND 
FOLDER TO BACK UP PANEL.

Add an extension Adds a specific data type file extension that 
you want to back up.

Remove an extension Deletes a specific data type file extension from 
the list.

Rename an extension Renames a specific data type file extension 
that you added to the list.

Restore default extension list Restores the default file extensions that were 
added to the predefined list of types and 
folders in the Select Files and Folder to Back 
Up panel.

“ ”
Note: On all versions of Windows, the My Documents folder contains two subfolders by default: My 

Pictures and My Music. These folders contain only the shortcuts to folders at another location and 

not the actual files. If you intend to back up your pictures and music files, be sure to include the 

actual folders where your files are stored.
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“ ”
Click Next.

In the Name and Destination panel, enter a backup name and destination, and then click Next.

NAME INDICATES THE NAME FOR THE NEW 
BACKUP.

Description (optional) Lets you type a description for the new 
backup.

Advanced Adds the security options to the recovery 
point.

Backup destination Indicates the default backup location. Or, you 
can specify your own local or network path 
for the recovery point files.

Veritas recommends that you create 
permissions for the backup destination to 
prevent unauthorized access to any data 
contained in the

recovery points.

For more information, refer to the following 
link:

https://technet.microsoft.com/en-us/library/
cc732880(v=ws.11).aspx

Browse Lets you browse to locate a folder for storing 
your backup data.

You cannot use an encrypted folder as your 
backup destination. If you want to encrypt 
your backup data to prevent another user 
from accessing it, you can use the Advanced 
option.

User name Specifies the user name if you back up to a 
folder that is located in a network path.

https://technet.microsoft.com/en-us/library/cc732880(v=ws.11).aspx
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NAME INDICATES THE NAME FOR THE NEW 
BACKUP.

Password Specifies the password to a network path.

Advanced Options for a file and folder backup

EXCLUDE LETS YOU DESELECT ANY OF THE 
FOLLOWING FOLDERS THAT YOU DO NOT 

WANT TO INCLUDE IN THE BACKUP\:

- WINDOWS FOLDER

- PROGRAM FILES FOLDER

- TEMPORARY FOLDER

- TEMPORARY INTERNET FILES FOLDER

- SAVE BACKUP FILES TO A UNIQUE 
SUBFOLDER

THE FOLDERS THAT ARE LISTED ARE 
TYPICALLY NOT USED FOR STORING 

PERSONAL FILES OR FOLDERS. 
THEREFORE, THEY ARE ALL SELECTED 
FOR BACKUP EXCLUSION BY DEFAULT. 

THESE FOLDERS ARE BACKED UP WHEN 
YOU DEFINE AND RUN A DRIVE-BASED 

BACKUP OF YOUR SYSTEM DRIVE 
(TYPICALLY C).

SEE DEFINING A DRIVE-BASED BACKUP .

Click Next

In the Backup Time panel, select the scheduling options you want.

“ ”
Note: Ensure that the time for running a base backup and an incremental backup is not the 

same.
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“ ”
Backup Time options

SCHEDULE INDICATES WHETHER A SCHEDULE IS 
ENABLED FOR THE BACKUP .

Default Lets you use the default backup schedule.

Start time Specifies the start time of the backup.

Sun Mon Tue Wed Thu Fri Sat Lets you select the days of the week that you 
want the backup to run.

Advanced Runs the backup more than once per day at a 
set number of times. You can also specify the 
amount of time that should lapse between 
backups.

Select event triggers Lets you select the types of events that 
automatically start a backup.

Change Schedule - File Backup Scheduling options

SCHEDULE LETS YOU SELECT THE DAYS AND A START 
TIME FOR WHEN YOU WANT TO BACK UP 

FILES AND FOLDERS.

Run more than once per day Runs the backup more than once a day to 
protect the data that you edit or change 
frequently.

Time between backups Specifies the maximum time that should occur 
between file and folder backups.

Number of times Specifies the number of times per day file and 
folder backups should run.

Change Schedule - File Backup event trigger options
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GENERAL LETS YOU SELECT THE TYPES OF EVENTS 
THAT AUTOMATICALLY START A BACKUP, 
SUCH AS WHEN YOU LOG OFF FROM THE 

COMPUTER.

In the Security Options panel, set the password, select the encryption for the file and folder 

backup, and then click Next.

USE PASSWORD SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

Password Lets you specify a password for the backup. 
Passwords can include standard characters. 
Passwords cannot include extended 
characters, or symbols. (Use characters with 
an ASCII value of 128 or lower.)

You must type this password before you 
restore a backup or view the contents of the 
recovery point.

Confirm password Lets you retype the password for 
confirmation.

AES encryption Encrypts recovery point data to add another 
level of protection to your recovery points.

If

you upgrade from a previous version to 
Veritas System Recovery 23, for older 
backup jobs where only

password protection is defined, you need to 
edit the jobs to select the AES

encryption level. If you do not edit the older 
backup jobs, they continue to run
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USE PASSWORD SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

without AES Encryption. Veritas 
recommends that you edit the job and select 
AES

encryption level.

Note: If theUse Passwordcheck box is 
selected, you must define AES encryption.

Choose from the following encryption levels:

- Standard 128-bit (8+ character password)

- Medium 192-bit (16+ character password)

- High 256-bit (32+ character password)

See Recovery point encryption .

In the Completing the Define Backup Wizard panel, review the backup options you have 

selected.

To review the total number and size of files to be included in the backup, click Preview.

“ ”
Note: Depending on the amount of data you have identified for file and folder backup, the 

preview process can take several minutes.

“ ”
If you want to run the backup immediately, click Run backup now, then clickFinish.
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Running and managing backup jobs

This section includes the following topics:

Running an existing backup job immediately

Adjusting the speed of a backup

Stopping a backup or a recovery task

Verifying that a backup is successful

Viewing the properties of a backup job

Editing backup settings

Enabling event-triggered backups

Editing a backup schedule

Disabling or enabling a backup job

Deleting backup jobs

Adding users who can back up your computer

Configuring access rights for users or groups

Running an existing backup job immediately
If you have a backup job already defined, you can use Run Backup Now to make a recovery point 

immediately. This feature is sometimes useful if you are about to install a software program. Or, 

maybe you have modified a large number of files and you do not want to wait for a regularly 

scheduled backup.

You can run an existing backup job at any time.

To run an existing backup immediately from the notification area

On the Windows desktop, right-click the Veritas System Recovery notification area icon.

Click Run Backup Now.

Click a backup job to start the backup.

If the menu displays No Jobs, you must start Veritas System Recovery and define a backup.

To run an existing backup immediately from within Veritas System Recovery
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On the Tasks menu, click Run or Manage Backups.

Select a backup from the list, and then click Run Now.

See Running a one-time backup from Veritas System Recovery.

See Enabling event-triggered backups.

See Editing a backup schedule.

Running a backup to create an alternate type of recovery point
You can use Run Backup With Options to run an existing drive-based backup but create an 

alternate type of recovery point.

“ ”
Note: Using this option does not change the original settings of the defined backup. To do that, you 

must open the backup and edit its settings manually.

“ ”
To run a backup with options

On the Tasks menu, click Run or Manage Backups.

In the Run or Manage Backups window, select the drive-based backup job that you want to run.

On the Tasks menu, click Run Backup With Options.

On the Run Backup With Options panel, select the appropriate options.

“ ”
Note: Depending on the current state of the backup, one or more options might be disabled. 

For example, if you have not yet run the backup, you cannot selectIncremental recovery point 

of recent changesbecause the base recovery point is not yet created.

“ ”
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5.

INCREMENTAL RECOVERY POINT OF 
RECENT CHANGES

CREATES A BACKUP THAT INCLUDES THE 
CHANGES THAT WERE MADE TO THE 

DRIVE SINCE THE LAST BACKUP. THIS 
OPTION IS AVAILABLE ONLY IF A BASE 

RECOVERY POINT EXISTS.

New recovery point set Starts a completely new recovery point set 
and creates a base recovery point.

Independent recovery point Creates an independent recovery point, 
which is a complete snapshot of your entire 
drive. After you select this option, you must 
enter a backup location.

Folder Indicates the location where you want to 
store the recovery point.

Browse Lets you browse to locate a backup 
destination that you want to use.

Browse for OpenStorage Destination Lets you browse to select a cloud storage 
destination that you want to use for backups.

See OpenStorage destination options for 
backups .

Description Details Displays the type of destination path. If you 
add a network path it also displays the user 
name.

Edit Lets you enter the user name and password 
for access to the network that is specified in 
the Folder field. This option is available only 
if you selected a backup destination that is 
on a network. Or, if you want to save the 
recovery point on a network share.

See Rules for network credentials .

Click OK to run the backup job and create the recovery point type you selected.

More Information

Editing a backup schedule
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Editing backup settings

Adjusting the speed of a backup
Depending on your computer's speed, amount of installed RAM, and the number of programs you 

run during a backup, your computer can become sluggish.

You can manually adjust the effect of a backup on the performance of your computer to match your 

needs at the moment. This feature is useful while you work on your computer and do not want the 

backup process to slow you down.

To adjust the speed of a backup

While a backup is running, on the View menu, click Progress and Performance.

Do one of the following:

If you want to increase the speed of your computer by reducing the speed of the backup, 

drag the slider toward Slow.

If you want the backup to complete quickly, and you have minimal work to do on your 

computer, drag the slider toward Fast.

When you are finished, click Hide to dismiss the Progress and Performance dialog box.

See Defining a drive-based backup.

More Information

Editing backup settings

Stopping a backup or a recovery task
You can stop a backup or a recovery task that has already started.

To stop a backup or a recovery task

Do one of the following:

If the Progress and Performance dialog box is displayed, click Cancel Operation.

If the Progress and Performance dialog box is hidden, on the View menu, click Progress 

and Performance, and then clickCancel Operation.

If the Progress and Performance dialog box is hidden, on the Windows system tray, right-

click the Veritas System Recovery tray icon. Click Cancel Current Operation.
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See Defining a drive-based backup.

More Information

Editing backup settings

Verifying that a backup is successful
After a backup completes, you can validate the success of the backup to ensure that you have a 

way to recover lost or damaged data.

The Status page contains a scrolling calendar that is aligned with each drive on your computer. 

The calendar lets you quickly identify when a backup ran, and what type of backup it was. It also 

identifies upcoming, scheduled backups.

See Icons on the Status page.

“ ”
Note: When you define a drive-based backup, you should select the option to verify the recovery 

point after it is created. Depending on the amount of data being backed up, this verification can 

significantly increase the time it takes to complete the backup. However, it can ensure that you 

have a valid recovery point when the backup finishes.

“ ”
See Verifying the integrity of a recovery point.

To verify that a backup is successful

On the Status page, review the Backups calendar, and verify that the backup appears on the 

date that you ran it.

Move your mouse over a backup icon to review the status of the backup.

See Defining a drive-based backup.

More Information

Editing backup settings
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Viewing the properties of a backup job
You can review the settings and configuration of a defined backup without opening the backup job.

To view the properties of a backup job

On the Home page, click Run or Manage Backups.

In the Run or Manage Backups window, select a backup job and then click Tasks > 

Properties.

See Running an existing backup job immediately.

See Running a backup to create an alternate type of recovery point.

See Editing backup settings.

Editing backup settings
You can edit the settings of an existing backup. The Edit Settings feature gives you access to 

several of the key pages of the Define Backup Wizard. You can edit every setting except the option 

to change the recovery point type.

To edit backup settings

On the Tasks menu, click Run or Manage Backups.

Select a backup to edit.

On the Run or Manage Backups toolbar, click Edit Settings.

Make changes to the backup.

See Defining a drive-based backup.

See Enabling event-triggered backups.

Enabling event-triggered backups
Veritas System Recovery can detect certain events and run a backup when they occur.

For example, when you install new software, a backup can run when it detects that new software is 

about to be installed. If a problem occurs that harms your computer, you can use this recovery 

point to restore your computer to its previous state.
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You can configure Veritas System Recovery to automatically run a backup when the following 

events occur:

Any application is installed or uninstalled.

A specified application is started.

Any user logs on or off of the computer.

The data that was added to a drive exceeds a specified number of megabytes.

This option is unavailable for backing up files and folders.

To enable event-triggered backups

On the Tasks menu, click Run or Manage Backups.

Select the backup you want to edit, and then click Change Schedule.

Under Event Triggers, click General.

Select the events you want to be detected.

Event Triggers - General options

ANY APPLICATION IS INSTALLED OR 
UNINSTALL

CREATES A BACKUP AT THE TIME YOU 
INITIATE AN INSTALL OR UNINSTALL OF A 

SOFTWARE APPLICATION.

Specific applications are launched Creates a backup when you start a software 
application.

Application Lets you specify the software applications that 
can trigger a backup when you start them.

Any user logs on to the computer Creates a backup when a user logs on to the 
computer.

Any user logs off to the computer Creates a backup when a user logs off from 
the computer.

Data added to the drive exceeds Creates a backup when the amount of data 
that is added to the hard disk exceeds a 
specified number of megabytes.

Trigger Application options
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APPLICATION IDENTIFIES THE NAME OF THE SOFTWARE 
APPLICATION'S EXECUTABLE FILE 

(.EXE, .COM).

Browse Lets you browse to a software application.

Applications that trigger a backup Lists the software applications that can trigger 
a backup when you start them.

Add Adds the software application to the list box.

Remove Removes the software application from the list 
box.

Click OK.

See Defining a drive-based backup.

More Information

Editing backup settings

Editing a backup schedule
You can edit any of the schedule properties for a defined backup to adjust the date and time.

To edit a backup schedule

On the Tasks menu, click Run or Manage Backups.

Select a backup to edit.

On the toolbar, click Change Schedule.

Make changes to the schedule.

Backup Time options for a recovery point set

SCHEDULE RUNS THE BACKUP AUTOMATICALLY 
ACCORDING TO A SPECIFIED START TIME 
AND THE SELECTED DAYS OF THE WEEK.

Default Lets you use the default backup time schedule.
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SCHEDULE RUNS THE BACKUP AUTOMATICALLY 
ACCORDING TO A SPECIFIED START TIME 
AND THE SELECTED DAYS OF THE WEEK.

Advanced Sets advanced scheduling options, such as 
setting up event triggers that start the backup 
in response to specific events.

Run more than once per day Sets the time between backups and the 
number of times to back up.

Start a new recovery point set (base) Starts a new recovery point set (base) weekly, 
monthly, quarterly, or yearly.

Custom (Optional) Indicates how frequently a new 
recovery point set should be started.

For example, if you select Monthly , a new 
base recovery point is created the first time the 
backup runs during each new month.

Select event triggers Lets you select events that automatically 
create a recovery point.

Details Shows you information about the backup time 
option you have selected or specified.

Backup Time options for an independent recovery point

NO SCHEDULE RUNS THE BACKUP ONLY WHEN YOU RUN 
IT YOURSELF, MANUALLY.

Weekly Runs the backup at the time and on the days 
of the week that you specify.

When you select this option, the Select the 
days of the week to protect dialog box 
appears.

Monthly Runs the backup at the time and on the days 
of the month that you specify.
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NO SCHEDULE RUNS THE BACKUP ONLY WHEN YOU RUN 
IT YOURSELF, MANUALLY.

When you select this option, the Select the 
days of the month to protect dialog box 
appears.

Only run once Runs the backup one time on the date and at 
the time you specify.

When you select this option, the Create a 
single recovery point dialog box appears.

Details Indicates information about the backup time 
option you have selected or specified.

Click OK.

See Enabling event-triggered backups.

Disabling or enabling a backup job
You can turn off a backup and turn it on later. When you turn off a backup, it does not run according 

to its defined schedule, if it has one. When a backup is turned off, triggered events do not run the 

backup, nor can you manually run the backup.

You can also delete a defined backup (not recovery points).

To turn off a backup job

On the Tasks menu, click Run or Manage Backups.

Select the backup that you want to turn off.

On the Run or Manager Backups dialog box, on the Tasks menu, click Disable Backup.

Repeat this procedure to turn on the backup. The Disable Backup menu item changes to Enable 

Backup when you disable the selected backup.

See Deleting backup jobs.

Deleting backup jobs
You can delete backup jobs when they are no longer needed.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

197

1.

2.

3.

4.

1.

2.

3.

4.

Deleting a backup job does not delete the recovery points or backed up file and folder data from 

the storage location. Only the backup job is deleted.

To delete backup jobs

On the Tasks menu, click Run or Manage Backups.

Select one or more backup names.

On the toolbar, click Remove.

Click Yes.

See About backup destinations.

Adding users who can back up your computer
You can use the Security Configuration Tool to control which users on your computer can access 

and configure key features of Veritas System Recovery.

For example, all users with Limited Windows accounts can run existing backup jobs, but they 

cannot create new jobs or edit existing jobs. Using the Security Configuration Tool, you can grant 

administrative privileges to a Limited user account. When you do, that user has full access to 

Veritas System Recovery and can create, edit, delete, and run backup jobs.

“ ”
Note: By default, all users can run existing backup jobs. But only users with administrative 

accounts can create, edit, or delete backup jobs.

“ ”
To add or users who can back up a computer

On the Windows taskbar, click Start > Programs > Veritas System Recovery > Security 

Configuration Tool.

Click Add.

In Enter the object names to select field, type the names of the users or groups you want to 

add.

Click OK.
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Click OK to apply your changes and close the Security Configuration Tool.

See Configuring access rights for users or groups.

Configuring access rights for users or groups
You can use the Security Configuration Tool to give users or groups certain access rights to the 

features of Veritas System Recovery.

To configure access rights for users or groups

On the Windows taskbar, click Start > Programs > Veritas System Recovery > Security 

Configuration Tool.

In Group or user names, select a user or group.

Choose from the following options:

PERMISSIONS ALLOW DENY

Full Control Gives a user or a group 
access to all of the features 
of Veritas System Recovery. 
Allows a user and group to 
create, edit, and delete 
backup jobs, including 
existing jobs.

Lets the selected user or 
group run existing backup 
jobs. Prevents the selected 
user or group from creating, 
editing, or deleting backup 
jobs.

Status Only Lets the selected user or 
group run existing backup 
jobs. Prevents the selected 
user or group from creating, 
editing, or deleting backup 
jobs.

Prevents the selected user 
or group from accessing any 
of the features of Veritas 
System Recovery.

Click OK to apply your changes and close the Security Configuration Tool.

See Adding users who can back up your computer.
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Backing up remote computers from your 
computer

This section includes the following topics:

About backing up other computers from your computer

About the Veritas System Recovery Agent

About deploying the Veritas System Recovery Agent

Best practices for Veritas System Recovery services

Viewing Veritas System Recovery Agent dependencies

About controlling access to Veritas System Recovery

About backing up other computers from your computer
Veritas System Recovery lets you connect to a second computer and back it up on your home or 

your office network. You can manage as many computers as needed, but you can only manage 

one computer at a time.

“ ”
Note: You must purchase a separate license for each computer you want to manage. You can 

deploy the agent without a license for a 60-day evaluation. After that time, you must purchase and 

install the license to continue managing the remote computer. Visit the following website: http://

veritas.force.com/public

“ ”
First, you add a computer's name or IP address to the Computer List. Then, you deploy the Veritas 

System Recovery Agent to the remote computer. After the agent is installed, the computer 

automatically restarts. After the computer restarts, you can then connect to the computer. The 

Veritas System Recovery product interface changes to reflect the status of the remote computer. At 

any time, you can switch back to manage your local computer.

See Adding remote computers to the Computer List.
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See Adding local computers to the Computer List.

See Removing a computer from the Computer List.

Adding remote computers to the Computer List
Before you can back up drives on a remote computer, you must first add the computer to the 

Computer List. You can then quickly switch between your local computer and any other computer 

on the list.

To add remote computers to the Computer List

On the Computers menu, click Add.

Do one of the following:

Type the name of the computer

Type the IP address of the computer

If you are in a workgroup environment instead of a domain you must manually specify the 

computer name for the computer you want to manage. You can do so by browsing to it using the 

Browse option.

Click Browse to search for the name or IP address of the computer

Click OK to add the computer to the Computer List.

See About backing up other computers from your computer.

See Adding local computers to the Computer List.

See Removing a computer from the Computer List.

Adding local computers to the Computer List
Before you can back up drives on a local computer, you must first add the computer to the 

Computer List. You can then quickly switch between your local computer and any other computer 

on the list.

To add a local computer to the Computer List

On the Computers menu, click Add Local Computer.

Click OK.

See About backing up other computers from your computer.
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See Adding remote computers to the Computer List.

See Removing a computer from the Computer List.

Removing a computer from the Computer List
You can remove local or remote computers from the Computer List.

Removing a computer from the Computer List does not uninstall the agent from the computer. You 

must run your operating system's uninstall program instead.

To remove a computer from the Computer List

On the Computers menu, click Edit List.

Select the remote or the local computer that you want to remove, and then click the minus sign 

( - ).

Click OK

See About backing up other computers from your computer.

See Adding remote computers to the Computer List.

See Adding local computers to the Computer List.

See Removing a computer from the Computer List.

About the Veritas System Recovery Agent
The Veritas System Recovery Agent is the unseen "engine" that does the actual backing up and 

restoring of data on a remote computer. Because the Veritas System Recovery Agent functions as 

a service, it does not have a graphical user interface.

See Using the Veritas System Recovery Agent.

The Veritas System Recovery Agent does, however, have a tray icon.available from the Windows 

notification area. The icon provides feedback of current conditions and lets you perform common 

tasks. For example, you can view backup jobs, reconnect the Veritas System Recovery Agent, or 

cancel a task that is currently running.

You can install the agent manually by visiting each computer you want to protect and installing the 

agent from the product DVD. A more efficient method, however, is to use the Veritas System 



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

202

•

◦

•

•

•

•

Recovery Deploy Agent feature. You can remotely install the agent on a computer in the domain 

whose data you want to protect.

See About managing the Veritas System Recovery Agent through Windows Services.

See About controlling access to Veritas System Recovery.

Using the Veritas System Recovery Agent
You can use the Veritas System Recovery tray icon in the Windows notification area to quickly 

access a variety of useful tasks.

To use the Veritas System Recovery Agent

On the Windows notification area, do one of the following:

Right-click the Veritas System Recovery tray icon, and then click Reconnect to restart the 

service automatically.

You cannot run a backup until the service is running.

If Veritas System Recovery is installed on the computer, double-click the Veritas System 

Recovery tray icon to start the program.

If only the agent is installed, double-clicking the tray icon only displays an About dialog box.

If the computer has the software installed, right-click the Veritas System Recovery tray icon to 

display a menu of common agent tasks.

See About the Veritas System Recovery Agent.

See About managing the Veritas System Recovery Agent through Windows Services.

About managing the Veritas System Recovery Agent through Windows 
Services
The Veritas System Recovery Agent is a Windows service that runs in the background.

It provides the following:

The ability to locally run scheduled backup jobs, even when there are no or unauthorized users 

that are logged on to the computer.

The ability to allow administrators to remotely back up computers throughout an enterprise from 

Veritas System Recovery running on another computer.
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See Using the Veritas System Recovery Agent.

To use the features of Veritas System Recovery, the Veritas System Recovery Agent must be 

started and properly configured. You can use the Windows Services tool to manage and 

troubleshoot the agent.

“ ”
Note: To manage the Veritas System Recovery Agent, you must be logged on as a local 

administrator.

“ ”
You can manage the Veritas System Recovery Agent in the following ways:

Start, stop, or disable the Veritas System Recovery Agent on local and remote computers.

See Starting or stopping the Veritas System Recovery Agent service.

Configure the user name and password that the Veritas System Recovery Agent uses.

See About controlling access to Veritas System Recovery.

Set up recovery actions to take place if the Veritas System Recovery Agent fails to start.

For example, you can restart the Veritas System Recovery Agent automatically or restart the 

computer.

See Setting up recovery actions when the Veritas System Recovery Agent does not start.

About deploying the Veritas System Recovery Agent
You can deploy the Veritas System Recovery Agent to the computers that are on the Computer List 

by using the Agent Deployment feature. After you install the agent, you can create backup jobs 

directly from Veritas System Recovery.

See About backing up other computers from your computer.

If you deselected the Agent Deployment option during installation, this feature is not available. You 

can run the installation again, and select the Modify option to add this feature back in.
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Your computer must meet the minimum memory requirement to run the Recover My Computer 

wizard or the Recovery Point Browser in Veritas System Recovery Disk.

If your computers are set up in a workgroup environment, you should prepare your local computer 

before you deploy an agent.

See Preparing a computer in a workgroup environment to deploy the Veritas System Recovery 

Agent.

See Deploying the Veritas System Recovery Agent.

See Manually installing the Veritas System Recovery Agent.

Preparing a computer in a workgroup environment to deploy the Veritas 
System Recovery Agent
You must complete certain steps in Windows to prepare a computer in a workgroup environment to 

deploy the Veritas System Recovery Agent.

To prepare a computer in a workgroup environment to deploy the agent

On the Windows taskbar, right-click Start, and then clickExplore.

On the Tools menu, click Folder Options > View.

On the View tab, scroll to the end of the list and verify that the Use simple file sharingcheck 

box is not selected, and then clickOK.

On the Windows Control Panel, click Windows Firewall.

On the Exceptions tab, select File and Printer Sharing, and then clickOK.

“ ”
Note: You should close any open applications before you continue with the agent installation. If 

theRebootcheck box is selected, the computer automatically restarts at the end of the 

installation wizard.

“ ”
See About deploying the Veritas System Recovery Agent.

See Deploying the Veritas System Recovery Agent.
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See Manually installing the Veritas System Recovery Agent.

Deploying the Veritas System Recovery Agent
You can deploy the Veritas System Recovery Agent to local or to remote computers.

To deploy the Veritas System Recovery Agent

Ensure that you have completed the steps to prepare the computer to deploy the Veritas 

System Recovery agent.

See Preparing a computer in a workgroup environment to deploy the Veritas System Recovery 

Agent.

On the Veritas System Recovery menu bar, click Computers > select a computer from the 

menu.

You must have administrator rights on the computer to which you install the agent.

Click Deploy Agent.

In the Deploy Veritas System Recovery Agent dialog box, specify the administrator user name 

(or a user name that has administrator rights) and the password.

In a workgroup environment, you must specify the remote computer name. You cannot use an IP 

address, even if you have successfully connected to the computer by using an IP address.

For example, type RemoteComputerName \_UserName_

If you want to restart the computer when the agent installation is finished, click Reboot when 

finished.

“ ”
Note: The computer cannot be backed up until the computer is restarted. However, be sure to 

warn the user of the impending reboot so that they can save their work.

“ ”
Click OK.

See About deploying the Veritas System Recovery Agent.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

206

1.

1.

1.

2.

3.

4.

5.

1.

2.

See Manually installing the Veritas System Recovery Agent.

Manually installing the Veritas System Recovery Agent
You can manually install the Veritas System Recovery Agent to local or to remote computers.

To manually install the Veritas System Recovery Agent

Ensure that you have completed the steps to prepare the computer to deploy the Veritas 

System Recovery agent.

See Preparing a computer in a workgroup environment to deploy the Veritas System Recovery 

Agent.

Insert the Veritas System Recovery product DVD into the media drive of the computer.

The installation program should start automatically.

If the installation program does not start, on the Windows taskbar, click Start > Run, type the 

following command, then clickOK.

<drive>:\browser.exe

where \<drive\> is the drive letter of your media drive.

In the DVD browser panel, click Install Veritas System Recovery.

In the Welcome panel, click Next.

Read the license agreement, click I accept the terms in the license agreement, and then 

clickNext.

Choose Customand clickNext.

Select only Backup and Recovery Serviceand un-select the remaining features, then 

clickNext.

Note: In default all the features are already selected.

If you want to change the default location for the program files, click Change. Then locate the 

folder in which you want to install the agent, and then clickNext.

Click Install.

See About deploying the Veritas System Recovery Agent.

See Deploying the Veritas System Recovery Agent.
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Best practices for Veritas System Recovery services
The following table describes some best practices for using Veritas System Recovery services.

Table: Best practices for using Veritas System Recovery services

BEST PRACTICE DESCRIPTION

Check the Events tab first before using 
Services.

The Events tab in the Advanced view can help 
you to track down the source of a problem. 
Particularly when it is associated with the 
Veritas System Recovery Agent. You should 
view the most recent log entries in the Events 
tab for more information about the potential 
causes of the problem.

Verify that the Veritas System Recovery Agent 
starts without user intervention.

The Veritas System Recovery Agent is 
configured to start automatically when Veritas 
System Recovery starts. You can view the 
status information to verify that the Veritas 
System Recovery Agent has started. The 
status area in the Task pane displays a Ready 
status message when the agent starts.

You can also test that the Veritas System 
Recovery Agent starts automatically by looking 
in Services. You can check the status and 
restart the service if necessary. If the Startup 
type is set to automatic, you should restart the 
agent.

See Starting or stopping the Veritas System 
Recovery Agent service .

Use caution when changing default settings for 
the Veritas System Recovery Agent.

Changing the default Veritas System Recovery 
Agent properties can prevent Veritas System 
Recovery from running correctly. You should 
use caution when changing the default Startup 
type and Log On settings of the Veritas System 
Recovery Agent. It is configured to start and 
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BEST PRACTICE DESCRIPTION

log on automatically when you start Veritas 
System Recovery .

See Opening Windows services.

Opening Windows services
You can use several methods to open Windows services to manage the Veritas System Recovery 

Agent.

To open Windows services

Do one of the following:

On the Windows Control Panel, click Administrative Tools > Services.

On the Windows taskbar, click Start > Run.

In the Open text field, type services.msc , and then clickOK.

Under the Name column, scroll through the list of services until you see Veritas System 

Recovery (the name of the agent).

Its status should be Started.

See Starting or stopping the Veritas System Recovery Agent service.

Starting or stopping the Veritas System Recovery Agent service
To start, stop, or restart the Veritas System Recovery Agent service, you must be logged on as an 

administrator. (If your computer is connected to a network, network policy settings might prevent 

you from completing these tasks.)

You might need to start, stop, or restart the Veritas System Recovery Agent service for the 

following reasons:

Table: Starting ot stopping the Veritas System Recovery Agent service

ACTION DESCRIPTION

Start or Restart You should start or restart the agent if Veritas 
System Recovery is unable to connect to it on 
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ACTION DESCRIPTION

a computer. Or, you cannot reconnect from 
Veritas System Recovery.

Restart You should restart the agent. This restart is 
necessary if you changed the user name or 
password that you use to log on to the agent 
service. You should also restart the agent after 
you have used the Security Configuration Tool 
to give additional users the ability to back up 
computers.

See About controlling access to Veritas 
System Recovery .

Stop You can stop the agent if you believe that it 
causes a problem on the computer, or if you 
want to temporarily free memory resources.

If you stop the agent, you also prevent all of 
your drive-based backups and file and folder 
backups from running.

If you stop the Veritas System Recovery Agent service and then start Veritas System Recovery, the 

agent restarts automatically. The Status changes to Ready.

If you stop the Veritas System Recovery Agent service while the software runs, you receive an 

error message. Veritas System Recovery is disconnected from the agent. In most cases, you can 

click Reconnect from the Task pane or from the Tray icon to restart the Veritas System Recovery 

Agent.

To start or stop the Veritas System Recovery Agent service

On the Windows taskbar, click Start > Run.

In the Run window, type services.msc 1. ClickOK.

In the Services window, in the Name column, click Veritas System Recovery.

On the Action menu, select one of the following:

Start

Stop
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Restart

See Setting up recovery actions when the Veritas System Recovery Agent does not start.

Setting up recovery actions when the Veritas System Recovery Agent does 
not start
You can specify the computer's response if the Veritas System Recovery Agent fails to start.

To set up recovery actions when the Veritas System Recovery Agent does not start

On the Windows taskbar, click Start > Run.

In the Run window, type services.msc 1. ClickOK.

In the Services window, on the Action menu, click Properties.

On the Recovery tab, in the First failure, Second failure, and Subsequent failures lists, select 

the action that you want:

RESTART THE SERVICE SPECIFY THE NUMBER OF MINUTES 
BEFORE AN ATTEMPT TO RESTART THE 

SERVICE IS MADE.

Run a Program Specify a program to run. You should not 
specify any programs or scripts that require 
user input.

Restart the Computer Click Restart Computer Options , and then 
specify how long to wait before restarting the 
computer. You can also create a message 
that you want to display to remote users 
before the computer restarts.

In the Reset fail count after box, specify the number of days that the agent must run 

successfully before the fail count is reset.

When the fail count is reset to zero, the next failure triggers the action that is set for the first 

recovery attempt.

Click OK.

See Starting or stopping the Veritas System Recovery Agent service.
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Viewing Veritas System Recovery Agent dependencies
The Veritas System Recovery Agent depends on other required services to run properly. If a 

system component is stopped or is not running properly, the dependent services can be affected.

If the Veritas System Recovery Agent fails to start, check the dependencies. Check to ensure that 

they are installed and that their Startup type is not set to Disabled.

“ ”
Note: To view theStartuptype setting for each of the interdependent services, you must select one 

service at a time. Then clickAction > Properties > General.

“ ”
The top list box on the Dependencies tab displays services the Veritas System Recovery Agent 

requires to run properly. The bottom list box does not have any services that need the Veritas 

System Recovery Agent to run properly.

The following table lists the services the Veritas System Recovery Agent requires to run properly, 

along with their default startup setting.

Table: Required services

SERVICE STARTUP TYPE

Event log Automatic

Plug and play Automatic

Remote procedure call (RPC) Automatic

To view Veritas System Recovery Agent dependencies

On the Windows taskbar, click Start > Run.

In the Run window, type services.msc .

Click OK.

In the Services window, under Name, click Veritas System Recovery.
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On the Action menu, click Properties.

Click the Dependencies tab.

About controlling access to Veritas System Recovery
You can use the Security Configuration Tool to grant the necessary permissions to access the 

agent, or the full Veritas System Recovery user interface.

When you use the Security Configuration Tool, any permission that you grant to the Users group 

applies to the members within that group.

“ ”
Note: The agent service can only be run as LocalSystem or by a user who belongs to the 

Administrator's group.

“ ”
The following table describes the permissions that can be allowed or denied for user and groups 

who use the Veritas System Recovery Agent.

Table: Permission options

OPTION DESCRIPTION

Full Control Gives the user or the group complete access 
to all Veritas System Recovery functionality as 
if they are the administrator. If you do not want 
users to define, change, or delete backups, or 
to manage recovery point storage, do not give 
them Full Control.

Status Only Users or groups can get status information, 
and can run a backup job. But they cannot 
define, change, or delete any backup jobs, or 
use any other function of the product.

Deny Users cannot perform any function, or see any 
information. They are blocked from any access 
to Veritas System Recovery.
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A deny setting takes precedence over an inherited allow setting. For example, a user who is a 

member of two groups is denied permissions if the settings for one of the groups denies 

permissions. User-denied permissions override group-allow permissions.

See Enabling users or groups to access Veritas System Recovery.

See Changing permissions for a user or a group.

See Disabling access for users or groups to Veritas System Recovery.

See Running Veritas System Recovery using different user rights.

Enabling users or groups to access Veritas System Recovery
You can use the Security Configuration Tool to add a user or a group so they can access Veritas 

System Recovery.

To add users and groups

On the Windows taskbar, click Start > Programs > Veritas System Recovery > Security 

Configuration Tool.

Click Add.

In the Select Users or Groups dialog box, click Advanced.

If necessary, click Object Types to select the types of objects that you want.

If necessary, click Locations to select the location that you want to search.

Click Find Now, select users and groups you want, and then clickOK.

Click OK when you are finished.

See About controlling access to Veritas System Recovery.

See Changing permissions for a user or a group.

See Disabling access for users or groups to Veritas System Recovery.

See Running Veritas System Recovery using different user rights.

Changing permissions for a user or a group
You can use the Security Configuration Tool to change the Veritas System Recovery access 

permissions of a user or a group.

To change permissions for a user or a group
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On the Windows taskbar, click Start > Programs > Veritas System Recovery > Security 

Configuration Tool.

In the Permissions for Veritas System Recovery dialog box, select the user or group whose 

permissions you want to change. Then do one of the following:

To set Full Control permissions, click AlloworDeny for the selected user or group.

To set Status Only permissions, click AlloworDeny for the selected user or group.

Click OK when you are finished.

See About controlling access to Veritas System Recovery.

See Enabling users or groups to access Veritas System Recovery.

See Disabling access for users or groups to Veritas System Recovery.

See Running Veritas System Recovery using different user rights.

Disabling access for users or groups to Veritas System Recovery
You can use the Security Configuration Tool to remove a user or a group so they cannot access 

Veritas System Recovery.

To remove a user or a group

On the Windows Start menu, click Programs > Veritas System Recovery > Security 

Configuration Tool.

Select the user or group that you want to remove, and then click Remove.

Click OK when you are finished.

See About controlling access to Veritas System Recovery.

See Enabling users or groups to access Veritas System Recovery.

See Changing permissions for a user or a group.

See Running Veritas System Recovery using different user rights.

Running Veritas System Recovery using different user rights
If the permissions for a user are insufficient for running Veritas System Recovery, you can use the 

Run As feature in Windows. The Run As feature lets you run the software using an account that 

has sufficient rights. This situation is true even if you are not currently logged on with the account.
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To perform Run As from Windows

On the Windows taskbar, click Start > All Programs > Veritas System Recovery.

Right-click Veritas System Recovery, and then clickRun As.

In the Run As dialog box, click The following user to log onto with another account.

In the User name and Password fields, enter the account name and password that you want to 

use, and then click OK.

See About controlling access to Veritas System Recovery.

See Enabling users or groups to access Veritas System Recovery.

See Changing permissions for a user or a group.

See Disabling access for users or groups to Veritas System Recovery.
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Monitoring the status of your backups

This section includes the following topics:

About monitoring backups

Icons on the Home page

Icons on the Status page

Configuring Veritas System Recovery to send SNMP traps

Customizing the status reporting of a drive (or file and folder backups)

Viewing drive details

Improving the protection level of a drive

About using event log information to troubleshoot problems

About monitoring backups
You should monitor your backups to ensure that you can effectively recover lost data when you 

need it.

The Home page provides a general status of your backup protection. The Status page provides 

details about which drives are protected, as well as a calendar view of past and future backups.

“ ”
Note: In addition to ensuring that you back up each drive, carefully review and follow best 

practices for backing up your computer.

“ ”
See Icons on the Home page.

See Icons on the Status page.
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Refreshing the information that displays about hard disk configuration 
changes
Use Refresh to update the drive information that is displayed in various views of the product. This 

feature is useful when hard disk configurations have changed but the changes do not immediately 

appear in Veritas System Recovery. For example, adding hard disk space or creating a partition.

When you use Refresh, Veritas System Recovery scans all attached hard disks for any 

configuration changes. It also updates information on removable media, media drives, hard drives, 

file systems, and hard drive letters.

To rescan a computer's hard disks

On the View menu, click Refresh.

The status bar at the bottom of the product's window indicates when the scanning takes place.

See About monitoring backups.

Icons on the Home page
On the Home page, the Backup Status pane provides a summary of the backup protection status 

of your computer. For example, suppose one or more drives are not included in a defined backup. 

In such cases, the background color and status icon change to reflect the level of backup 

protection. The Status Details pane provides recommendations on which actions you should take.

The following table describes each of the levels of backup protection that the Home page displays.

Table: Backup protection levels

ICON TITLE DESCRIPTION

Backed up At least one drive-based 
backup is defined and it runs 
on a regular basis.

This status indicates that all 
drives, files, and folders can 
be fully recovered, if 
necessary.
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ICON TITLE DESCRIPTION

Partially backed up A backup is defined, but it is 
not scheduled or has not run 
for a long time. This status 
can indicate that the existing 
recovery points are outdated. 
It can also indicate that one 
or more drives are not 
assigned to a defined 
backup.

A partially protected drive can 
be recovered, but if the 
recovery points are outdated, 
it might not contain the latest 
versions of your data.

At risk No defined backup exists and 
no recovery points are 
available from which to 
recover the drive.

An unprotected drive cannot 
be recovered and is at risk.

Status unknown The status is forthcoming, or 
you have not yet licensed 
your product.

Either wait a few seconds for 
the status to display, or make 
sure that you have licensed 
your copy of the product.

No backup protection 
assigned

The drive that displays this 
icon is not monitored for 
backup status; or, it is 
monitored for errors only. 
However, there are no errors 
to report.
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ICON TITLE DESCRIPTION

Use the Customize Status 
Report feature on the Status 
page to change the status 
report setting.

See About monitoring backups.

See Icons on the Status page.

Icons on the Status page
Refer to the following table for the meaning of each icon that is displayed in the Backups calendar 

of the Status page.

Table: Backups calendar icons

ICON DESCRIPTION STATES

Represents a drive-based 
backup that is configured to 
create a single, independent 
recovery point. When this 
icon appears in the Backup 
timeline, it indicates that a 
drive-based backup is 
scheduled to occur.

    This icon can 
appear in the following 
states\:

Indicates that a backup has 
run and an independent 
recovery point was created.

Indicates that the backup is 
unavailable.

Indicates that the backup did 
not run as scheduled. This 
problem could occur if an 
error prevents the backup 
from running or if you 
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ICON DESCRIPTION STATES

manually cancel a backup 
before it completes.

Indicates a drive-based 
backup that is scheduled to 
run at a future time.

Represents a drive-based 
backup that is configured to 
create incremental recovery 
points. It indicates that a 
drive-based backup is 
scheduled to occur on the 
day that it appears in the 
backup timeline.

    This icon can 
appear in the following 
states\:

Indicates that a backup has 
run and an incremental 
recovery point was created.

Indicates that the backup is 
unavailable.

Indicates that the backup did 
not run as scheduled. This 
problem could occur if an 
error prevents the backup 
from running or if you 
manually cancel a backup 
before it completes.

Indicates that the backup is 
scheduled to run at a future 
time.

Represents backing up files 
and folders. It indicates that a 
backup of files and folders 
occurs on the day that it 
appears in the backup 
timeline.

    This icon can 
appear in the following 
states\:
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Indicates that a backup has 
run and that backup data for 
files and folders was created 
successfully.

Indicates that the backup is 
not available.

Indicates that the backup did 
not run as scheduled. This 
problem could occur if an 
error prevents the backup 
from running, or if you 
manually canceled a backup 
before it completed.

Indicates that the backup is 
scheduled to run at a future 
time.

Represents two or more 
backups are scheduled to run 
on the day on which this icon 
appears.

    This icon can 
appear in the following 
states\:

Indicates that two or more 
backups have run and the 
last backup was created 
successfully.

Indicates that two or more 
backups are scheduled and 
that at least one is 
unavailable.

Indicates that two or more 
backups have run and the 
last backup was 
unsuccessful. This problem 
could occur if an error 
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ICON DESCRIPTION STATES

prevents a backup from 
running.

Indicates that the backup is 
scheduled to run at a future 
time.

Configuring Veritas System Recovery to send SNMP traps
If you use Network Management System (NMS) applications, you can configure Veritas System 

Recovery to send SNMP traps for different priority and notification types.

By default, Veritas System Recovery is not enabled to send SNMP traps to NMS managers. You 

can configure Veritas System Recovery to send SNMP traps for different priority and notification 

types.

To configure Veritas System Recovery to send SNMP traps

On the Tasks menu, click Options.

Under Notifications, click SNMP Trap.

Click the Select the priority and type of messages list and select the priority level at which 

traps should be generated.

ALL MESSAGES SEND ALL MESSAGES, REGARDLESS OF 
PRIORITY LEVELS.

Medium and high priority messages Send only medium and high priority 
messages.

High priority messages only Send only high priority messages.

No messages Do not send any messages, regardless of 
priority levels.

Select one or more of the following options:

Errors-Warnings-Information

Select the version of SNMP traps to be sent (Version 1 or Version 2), and then clickOK.
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The Veritas System Recovery Management Information Base (MIB) is an enterprise MIB. It 

contains the Veritas System Recovery SNMP trap definitions. All Network Management System 

(NMS) applications have options to load an MIB. You can use any of these options to load the 

Veritas System Recovery MIB. If you do not load the MIB, the NMS application can still receive, 

and display the traps. However, the traps are not displayed in informative text. The MIB file, named 

ssr_mib.mib , is located in the Support folder on the Veritas System Recovery product DVD.

Customizing the status reporting of a drive (or file and folder 
backups)
You can configure how Veritas System Recovery reports the status of a particular drive (or all 

backups of files and folders).

For example, suppose that drive D contains unimportant data and you have chosen not to include 

it in a drive-based backup. The status on the Home page continues to report that your computer is 

at risk. You can configure Veritas System Recovery to ignore drive D. By ignoring it, you ensure 

that it does not calculate the status of drive D in the Backup Status panel on the Home page.

Or, you can specify that only errors, such as missed or failed backups, are included in the status 

report.

“ ”
Note: The backup status of each drive is reported throughout the product, wherever the drive is 

listed. When you customize status reporting for a drive, the status is reflected anywhere that the 

drive is listed in Veritas System Recovery.

“ ”
You should first determine the importance of the data that is on a particular drive. Or, the 

importance of data you have included in a backup of files and folders. Then you can decide on the 

level of status reporting to assign to it.

To customize the status reporting of a drive (or file and folder backups)

On the Status page, click a drive (or File and folders) to select it.

You can also click Customize status reporting from the Home page.
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Click Customize status reporting.

Select a status reporting option.

FULL STATUS REPORTING SHOWS THE CURRENT STATUS OF THE 
SELECTED DRIVE OR FILE AND FOLDER 
BACKUPS ON THE HOME AND STATUS 

PAGES.

SELECT THIS OPTION IF THE DATA IS 
CRITICAL.

Errors only status reporting Shows the current status of the selected 
drive or file and folder backups only when 
errors occur.

Select this option if the data is important, but 
you only want the status to report errors, 
whenever they occur.

No status reporting Does not show any status for the selected 
drive or file and folder backups.

Select this option if the data is unimportant 
and missed or failed backups do not need to 
be reported.

Click OK.

Viewing drive details
The Advanced page lets you view details about your hard drives.

To view drive details

On the View menu, click Advanced.

On the Drives tab, in the Drive column of the table, select a drive.

Review the Details section.
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NAME DISPLAYS THE NAME THAT YOU 
ASSIGNED TO THE BACKUP WHEN YOU 

DEFINED IT.

Type Identifies the type of recovery point that the 
backup creates when it runs.

Destination Identifies the storage location of the recovery 
point, or the location in which the drive 
should be backed up.

Last Run Displays the day and time when the backup 
was last run.

Next Run Displays the day and time of the next 
scheduled backup.

See Improving the protection level of a drive.

Improving the protection level of a drive
When the status of a drive-based backup indicates that it needs attention, you should take steps to 

improve the status.

You might need to add a drive to an existing backup, edit the schedule of a backup, or edit the 

settings of a backup. Or, you may need to define a new backup.

See About backing up your data.

To improve the protection level of a drive

On the View menu, click Status.

In the Drives column, select a drive that requires attention.

In the Status panel, right-click on the name of a backup job you want to edit, and then select 

one of the following menu items:

RUN BACKUP NOW RUNS THE SELECTED BACKUP JOB 
IMMEDIATELY.

Run Backup With Options Opens the Run Backup With Options dialog 
box, which lets you select the desired 
recovery point type. Recovery point option 
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RUN BACKUP NOW RUNS THE SELECTED BACKUP JOB 
IMMEDIATELY.

types include Incremental recovery point, 
Recovery point set, and Independent 
recovery point.

Change Schedule Opens the Run When dialog box so that you 
can edit the backup schedule.

Edit Settings Opens the Define Backup Wizard , which lets 
you edit the backup definition.

This option takes you to the second page of 
the wizard.

Edit Offsite Opens the Offsite Copy Settings dialog box, 
where you can edit or change settings for the 
Offsite Copy feature.

Remove Backup Job Deletes the backup that you have selected.

When you delete a backup, only the backup 
definition is deleted. The backup data is not 
deleted (for example, the recovery points or 
the backup data of files and folders).

Disable (Enable) Backup Turns on or turns off the backup that you 
have selected.

Define New Backup Opens the Define Backup Wizard , where 
you can select between backing up your 
computer or backing up selected files and 
folders.

This option is useful if a drive in the Drives 
column is not yet assigned to a backup. You 
can select a drive that is assigned to a 
backup job. Then you have access to the 
shortcut method for starting the Define 
Backup Wizard from the Status page.

Manage Backup Destination Opens the Manage Backup Destination 
dialog box, where you can specify 
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RUN BACKUP NOW RUNS THE SELECTED BACKUP JOB 
IMMEDIATELY.

destination drives as well as delete, copy, or 
explore existing recovery points on 
destination drives.

Customize Status Reporting Opens the Customize Status Reporting 
dialog box, where you can specify if you 
want status reporting, and the type of status 
reporting.

See Editing backup settings.

About using event log information to troubleshoot problems
When Veritas System Recovery performs an action, it records the event (for example, when a 

backup job runs). It also records program error messages.

You can use the event log to track down the source of problems or to verify the successful 

completion of a backup job.

Log entries provide information about the success or failure of numerous actions by Veritas System 

Recovery or by a user. It offers a single view of all of the information and the program error 

messages.

To access the event log

On the Tasks menu, click Options.

Under Notifications, click Event Log.

Select the appropriate event log options.

The generated event log includes the following information:

TYPE INDICATES IF THE EVENT IS AN ERROR 
MESSAGE OR OTHER INFORMATION, SUCH 
AS THE SUCCESSFUL COMPLETION OF A 

BACKUP JOB.

Source Identifies if Veritas System Recovery 
generates the message or another program.
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TYPE INDICATES IF THE EVENT IS AN ERROR 
MESSAGE OR OTHER INFORMATION, SUCH 
AS THE SUCCESSFUL COMPLETION OF A 

BACKUP JOB.

Date Displays the exact date and time that a 
selected event occurred.

Description Lets you review information about an event 
that can help you troubleshoot errors.

See Logging Veritas System Recovery messages.
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Managing and Monitoring the backup status 
of remote computers using Veritas System 
Recovery Manager

This section includes the following topics:

About

Configuring Windows firewall exceptions for Veritas System Recovery Manager

Starting Veritas System Recovery Manager

Icons on the Veritas System Recovery Manager console

Configuring Veritas System Recovery Manager default options

Viewing Veritas System Recovery Dashboard

Adding a remote computer to All Computers

Searching a remote computer from All Computers

Modifying the logon credentials for the remote computers

Running or Deleting Backup Jobs for the Remote computers

Removing a remote computer from the All Computers

Viewing the backup protection status of a remote computer

Viewing the backup protection status for a remote computer

Viewing the Protection Status report

About Backup Tasks

Creating Backup Jobs

Editing Backup Jobs

Removing Backup Jobs

Applying Backup Jobs
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About
Veritas System Recovery Monitor is re-branded as Veritas System Recovery Manager. It is an 

extremely simple, standalone, lightweight and easy to manage and monitor the remote computers. 

Veritas System Recovery Manager helps you determine the backup protection status of the remote 

computers that you backed up using Veritas System Recovery Windows and Linux clients. It allows 

you to Create, Edit, Apply, View, Run, and Delete backup jobs to the remote Veritas System 

Recovery Windows computers and only allows you to monitor the backup protection status of 

Veritas System Recovery Linux clients.

The Veritas System Recovery Manager application lets you do the following:

Manage and Monitor the backup protection status for a maximum of 1000 remote computers at 

a time.

Refresh any of the computers in the All computers to view the latest protection status. You can 

also configure an hourly refresh interval for the remote computers.

Create, Edit, Apply, View, Run, and Delete backup jobs to the remote Veritas System Recovery 

Windows computers.

Monitor the backup protection status of Veritas System Recovery Linux client versions 22 and 

21.

See Starting Veritas System Recovery Manager.

See Icons on the Veritas System Recovery Manager console.

See Adding a remote computer to All Computers.

Configuring Windows firewall exceptions for Veritas System 
Recovery Manager
Before you start Veritas System Recovery Manager, configure the Windows firewall program and 

port exceptions on both the host computer and the client computer.

To configure Windows firewall port exceptions

Click Start > Run, and type firewall.cpl.

On the left-pane, click Advanced Settings.

Select the Inbound Rules option.

On the left-pane, click New rule.
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Perform the following steps to configure the Windows firewall port exceptions:

Under Rule Type, select the Port option.

Click Next.

Select the TCP option.

Select the Specific local ports option.

In the Specific local ports field, enter 135 as the default port number.

Click Next.

Select the Allow the connection option.

Click Next.

Do not modify the default settings.

Click Next.

In the Rule field, specify a name for the rule.

Click Finish.

Perform the following steps to configure the Windows firewall program exceptions:

Under Rule Type, select the Program option.

Click Next.

Select the This Program Path option.

For Veritas System Recovery, browse to the following location where Vprosvc.exe  is 

installed:

Default path:

C:\Program Files\Veritas\Veritas System Recovery\Agent\Vprosvc.exe

Custom path:

<\<Veritas System Recovery installation path\>>\Agent\Vprosvc.exe

Click Next.

Select the Allow the connection option.

Click Next.

Do not modify the default settings.
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Click Next.

In the Rule field, specify a name for the rule.

Click Finish.

See About.

Starting Veritas System Recovery Manager
Veritas System Recovery Manager is installed in the Windows All Programs menu. During 

installation, a program icon is installed in the system tray from which you can open Veritas System 

Recovery Manager. You can also open Veritas System Recovery Manager from the Windows 

taskbar.

To start Veritas System Recovery Manager

On the Windows taskbar , click Start > All Programs > Veritas System Recovery Manager > 

Veritas System Recovery 23 Manager.

The Veritas System Recovery Manager console appears.

See Icons on the Veritas System Recovery Manager console.

Icons on the Veritas System Recovery Manager console
The following table describes the icons on the Veritas System Recovery Manager console:

Table: About the Veritas System Recovery Manager console 
icons

ICON TITLE DESCRIPTION

View Options Lists shortcuts to access 
most of the commonly used 
features of Veritas System 
Recovery Manager 
application, such as Add 
Computer, Import Computers, 
Export, Manage targets, 
Settings and Help.
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ICON TITLE DESCRIPTION

Add new computer Adds a remote computer to 
the Computer List that 
displays in the Backup Status 
pane.

(Ctrl + N) See Adding a remote 
computer to All Computers .

Import Computers (Ctrl + I) Imports a text file to add 
multiple remote computers. 
This text file contains the IP 
addresses of both Windows 
and Linux remote computers.

See Adding a remote 
computer to All Computers .

Export (Ctrl + X) Exports the Protection Status 
report for the selected 
computers on the Veritas 
System Recovery Manager 
console in an HTML or in a 
CSV format.

See Viewing the Protection 
Status report .

Manage Targets Lets you view the default 
targets and create, edit and 
remove the custom targets.

Application settings Opens the Settings pane and 
configure the Veritas System 
Recovery Manager default 
options.

(Ctrl + S) See Configuring Veritas 
System Recovery Manager 
default options .
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ICON TITLE DESCRIPTION

Help (F1) Accesses the Veritas System 
Recovery Manager's Help 
system.

Exit (Alt + F4) Closes the Veritas System 
Recovery Manager console.

Search Searches a remote computer 
from the Computer List.

At Risk Indicates that no drive-based 
backup policy has been 
created for the computers 
that appear in the Computer 
List.

The drives, files, or folders of 
these computers are 
unprotected and cannot be 
recovered and are at risk.

Need Attention Indicates that\:

- A drive-based backup policy 
for the computers that appear 
in this Computer List was 
defined. However, the policy 
has not run recently or the 
computers are not assigned 
to the defined backup policy.

- Some computers can be 
recovered, however, if the 
recovery points are outdated, 
they may not contain the 
latest version of your data.

Unknown Indicates that the backup 
protection status of the 
computers in the Computer 
List is not known. This status 
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ICON TITLE DESCRIPTION

may appear if the Veritas 
System Recovery Manager 
cannot connect to the remote 
computer due to the following 
issues\:

- Network connectivity issues

- Firewall issues

- Incorrect user name or 
password

Backed up Indicates that a drive-based 
backup policy was created 
and it runs on a regular basis. 
All the drives, files, and 
folders of the remote 
computers are protected and 
can be recovered, if 
necessary.

Computer Details Opens the Computer Details 
pane. The Computer Details 
pane displays a summary of 
the backup protection status 
for the selected remote 
computer.

See Viewing the backup 
protection status of a remote 
computer .

Remove Computer (Delete) Removes a remote computer 
from the Computer List.

See Removing a remote 
computer from the All 
Computers .

Refresh Protection Status 
(Ctrl + R)

Manually refresh the Backup 
Status pane to see the latest 



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

236
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backup protection status for 
the Computer List.

You can also select an 
individual computer from the 
Computer List and select 
refresh to see the latest 
backup protection status.

View Console Lets you manage and monitor 
the remote computers and 
view the backup protection 
status in the Veritas System 
Recovery application. You are 
not required to enter the 
command line parameters or 
user credentials to connect to 
the remote computer.

Note: View Console does not 
appear for Veritas System 
Recovery Linux edition.

Edit Computer (Ctrl + E) Modifies the logon credentials 
for the remote computers.

See Modifying the logon 
credentials for the remote 
computers .

Backup Tasks Lets you view, run or delete a 
backup job for an individual 
client computer.

Next Synchronization Time Displays the time in minutes 
that remains for the next 
automatic refresh.

See Configuring Veritas System Recovery Manager default options.

See Adding a remote computer to All Computers.
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Configuring Veritas System Recovery Manager default options
The Settings pane lets you configure the Veritas System Recovery Manager default options. The 

following table describes the options on the Settings pane.

To view the Settings pane

Do one of the following:

On the Veritas System Recovery Manager console, click the View Options icon and then 

click Settings.

On the Veritas System Recovery Manager console, click the Application settings icon.

On the Settings pane, configure the default options.

See Adding a remote computer to All Computers.

Table: Configure the Veritas System Recovery Manager default 
options

SETTINGS DO THE FOLLOWING

Always on Top Select the check box to display the Veritas 
System Recovery Manager application on the 
top of the other Microsoft Windows 
applications.

Save window location on exit Select the check box to save the location of the 
console when you close the application. When 
you launch the application again the console 
displays in the location you saved.

Start with window OS Select the check box to automatically start the 
Veritas System Recovery Manager application 
with the Microsoft Windows operating system. 
When you log on to Microsoft Windows, Veritas 
System Recovery Manager automatically 
starts, manage and monitor the remote 
computers.

Auto Refresh Select the check box to enable the automatic 
refresh Veritas System Recovery Manager.
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SETTINGS DO THE FOLLOWING

Refresh interval minutes You can modify the refresh interval. Ensure 
that the interval value must be between 60 min 
to 720 min.

Port Number If you are not using the default port number 
4443, use any Custom port number and click 
Save .

Domain Account and Password Select the check box if you want to access, 
manage and monitor a group of remote 
computers available in a domain account or an 
Active Directory.

Username: (Domain\username) Enter the global account name in the format . 
For example, Veritas\IMG.

Password Enter the password.

Confirm Password Retype the password.

Save To store the Veritas System Recovery Manager 
default options, click Save .

Viewing Veritas System Recovery Dashboard
On opening Veritas System Recovery Manager, a dashboard page appears. Dashboard gives 

glimpse of remote Veritas System Recovery Windows and Linux client's status based on different 

category on a single page.

Dashboard shows overall count of remote computer based on Veritas System Recovery Windows 

and Linux client's backup protection status.

Table: Overall Status of Computers

ITEMS DESCRIPTION

Total Computer Total Veritas System Recovery Windows and 
Linux computer count that are monitored by 
Veritas System Recovery Manager.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

239

•

◦

◦

◦

◦

•

◦

•

◦

◦

ITEMS DESCRIPTION

Backed Up All computers whose critical drive is backed up 
using Veritas System Recovery Windows and 
Linux.

Attention Needed All computers whose critical drive could not be 
backed up using Veritas System Recovery 
Windows and Linux and need user attention.

At Risk All computers whose critical drive is not 
backed up using Veritas System Recovery 
Windows and Linux.

Unknown All Windows and Linux computers which are 
not responding to Veritas System Recovery 
Manager.

Dashboard shows graphical representation of all Windows and Linux remote computers based on 

following category. Each legend in the graphical representation is clickable and a window with 

detailed information regarding the remote computers opens.

Computer Backup Status - Displays all remote Veritas System Recovery Windows and Linux 

computer's protection status count graphically.

Backed Up

Attention Needed

At Risk

Unknown

Version of remote Veritas System Recovery - Displays all remote Veritas System Recovery 

Windows and Linux client's versions.

All supported version of Veritas System Recovery Windows and Linux based on current 

Veritas System Recovery Manager version.

License Status of Veritas System Recovery - Displays all remote Veritas System Recovery 

Windows and Linux client's License Status count graphically

Activated

Expired
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Trial Period

Unknown

Platform of remote Veritas System Recovery - Displays all remote Veritas System Recovery 

Windows and Linux client's Platforms.

Adding a remote computer to All Computers
Before you can manage and monitor the backup protection status for a remote computer, you must 

add the remote computer to All Computers.

To add remote computers to All computers

On the Veritas System Recovery Manager console, under View Options, clickAdd Computer.

See Icons on the Veritas System Recovery Manager console.

In the Hostname or IP address field, type the name or the IP address of the computer that you 

want to add.

For more information about controlling access to the Veritas System Recovery, see the Veritas™ 

System Recovery User's Guide.

In the Username field, type the user name for an account that has appropriate permissions to 

access the backup protection status of the computer.

In the Password field, type the password for the user account.

In the Confirm Password field, type the password again to confirm it.

Click Add.

“ ”
Note: Select theCheck for Linux Machinecheck box if you are using Linux computer.

“ ”
See Modifying the logon credentials for the remote computers.

To add multiple remote computers to All Computers, you can import a text file that contains the IP 

address of all the Windows and Linux remote computers.
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To import a text file

Select and configure the domain account and password in the Settings pane. See Configuring 

Veritas System Recovery Manager default options.

Create a text file that contains the IP addresses of the both Windows and Linux remote 

computers that you want to manage and monitor.

“ ”
Note: In the text file, you should provide in the following format ''IP address, 0'' for Windows 

computer and ''IP address, 1'' for Linux computer.

“ ”
For e.g.

xx.xx.xx.xx,0

yy.yy.yy.yy,0

zz.zz.zz.zz,1

On the Veritas System Recovery Manager console, click Import Text file to add multiple 

Computers.

Browse to select the text file that contains the IP addresses of the remote computers.

Click OK.

Importing a text file to add multiple remote computers to All Computers
To add multiple remote computers to All Computers, you can import a text file that contains the IP 

address of all the remote computers.

See Adding a remote computer to All Computers.

See Modifying the logon credentials for the remote computers.

See Viewing the backup protection status of a remote computer.

Before you import a text file, you must ensure that you do the following:
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Select and configure the domain account and password in the Settings pane. See Configuring 

Veritas System Recovery Manager default options.

Create a text file that contains the IP addresses of both Windows and Linux remote computers 

that you want to manage and monitor.

To import a text file

On the Veritas System Recovery Manager console, click Import Text file to add multiple 

Computers.

Browse to select the text file that contains the IP addresses of the windows and Linux remote 

computers.

Click OK.

Searching a remote computer from All Computers
You can search a remote computer from the All Computers using the Search bar that is available at 

the top-right corner of the Veritas System Recovery Manager console.

To search a remote computer from the All Computers

In the Search bar, type the whole or partial name for one of the following:

Host computer name

Activity names:

For windows computer: Connecting, Connection failed, Sync pending and View Console.

For Linux computer: Connecting, Connected, Connection failed and Sync pending.

Last Run date or time

Username

License

Version

Platform

Click Search.

See Viewing the backup protection status of a remote computer.

See Viewing the Protection Status report.
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Modifying the logon credentials for the remote computers
You can modify the logon credential for the selected remote computer from the All Computers.

To modify the logon credentials for the remote computer

On the Veritas System Recovery 23 Manager console, select the remote computer from the All 

Computers .

Right click and select Edit Computer.

In the Hostname or IP address field, modify the host computer name or the IP address of the 

host computer.

In the Username field, modify the user name for an account that has necessary permissions to 

access the backup protection status of the computer.

In the Password field, modify the password for the user account.

In the Confirm Password field, retype the modified password for the user account.

“ ”
Note: Select theCheck for Linux Machinecheck box if you are using Linux computer

“ ”
See Adding a remote computer to All Computers.

Running or Deleting Backup Jobs for the Remote computers
You can run or delete Backup Jobs for any selected computers when the Backup Jobs are 

configured.

“ ”
Note: The Backup Tasks option is available only for Windows computers and for Linux computers 

only Monitoring can be performed.

“ ”
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To run Backup Job for a remote computer from All Computers

On the Veritas System Recovery Manager console, select All Computers.

Select a computer for which you want to perform Backup Job, Right click and select Backup 

Tasks.

The Backup Tasks window appears.

Select any Backup Name and click Run.

To delete Backup Job for a remote computer from All Computers

On the Veritas System Recovery Manager console, select All Computers.

Select a computer for which you want to delete Backup Job, Right click and select Backup 

Tasks.

The Backup Tasks window appears.

Select the required Backup Names and click Delete.

“ ”
Note: If you want to Delete backup Job for multiple Backup Names, Ctrl + click the Backup 

Names and clickDelete.

“ ”

Removing a remote computer from the All Computers
You can remove remote computers from All Computers.

To remove a remote computer from All Computers

On the Veritas System Recovery Manager console, select the remote computer that you want 

to remove.

“ ”
Note: If you want to remove multiple computers,Ctrl+ click the remote computers in theAll 

Computersand pressDeletekey.
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“ ”
Click Remove Computer.Deleted computer disappears from theAll Computers.

See Adding a remote computer to All Computers.

Viewing the backup protection status of a remote computer
After you add a remote computer to All Computers, Veritas System Recovery Manager does the 

following:

Automatically monitors the remote computer.

Displays a Computer List where all remote computers can be viewed under the following 

protection status category:

Backed Up

Attention Needed

At Risk

Unknown

Lets you view the backup protection status of an individual remote computer.

Lets you view the reason or detailed information, if the remote computer that you monitor is 

displayed under the following protection state category:

At Risk

Attention Needed

Unknown

The Computer Details pane lets you view the detailed information about the monitored backup 

protection status for the remote computer.

To view the details of a remote computer

On the Veritas System Recovery Manager console, select a remote computer from the All 

Computers.

Right-click and select View Computer Info.

Computer Details window appears.
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1. Click Computer Details.

Refer to the below table to view the detailed information about Monitoring backup protection status 

of the remote Computers:

LAST UPDATED TIME DISPLAYS THE LAST TIME, WHEN VERITAS 
SYSTEM RECOVERY MANAGER ACCESSED 

THE COMPUTER TO CHECK THE 
PROTECTION STATUS.

VSR Version Displays the version of the Veritas System 
Recovery application.

OS Version Displays the operating system version of the 
remote computer, for which the backup 
protection status is monitored.

License Displays the License status of the product.

State Displays the backup protection status of the 
computer.

Reason Specifies the reason for the protection state.

See Icons on the Veritas System Recovery Manager console.

The View Console functionality lets you monitor a remote computer and view the backup protection 

status in the Veritas System Recovery application. You are not required to enter the command line 

parameters or user credentials to connect to the remote computer.

“ ”
Note: TheView Consoleoption is available only for Windows computers and in Linux computers it 

will be shown as connected.

“ ”
See Adding a remote computer to All Computers.

See Viewing the Protection Status report.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

247

1.

2.

1.

2.

To view the backup protection status for a remote computer in the Veritas System Recovery

On the Veritas System Recovery Manager console, select a remote computer from the All 

Computers.

Click View Console.

Viewing the backup protection status for a remote computer
The View Console functionality lets you monitor a remote computer and view the backup protection 

status in the Veritas System Recovery application. You are not required to enter the command line 

parameters or user credentials to connect to the remote computer.

“ ”
Note: If you have Veritas System Recovery 2011 (Service Pack 2) or later on your host computer, 

theView Consolelink appears active. On a host computer with a previous version of Veritas System 

Recovery the link appears inactive.

“ ”
For more information about Veritas System Recovery, see the Veritas™ System Recovery User's 

Guide.

See Adding a remote computer to All Computers.

See Viewing the Protection Status report.

To view the backup protection status for a remote computer in the Veritas System Recovery

On the Veritas System Recovery 23 Manager console, select a remote computer from the 

Computer List.

Click View Console.

Viewing the Protection Status report
The protection status report provides detailed information about the backup protection status for all 

the remote computers that are backed up with Veritas System Recovery Windows and Linux. You 

can export the protection status report to one of the following formats:
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Hypertext Markup Language (HTML)

Comma Separated Value (CSV)

See Icons on the Veritas System Recovery Manager console.

See Adding a remote computer to All Computers.

See Removing a remote computer from the All Computers.

To export and view the protection status report

On the Veritas System Recovery Manager console, under View OptionsclickExport.

From the list of exportable data formats, select HTMLorCSV.

Click Export computer information to a File.

In the Save As window, enter the file name and location where you want to export the report.

Click Save.

About Backup Tasks
You can create backup jobs to automate the creation of recovery points by using a daily, weekly, or 

monthly schedule. This method is useful if you want to create recovery points of managed client 

computers during off-hours when you are not present or if you want to create a recovery point set 

without interrupting the normal flow of work. If you create a recovery point set, you can also specify 

that certain events, like logging on or off of a computer, create incremental recovery points.

By default, file names for scheduled independent recovery points or recovery point sets are 

appended with 001.v2i, 002.v2i, and so forth. File names for incremental recovery points within a 

recovery point set are appended with \_i001.iv2i, \_i002.iv2i, and so forth. For example, if your 

base recovery point were called C_Drive001.v2i, the first incremental recovery point would be 

called C_Drive001_i001.iv2i.

The name of the computer (where the backup occurs) is always appended to the recovery point file 

name.

Each backup jobs that you create is added to the Backup Tasks tree of the product.

You implement a backup jobs by doing the following:

Create Backup Tasks.
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You specify what to back up, the backup destination where the resulting recovery points are stored, 

and when to run the backup (scheduled or manually).

Edit any of the properties and options of a backup jobs, except the backup type.

Apply backup jobs to one or more remote computer.

Delete a backup job from the Veritas System Recovery Manager console.

You can also specify the compression levels of recovery points, enable encryption and password 

protection. Many other options are available that let you customize each backup according to your 

business needs.

The client computer must be turned on to create a recovery point at the scheduled time. However, 

Veritas System Recovery Manager does not need to be open for the backup to take place. Also, a 

remote user does not need to be logged on to the managed client computer. However, Windows 

must be started on the computer.

To verify that a backup completed as scheduled, you can use the All computers option to check the 

backup protection status of a remote computer.

“ ”
Note: Veritas System Recovery Manager supports saving backups to a network share or a local 

drive on a client computer as a backup destination.

“ ”
This section also includes the following topics:

See Recovery Point Set and Independent Recovery Point in backup job

See Tips for creating recovery points

Recovery Point Set and Independent Recovery Point in backup job
The following table describes the advantages and disadvantages of scheduled recovery point or 

independent recovery points sets as part of your backup jobs.

“ ”
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Warning: If you are choosing Recovery Point Set backup the full recovery point and all associated 

incremental recovery points that make up the recovery point set must be kept together in the same 

folder. If there are missing files, the recovery point becomes invalid and you cannot restore the 

data.

“ ”
Table: Backup Types

TYPE DESCRIPTION

Recovery point set Consider the following when you create 
recovery point sets.

- A recovery point set is the same as an 
Independent recovery point except that it also 
has incremental tracking enabled for the 
selected drive.

- This type of backup creates a base recovery 
point. Additional recovery points are created 
but save only the hard disk sectors that have 
changed since the creation of the base 
recovery point or the previous incremental 
recovery point.

- Incremental recovery points are created 
faster than the first (base) recovery point and 
use less storage space than an independent 
recovery point.

- Recovery point sets are ideal when you 
combine them with a schedule.

Independent recovery point Consider the following when you create 
independent recovery points.

- An independent recovery point creates a 
complete, independent copy of the entire 
selected drive.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

251

•

•

•

•

•

•

TYPE DESCRIPTION

- An independent recovery point is not 
associated with incremental recovery points or 
recovery point sets in any way. As such, 
independent recovery points stand on their 
own and are usually a less complicated 
method for protecting your computer than 
recovery point sets. You can create an 
independent recovery point of a drive even if 
that drive is tracked with a recovery point set.

- This backup type typically requires more 
storage space on a hard disk than a recovery 
point set.

Tips for creating recovery points
The following information may help when you create recovery points:

Veritas System Recovery Manager does not need to be open for a scheduled backup to start or 

run. Therefore, after you create a backup jobs and assign it to resource targets, you can exit 

the console. The client computer that you manage, however, must be turned on and Windows 

must be started.

All backup jobs are saved in the Veritas System Recovery Manager console so that you can 

edit or apply to the target later.

Store recovery points to a network share or to a local drive on the managed client computer 

other than the primary hard disk C. This practice helps ensure that you can recover the system 

in the event that the client's primary hard disk fails.

Avoid the need to run a disk defragmentation program on the managed client computer during 

the creation of recovery points. Doing so significantly increases the time it takes to create the 

recovery point, and it may cause unexpected system resource issues on the client computer.

If you have two or more drives that are dependent on each other, or they are used as a group 

by a program like a database service, include both drives in the same backup jobs. Back up 

multiple drives simultaneously by selecting two or more drives in the Create Backup Job 

window.

Include multiple drives in the same backup jobs to reduce the total number of backups that 

must be run.
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Avoid storing recovery points on the Veritas System Recovery computer. As the number or size 

of recovery points grows, you have less disk space available for regular server use. When you 

save recovery points to a separate drive or a network location, this problem is eliminated. Also, 

if you decide to store recovery points on the client computer, store them to a secondary hard 

disk. Avoid storing them on the primary hard disk C. This practice helps ensure that you can 

recover the system in the event that the client's primary hard disk fails.

Creating Backup Jobs
You can automate the creation of recovery points with a daily, weekly, or monthly schedule. If you 

create a recovery point set, you can also specify that certain events, like logging on or off a 

computer, create incremental recovery points.

To create a Backup Job

On the Veritas System Recovery Manager console, click Manage Computers tab in the left 

pane.

Click Create in the Backup Tasks tab.

On the Create Backup Job window, select any Backup Type.

On the Drives panel, set any drive option you want.

ALL DRIVES ON SELECTED COMPUTERS LETS YOU DEFINE A BACKUP JOB FOR 
TWO OR MORE DRIVES. YOU SHOULD 

SELECT THIS OPTION TO PROTECT ALL 
DRIVES (INCLUDING HIDDEN OR 

UNMOUNTED), THAT EXIST ON THE 
CLIENT COMPUTERS.

By Drive Lets you select the drives that you want to 
back up on the selected client computers.

Hidden drives are not displayed in the By 
Drive list. Also, by checking the Other option, 
you can add any single drive and also 
multiple drives by separating with semi-
colon. For e.g. E or for multiple drives E;F;G

Sometimes a selected drive letter is not 
available for backing up on a particular client 
computer. The drive has been deleted or the 
entire hard disk has been removed from the 
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ALL DRIVES ON SELECTED COMPUTERS LETS YOU DEFINE A BACKUP JOB FOR 
TWO OR MORE DRIVES. YOU SHOULD 

SELECT THIS OPTION TO PROTECT ALL 
DRIVES (INCLUDING HIDDEN OR 

UNMOUNTED), THAT EXIST ON THE 
CLIENT COMPUTERS.

client computer since Veritas System 
Recovery was installed. In such cases, when 
the recovery point is created, it does not 
include the drive.

In the Destination pane. Specify the path to a local drive or a network share.

USER NAME LETS YOU SPECIFY THE USER NAME TO A 
DESTINATION FOLDER THAT IS LOCATED 

IN A NETWORK PATH.

Password Lets you specify the password to a 
destination that is located in a network path.

Veritas recommends that you use AES encryption when you define a backup to prevent 

unauthorized access to the files.

ENABLE PASSWORD PROTECTION SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

Password Lets you specify a password for the backup. 
Passwords can include standard characters. 
Passwords cannot include extended 
characters, or symbols. (Use characters with 
an ASCII value of 128 or lower.)

Confirm password Lets you retype the password for

confirmation.

AES encryption Encrypts recovery point data to add another 
level of protection to your recovery points.
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ENABLE PASSWORD PROTECTION SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

Note: If theUse Passwordcheck box is 
selected, you must define AES encryption.

Choose from the following encryption levels:

- Standard 128-bit (8+ character password)

- Medium 192-bit (16+ character password)

- High 256-bit (32+ character password)

While higher strengths require longer 
passwords, the result is greater security for 
your data.

On the Schedule panel, check the Schedule check box and set the schedule options you want.

The available scheduling options depend on the backup type that you selected.

Schedule tab options for a recovery point set

SCHEDULE LETS YOU SELECT THE DAYS AND A START 
TIME FOR WHEN THE BACKUP SHOULD 

RUN.

Start time (24 hour format) Lets you customize the start time of the 
backup .

Sun Mon Tue Wed Thu Fri Sat Lets you customize the days of the week for 
the backup to run. The default is to run the 
backup Monday through Friday.

Run more than once per day Lets you run the backup more than once a day 
to protect the data that you edit or change 
frequently.
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SCHEDULE LETS YOU SELECT THE DAYS AND A START 
TIME FOR WHEN THE BACKUP SHOULD 

RUN.

Time between backups Lets you specify the maximum time that should 
occur between backups.

Number of times Lets you specify the number of times per day 
that the backup should run.

Automatically optimize Lets you select how often optimization should 
occur for the backup destination to manage the 
used disk space.

You can choose from the following options:

- Never Indicates that no deletion of 
incremental recovery points is performed.

- Every four hours Indicates that a deletion of 
incremental recovery points that are four hours 
old (or older) is performed every four hours. 
Also, after the first incremental of the day is 
taken, all incremental files from two days 
previous are consolidated to a single file.

- Every twelve hours Indicates that a deletion 
of incremental recovery points that are 12 
hours old (or older) is performed every 12 
hours. Also, after the first incremental of the 
day is taken, all incremental files from two days 
previous are consolidated to a single file.

Start a new recovery point set Lets you select how frequently a new recovery 
point set should be started.

Your options for starting new recovery point set 
(base) include the following:

- Weekly Creates a new recovery point set on 
the first scheduled or manual backup of the 
week.
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SCHEDULE LETS YOU SELECT THE DAYS AND A START 
TIME FOR WHEN THE BACKUP SHOULD 

RUN.

- Monthly Creates a new recovery point set on 
the first scheduled or manual backup of the 
month.

- Quarterly Creates a new recovery point set 
on the first scheduled or manual backup every 
three months from the date when you selected 
this option.

- Yearly Creates a new recovery point set on 
the first scheduled or manual backup of the 
year, once a year, on the date that you 
selected for this option.

- Custom Lets you set specific weekly or 
monthly options for starting a new recovery 
point set.

Custom Lets you customize the start time, and the days 
of the week or month to run the backup.

Note: If you choose to archive recovery points, 
consider creating recovery point sets more 
frequently to keep the size of your recovery 
point sets smaller.

Schedule options for an independent recovery point
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AUTOMATICALLY CREATE A RECOVERY 
POINT

LETS YOU SPECIFY A WEEKLY OR 
MONTHLY BACKUP SCHEDULE.

THE SCHEDULING OPTIONS INCLUDE THE 
FOLLOWING:

- NO SCHEDULE SAVES ALL OF THE 
BACKUP JOBS SETTINGS EXCEPT A 

SCHEDULE. YOU CAN LATER APPLY THE 
BACKUP JOBS AT YOUR CONVENIENCE BY 

ASSIGNING A SCHEDULE TO THE JOB.

- WEEKLY CREATES A NEW, INDEPENDENT 
RECOVERY POINT ON EACH DAY OF THE 

WEEK THAT YOU CHECK, AND AT THE 
SPECIFIED TIME. WHEN YOU CREATE 

INDEPENDENT RECOVERY POINTS ONE OR 
MORE TIMES PER WEEK, LARGE AMOUNTS 

OF DISK STORAGE SPACE MAY BE 
REQUIRED.

- MONTHLY CREATES A NEW, INDEPENDENT 
RECOVERY POINT ON EACH DAY OF THE 
MONTH THAT YOU CHECK, AND AT THE 

SPECIFIED TIME.

Start time (24 hour format) Lets you customize the start time of the 
backup .

Days of the week Lets you customize the days of the week for 
the backup jobs to run.

Days of the month Lets you customize the days of the month for 
the backup jobs to run.

On the Advanced Options panel, in the Compression list, set the compression level for the 

recovery points.
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NONE INDICATES THAT COMPRESSION IS NOT 
USED ON THE RECOVERY POINT.

YOU CAN CHOOSE THIS OPTION IF 
STORAGE SPACE IS NOT AN ISSUE. IF 
THE RECOVERY POINT IS SAVED TO A 

BUSY NETWORK DRIVE, HIGH 
COMPRESSION MAY BE FASTER THAN NO 

COMPRESSION BECAUSE LESS DATA 
NEEDS TO BE WRITTEN ACROSS THE 

NETWORK

Standard (recommended) Lets you use low compression for a 40 
percent average data compression ratio on 
recovery points. This setting is the default.

Medium Lets you use medium compression for a 45 
percent average data compression ratio on 
recovery points.

High Lets you use high compression for a 50 
percent average data compression ratio on 
recovery points. This setting is usually the 
slowest method.

When a high compression recovery point is 
created, CPU usage may be higher than 
normal. Other processes on the computer 
may also be slower. To compensate, you can 
adjust the operation speed of the backup 
process. Speed adjustments may improve 
the performance of other resource-intensive 
applications that you run at the same time.

On the Advanced Options panel, use the below options and click Apply.
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LIMIT THE NUMBER OF RECOVERY POINT 
SETS (BASES) SAVED FOR THIS BACKUP 

(RECOVERY POINT SETS ONLY)

SPECIFIES THE MAXIMUM NUMBER OF 
RECOVERY POINTS OR RECOVERY POINT 
SETS THAT ARE SAVED FOR EACH DRIVE.

OR WHEN THIS LIMIT IS REACHED, EACH 
SUCCESSIVE RECOVERY POINT OR SET 
IS FIRST CREATED AND STORED. THE 

OLDEST, PREVIOUSLY CREATED 
RECOVERY POINT OR SET IS THEN 

DELETED (INCLUDING ALL ASSOCIATED 
INCREMENTAL, IF APPLICABLE) FROM 

THE SAME STORAGE LOCATION.

LIMIT THE NUMBER OF RECOVERY 
POINTS SAVED FOR THIS BACKUP 

(INDEPENDENT RECOVERY POINTS ONLY)

ENSURE THAT YOU HAVE ENOUGH HARD 
DISK SPACE TO ACCOMMODATE THE 

NUMBER OF RECOVERY POINTS OR SETS 
YOU SPECIFY, PLUS ONE ADDITIONAL 

RECOVERY POINT OR SET.

IF YOU RUN OUT OF HARD DISK SPACE 
BEFORE THE NUMBER IS REACHED, THE 
RECURRING RECOVERY POINT PROCESS 

CANNOT COMPLETE SUCCESSFULLY, 
AND A CURRENT RECOVERY POINT OR 

SET IS NOT CREATED

Divide into smaller files to simplify archiving Splits a recovery point into two or more 
smaller files. This feature is useful if you 
create or export a recovery point that you 
want to copy to removable media later for 
safekeeping. The recovery point is split into 
smaller, more manageable files. You can 
then copy the files onto separate, removable 
media, such as a DVD or CD.

If Veritas System Recovery creates an .sv2i 
file in addition to the .v2i files, you need to 
save the .sv2i file on the same media as the 
first .v2i file.

If you create a recovery point of volumes 
with thousands of files on a computer that 
has low memory, splitting the recovery point 
into smaller segments can help speed the 
process.
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LIMIT THE NUMBER OF RECOVERY POINT 
SETS (BASES) SAVED FOR THIS BACKUP 

(RECOVERY POINT SETS ONLY)

SPECIFIES THE MAXIMUM NUMBER OF 
RECOVERY POINTS OR RECOVERY POINT 
SETS THAT ARE SAVED FOR EACH DRIVE.

OR WHEN THIS LIMIT IS REACHED, EACH 
SUCCESSIVE RECOVERY POINT OR SET 
IS FIRST CREATED AND STORED. THE 

OLDEST, PREVIOUSLY CREATED 
RECOVERY POINT OR SET IS THEN 

DELETED (INCLUDING ALL ASSOCIATED 
INCREMENTAL, IF APPLICABLE) FROM 

THE SAME STORAGE LOCATION.

LIMIT THE NUMBER OF RECOVERY 
POINTS SAVED FOR THIS BACKUP 

(INDEPENDENT RECOVERY POINTS ONLY)

ENSURE THAT YOU HAVE ENOUGH HARD 
DISK SPACE TO ACCOMMODATE THE 

NUMBER OF RECOVERY POINTS OR SETS 
YOU SPECIFY, PLUS ONE ADDITIONAL 

RECOVERY POINT OR SET.

IF YOU RUN OUT OF HARD DISK SPACE 
BEFORE THE NUMBER IS REACHED, THE 
RECURRING RECOVERY POINT PROCESS 

CANNOT COMPLETE SUCCESSFULLY, 
AND A CURRENT RECOVERY POINT OR 

SET IS NOT CREATED

If a recovery point is divided into multiple 
files, the file names for subsequent files are 
appended with \_S01, \_S02, and so forth. 
For example, if the default file name were 
Dev-RBrough_C_Drive.v2i, the second file 
name would be Dev-
RBrough_C_Drive_S01.v2i, and so on.

Click Create>Note: Create button will be disabled if all the required fields are not entered 

properly.

Editing Backup Jobs
You can edit any of the properties and options of a backup job, except the backup type. Then the 

backup job can be re-applied on any computers that are in its assigned resource target and also to 

any new target.

To edit a Backup Job
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On the Veritas System Recovery Manager console, click Manage Computers tab in the left 

pane.

Select any Backup Job you want to edit and Click Edit in the Backup Tasks tab.

On the Edit Backup Job window, use the available options and backup properties to make any 

changes that you want to the backup job.

Click Save.

Removing Backup Jobs
Removing a backup job removes it only from the console and the backup job remains in the client 

computer.

To remove a Backup Job

On the Veritas System Recovery Manager console, click Manage Computers tab in the left 

pane.

Select any Backup Job you want remove and Click Remove in the Backup Tasks tab.

“ ”
Note: If you want to remove multiple backup jobs, Ctrl + click the backup jobs and 

ClickRemove.

“ ”

Applying Backup Jobs
You can apply backup jobs to the resource targets that have Veritas System Recovery installed.

When you apply backup job to resource targets, all of the computers within a given target have the 

same backup schedule.

“ ”
Note: If you have two backup jobs, each job has the recovery point set options pointing to the 

same drives, when the job is assigned to the client computer, the Apply Backup Job operation fails 

with no generated errors.
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“ ”
To apply a Recovery Point Set backup job in a default or custom target

On the Veritas System Recovery Manager console, click Manage Computers tab in the left 

pane.

Select any Backup Job you want to apply to a target and Click Apply in the Backup Tasks tab.

On the Apply Backup Job window, choose the available default or created custom targets and 

Click Apply.

“ ”
Note: In case the Backup Type is Recovery Point Set. The Apply recovery point set backup job 

window appears.

“ ”
Select Create a new backup job, if it doesn't exist , to create a new job if there is no existing 

job present.

“ ”
Note: Apply backup job will fail if any existing job present. If no existing job present, then a new 

backup job will be applied.

“ ”
or

Select On the selected computer, if the specified drive is already assigned to an existing 

recovery point set backup job, choose to Keep the existing backup job and not apply the 

new backup job.>Note: Apply backup job will fail if any existing job present. If no existing job 

present, then the new backup job will be applied.

or Select On the selected computer, if the specified drive is already assigned to an existing 

recovery point set backup job, choose to Delete the existing backup job and apply the new 
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backup job.>Note: Existing backup job will be deleted and the new backup job will be applied. If 

no existing job present, then just the new backup job will be applied.

Click Ok.

“ ”
Note: The summary pop-up window appears with the information of total number of computer 

count where the Apply backup job attempted, succeeded and failed.

“ ”
To apply an Independent Recovery Point Set backup job in a default or custom target

On the Veritas System Recovery Manager console, click Manage Computers tab in the left 

pane.

Select any Backup Job you want to apply to a target and Click Apply in the Backup Tasks tab.

On the Apply Backup Job window, choose the available default or created custom targets and 

Click Apply.

“ ”
Note: The summary pop-up window appears with the information of total number of computer 

count where the Apply backup job attempted, succeeded and failed.

“ ”
To create a custom target from Apply Backup Job

On the Veritas System Recovery Manager console, click Manage Computers tab in the left 

pane.

Click Apply in the Backup Tasks tab.

“ ”
Note: The Apply Backup Job window appears.
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“ ”
Click Create.

On the Create Target window, Enter any Target name in the text field.

In the Select Computers pane select any computer to add it to the target.

“ ”
Note: If you want to add multiple computers to the target, Ctrl + click the computers and 

clickRight Arrowand if you want to remove computers from the target clickLeft Arrow.

“ ”
Click Create

To create a custom target using Manage Targets

On the Veritas System Recovery Manager console, click Manage Targets.

Click Create in the Manage Target window.

“ ”
Note: The Create Target window appears.

“ ”
On the Create Target window, Enter any Target name in the text field.

In the Select Computers pane select any computer to add it to the target.

“ ”
Note: If you want to add multiple computers to the target, Ctrl + click the computers and 

clickRight Arrowand if you want to remove computers from the target clickLeft Arrow.
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Click Create.
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Exploring the contents of a recovery point

This section includes the following topics:

About exploring recovery points

Exploring a recovery point through Windows Explorer

Opening and restoring files within a recovery point browser

Dismounting a recovery point drive

Viewing the drive properties of a recovery point

About exploring recovery points
You can use Veritas System Recovery to explore files in a recovery point. You mount the recovery 

point and assign it a drive letter so that it is visible from Windows Explorer.

You can perform the following tasks on the assigned drive:

Run ScanDisk (or CHKDSK).

Perform a virus check.

Copy folders or files to an alternate location.

View disk information about the drive, such as used space and free space.

Run programs existing within a mounted recovery point.

Within a mounted recovery point, programs that you run cannot rely on any registry values. The 

programs also cannot rely on COM interfaces, Dynamic Link Libraries (DLLs), or other similar 

dependencies.

You can set up a mounted drive as a shared drive. Users on a network can connect to the shared 

drive and restore files and folders from the recovery point.

You can mount one or more recovery points at a time. The drives remain mounted until you 

unmount them or you restart the computer. Mounted drives do not take up extra hard-disk space.

You do not need to mount a drive to restore the files or folders from within a recovery point.

All security on the NTFS volumes remains intact when they are mounted.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

267

1.

2.

•

•

See Exploring a recovery point through Windows Explorer.

See Dismounting a recovery point drive.

See Viewing the drive properties of a recovery point.

Exploring a recovery point through Windows Explorer
When you explore a recovery point, Veritas System Recovery mounts the recovery point as a drive 

letter and opens the recovery point in Windows Explorer.

For each drive that is included in the recovery point, a new mounted drive letter is created. For 

example, if your recovery point contains backups of drives C and D, two newly mounted drives 

appear (for example, E and F). The mounted drives include the original drive labels of the drives 

that were backed up.

To explore a recovery point through Windows Explorer

On the Tasks menu, click Manage Backup Destination.

Do one of the following:

Select a recovery point set that you want to explore and in the Range column, double-click 

the date range.

In the Explore Recovery Pointsdialog box, select the required recovery points and then clickOK.

Select the recovery point or recovery point set that you want to explore, and then click Explore.

If you select a recovery point set, in the Explore Recovery Pointsdialog box, select the required 

recovery points and then clickOK.

See About exploring recovery points.

Mounting a recovery point from Windows Explorer
You can manually mount a recovery point as a drive by opening your backup destination folder in 

Windows Explorer.

You can use Windows Explorer to search the contents of the recovery point. For example, if you 

cannot remember where a particular file was originally stored, you can use the Windows Explorer 

search feature. You can locate the file, as you normally would locate a file on your hard drive.

To mount a recovery point from Windows Explorer
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In Windows Explorer, navigate to a recovery point.

The recovery point is located in the storage location that you selected when you defined your 

backup.

Right-click the recovery point, and then click Mount.

In the Mount Recovery Point window, under the Drive Label column, select the drive that you 

want to mount.

In the Drive letter list, select the letter that you want to associate with the drive.

Click OK.

See About exploring recovery points.

Opening and restoring files within a recovery point browser
Using the Recovery Point Browser, you can open files within a recovery point. The file opens in the 

program that is associated with that file type. You can also restore files by saving them using the 

application that is associated with them. Or, you can restore files by using the Recover Files option 

in the Recovery Point Browser.

If the file type is not associated with a program, the Microsoft Open With dialog box is displayed. 

You can then select the correct program for opening the file.

“ ”
Note: In theRecovery Point Browser, you cannot view encrypted file system (EFS) NTFS volumes.

“ ”
To open and restore files within a recovery point

On the Tools page, click Run Recovery Point Browser.

In the Select Recovery Point panel, select a recovery point to restore, and then click OK.

Recovery Point options by Date
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VIEW RECOVERY POINTS BY - DATE DISPLAYS ALL DISCOVERED RECOVERY 
POINTS

IN THE ORDER THAT THEY ARE CREATED.

IF NO RECOVERY POINTS ARE 
DISCOVERED, THE

TABLE IS EMPTY. IN SUCH CASES, YOU 
CAN SEARCH

ALL LOCAL DRIVES ON THE COMPUTER OR 
BROWSE

TO FIND A RECOVERY POINT.

Select source folder Lets you view a list of all the available recovery

points that exist on your computer's

local drives or on a specific drive.

Browse Locates a recovery point on a local drive or

a network folder.

Select the Show hidden drives check box to 
see a list of the hidden drives along with the list 
of the other drives.

You can select a hidden drive as a location 
where you want to store the recovery points.

The hidden drives are displayed in the 
following format:

DiskNo-PartitionNo\

For example, a hidden drive is displayed as: 
2-3\. Where 2 is the disk number and 3 is the 
partition number.

Note: By default, this check box is not 
selected.
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VIEW RECOVERY POINTS BY - DATE DISPLAYS ALL DISCOVERED RECOVERY 
POINTS

IN THE ORDER THAT THEY ARE CREATED.

IF NO RECOVERY POINTS ARE 
DISCOVERED, THE

TABLE IS EMPTY. IN SUCH CASES, YOU 
CAN SEARCH

ALL LOCAL DRIVES ON THE COMPUTER OR 
BROWSE

TO FIND A RECOVERY POINT.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
backups .

Select a recovery point Lets you select the recovery point to restore.

Recovery point details Displays additional information about the

recovery point that you want to restore.

Recovery Point options by Filename

VIEW RECOVERY POINTS BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE

NAME.

Recovery point folder and file name Specifies a path and a file name of a recovery

point.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:
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VIEW RECOVERY POINTS BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE

NAME.

DiskNo-PartitionNo

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 2-3. 
Where 2 is the disk number and 3 is the 
partition number.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

Browse Locates a recovery point on a local drive or

a network folder.

Recovery point details Displays additional information about the

recovery point that you want to restore.

In the Recovery Point Browser, in the tree panel on the left, select a drive.

In the right content panel, double-click the folder that contains the file that you want to view.

Right-click the file that you want to view, and then click View File.

The View File option is grayed out if you select program files with the .exe, .dll, or .com file 

extensions.

To restore a file, in the Recovery Point Browser, in the list panel on the right, select one or more 

files.

Click Recover Files, and then clickRecover to restore them to their original location.

If you are prompted, click Yes, orYes to All to overwrite the existing (original) files.

See About exploring recovery points.
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Dismounting a recovery point drive
All of your mounted recovery point drives are dismounted when you restart the computer. You can 

also dismount the drives without restarting the computer.

“ ”
Note: Any data that is written to a mounted recovery point is lost when the recovery point is 

unmounted. This data includes any data that is created, edited, or deleted at the time.

“ ”
To dismount a recovery point drive

Do one of the following:

In Windows Explorer, navigate to the mounted recovery point.

In Recovery Point Browser, in the tree view, locate the mounted recovery point.

“ ”
Note: To access the recovery point browser, on theToolspage, clickRun Recovery Point 

Browser.

“ ”
Right-click the mounted recovery point that is displayed as a drive, and then click Dismount 

Recovery Point.

See About exploring recovery points.

See Viewing the drive properties of a recovery point.

Viewing the drive properties of a recovery point
You can view various drive properties of a recovery point using the Recovery Point Browser.

To view the drive properties of a recovery point
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In the Recovery Point Browser, in the tree panel on the left, click the recovery point that 

contains the drive that you want to view.

Select a drive.

Do one of the following:

On the File menu, click Properties.

Right-click the recovery point, and then click Properties.

DESCRIPTION A USER-ASSIGNED COMMENT THAT IS 
ASSOCIATED WITH THE RECOVERY 

POINT.

Original drive letter The original drive letter that was assigned 
to the drive.

Cluster size The cluster size (in bytes) of the FAT, 
FAT32, or NTFS drive.

File system The file system type that is used within the 
drive. For example, FAT, FAT32, or NTFS.

Primary/Logical The selected drive's status as either a 
primary partition or a logical partition.

Size The total size (in MB) of the drive. This 
total includes used space and unused 
space.

Used space The amount of used space (in MB) within 
the drive.

Unused space The amount of unused space (in MB) 
within the drive.

Contains bad sectors Indicates if any bad sectors exist on the 
drive.

Cleanly quiesced Indicates whether the database application 
quiesced properly when a recovery point 
was created.
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Managing backup destinations

This section includes the following topics:

About backup destinations

Differences between drive-based backups and file and folder backups

Cleaning up old recovery points

Deleting a recovery point set

Deleting recovery points within a recovery point set

Copying recovery points

About managing file and folder backup data

Automating the management of backup data

Moving your backup destination

About support of OneDrive for Business

About backup destinations
A backup destination is the location in which your backup data is stored.

Veritas System Recovery includes the features for managing the size of your backup destinations 

so that you can use your computer's valuable disk space for other purposes.

If you have defined multiple backup destinations, the Backup Destination panel on the Home page 

lets you select a destination for which a pie chart is displayed. The pie chart of the selected 

destination displays the following information about the backup drive or folder:

Actual data backup

Other used space

Free space available

See Cleaning up old recovery points.

See Deleting a recovery point set.

See Deleting recovery points within a recovery point set.
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See Copying recovery points.

Differences between drive-based backups and file and folder 
backups
Veritas System Recovery offers two backup methods:

Table: Backup methods

METHOD DESCRIPTION

Drive-based backup Use this option to back up an entire drive (for 
example your system drive which is typically 
C). You can then restore any file or folder, or 
your entire drive.

See Defining a drive-based backup .

File and folder backup Use this option to back up only the files and 
folders that you select. You can then restore 
any file or all of them at any time.

This option typically requires less disk space 
than drive-based backups.

See Backing up files and folders .

Drive-based backups

When you run a drive-based backup, a snapshot of everything is taken and stored on your 

computer's hard disk. Each snapshot is stored on your computer as a recovery point. A recovery 

point is a point in time. You can use the recovery point to restore your computer back to the way it 

was when the snapshot was created.

Table: Types of recovery points

TYPE DESCRIPTION

Independent recovery point (.v2i) Creates a complete, independent copy of the 
drives that you select. This backup type 
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TYPE DESCRIPTION

typically requires more storage space than a 
recovery point set.

Recovery point set (.iv2i) Includes a base recovery point. A base 
recovery point is a complete copy of your 
entire drive, and is similar to an independent 
recovery point. The recovery point set also 
includes recovery points. These recovery 
points capture only the changes that were 
made to your computer since the creation of 
the base recovery point.

Although you can recover files and folders from a drive-based backup, you cannot select a specific 

set of files or folders to back up. Your entire hard drive is backed up.

File and folder backups

You can edit or create a select set of personal documents and folders, and then define a backup 

for those files and folders. For example, you might want to define a backup to capture one or more 

folders. Within those folders contain the files that you change on a regular basis. This kind of 

backup is useful because you do not need to use additional hard disk resources to back up your 

entire computer.

File and folder backups let you select individual files or folders to back up. You can also specify a 

file type to back up. Then Veritas System Recovery can locate and back up all files of the type you 

specified. For example, suppose you have Microsoft Word documents stored at several locations 

on your computer. Veritas System Recovery locates all Word documents (files that end with .doc) 

and includes them in your backup. You can even edit the list of file types to include the types that 

are unique to the software you use.

Veritas System Recovery also keeps multiple versions of the same files for you. This redundancy 

means you can restore the version of a file that contains the changes you need to restore. You can 

even set a limit to the number of versions that are kept so that you can control the use of disk 

space.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

277

1.

2.

3.

1.

2.

Cleaning up old recovery points
Over time, you might end up with recovery points that you no longer need. For example, you might 

have several older recovery points that you no longer need because you have more current ones 

containing your latest work.

See Automating the management of backup data.

The Clean Up feature deletes all but the most current recovery point set, to help make more space 

available on your hard disk.

“ ”
Note: After you delete a recovery point, you no longer have access to the files or system recovery 

from that point in time. You should explore the contents of the recovery point before you delete it.

“ ”
To clean up old recovery points

On the View menu, click Tools.

Click Manage Backup Destination. and then clickClean Up.

“ ”
Note: TheClean Upbutton is enabled based on the settings that are selected in theManage 

Backup Destination Settingsdialog box and when the recovery point set limit is reached.

“ ”
In the Clean Up Recovery Points dialog box, select the recovery points that you want to delete.

The recovery point sets that can be safely removed without eliminating your latest recovery point 

are selected automatically. You can also select or deselect the recovery point sets to specify which 

ones to remove.

Click Delete.

Click Yes to confirm the deletion.
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Click OK.

See Opening and restoring files within a recovery point browser.

See About exploring recovery points.

See Deleting a recovery point set.

See Deleting recovery points within a recovery point set.

See Copying recovery points.

Deleting a recovery point set
If you know that you no longer want a particular recovery point set, you can delete it at any time.

“ ”
Note: After you delete a recovery point, you no longer have access to file or system recovery for 

that point in time.

“ ”
To delete a recovery point set

On the View menu, click Tools.

Click Manage Backup Destination.

In the Recovery Point Sets table, select a recovery point set that you want to delete.

The recovery point set you select should have only one set associated with it and appear as "1 

Recovery Point" in the table.

In the Manage Backup Destination window, on the Tasks menu, click Delete.

In the Delete Recovery Point Set dialog box, click Yes to confirm the deletion.

Click OK.

See Cleaning up old recovery points.

See Deleting recovery points within a recovery point set.

See Copying recovery points.
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See About exploring recovery points.

Deleting recovery points within a recovery point set
A recovery point set can contain multiple recovery points that were created over time. You can 

delete recovery points to reclaim more storage space.

The Delete Recovery Points option lets you delete all the recovery points that were created 

between the first recovery point and last recovery point in the set.

“ ”
Warning: Be careful about which recovery points you choose to delete. You can inadvertently lose 

data. For example, you create a new document, which is captured in the third recovery point in a 

recovery point set. You then accidentally delete the file, which is captured in the fourth recovery 

point. If you delete the third recovery point, you permanently lose the version of the file that was 

backed up. If you are unsure, you should explore the contents of a recovery point before you 

delete it.

“ ”
See Opening and restoring files within a recovery point browser.

You can manually select which recovery points to remove, if you know which recovery points that 

you want to keep within a set.

See Cleaning up old recovery points.

To delete recovery points within a set

On the View menu, click Tools.

Click Manage Backup Destination.

In the Recovery Point Sets table, select the recovery point set that contains recovery points 

that you want to delete.

The recovery point set you select should have more than one set associated with it. For example, a 

recovery point set that contains more than one recovery point may appear as "4 Recovery Points" 

in the table.

In the Manage Backup Destination window, on the Tasks menu, click Delete.
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Do one of the following:

To automatically delete all but the first and last recovery point in the set, click Automatic.

To manually select which recovery points in the set to delete, click Manual , and then select 

the recovery points you want to delete.

To delete all the recovery points in the set you selected, click Delete all recovery points in 

the set.

Click OK.

See Deleting a recovery point set.

See Copying recovery points.

See About exploring recovery points.

Copying recovery points
You can copy recovery points to another location for added security. For example, you can copy 

them to another hard disk, another computer on a network, or on removable media such as USB 

disks. You can then store these copies in a protected location.

You can also create archive copies of your recovery points to free up disk space. For example, you 

can copy recovery points to a network location or USB disk, and then manually delete the original 

recovery points. You should verify the copies of the recovery points to ensure that they are valid.

To make copies of recovery points

On the View menu, click Tools.

Click Manage Backup Destination.

In the Recovery Point Sets table, select a recovery point set.

In the Manage Backup Destination window, on the Tasks menu, click Copy.

If the Copy Recovery Point dialog box is displayed, select a recovery point within the set that 

you want to copy. Otherwise, skip to the next step.

On the Welcome panel of the Copy Recovery Point Wizard, click Next.

Do one of the following:

If you selected a recovery point in step 5, the recovery point that you want to copy is 

already highlighted (selected) for you in the Date table of the Source panel. Click Next.
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• On the Source panel, select the recovery point that you want to copy.

Recovery point sets appear as single recovery points. Select View all recovery points to display 

all incremental recovery points that are included within the recovery point sets.

Source options when you copy recovery points by Date

VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

Date Lets you select an alternate date by using the 
drop-down calendar. Use the calendar if no 
recovery points are discovered and displayed 
in the table.

View all recovery points Lets you view all recovery points that are 
available.

Source options when you copy recovery points by File name

VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

File name Specifies a path and a file name of a recovery 
point.

Browse Lets you browse to a path that contains a 
recovery point.

For example, you can browse for a recovery 
point (.v2i) or incremental recovery point (.iv2i) 
file on an external (USB) drive. Or, you can 
browse to a network location, or removable 
media.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .
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VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

User name Specifies the user name if you specify a 
recovery point file name that is located in a 
network path.

See Rules for network credentials .

Password Specifies the password to a network path.

Source options when you copy recovery points by System

VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

Date Lets you select an alternate date of a system 
index file date by using the drop-down 
calendar. Use the calendar if no recovery 
points are discovered and displayed in the 
table.

Use latest recovery points for this computer Restores the most recent recovery points that 
exist in the recovery point storage location on 
your computer.
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VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

The list of drives, source files (.v2i and .iv2i 
files), and dates comes from the most current 
system index file (.sv2i).

Use alternate system index (.sv2i) file Restores the recovery points that exist on 
another computer.

Browse to and select the .sv2i file for the 
desired system

Specifies a path to a system index file (.sv2i) 
file that resides elsewhere, such as a network 
location.

If you selected a system index file that is 
stored on a network, you are prompted for your 
network credentials.

See Rules for network credentials .

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index file.
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VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

Drives Lets you select the drives with the recovery 
points that you want to restore based on the 
selected system index file.

Click Next.

In the Destination Location panel, specify the folder path where you want to copy the recovery 

point, and then click Next.

FOLDER LETS YOU TYPE THE PATH TO WHICH YOU 
WANT TO COPY THE RECOVERY POINT.

Browse Lets you browse to a folder path where you 
want to copy the recovery point.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.
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FOLDER LETS YOU TYPE THE PATH TO WHICH YOU 
WANT TO COPY THE RECOVERY POINT.

See OpenStorage destination options for 
recovery .

Edit Lets you edit the destination information.

File name Lets you select a file name that you want to 
rename.

Rename Lets you renames the file that you have 
selected in the File name table.

On the Options panel, set the options you want for the copied recovery point, and then click 

Next.

Copy recovery point options

COMPRESSION LETS YOU USE ONE OF THE FOLLOWING 
COMPRESSION LEVELS FOR THE 

RECOVERY POINT\:

- NONE

- STANDARD

- MEDIUM

- HIGH

THE RESULTS CAN VARY DEPENDING ON 
THE TYPES OF FILES THAT ARE SAVED IN 

THE DRIVE.

Verify recovery point after creation Verifies whether the recovery point is valid 
after it is created.

Include system and temporary files Includes indexing support for an operating 
system and temporary files when a recovery 
point is created or copied on the client 
computer.
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1.

COMPRESSION LETS YOU USE ONE OF THE FOLLOWING 
COMPRESSION LEVELS FOR THE 

RECOVERY POINT\:

- NONE

- STANDARD

- MEDIUM

- HIGH

THE RESULTS CAN VARY DEPENDING ON 
THE TYPES OF FILES THAT ARE SAVED IN 

THE DRIVE.

Advanced Lets you add security options to the recovery 
point.

Description Indicates a description for the recovery point. 
The description can be anything that helps you 
further identify the recovery point's contents.

Advanced options

DIVIDE INTO SMALLER FILES TO SIMPLIFY 
ARCHIVING

LETS YOU SPLIT THE RECOVERY POINT 
INTO SMALLER FILES AND SPECIFIES THE 

MAXIMUM SIZE (IN MB) FOR EACH FILE.

FOR EXAMPLE, TO COPY A RECOVERY 
POINT TO ZIP DISKS FROM YOUR BACKUP 
DESTINATION, SPECIFY A MAXIMUM FILE 

SIZE OF 100 MB, ACCORDING TO THE SIZE 
OF EACH ZIP DISK.

In the Security Options panel, set the password, select the encryption for the copied recovery 

point, and then click Next.
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USE PASSWORD SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

Password Lets you specify a password for the backup. 
Passwords can include standard characters. 
Passwords cannot include extended 
characters, or symbols. (Use characters with 
an ASCII value of 128 or lower.)

You must type this password before restoring 
a backup or view the contents of the 
recovery point.

Confirm password Lets you retype the password for

confirmation.

AES encryption Encrypts recovery point data to add another 
level of protection to your recovery points.

If

you upgrade from a previous version to 
Veritas System Recovery 23, for older 
backup jobs where only

password protection is defined, you need to 
edit the jobs to select the AES

encryption level. If you do not edit the older 
backup jobs, they continue to run

without AES Encryption. Veritas 
recommends that you edit the job and select 
AES

encryption level.

Note: If theUse Passwordcheck box is 
selected, you must define AES encryption.
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USE PASSWORD SETS A PASSWORD AND ENABLES AES 
ENCRYPTION ON THE RECOVERY POINT 

WHEN IT IS CREATED.

THIS CHECK BOX IS SELECTED BY 
DEFAULT.

Choose from the following encryption levels:

- Standard 128-bit (8+ character password)

- Medium 192-bit (16+ character password)

- High 256-bit (32+ character password)

Review the options that you selected, and then click Finish.

After the recovery points are safely copied, you can delete them from your computer.

See Deleting a recovery point set.

See Cleaning up old recovery points.

See Deleting recovery points within a recovery point set.

More Information

Compression levels for recovery points

About managing file and folder backup data
Drive-based backups capture your entire hard drive. As such, the size of a recovery point is 

typically much larger than the data that is captured during the backup of files and folders. However, 

file and folder backup data can take up significant disk space if it is not managed. For example, 

audio files, video files, and photographs are typically large files.

You must decide how many versions of backup files that you want to keep. This decision can 

depend on how frequently you change the content of your files and how frequently you run the 

backups.

See Viewing the amount of file and folder backup data that is stored on a backup destination.

See Manually deleting files from your backups of files and folders.
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3.

4.

5.

See Finding versions of a file or folder.

Viewing the amount of file and folder backup data that is stored on a backup 
destination
You can view the total amount of file and folder backup data that you have currently stored.

To view how much file and folder backup data is stored

On the Tasks menu, click Manage Backup Destination.

In the Drives list, select the drive that you want to use as a backup destination.

Based on the drive that you select, in the Manage Backup Destination panel, the Space used for 

file and folder storage box displays the amount storage space that is currently used.

See About managing file and folder backup data.

Manually deleting files from your backups of files and folders
You can manually delete the files that are stored in your backup destination.

To manually delete files from your backups of files and folders

On the Tasks menu, click Recover My Files.

Do one of the following:

In the Find files to recover box, type the file name of the file that you want to delete, and 

then click Search.

If you do not know the name of the file, click Search , and then browse for the file.

Click View All Versions to display all versions of each file that exist in the backup of files and 

folders data.

Select one or more files that you want to delete.

Right-click, and then click Delete.

See About managing file and folder backup data.

Finding versions of a file or folder
You can use Windows Explorer to view information about the available versions that are included in 

a backup of files and folders.

You can limit the number of versions of each file and folder that you want to store.
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See Automating the management of backup data.

To find versions of a file or folder

Open Windows Explorer.

Navigate to a file that you know is included in a backup of files and folders.

Right-click the file, and then click Show Versions.

See About managing file and folder backup data.

Automating the management of backup data
Veritas System Recovery can monitor your backup storage space and notify you when it gets full. It 

can also automatically delete old recovery points and older versions of files from file and folder 

backups exceeding the threshold. If you do not specify a threshold, Veritas System Recovery 

notifies you when the disk reaches 90 percent of its total capacity.

You can also manage your file and folder backup data by limiting the number of versions of backup 

files that you keep. This kind of maintenance can significantly reduce the amount of disk space that 

is required, especially if the file size is large.

To automate the management of backup data

On the Tasks menu, click Manage Backup Destination.

On the Manage Backup Destinationdialog box, clickSettings.

Select Limit file versions for file and folder backups , and then type a number between 1 

and 99.

Select Monitor disk space usage for backup storage. Drag the slider to limit the total 

amount of disk space that can be used for your backup data.

Do one of the following:

Select Warn me when backup storage exceeds threshold if you only want to be notified 

when the storage size is exceeded, but you do not want any action to be taken.

Select Automatically optimize storage if you want Veritas System Recovery to manage 

the backup data automatically, without prompting you.

Veritas System Recovery automatically deletes the old recovery points, and limits file versions to 

remain within the threshold that you set.
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Select Delay changes until next backup if you do not want to apply your changes until the 

next backup runs.

Click OK.

See About managing file and folder backup data.

Moving your backup destination
You can change the backup destination for your recovery points and move your existing recovery 

points to a new location. For example, suppose you install an external hard drive for storing your 

backup data. You can then change the backup destination for one or more backups to the new 

drive.

When you select a new location, you can also choose to move the existing recovery points to the 

new destination. All future recovery points for the backups that you select are created at the new 

location.

“ ”
Note: You can move your backup destination to a new internal or external hard drive. Make sure 

that the drive is properly installed or connected before you proceed.

“ ”
To move your backup destination

On the Tasks menu, click Manage Backup Destination.

In the Manage Backup Destination window, in the Drives list, select the drive that contains the 

backup destination that you want to move.

Click Move.

In the Move Backup Destination dialog box, do one of the following:

In the New backup destination box, type the path to the new backup destination.

Click Browseto locate and select a new backup destination, and then clickOK.

Select the defined backups that should use the new backup destination.

Deselect the defined backups that you do not want to move.
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Select Save as default backup destination if you want to use this destination as the default 

backup destination for any new backups that you define in the future.

Click OK.

To move existing recovery points to the new backup destination, select Move recovery 

points , and then do one of the following:

Select Move the latest recovery points for each backup and delete the rest.

Select Move all recovery points to the new destination.

If you have file and folder backup data that you want to move to the new backup destination, 

click Move file backup data.

The Move file backup data option is not available if no backup data of files and folders is found at 

the original backup destination.

Click OK.

See About managing file and folder backup data.

About support of OneDrive for Business
OneDrive is the Microsoft cloud service that connects you to all your files. It lets you store and 

protect your files, share them with others, and get to them from anywhere on all your devices. 

OneDrive used by an organization is OneDrive for Business.

Veritas System Recovery now supports Microsoft OneDrive for Business as a primary destination 

for backups and you can restore recovery points from a OneDrive sync location. The Microsoft 

OneDrive for Business must be configured on a machine locally.

OneDrive for Business does not support backup and restore of recovery points from a Veritas 

System Recovery Disk, physical to virtual conversion, file and folder backup.

To configure OneDrive for Business locally, use the following link:

https://support.office.com/en-us/article/sync-files-with-the-onedrive-sync-client-in-

windows-615391c4-2bd3-4aae-a42a-858262e42a49

When you configure OneDrive for Business, there are some limitations for file names and file 

types. refer to the following link to know more about the limitations:

https://support.office.com/en-us/article/invalid-file-names-and-file-types-in-onedrive-onedrive-for-

business-and-sharepoint-64883a5d-228e-48f5-b3d2-eb39e07630fa

https://support.office.com/en-us/article/sync-files-with-the-onedrive-sync-client-in-windows-615391c4-2bd3-4aae-a42a-858262e42a49
https://support.office.com/en-us/article/invalid-file-names-and-file-types-in-onedrive-onedrive-for-business-and-sharepoint-64883a5d-228e-48f5-b3d2-eb39e07630fa
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When you specify a OneDrive for Business location as the primary destination for backups, the 

recovery points larger than 9180 MB are automatically split into smaller files of 9180 MB. You can 

reduce the size of the recovery points to less than 9180 MB. Recovery points greater than 9180 

MB are not synced by OneDrive to the cloud.

If a volume being backed up has an existing OneDrive folder, that folder is not included as a part of 

the generated recovery point when the backup actually runs.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

294

•

•

•

•

•

•

•

 

Managing virtual conversions

This section includes the following topics:

Defining a virtual conversion job

Running an existing virtual conversion job immediately

Viewing the properties of a virtual conversion job

Viewing the progress of a virtual conversion job

Editing a virtual conversion job

Deleting a virtual conversion job

Running a one-time conversion of a physical recovery point to a virtual disk

Defining a virtual conversion job
You can use Veritas System Recovery to convert recovery points of a physical computer to 

VMware virtual disk. You can create a schedule to convert recovery points to a VMware virtual disk 

(.vmdk format) or a Microsoft virtual disk (.vhd format).

“ ”
Note: If the disk sector size is 4K, the Microsoft virtual disk can only be converted to a .vhdx 

format.

“ ”
You can also convert recovery points directly to VMware ESXi Server. Virtual disks are excellent for 

testing and evaluation purposes.

“ ”
Note: You cannot convert a 4K disk to a .vmdk format.

“ ”
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You can find a list of platforms that support the virtual disks that are created from recovery points in 

the software compatibility list. The software compatibility list is available at the following URL:

https://www.veritas.com/content/support/en_US/doc/VSR_22_SCL

Scheduled conversions use the system index file (.sv2i) to convert recovery points to virtual disks. 

The .sv2i file reduces the time it takes to convert multiple recovery points. When a recovery point is 

created, a .sv2i file is saved with it. The .sv2i file contains a list of the most recent recovery points, 

which includes the original drive location of each recovery point.

You can also create a one-time virtual conversion.

See Running a one-time conversion of a physical recovery point to a virtual disk.

To define a virtual conversion job

On the Tasks menu, click Run or Manage Virtual Conversions.

On the toolbar, click Define New.

Select the virtual disk type (and version, if applicable) that you want to create, and then click 

Next.

VMWARE VIRTUAL DISK (.VMDK) CONVERTS THE RECOVERY POINTS TO 
A .VMDK FORMAT.

THIS FORMAT ONLY SUPPORTS 
WORKSTATION VERSION 8.

VMware ESXi Server Converts the recovery points to a VMware 
ESXi Server.

Note: Veritas System Recovery .0.2 no 
longer supports physical to virtual conversion 
for ESXi on a 32-bit operating system.

Microsoft Virtual Disk Converts the recovery points to a .vhd 
or .vhdx format. The .vhd format is supported 
for all versions before Windows 8 and 
the .vhdx format is supported for Windows 8 
and above.

Note: The Microsoft Virtual Disk type 
supports .vhd and .vhdx conversions. 
The .vhd conversion is available for all 

https://www.veritas.com/content/support/en_US/doc/VSR_22_SCL
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4.

VMWARE VIRTUAL DISK (.VMDK) CONVERTS THE RECOVERY POINTS TO 
A .VMDK FORMAT.

THIS FORMAT ONLY SUPPORTS 
WORKSTATION VERSION 8.

operating systems. The .vhdx conversion is 
only available for Windows 8/2012 R2 and 
above. If the sector size is 4K, the virtual disk 
can only be converted to a .vhdx format.

In the Source panel, select the recovery points you want to convert, and then click Next.

“ ”
Note: If you have specified a password while defining a backup job, theEnter Passworddialog 

box is displayed. Enter the password that you specified when you created the backup job and 

clickOK.

“ ”

PERFORM CONVERSION USING LATEST 
RECOVERY POINTS FOR THIS COMPUTER

CONVERTS THE MOST RECENT 
RECOVERY POINTS THAT EXIST IN THE 
RECOVERY POINT STORAGE LOCATION 

ON YOUR COMPUTER.

THE LIST OF DRIVES, SOURCE FILES (.V2I 
AND .IV2I FILES), AND DATES COMES 
FROM THE MOST CURRENT SYSTEM 

INDEX FILE (.SV2I).

Perform conversion using recovery points for 
another computer

Converts the recovery points that exist on 
another computer.

Browse to and select the .sv2i file for the 
desired system

Specifies a path to a system index file (.sv2i) 
that resides elsewhere, such as a network 
location.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:
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PERFORM CONVERSION USING LATEST 
RECOVERY POINTS FOR THIS COMPUTER

CONVERTS THE MOST RECENT 
RECOVERY POINTS THAT EXIST IN THE 
RECOVERY POINT STORAGE LOCATION 

ON YOUR COMPUTER.

THE LIST OF DRIVES, SOURCE FILES (.V2I 
AND .IV2I FILES), AND DATES COMES 
FROM THE MOST CURRENT SYSTEM 

INDEX FILE (.SV2I).

DiskNo-PartitionNo\Filename.sv2i

For example, if the hidden drive location is 
on Disk 2 and Partition 3, you must enter 
2-3\file.sv2i. Where 2 is the disk number and 
3 is the partition number.

If you selected a system index file that is 
stored on a network, you are prompted for 
your network credentials.

See Rules for network credentials .

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index 
file.

Drives Lets you select the drives with the recovery 
points that you want to convert based on the 
selected system index file.

Sector Size Displays the sector size as 4K or 512.

In the Virtual Disks Destination panel, set the options you want based on the virtual disk format 

and version (if applicable) that you selected earlier. Then click Next.

“ ”
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Note: Veritas recommends that you select a secure remote network location as the virtual 

conversion over a network is unencrypted. If the virtual disk files and images are stored on a 

local computer, select a protected folder. Only privileged users or an administrator should have 

the rights to access the folder. The recommendation also applies to a one-time virtual 

conversion of a recovery point to a virtual disk.

“ ”
Virtual Disks Destination options for converting to VMware virtual disk or Microsoft virtual disk

FOLDER FOR VIRTUAL DISKS LETS YOU TYPE THE PATH TO THE FOLDER 
WHERE YOU WANT TO PLACE THE VIRTUAL 

DISK FILES.

NOTE: WHEN YOU SELECT A PATH TO 
PLACE THE VIRTUAL DISK FILES, 

THESECTOR SIZEOF THE SOURCE AND THE 
DESTINATION MUST BE THE SAME.

Browse Lets you browse to locate the folder in which 
you want to place the virtual disk files.

User name Lets you type the user name if you specified a 
virtual disk folder location on a network

See Rules for network credentials .

Password Specifies the password to a network path.

Create one virtual disk per volume Creates one virtual disk file per volume.

If you do not select this option, each drive is 
matched to its respective hard drive letter 
assignment during the conversion. Therefore, it 
results in multiple drives within one virtual disk 
file.

Note: This option is not available if the 
volumes are on separate disks.

Rename Lets you edit the file name of the resulting 
virtual disk file.
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Virtual Disks Destination options for converting to VMware ESXi Server

ESXI SERVER NAME OR IP ADDRESS LETS YOU TYPE THE NAME OF THE 
SERVER OR THE SERVER'S IP ADDRESS.

User name Lets you type a valid administrator user name 
that has sufficient rights to an ESXi server.

Password Lets you type a valid password to the ESXi 
server.

Destination for the virtual disks Lets you type the path to the folder where you 
want to place the virtual disk files.

Browse Lets you browse to a destination location for 
the virtual disks.

Rename Lets you edit the name of the resulting virtual 
disk file.

Next Specifies the additional options for VMware 
ESXi Server virtual disks.

Temporary location for conversion Lets you type the name of the server or the 
server's IP address that you can use as a 
temporary location for files.

Temporary Location Credentials Lets you type a valid administrator user name 
and password that has sufficient rights.

In the General Options panel set the conversion options you want, and then click Next.

CONVERSION JOB NAME LETS YOU TYPE A NAME FOR THE 
VIRTUAL CONVERSION JOB OR YOU CAN 

LEAVE THE DEFAULT NAME.

Split virtual disk into 2 GB (.vmdk) files Lets you split the virtual disk into multiple 2 
GB .vmdk files.

For example, use this option if your virtual 
disk is stored on a FAT32 drive. Or, any file 
system that does not support files larger than 
2 GB. Or, if you want to copy the virtual disk 
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CONVERSION JOB NAME LETS YOU TYPE A NAME FOR THE 
VIRTUAL CONVERSION JOB OR YOU CAN 

LEAVE THE DEFAULT NAME.

files to a DVD but the size is larger than the 
DVD allows.

Note: This option is specific to VMware; it is 
not available if you selectedMicrosoft Virtual 
Diskas the conversion format.

In the Conversion Time panel, set the conversion job schedule that you want, and then click 

Next.

Conversion Time options for a Weekly schedule

AUTOMATICALLY CONVERT LATEST 
RECOVERY POINTS - WEEKLY

CONVERTS THE LATEST RECOVERY 
POINTS TO VIRTUAL DISKS USING A 

WEEKLY SCHEDULE.

Default Uses the default conversion schedule.

Start time Lets you select the time you want the 
conversion to start.

Days Lets you select the day of the week that you 
want the conversion to take place.

Run more than once per day Converts the recovery points multiple times 
throughout a day.

Time between conversions Lets you select the amount of time to elapse 
before the next conversion.

Number of times Specifies the number of times that you want 
the conversion to occur, beginning from the 
selected start time.

Details Displays the conversion time information you 
have selected.

Conversion Time options for a Monthly schedule
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AUTOMATICALLY CONVERT LATEST 
RECOVERY POINTS - MONTHLY

CONVERTS THE LATEST RECOVERY 
POINTS TO VIRTUAL DISKS USING A 

MONTHLY SCHEDULE.

Default Lets you use the default conversion schedule.

Start time Lets you select the time you want the 
conversion to start.

Days of the month Lets you select the day of the month that you 
want the conversion to take place.

Details Displays the conversion time information you 
have selected.

Conversion Time options for an Only Run Once schedule

AUTOMATICALLY CONVERT LATEST 
RECOVERY POINTS - ONLY RUN ONCE

RUNS THE CONVERSION ONE TIME ON THE 
DATE AND AT THE TIME THAT YOU SPECIFY.

Date Lets you select the day, month, and year that 
you want the conversion to run.

Time Lets you select the time that you want the 
conversion to start.

Details Displays the conversion time information you 
have selected.

If you want to run the new conversion job immediately, click Run conversion now.

This option is not available if you selected the Only run once option in the Conversion Time panel.

Click Finish.

See Viewing the properties of a virtual conversion job.

See Viewing the progress of a virtual conversion job.

See Editing a virtual conversion job.

See Running an existing virtual conversion job immediately.

See Deleting a virtual conversion job.
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Running an existing virtual conversion job immediately
After you create a conversion job, you can use Run Now to create an on-demand recovery point 

conversion to virtual disk format. A manual conversion starts immediately.

To run an existing virtual conversion job immediately

On the Tasks menu, click Run or Manage Virtual Conversions.

Select the name of a conversion job that you want to run immediately.

On the toolbar, click Run Now.

See Viewing the properties of a virtual conversion job.

See Viewing the progress of a virtual conversion job.

See Editing a virtual conversion job.

See Deleting a virtual conversion job.

Viewing the properties of a virtual conversion job
You can use Properties for a selected virtual conversion job to review a summary of the settings, 

options, and assigned schedule.

To view the properties of a virtual conversion job

On the Tasks menu, click Run or Manage Virtual Conversions.

Select the name of a conversion job whose properties you want to view.

On the Tasks menu, click Properties.

Click OK.

See Viewing the progress of a virtual conversion job.

See Editing a virtual conversion job.

See Running an existing virtual conversion job immediately.

See Deleting a virtual conversion job.
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Viewing the progress of a virtual conversion job
You can view the progress of a virtual conversion job while it runs to determine how much time 

remains until the conversion completes.

To view the progress of a virtual conversion job

Do one of the following:

On the View menu, click Progress and Performance.

On the Tasks menu, click Run or Manage Virtual Conversions, and then on the View 

menu, clickProgress and Performance.

See Viewing the properties of a virtual conversion job.

See Editing a virtual conversion job.

See Running an existing virtual conversion job immediately.

See Deleting a virtual conversion job.

Editing a virtual conversion job
You can edit the schedule portion of an existing conversion job or you can edit all aspects of the 

job.

To edit a virtual conversion job

On the Tasks menu, click Run or Manage Virtual Conversions.

Select the name of a conversion job that you want to edit.

Do one of the following:

TO CHANGE THE SCHEDULE ON THE TOOLBAR, CLICK CHANGE 
SCHEDULE .

MAKE CHANGES TO THE CONVERSION 
SCHEDULE, AND THEN CLICK OK .

To change the job settings On the toolbar, click Edit Settings .

Make the changes you want in each wizard 
pane, and then click Finish .
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See Viewing the properties of a virtual conversion job.

See Viewing the progress of a virtual conversion job.

See Running an existing virtual conversion job immediately.

See Deleting a virtual conversion job.

Deleting a virtual conversion job
You can delete virtual conversion jobs you no longer need or use.

When you delete a virtual conversion job, no recovery points or virtual disks are deleted from the 

storage location. Only the conversion job itself is deleted.

To delete a virtual conversion job

On the Tasks menu, click Run or Manage Virtual Conversions.

Select the names of one or more conversion jobs that you want to delete.

On the toolbar, click Remove.

Click Yes to confirm the deletion.

See Viewing the properties of a virtual conversion job.

See Viewing the progress of a virtual conversion job.

See Editing a virtual conversion job.

See Running an existing virtual conversion job immediately.

Running a one-time conversion of a physical recovery point to a 
virtual disk
You can use Veritas System Recovery to convert recovery points of a physical computer to 

VMware virtual disk. You can create a schedule to convert recovery points to a VMware virtual disk 

(.vmdk format) or a Microsoft virtual disk (.vhd format).

“ ”
Note: If the disk sector size is 4K, the Microsoft virtual disk can only be converted to a .vhdx 

format.
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“ ”
You can also convert recovery points directly to VMware ESXi Server. Virtual disks are excellent for 

testing and evaluation purposes.

“ ”
Note: You cannot convert a 4K disk to a .vmdk format.

“ ”
You can find a list of platforms that support the virtual disks that are created from recovery points in 

the software compatibility list. The software compatibility list is available at the following URL:

https://www.veritas.com/content/support/en_US/doc/VSR_22_SCL

You can also create scheduled recovery point conversions to virtual disks.

See Defining a virtual conversion job.

To run a one-time recovery point conversion to virtual disk

On the Tasks menu, click One Time Virtual Conversion.

Click the virtual disk type (and version, if applicable) that you want to create, and then click 

Next.

VMWARE VIRTUAL DISK (.VMDK) CONVERTS THE RECOVERY POINTS TO 
A .VMDK FORMAT. THIS FORMAT ONLY 
SUPPORTS WORKSTATION VERSION 8.

VMware ESXi Server Converts the recovery points to a VMware 
ESXi Server.

Note: Veritas System Recovery .0.2 no 
longer supports physical to virtual conversion 
for ESXi on a 32-bit operating system.

Microsoft Virtual Disk The .vhd format is supported for all versions 
before Windows 8 and the .vhdx format is 
supported for Windows 8 and above.

https://www.veritas.com/content/support/en_US/doc/VSR_22_SCL
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VMWARE VIRTUAL DISK (.VMDK) CONVERTS THE RECOVERY POINTS TO 
A .VMDK FORMAT. THIS FORMAT ONLY 
SUPPORTS WORKSTATION VERSION 8.

Note: The Microsoft Virtual Disk type 
supports .vhd and .vhdx conversions. 
The .vhd conversion is available for all 
operating systems. The .vhdx conversion is 
only available for Windows 8/2012 R2 and 
above. If the sector size is 4K, the virtual disk 
can only be converted to a .vhdx format.

Do one of the following:

Click View all recovery points near the bottom of the pane, and then select a recovery 

point in the list based on its creation date.

In the View by list, select a recovery point source.

“ ”
Note: If you have specified a password while defining a backup job, theEnter 

Passworddialog box is displayed. Enter the password that you specified when you created 

the backup job and clickOK.

“ ”
Source options when you view recovery points by Date

VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

Date Lets you select an alternate date by using the 
drop-down calendar. Use the calendar if no 
recovery points are discovered and displayed 
in the table.

View all recovery points Lets you view all recovery points that are 
available.
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VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

Sector Size Lets you view the sector size, which is 
displayed as 4K or 512.

Source options when you view recovery points by File name

VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

File name Specifies a path and a file name of a recovery 
point.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.v2i  or 
DiskNo-PartitionNo\Filename.iv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.v2i. Where 2 is the disk number and 3 
is the partition number.

Browse Lets you browse to a path that contains a 
recovery point.

For example, you can browse for a recovery 
point (.v2i) or incremental recovery point (.iv2i) 
file on an external (USB) drive. Or, you can 
browse to a network location, or removable 
media.

User name Specifies the user name if you specify a 
recovery point file name that is located in a 
network path.

See Rules for network credentials .

Password Specifies the password to a network path.
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Source options when you view recovery points by System

VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

Date Lets you select an alternate date of a system 
index file by using the drop-down calendar. 
Use the calendar if no recovery points are 
discovered and displayed in the table.

Perform conversion using latest recovery 
points for this computer

Converts the most recent recovery points that 
exist in the recovery point storage location on 
your computer.

The list of drives, source files (.v2i and .iv2i 
files), and dates comes from the most current 
system index file (.sv2i).

Perform conversion using recovery points for 
another computer

Converts the recovery points that exist on 
another computer.

Browse to and select the .sv2i file for the 
desired system

Specifies a path to a system index file (.sv2i) 
that resides elsewhere, such as a network 
location.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:
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VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

DiskNo-PartitionNo\Filename.sv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.sv2i. Where 2 is the disk number and 3 
is the partition number.

If you selected a system index file that is 
stored on a network, you are prompted for your 
network credentials.

See Rules for network credentials .

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index file.

Drives Lets you select the drives with the recovery 
points that you want to convert based on the 
selected system index file.
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VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

Sector Size Lets you view the sector size, which is 
displayed as 4K or 512.

Click Next.

Set the virtual disk destination options based on the virtual disk format and version (if 

applicable) that you selected, and then click Next.

Virtual Disks Destination options for converting to VMware virtual disk or Microsoft virtual disk

FOLDER FOR VIRTUAL DISKS LETS YOU TYPE THE PATH TO THE FOLDER 
WHERE YOU WANT TO PLACE THE VIRTUAL 

DISK FILES.

NOTE: WHEN YOU SELECT A FOLDER TO 
PLACE THE VIRTUAL DISK FILES, 

THESECTOR SIZEOF THE SOURCE AND 
DESTINATION MUST BE THE SAME.

Browse Lets you browse to locate the folder in which 
you want to place the virtual disk files.

User name Lets you type the user name if you specified a 
virtual disk folder location on a network

See Rules for network credentials .
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FOLDER FOR VIRTUAL DISKS LETS YOU TYPE THE PATH TO THE FOLDER 
WHERE YOU WANT TO PLACE THE VIRTUAL 

DISK FILES.

NOTE: WHEN YOU SELECT A FOLDER TO 
PLACE THE VIRTUAL DISK FILES, 

THESECTOR SIZEOF THE SOURCE AND 
DESTINATION MUST BE THE SAME.

Password Specifies the password to a network path.

Create one virtual disk per volume Lets you create one virtual disk file per volume.

If you do not select this option, each drive is 
matched to its respective hard drive letter 
assignment during the conversion. Therefore, it 
results in multiple drives within one virtual disk 
file.

Note: This option is not available if the 
volumes are on separate disks.

Rename Lets you edit the file name of the resulting 
virtual disk file.

Virtual Disks Destination options for converting to VMware ESXi Server

ESXI SERVER NAME OR IP ADDRESS INDICATES THE NAME OF THE SERVER OR 
THE SERVER'S IP ADDRESS.

User name Indicates a valid administrator user name that 
has sufficient rights to an ESXi server.

Password Indicates a valid password to the ESXi server.

Destination for the virtual disks Indicates the path to the folder where you want 
to place the virtual disk files.

Browse Lets you browse to a destination location for 
the virtual disks.

Rename Lets you edit the name of the resulting virtual 
disk file.
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ESXI SERVER NAME OR IP ADDRESS INDICATES THE NAME OF THE SERVER OR 
THE SERVER'S IP ADDRESS.

Next Specifies a temporary location options for 
VMware ESXi Server virtual disks.

Temporary location for conversion Lets you type the name of the server or the 
server's IP address that you can use as a 
temporary location for files.

Temporary Location Credentials Lets you type a valid administrator user name 
and password that has sufficient rights.

Set the general conversion options you want, and then click Next.

SPLIT VIRTUAL DISK INTO 2 GB (.VMDK) 
FILES

SPLITS THE VIRTUAL DISK INTO 
MULTIPLE 2 GB .VMDK FILES.

FOR EXAMPLE, USE THIS OPTION IF 
YOUR VIRTUAL DISK IS STORED ON A 

FAT32 DRIVE. OR, ANY FILE SYSTEM THAT 
DOES NOT SUPPORT FILES LARGER 

THAN 2 GB. OR, IF YOU WANT TO COPY 
THE VIRTUAL DISK FILES TO A DVD BUT 

THE SIZE IS LARGER THAN THE DVD 
ALLOWS.

NOTE: THIS OPTION IS SPECIFIC TO 
VMWARE; IT IS NOT AVAILABLE IF YOU 

SELECTEDMICROSOFT VIRTUAL DISKAS 
THE CONVERSION FORMAT.

Review the summary of the choices you made.

If you need to make any changes, click Back.

Click Finish.

See Viewing the properties of a virtual conversion job.

See Viewing the progress of a virtual conversion job.

See Editing a virtual conversion job.
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See Running an existing virtual conversion job immediately.

See Deleting a virtual conversion job.
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Managing cloud storage

This section includes the following topics:

Direct to cloud

Downloading OpenStorage Files

How Offsite Copy works for cloud storage

About creation of Amazon Machine Image (AMI) in Amazon from Veritas System Recovery 

backups

About S3-Compatible Cloud Storage

About Veritas System Recovery supporting Veritas Access

About the Cloud Instance Creator Utility

Direct to cloud
You can now enable cloud storage as the primary destination when you define backups and during 

restore.

You are not required to maintain large amounts of data on-premise. Cloud storage gives you the 

flexibility of maintaining large amounts of data. You can access data from anywhere, at any time.

If a disaster occurs, as all your data is maintained in the cloud, there is no data loss and you can 

recover your data at any time.

For backups you can specify the OpenStorage destination when you define a drive based backup, 

a one time backup, and also when you backup using Veritas System Recovery Disk.

For restores, you can specify the OpenStorage destination when you restore files and folders, 

drives, and use the Veritas System Recovery Disk for restore.

“ ”
Note: Although cloud storage is a part of OpenStorage, Veritas System Recovery 23 refers to 

cloud storage as OpenStorage.
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“ ”
You can provide OpenStorage as a primary destination. The path for OpenStorage logical storage 

unit must be:

Microsoft Azure storage path: Azure:azure:azure.com/container name- Amazon S3 Storage 

path: S3:amazon:amazon.com/bucket name- Generic S3 Storage path: S3:compatible-with-

s3:instance name/bucket name- Veritas Access Storage path: S3:vtas-access:instance name/

bucket name

“ ”
Note: In Veritas System Recovery, a bucket and container are referred to as a logical storage 

unit.

“ ”
The Direct to cloud feature is supported only on a 64-bit operating system.

You cannot restore recovery points from the cloud storage using the Granular Restore Option.

You cannot directly create a .vhd or .vhdx file to cloud and cannot use a .v2i file as a source for 

physical to virtual conversions.

See About S3-Compatible Cloud Storage.

See Using S3-Compatible Cloud Storage in Veritas System Recovery.

See About Veritas System Recovery supporting Veritas Access.

See Using Veritas Access Storage in Veritas System Recovery.

See Defining a drive-based backup.

See Running a one-time backup from Veritas System Recovery.

See Running a backup from Veritas System Recovery Disk.

See Running an existing backup job immediately.

See Opening and restoring files within a recovery point browser.
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See Copying recovery points.

See Recovering files and folders.

See Recovering a secondary drive.

See Recovering a drive.

See Recovering files and folders by using Veritas System Recovery Disk.

See Recovering a computer.

See Recovering a computer with different hardware.

Providing the OpenStorage destination path
When you define OpenStorage destination path for cloud storage, you must do the following:

For Amazon S3

To specify the OpenStorage destination, type S3:amazon:amazon.com/\< bucket name\>Where\< 

bucket name\> is the location on the Amazon S3 storage.

For Microsoft Azure

To specify the OpenStorage destination, type Azure:azure:azure.com/\< container_name\>Where\< 

container_name\> is the location on the Microsoft Azure storage.

For Generic S3

To specify the Generic S3 destination, type S3:compatible-with-s3:\< instance name\>/\< bucket 

name\>Wherecompatible-with-s3:instance nameis the server name that you specify andinstance 

name is created using the Cloud Instance Creator Utility.

For Veritas Access

To specify the OpenStorage destination, type S3:vtas-access:\< instance name\>/\< bucket 

name\>Wherevtas-access:instance nameis the server name that you specify andinstance name is 

created using the Cloud Instance Creator Utility.

See Defining a drive-based backup.

See About S3-Compatible Cloud Storage.

See Using S3-Compatible Cloud Storage in Veritas System Recovery.
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See About Veritas System Recovery supporting Veritas Access.

See Using Veritas Access Storage in Veritas System Recovery.

OpenStorage destination options for backups
The following table describes the options on the OpenStorage Destination dialog box.

Table: OpenStorage destination options for backups

OPENSTORAGE 
DESTINATION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

- Server type Server 
name

Log on: 
User name

Log on: 
Password

Logical 
storage unit

Amazon S3 S3 amazon:amazon.comAmazon 
account 
access key.

Amazon 
account 
secret key.

The storage

unit is called 
a bucket.

Microsoft 
Azure

Azure azure:azure.com Microsoft 
Azure 
storage user 
name.

Microsoft 
Azure 
storage 
account 
access key. 
You can 
enter the 
primary 
access key 
or the 
secondary 
access key.

The storage 
unit is called 
a container/
blob.

Generic S3 S3 compatible-
with-S3: 
instance 
name

Provider 
account 
access key.

Provider 
account 
secret key.

The storage

unit is called 
a bucket.
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OPENSTORAGE 
DESTINATION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

Veritas 
Access

S3 vtas-access: 
instance 
name

Provider 
account 
access key.

Provider 
account 
secret key.

The storage

unit is called 
a bucket.

“ ”
Note: For Generic S3 and Veritas Access, you can create the cloud instance using the Cloud 

Instance Creator Utility and use the cloud instance as the OpenStorage destination when you 

define backups.

“ ”
See About S3-Compatible Cloud Storage.

See Using S3-Compatible Cloud Storage in Veritas System Recovery.

See About Veritas System Recovery supporting Veritas Access.

See Using Veritas Access Storage in Veritas System Recovery.

See About the Cloud Instance Creator Utility.

See Defining a drive-based backup.

See Using Amazon S3 storage as your Offsite Copy destination.

See Using Microsoft Azure as your offsite copy destination.

See Downloading OpenStorage Files.

See Running a one-time backup from Veritas System Recovery.

See Running a backup from Veritas System Recovery Disk.

See Running an existing backup job immediately.
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OpenStorage destination options for recovery
The following table describes the options on the OpenStorage Destination dialog box.

Table: OpenStorage destination options for recovery

OPENSTORAGE 
DESTINATION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

- Server type Server 
name

Log on: 
User name

Log on: 
Password

Logical 
storage unit

Amazon S3 S3 amazon:amazon.comAmazon 
account 
access key.

Amazon 
account 
secret key.

The storage

unit is called 
a bucket.

Microsoft 
Azure

Azure azure:azure.com Microsoft 
Azure 
storage user 
name.

Microsoft 
Azure 
storage 
account 
access key. 
You can 
enter the 
primary 
access key 
or the 
secondary 
access key.

The storage 
unit is called 
a container/
blob.

Generic S3 S3 compatible-
with-S3: 
instance 
name

Provider 
account 
access key.

Provider 
account 
secret key.

The storage

unit is called 
a bucket.

Veritas 
Access

S3 vtas-access: 
instance 
name

Provider 
account 
access key.

Provider 
account 
secret key.

The storage
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OPENSTORAGE 
DESTINATION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

OPTION 
AND 

DESCRIPTION

unit is called 
a bucket.

Click OK.

The OpenStorage File Selection dialog box is displayed.

Based on the logical storage unit that you select, all available recovery points are listed. In Select 

the recovery points (*.v2i) that you want to restore, select the recovery points.

For the recover my computer, recover files and folders, recovery point browser, the Filename 

option, lets you select only one .v2i, .iv2i file and for System, you can select only one .sv2i file.

“ ”
Note: For Generic S3 and Veritas Access, you can create the cloud instance using the Cloud 

Instance Creator Utility and use the cloud instance and restore from OpenStorage.

“ ”
See About the Cloud Instance Creator Utility.

See About S3-Compatible Cloud Storage.

See Using S3-Compatible Cloud Storage in Veritas System Recovery.

See About Veritas System Recovery supporting Veritas Access.

See Using Veritas Access Storage in Veritas System Recovery.

See Recovering files and folders.

See Recovering a secondary drive.

See Recovering a drive.

See Recovering files and folders by using Veritas System Recovery Disk.
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See Recovering a computer.

See Recovering a computer with different hardware.

See Opening and restoring files within a recovery point browser.

See Copying recovery points.

Downloading OpenStorage Files
When you use the Offsite Copy option to backup your recovery points to the Amazon S3 or 

Microsoft Azure storage, these files (recovery points) are available in OST (OpenStorage 

Technology) format. You must download these files to your computer or a network destination to 

use them to restore your computer. Veritas System Recovery 23 has created a utility using which 

you can select the OpenStorage location (Amazon S3 or Microsoft Azure storage), the files that 

you want to download, and then download the files.

To download OpenStorage files

On the View menu, click Tools.

Click Download OpenStorage Files and select the appropriate options.

OPENSTORAGE LOCATION LETS YOU SELECT THE OPENSTORAGE 
LOCATION FROM WHERE YOU WANT TO 

DOWNLOAD THE RECOVERY POINTS.

CLICK THE BROWSE FOR OPENSTORAGE 
DESTINATION ICON TO CHANGE THE 

LOGICAL STORAGE UNIT NAME AND THE 
LOGON CREDENTIALS. REFER TO STEP 

9  OF THE DEFINING A DRIVE-BASED 

BACKUP  PROCEDURE.

SEE DEFINING A DRIVE-BASED BACKUP .

Download destination Lets you select the destination to where you 
want to download the recovery points. You 
can click Browse and save the recovery 
points to your computer or a network 
location.

Download destination details Lets you view the details of the download 
destination that you selected.
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OPENSTORAGE LOCATION LETS YOU SELECT THE OPENSTORAGE 
LOCATION FROM WHERE YOU WANT TO 

DOWNLOAD THE RECOVERY POINTS.

CLICK THE BROWSE FOR OPENSTORAGE 
DESTINATION ICON TO CHANGE THE 

LOGICAL STORAGE UNIT NAME AND THE 
LOGON CREDENTIALS. REFER TO STEP 

9  OF THE DEFINING A DRIVE-BASED 

BACKUP  PROCEDURE.

SEE DEFINING A DRIVE-BASED BACKUP .

If you selected a network location, click Edit 
to update the network credentials.

Files available in the OpenStorage location Lets you select the files (recovery points) 
that you want to download.

Select file types available in the 
OpenStorage location

Displays the type of files that you can 
download.

Recovery Points (.v2i,.iv2i,*.sv2i)

Click OK.

See Using Amazon S3 storage as your Offsite Copy destination.

See Using Microsoft Azure as your offsite copy destination.

See Using S3-Compatible or Veritas Access as your offsite copy destination.

How Offsite Copy works for cloud storage
Using Amazon S3 storage as your Offsite Copy destination

When you create or edit a backup job, you can provide an Amazon S3 storage as an offsite 

destination. After the backup is complete, the recovery points are copied at the offsite destination 

(Amazon S3 storage).

Requirements for using the Amazon S3 storage

Veritas System Recovery 23 installed.

An Amazon S3 account

http://docs.aws.amazon.com/AmazonS3/latest/gsg/SigningUpforS3.html


VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

323

◦

◦

•

•

•

An Amazon access key

An Amazon secret key

An Amazon S3 bucket

You must create buckets before configuring the offsite destination in Veritas System Recovery. The 

buckets are not available for use in Veritas System Recovery if the bucket name does not comply 

with the bucket naming convention.

Refer to the following technote to view the bucket naming conventions:

http://www.veritas.com/docs/000107885

Ensure that you have Internet connectivity and access to HTTP (Port 80) and HTTPS (Port 

443).

The recovery points created during backup are stored on the cloud storage as OST (OpenStorage 

Technology) files. You cannot directly restore your computer using the OST files available on the 

Amazon S3 storage. You must first download these recovery points using the Download 

OpenStorage Files utility to your computer or a network location and then start the restore process.

See Downloading OpenStorage Files.

Using Microsoft Azure as your offsite copy destination

When you create or edit a backup job, you can provide a Microsoft Azure storage as an offsite 

destination. After the backup is complete, the recovery points are copied at the offsite destination 

(Microsoft Azure storage).

Requirements for using the Microsoft Azure storage

Veritas System Recovery 23 installed.

http://docs.aws.amazon.com/AWSSimpleQueueService/latest/SQSGettingStartedGuide/AWSCredentials.html
http://docs.aws.amazon.com/AWSSimpleQueueService/latest/SQSGettingStartedGuide/AWSCredentials.html
http://docs.aws.amazon.com/AmazonS3/latest/gsg/CreatingABucket.html
http://www.veritas.com/docs/000107885
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A Microsoft Azure portal account. You should also have a "Storage Account" and a "Container" 

associated with that "Storage Account.

“ ”
Note: To understand more about how to configure a "Storage Account" in Azure portal, see the 

following link: https://azure.microsoft.com/en-in/documentation/articles/storage-create-storage-

account/

“ ”
A Microsoft Azure storage account, and at least one storage access key (Primary access key or 

Secondary access key).

Ensure that the Blob Service containers are already created. Containers represent a logical unit 

of storage on the cloud-based storage device.

“ ”
Note: As a best practice, specific containers should be created to use exclusively with Veritas 

System Recovery.

“ ”
Ensure that the container names meet the following Veritas System Recovery requirements:

Container names can contain lowercase letters, numbers, and hyphens.

Containers names cannot begin with a hyphen.

“ ”
Note: The containers are not available for use in Veritas System Recovery if the container 

names do not comply with the container naming convention.

“ ”
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The recovery points created during backup are stored on the cloud storage as OST (OpenStorage 

Technology) files. You cannot directly restore your computer using the OST files available on the 

Microsoft Azure storage. You must first download these recovery points using the Download 

OpenStorage Files utility to your computer or a network location and then start the restore process.

See Downloading OpenStorage Files.

Using S3-Compatible or Veritas Access as your offsite copy destination

When you create or edit a backup job, you can provide a Generic S3 or Veritas Access storage as 

an offsite destination. After the backup is complete, the recovery points are copied at the offsite 

destination (Generic S3 or Veritas Access storage).

Requirements for using the Generic S3 or Veritas Access storage

Veritas System Recovery 23 or later installed.

Requirements as per the Generic S3 or Veritas Access storage that you have configured.

The recovery points created during backup are stored on the cloud storage as OST (OpenStorage 

Technology) files. You cannot directly restore your computer using the OST files available on the 

Generic S3 or Veritas Access storage. You must first download these recovery points using the 

Download OpenStorage Files utility to your computer or a network location and then start the 

restore process.

See Downloading OpenStorage Files.

See About S3-Compatible Cloud Storage.

See About Veritas System Recovery supporting Veritas Access.

About creation of Amazon Machine Image (AMI) in Amazon 
from Veritas System Recovery backups
You can now create an Amazon Machine Images (AMI) in Amazon cloud using Veritas System 

Recovery recovery points and view the status of an existing AMI. Veritas System Recovery 

provides two PowerShell scripts using which you can create AMI in Amazon cloud and view the 

status of an existing AMI. You can use the AMI to launch an EC2 instance in cloud.

CREATE_AMI_IN_AWS : Script for creating an AMI

QUERY_AMI_CREATION_STATUS : Script for viewing status of an AMI
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•

•

•

•

•

During a disaster recovery situation you can restore your machine based on the available recovery 

points. Using this feature you can bring up a virtual machine using the created AMI in Amazon Web 

Services.

Prerequisites to create an AMI in Amazon:

You must have a machine that has Veritas System Recovery 23 or later installed on it, and a 

backup job that ran successfully to create a .sv2i file. The recovery points must be in a local 

folder or a network location.

The AWS Identity and Access Management (IAM) user credential that you use must have the 

administrator role assigned.

The machine where you are running the AMI script must have AWS SDK and AWSCLI 

installed.

If you have Veritas System Recovery 23 or earlier installed on your computer, the PowerShell 

supports conversion to .vhdx or .vhd files from backups that are not password protected. You can 

create an AMI from any existing .vhdx or .vhd files.

This feature is not available from the Veritas System Recovery user interface and only available 

using the PowerShell scripts.

To create an AMI, system reserved information is required. Ensure that you create the system drive 

backup with system reserved partition along with the data drive backup.

If you have .sv2i files stored in an Amazon S3 bucket or any other cloud storage, you must first 

download the files to a local or network destination or to the machine on which the script is running. 

You cannot specify a cloud destination to select the .sv2i files.

You must use recovery points with a .vhdx or .vhd format. If you have a .sv2i file, you must first 

convert the file to a .vhdx or .vhd format. You can do this in two ways:

Convert the recovery point to a .vhdx or .vhd format using Veritas System Recovery virtual 

conversion job.

Use a PowerShell command to convert the recovery points to a .vhdx or .vhd format.

If you want to convert recovery points to a .vhdx or .vhd format, Veritas System Recovery supports 

conversion of recovery points that are less than 2 terabytes.

The CREATE_AMI_IN_AWS  script only supports a .vhdx or .vhd format and does not support 

the .vmdk format. If you convert the recovery points from Veritas System Recovery, ensure that the 

file format is .vhdx or .vhd as these are the only formats supported to create an AMI.
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1.

1.

2.

See How to create an Amazon Machine Image (AMI).

See How to view the conversion tasks and AMI status.

How to create an Amazon Machine Image (AMI)
To create an AMI, you must first convert your recovery points to a .vhdx/.vhd format. Ensure that all 

your drives are backed up including hidden drives. After you convert the .sv2i files to .vhdx/.vhd 

files either using Veritas System Recovery or the PowerShell script, you can create the AMI.

To run the CREATE_AMI_IN_AWS  script.

Run the CREATE_AMI_IN_AWS  script from the PowerShell command line in the administrator 

mode.

A message is displayed asking if you want to use a .vhdx or .vhd file for creating the AMI.

Press Yto use a .vhdx format or pressN or any other key to use a .vhd format.

“ ”
Note: The steps to create an AMI remain the same whether you pressYfor .vhdx files 

orNfor .vhd files.

“ ”
Do one of the following.
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

Press N if you do not have a .vhdx/.vhd file. Do the following in the order listed\:

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

1. Type the path of the .sv2i file, which is to 

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

be converted to a .vhdx/.vhd format. Note: If 

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

the .sv2i file is on a network location, type 

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

the credentials of the network path.

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

2. Type the path where you want to the 

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

converted .vhdx/.vhd file to be placed. Note:

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

If the .vhdx/.vhd file is to be created a 

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

network location, type the credentials of the 

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

network path. You must maintain separate 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

folders for the virtual hard disks of each 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

computer. When you create the AMI, 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

all .vhdx/.vhd files for one computer are 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

used. If .vhdx/.vhd files are not maintained 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

separately, when creating an AMI, files 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

belonging to different computers may get 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

used together.
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

3. Type the Amazon account details. Type 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

the Access Key. Type the Secret Key.
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

4. Press 1 to create a new Amazon S3 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

bucket or press 2 for an existing bucket.
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

5. If you pressed 1 , type a name for the new 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

bucket, the region name, and the name of 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

the folder to be created to upload 

https://docs.aws.amazon.com/general/latest/gr/rande.html


VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

352

PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

the .vhdx/.vhd files. For more information 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

about AWS regions, refer to the following 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

link: https://docs.aws.amazon.com/general/
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

latest/gr/rande.html If you pressed 2 , type 

https://docs.aws.amazon.com/general/latest/gr/rande.html
https://docs.aws.amazon.com/general/latest/gr/rande.html


VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

356

PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

the name of the existing bucket, the region of 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

the bucket, and the name of the folder to 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

upload the .vhdx/.vhd files. After you enter all 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

the inputs, the .sv2i file is converted 
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

to .vhdx/.vhd file, the .vhdx/.vhd files are 

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

uploaded. The AMI is created, and you can 

https://docs.aws.amazon.com/general/latest/gr/rande.html
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PRESS Y IF YOU ALREADY HAVE 
A .VHDX/.VHD FILE

DO THE FOLLOWING IN THE ORDER 
LISTED\:

1. PRESS 1 TO UPLOAD THE .VHDX/.VHD 
TO AN AMAZON S3 BUCKET BEFORE 
CREATING THE AMI OR PRESS 2 IF 
THE .VHDX/.VHD FILE IS ALREADY 

AVAILABLE IN AN AMAZON S3 BUCKET.

2. IF YOU PRESSED 1 , ENTER THE PATH 
WHERE THE .VHDX/.VHD FILE IS 

LOCATED. NOTE: IF THE .VHDX/.VHD FILE 
IS AVAILABLE AT A NETWORK LOCATION, 

ENTER THE CREDENTIALS OF THE 
NETWORK PATH. YOU MUST MAINTAIN 

SEPARATE FOLDERS FOR THE VIRTUAL 
HARD DISKS OF EACH COMPUTER. WHEN 

YOU CREATE THE AMI, ALL .VHDX/.VHD 
FILES FOR ONE COMPUTER ARE USED. 

IF .VHDX/.VHD FILES ARE NOT 
MAINTAINED SEPARATELY, WHEN 

CREATING AN AMI, FILES BELONGING TO 
DIFFERENT COMPUTERS MAY GET USED 

TOGETHER. IF YOU PRESSED 2 , 
CONTINUE FROM STEP 3.

3. TYPE THE AMAZON ACCOUNT DETAILS. 
TYPE THE ACCESS KEY. TYPE SECRET 

KEY.

4. PRESS 1 TO CREATE A NEW BUCKET 
OR PRESS 2 FOR AN EXISTING BUCKET.

5. IF YOU PRESSED 1 , TYPE A NAME FOR 
THE NEW BUCKET, THE REGION NAME, 
AND THE NAME OF THE FOLDER TO BE 
CREATED TO UPLOAD THE .VHDX/.VHD 

FILES. FOR MORE INFORMATION ABOUT 
AWS REGIONS, REFER TO THE 

FOLLOWING LINK: HTTPS://
DOCS.AWS.AMAZON.COM/GENERAL/

LATEST/GR/RANDE.HTML IF YOU 
PRESSED 2 , TYPE THE NAME OF THE 

EXISTING BUCKET, THE REGION OF THE 
BUCKET, AND THE NAME OF THE FOLDER 

TO UPLOAD THE .VHDX/.VHD FILES. 
AFTER YOU ENTER ALL THE INPUTS, THE 

VHDX/VHD FILES ARE UPLOADED, THE 
AMI IS CREATED, AND YOU CAN VIEW 

THE CREATED AMI IN THE AWS ACCOUNT.

view the created AMI in the AWS account.

https://docs.aws.amazon.com/general/latest/gr/rande.html


VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

363
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When the script creates the AMI, an ImportTaskId is generated. The AMI is then created with an 

AMI ID and listed on the Amazon account. You can right-click the AMI and launch the EC2 

instance.

See About creation of Amazon Machine Image (AMI) in Amazon from Veritas System Recovery 

backups.

How to view the conversion tasks and AMI status
For any AMI you have already created, you can view the list of all conversion tasks for your region. 

You can also view the status of any AMI that you created using the ImportTaskId.

To view the conversion tasks and AMI status

Run the QUERY_AMI_CREATION_STATUS  script from the PowerShell command line in the 

administrator's mode.

Press 1to view the status of all conversion tasks in your region or press2to view the status of 

AMI creation byImportTaskId.

If you press 2, enter theImportTaskIdin the following format:import-ami-ID , where the ID is 

replaced with the ImportTaskId number.

See About creation of Amazon Machine Image (AMI) in Amazon from Veritas System Recovery 

backups.

See How to create an Amazon Machine Image (AMI).

About S3-Compatible Cloud Storage
Veritas System Recovery provides the S3-compatible cloud storage feature. You can use the Cloud 

Instance Creator utility to create an instance for the S3-compatible provider.

Veritas System Recovery supports only signature Version 2 for the S3-compatible cloud storage.

The created cloud instance can access S3 compatible cloud environments. S3 compatible 

communications have not been tested in all cloud environments and may not work in some cases.

“ ”
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Note: Create the Veritas System Recovery Disk/LightsOut Restore after adding the generic cloud 

instances if you want to use S3-Compatible cloud storage from Veritas System Recovery Disk/

LightsOut Restore environment.

“ ”
See Using S3-Compatible Cloud Storage in Veritas System Recovery.

See About the Cloud Instance Creator Utility.

Using S3-Compatible Cloud Storage in Veritas System Recovery
You can use S3-compatible cloud storage that Veritas System Recovery can access.

To use S3-Compatible cloud storage in Veritas System Recovery

Open the Cloud Instance Creator Utility using the command prompt in the administrator mode.

The Cloud Instance Creator Utility is located at the following path:

\< VSR Installation folder\>/Agent folder

Create a cloud instance using the Cloud Instance Creator utility.

To create a cloud instance, you must pre-configure a user account and buckets in the cloud 

environment.

For S3, following is the example command

CloudInstance.exe -addinstance

CloudInstance Name: CloudInstance0001

CloudInstance Provider: compatible-with-s3

CloudInstance ServiceHost: s3.yourendpoint.com

SSL Supported <0/1/2>: 2

HTTP Port: 80

HTTPS Port: 443

Where ServiceHost  is replaced with your cloud service host endpoint address.
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Veritas System Recovery supports the SSL protocol. While creating a cloud instance you can 

decide to use the SSL protocol. It is recommended that SSL be set to be 2  (Full). SSL: 0 

(disabled) and SSL: 1 (AuthenticationOnly).

Use 80 as the HTTP Port and 443 as the HTTPS Port. These are the default ports. You can 

change the ports as per your server settings.

Ensure that the S3-compatible cloud-based storage server has a Certificate Authority (CA)-signed 

certificate. Veritas System Recovery supports only CA-signed certificates while it communicates 

with the S3-compatible cloud storage in the SSL mode. If it does not have the CA-signed 

certificate, data transfer between Veritas System Recovery and the S3-compatible cloud provider 

may fail in the SSL mode.

Create a new backup job in Veritas System Recovery and in the OpenStorage Destination 

dialog box select S3 as the server type and enter the details of the created cloud instance that 

can be used to access S3 compatible cloud.

For example, in Server Type, selectS3and inServer Name, entercompatible-with-

s3:CloudInstance0001(cloudinstance provider:cloudinstance name)

See About S3-Compatible Cloud Storage.

See About the Cloud Instance Creator Utility.

About Veritas System Recovery supporting Veritas Access
Veritas™ Access is a software-defined, scale-out network-attached storage (NAS) solution. Veritas 

System Recovery supports Veritas Access. You can back up your data to your local Veritas Access 

storage or use it as a cloud provider to migrate your data from the local access storage to cloud.

From the Cloud Instance Creator utility, you can create a cloud instance and provide Veritas 

Access as a cloud provider. Use the cloud instance as the OpenStorage destination when you 

define backups and restore from OpenStorage.

“ ”
Note: Create the Veritas System Recovery Disk/LightsOut Restore after adding the generic cloud 

instances if you want to use S3-Compatible cloud storage from Veritas System Recovery Disk/

LightsOut Restore environment.
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“ ”
See Using Veritas Access Storage in Veritas System Recovery.

Using Veritas Access Storage in Veritas System Recovery
You can use Veritas Access cloud storage that Veritas System Recovery can access.

To use Veritas Access cloud storage in Veritas System Recovery

Open the Cloud Instance Creator Utility using the command prompt in administrator mode.

The Cloud Instance Creator Utility is located at the following path:

\< VSR Installation folder\>/Agent folder

Create a Veritas Access cloud instance using the Cloud Instance Creator utility.

CloudInstance.exe -addinstance

CloudInstance Name: CloudInstance0001

CloudInstance Provider: vtas-access

CloudInstance ServiceHost: s3.yourservicehost.com

SSL Supported <0/1/2>: 2

HTTP Port: 8143

HTTPS Port: 443

Where ServiceHost  is replaced with your cloud service host endpoint address.

Veritas System Recovery supports the SSL protocol. While creating a cloud instance you can 

decide to use the SSL protocol. It is recommended that SSL be set to 2  (Full). SSL: 0 (disabled) 

and SSL: 1 (AuthenticationOnly).

Use 8143 as the HTTP Port and 443 as the HTTPS Port. These are the default ports. You can 

change the ports as per your server settings.

Create a new backup job in Veritas System Recovery and in the OpenStorage Destination 

dialog box select S3 as the server type and enter the details of the created Veritas Access 

cloud instance that can be used to access Veritas Access storage.
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For example, in Server Type, selectS3and inServer Name, entervtas-

access:CloudInstance0001(cloudinstance provider:cloudinstance name)

See About the Cloud Instance Creator Utility.

See About Veritas System Recovery supporting Veritas Access.

About the Cloud Instance Creator Utility
The Cloud Instance Creator Utility is a tool that can be used to create a cloud instance for S3 

compatible and Veritas Access cloud storage environments. Any cloud providers that use S3 

protocol, can create the cloud instance.

You can use this cloud instance when you create backups using Veritas System Recovery. In the 

OpenStorage Destination dialog box select S3 as the server type and enter the details of the 

created cloud instance that can be used to access S3 compatible and Veritas Access cloud 

storage.

There are three functions that you can perform with this utility.

Creating a cloud instance

Viewing a cloud instance

Deleting a cloud instance

Syntax

CloudInstance [-addinstance] [-getinstance] [-deleteinstance] [-help]

The Cloud Instance Creator Utility is located at the following path:

\< VSR Installation folder\>/Agent folder

Creating a cloud instance

Synopsis

Creates a new cloud instance.

CloudInstance.exe -addinstance

CloudInstance Name: CloudInstance0001

CloudInstance Provider: compatible-with-s3
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CloudInstance ServiceHost: s3.yourendpoint.com

SSL Supported <0/1/2>: 2

HTTP Port: 80

HTTPS Port: 443

Instance CloudInstance0001 added successfully

Where

CloudInstance Name

Specifies the name of the new cloud instance. Cloud instance name can contain letters, numbers, 

and dashes (or hyphens). It cannot begin with a dash (or a hyphen).

CloudInstance Provider

Specifies the provider of the cloud instance.

CloudInstance ServiceHost

Specifies the cloud server endpoint address.

SSL Supported <0/1/2>

Specifies the SSL mode that is used for communication with the cloud instance.

0: Disabled

1: AuthenticationOnly

2: Full

HTTP Port

Specifies the http port of the cloud instance.

HTTPS Port

Specifies the https port of the cloud instance.

Viewing a cloud instance

Synopsis

Gets all of the instances created using the utility.
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CloudInstance.exe -getinstance

Deleting a cloud instance

Synopsis

Removes a instance created using the utility.

CloudInstance.exe -deleteinstance

Instance Name: CloudInstance0001

Deletion successful for instance: CloudInstance0001

Displaying Help

Synopsis

Displays help on how to use CloudInstance.exe.

CloudInstance.exe -help

Usage CloudInstance [-addinstance] [-getinstance] [-deleteinstance] [-help]

-addinstance : add a custom cloud instance

-getinstance : get custom cloud instance

-deleteinstance : delete custom cloud instance

-help : Display this help message

See About S3-Compatible Cloud Storage.

See Using S3-Compatible Cloud Storage in Veritas System Recovery.

See About Veritas System Recovery supporting Veritas Access.

See Using Veritas Access Storage in Veritas System Recovery.
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Recovering files, folders, or entire drives

This section includes the following topics:

About recovering lost data

Recovering files and folders by using file and folder backup data

Recovering files and folders

Recovering a secondary drive

Recovering a drive

Exploring files and folders on your computer by using Veritas System Recovery Disk

Recovering files and folders by using Veritas System Recovery Disk

About recovering lost data
Veritas System Recovery can restore lost files, folders, or entire drives by using recovery points or 

file and folder backup data.

You must have either a recovery point or file and folder backup data to recover lost files and 

folders. You must have a recovery point to recover an entire drive. You can recover recent changes 

to a lost file or folder. However, your backup data must be at least as current as the changes that 

were made to the lost file or folder.

See Recovering files and folders by using file and folder backup data.

See Recovering files and folders.

Recovering files and folders by using file and folder backup data
If you defined a backup of files and folders and need to recover files, you can recover them from a 

recent file and folder backup.

Veritas System Recovery includes a search tool to help you locate the files that you want to 

recover.

See About recovering lost data.

To recover files and folders by using file and folder backup data
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On the Tasks menu, click Recover My Files.

In the left pane of the Recover My Files dialog box, select File and Folder as the search 

method.

Do one of the following:

In the Find files to recover search box, type the whole name or partial name of a file or 

folder that you want to restore. Click Search.

For example, type recipe . Any file or folder that includes the word recipe in its name such as 

Chocolate Cheesecake Recipes.doc, Cathy Read Recipes.xls, Recipes for Success.mp3 are 

found.

Click Advanced Search, type or select your search criteria, and then clickSearch.

NAME SPECIFY A FILE NAME THAT YOU WANT 
TO SEARCH.

YOU CAN USE THE FOLLOWING OPTIONS 
TO FILTER YOUR SEARCH:

- CONTAINS

- IS

- STARTS WITH

- ENDS WITH

Look in Lets you select the local drives or folders for 
a file.

Select the Include subfolders check box to 
extend the search to the subfolders of the 
drives or folders.

File date/time Lets you select the time and the date of a file 
by using the drop-down calendar.

You can use the following options to filter 
your search:

- anytime
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NAME SPECIFY A FILE NAME THAT YOU WANT 
TO SEARCH.

YOU CAN USE THE FOLLOWING OPTIONS 
TO FILTER YOUR SEARCH:

- CONTAINS

- IS

- STARTS WITH

- ENDS WITH

- on

- before

- after

- between

File size Lets you specify the size of the file that you 
want to search in KB, MB, or GB.

You can use the following options to filter 
your search:

- any size

- less than

- greater than

- between

To return to the standard search text box, click Basic search.

In the search results list box, select the files that you want to restore.

Click Recover Files.

In the Recover My Files dialog box, do one of the following:

Click Original folders to restore your files to the same folders where they existed when 

they were backed up.
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If you want to replace the original files, select Overwrite existing files. If you do not select this 

option, a number is added to the file name. The original file is untouched.

“ ”
Caution: TheOverwrite existing filesoption replaces your original files with the files that you 

restore. Or, it replaces the files of the same names that are currently stored at that location.

“ ”
Click Recovered Files folder on the desktop to restore your files to a Recovered Files folder 

on your Windows desktop.

Veritas System Recovery creates this folder during the restore.

Click Alternate folder and type the path to the location in which you want to restore your files.

Click Recover.

If you are prompted to replace the existing file, click Yes. Be certain that the file that you what 

to recover is the file that you want.

Click OK.

See Recovering files and folders.

Recovering files and folders
You can restore files or folders using recovery points if you have defined and run a drive-based 

backup.

See About recovering lost data.

To recover files and folders by using a recovery point

On the Tasks menu, click Recover My Files

In the left pane of the Recover My Files dialog box, selectRecovery Point as the search 

method.

If you want to use a different recovery point than the one selected for you in the Recovery Point 

dialog box, click Change. Locate the recovery point you want to use, and then clickOK.

Select Recovery Point options when you view recovery points by Date
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VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

Date Lets you select an alternate date by using the 
drop-down calendar. Use the calendar if no 
recovery points are discovered and displayed 
in the table.

View all recovery points Lets you view all recovery points that are 
available.

Select Recovery Point options when you view recovery points by File name

VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

File name Specifies a path and a file name of a recovery 
point.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.v2i  or 
DiskNo-PartitionNo\Filename.iv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.v2i. Where 2 is the disk number and 3 
is the partition number.

Browse Lets you browse to a path that contains a 
recovery point.

For example, you can browse for a recovery 
point (.v2i) or incremental recovery point (.iv2i) 
file on an external (USB) drive. Or, you can 
browse to a network location, or removable 
media.
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VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

Browse for OpenStorage Destination Lets you browse an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

User name Specifies the user name if you specify a 
recovery point file name that is located in a 
network path.

See Rules for network credentials .

Password Specifies the password to a network path.

Select Recovery Point options when you view recovery points by System

VIEW BY - SYSTEM USES THE CURRENT SYSTEM INDEX FILE 
THAT IS LOCATED IN THE RECOVERY POINT 
STORAGE LOCATION. THE SYSTEM INDEX 

FILE DISPLAYS A LIST OF ALL OF THE 
DRIVES ON YOUR COMPUTER AND ANY 
ASSOCIATED RECOVERY POINTS FROM 

WHICH YOU CAN SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

Date Lets you select an alternate date of a system 
index file date by using the drop-down 
calendar. Use the calendar if no recovery 
points are discovered and displayed in the 
table.
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VIEW BY - SYSTEM USES THE CURRENT SYSTEM INDEX FILE 
THAT IS LOCATED IN THE RECOVERY POINT 
STORAGE LOCATION. THE SYSTEM INDEX 

FILE DISPLAYS A LIST OF ALL OF THE 
DRIVES ON YOUR COMPUTER AND ANY 
ASSOCIATED RECOVERY POINTS FROM 

WHICH YOU CAN SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

Use latest recovery points for this computer Restores the most recent recovery points that 
exist in the recovery point storage location on 
your computer.

The list of drives, source files (.v2i and .iv2i 
files), and dates comes from the most current 
system index file (.sv2i).

Use alternate system index (.sv2i) file Restores the recovery points that exist on 
another computer.

Browse to and select the .sv2i file for the 
desired system

Specifies a path to a system index file (.sv2i) 
file that resides elsewhere, such as a network 
location.

If you selected a system index file that is 
stored on a network, you are prompted for your 
network credentials.

See Rules for network credentials .

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.sv2i
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VIEW BY - SYSTEM USES THE CURRENT SYSTEM INDEX FILE 
THAT IS LOCATED IN THE RECOVERY POINT 
STORAGE LOCATION. THE SYSTEM INDEX 

FILE DISPLAYS A LIST OF ALL OF THE 
DRIVES ON YOUR COMPUTER AND ANY 
ASSOCIATED RECOVERY POINTS FROM 

WHICH YOU CAN SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.sv2i. Where 2 is the disk number and 3 
is the partition number.

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index file.

Browse for OpenStorage Destination Lets you browse an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

Drives Lets you select the drives with the recovery 
points that you want to restore based on the 
selected system index file.

“ ”
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Note: If Veritas System Recovery cannot locate any recovery points, theSelect Recovery 

Pointdialog box opens automatically.

“ ”
In the Find files to recover field, type the whole name or partial name of a file or folder that you 

want to restore, and then click Search.

For example, type recipe . Any file or folder that includes the word recipe in its name such as 

Chocolate Cheesecake Recipes.doc, Cathy Read Recipes.xls, Recipes for Success.mp3 are 

found.

In the Name table, select the files that you want to restore.

Click Recover Files.

In the Recover My Files dialog box, select the option you want.

ORIGINAL FOLDERS RECOVERS THE FILES TO THE ORIGINAL 
FOLDER WHERE THEY EXISTED WHEN 

THEY WERE BACKED UP.

New folder ("Recovered Files") on the 
desktop

Recovers the files to a new folder that is 
created on your Windows desktop called 
Recovered Files.

Alternate folder Specifies the path to an alternate location 
where you want your files to be restored.

Click Recover.

If you are prompted to replace the existing file, click Yes. Be certain that the file that you want 

to recover is the file that you want.

Click OK.

See Recovering files and folders by using file and folder backup data.

Recovering a secondary drive
If you lose data on a secondary drive, you can use an existing recovery point for that drive to 

restore the data. A secondary drive is a drive other than the drive on which your operating system 

is installed.
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For example, your computer has a D drive and the data is lost. You can restore the D drive back to 

an earlier date and time.

To recover a drive, you must have a recovery point that includes the drive that you want to recover. 

If you are not sure, review the Status page to determine what recovery points are available.

See Icons on the Status page.

“ ”
Note: Before you proceed, close any applications and files that are open on the drive that you want 

to restore. Warning: When you recover a drive, the data in the recovery point replaces all of the 

data on the drive. Any changes that you made to the data on a drive after the date of the recovery 

point you use to recover it are lost. For example, if you created a new file on the drive after you 

created the recovery point, the new file is not recovered.

“ ”
To recover a secondary drive

On the Tasks menu, click Recover My Computer.

Select a recovery point.

Recover My Computer options when you view recovery points by Date

VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

Date Lets you select an alternate date by using the 
drop-down calendar. Use the calendar if no 
recovery points are discovered and displayed 
in the table.

View all recovery points Lets you view all recovery points that are 
available.

Recover My Computer options when you view recovery points by File name
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VIEW BY - FILE NAME VIEWS THE RECOVERY POINTS BY THEIR 
FILE NAME.

File name Specifies a path and a file name of a recovery 
point.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.v2i  or 
DiskNo-PartitionNo\Filename.iv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.v2i. Where 2 is the disk number and 3 
is the partition number.

Browse Lets you browse to a path that contains a 
recovery point.

For example, you can browse for a recovery 
point (.v2i) or incremental recovery point (.iv2i) 
file on an external (USB) drive. Or, you can 
browse to a network location, removable 
media, or Microsoft OneDrive for Business 
location.

See About support of OneDrive for Business .

Browse for OpenStorage Destination Lets you browse an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

User name Specifies the user name if you specify a 
recovery point file name that is located in a 
network path.

See Rules for network credentials .
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VIEW BY - FILE NAME VIEWS THE RECOVERY POINTS BY THEIR 
FILE NAME.

Password Specifies the password to a network path.

Recover My Computer options when you view recovery points by System

VIEW BY - SYSTEM USES THE CURRENT SYSTEM INDEX FILE 
THAT IS LOCATED IN THE RECOVERY POINT 
STORAGE LOCATION. THE SYSTEM INDEX 

FILE DISPLAYS A LIST OF ALL OF THE 
DRIVES ON YOUR COMPUTER AND ANY 
ASSOCIATED RECOVERY POINTS FROM 

WHICH YOU CAN SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

Date Lets you select an alternate date of a system 
index file date by using the drop-down 
calendar. Use the calendar if no recovery 
points are discovered and displayed in the 
table.

Use latest recovery points for this computer Restores the most recent recovery points that 
exist in the recovery point storage location on 
your computer.

The list of drives, source files (.v2i and .iv2i 
files), and dates comes from the most current 
system index file (.sv2i).

Use alternate system index (.sv2i) file Restores the recovery points that exist on 
another computer.
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VIEW BY - SYSTEM USES THE CURRENT SYSTEM INDEX FILE 
THAT IS LOCATED IN THE RECOVERY POINT 
STORAGE LOCATION. THE SYSTEM INDEX 

FILE DISPLAYS A LIST OF ALL OF THE 
DRIVES ON YOUR COMPUTER AND ANY 
ASSOCIATED RECOVERY POINTS FROM 

WHICH YOU CAN SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

Browse to and select the .sv2i file for the 
desired system

Specifies a path to a system index file (.sv2i) 
file that resides elsewhere, such as a network 
location.

If you selected a system index file that is 
stored on a network, you are prompted for your 
network credentials.

See Rules for network credentials .

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.sv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.sv2i. Where 2 is the disk number and 3 
is the partition number.

Browse Lets you browse to a path that contains a 
system index file.
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VIEW BY - SYSTEM USES THE CURRENT SYSTEM INDEX FILE 
THAT IS LOCATED IN THE RECOVERY POINT 
STORAGE LOCATION. THE SYSTEM INDEX 

FILE DISPLAYS A LIST OF ALL OF THE 
DRIVES ON YOUR COMPUTER AND ANY 
ASSOCIATED RECOVERY POINTS FROM 

WHICH YOU CAN SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index file.

You can browse a Microsoft OneDrive location 
for your recovery point.

See About support of OneDrive for Business .

Browse for OpenStorage Destination Lets you browse an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

Drives Lets you select the drives with the recovery 
points that you want to restore based on the 
selected system index file.

Click Recover Now.

Click OK.

Click Yes.

See Recovering a drive.
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Recovering a drive
You can set various options to customize the recovery of a drive.

To customize the recovery of a drive

On the Tasks menu, click Recover My Computer.

Select a recovery point and click Tasks>Custom Recovery to start the Recover Drive Wizard.

On the wizard's Welcome panel, click Next.

In the Recovery Point to Restore panel, set the options you want.

RECOVERY POINT FILE NAME SPECIFIES THE RECOVERY POINT YOU 
WANT TO USE TO RECOVER THE DRIVE.

YOU CAN USE THE RECOVERY POINT 
THAT IS ALREADY ADDED TO THIS FIELD, 
OR YOU CAN BROWSE TO A DIFFERENT 

RECOVERY POINT.

IF THE RECOVERY POINT IS LOCATED IN 
A HIDDEN DRIVE, YOU MUST SPECIFY 

THE LOCATION OF THE HIDDEN DRIVE IN 
THE FOLLOWING FORMAT:

DISKNO-PARTITIONNO\FILENAME.V2I  OR 
DISKNO-PARTITIONNO\FILENAME.IV2I

FOR EXAMPLE, IF THE HIDDEN DRIVE 
LOCATION IS ON DISK 2 AND PARTITION 

3, YOU MUST ENTER 2-3\FILE.V2I. WHERE 
2 IS THE DISK NUMBER AND 3 IS THE 

PARTITION NUMBER.

Browse Lets you browse to a path that contains a 
recovery point.

For example, you can browse for a recovery 
point (.v2i) or incremental recovery point 
(.iv2i) file on an external (USB) drive. Or, you 
can browse to a network location, removable 
media, or Microsoft OneDrive for Business 
location.
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RECOVERY POINT FILE NAME SPECIFIES THE RECOVERY POINT YOU 
WANT TO USE TO RECOVER THE DRIVE.

YOU CAN USE THE RECOVERY POINT 
THAT IS ALREADY ADDED TO THIS FIELD, 
OR YOU CAN BROWSE TO A DIFFERENT 

RECOVERY POINT.

IF THE RECOVERY POINT IS LOCATED IN 
A HIDDEN DRIVE, YOU MUST SPECIFY 

THE LOCATION OF THE HIDDEN DRIVE IN 
THE FOLLOWING FORMAT:

DISKNO-PARTITIONNO\FILENAME.V2I  OR 
DISKNO-PARTITIONNO\FILENAME.IV2I

FOR EXAMPLE, IF THE HIDDEN DRIVE 
LOCATION IS ON DISK 2 AND PARTITION 

3, YOU MUST ENTER 2-3\FILE.V2I. WHERE 
2 IS THE DISK NUMBER AND 3 IS THE 

PARTITION NUMBER.

See About support of OneDrive for 
Business .

Browse for OpenStorage Destination Lets you browse an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

User name Specifies the user name if you specify a 
recovery point file name that is located in a 
network path.

See Rules for network credentials .

Password Specifies the password to a network path.

In the Target Drive panel, select one or more drives that you want to restore, and then click 

Next.

If the drive does not have enough space available to restore a recovery point, press Shift. Select 

multiple, contiguous destinations that exist on the same hard disk.
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“ ”
Note: When you select aTarget Drive, theSector Sizeof the backed-up drive and the destination 

drive, must be the same.

“ ”
If the recovery point is password-protected, in the Password dialog box, type the password, 

and then click OK.

In the Recovery Options panel, select the restore options you want.

IGNORE RECOVERY POINT CORRUPTION 
DURING RESTORE (POTENTIAL DATA 

LOSS)

AUTOMATICALLY EXCLUDES THE 
CORRUPTED DATA AND CONTINUES TO 

RESTORE THE RECOVERY POINT.

THE RESTORED DATA DOES NOT 
CONTAIN THE CORRUPTED PORTION OF 

DATA.

NOTE: THERE MAY BE POTENTIAL DATA 
LOSS AS CORRUPTED DATA IS 
EXCLUDED FROM RESTORE.

Verify recovery point before restore Verifies whether a recovery point is valid or 
corrupt before it is restored.

This option can significantly increase the 
time that is required for the recovery to 
complete.

Do not verify recovery point before restore Does not verify whether a recovery point is 
valid or corrupt before it is restored. During 
restore, if there is corrupted data on the 
recovery point, an error message is 
displayed and you cannot restore the 
recovery point.

Check for file system errors Checks the restored drive for errors after the 
recovery point is restored.
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IGNORE RECOVERY POINT CORRUPTION 
DURING RESTORE (POTENTIAL DATA 

LOSS)

AUTOMATICALLY EXCLUDES THE 
CORRUPTED DATA AND CONTINUES TO 

RESTORE THE RECOVERY POINT.

THE RESTORED DATA DOES NOT 
CONTAIN THE CORRUPTED PORTION OF 

DATA.

NOTE: THERE MAY BE POTENTIAL DATA 
LOSS AS CORRUPTED DATA IS 
EXCLUDED FROM RESTORE.

Resize restored drive Expands the drive automatically to occupy 
the target drive's remaining unallocated 
space.

Set drive active (for booting OS) Makes the restored drive the active partition 
(for example, the drive from which the 
computer starts).

This option is appropriate if you restore the 
drive on which your operating system is 
installed.

Restore original disk signature Restores the original, physical disk signature 
of the hard drive.

Disk signatures are part of all Windows 
operating systems that Veritas System 
Recovery supports. Disk signatures are 
required to use the hard drive.

Select this option if either of the following 
situations are true:

- Your computer's drive letters are atypical 
(for example, assigned letters other than C, 
D, E, and so forth).

- You restore a recovery point to a new, 
empty hard disk.
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IGNORE RECOVERY POINT CORRUPTION 
DURING RESTORE (POTENTIAL DATA 

LOSS)

AUTOMATICALLY EXCLUDES THE 
CORRUPTED DATA AND CONTINUES TO 

RESTORE THE RECOVERY POINT.

THE RESTORED DATA DOES NOT 
CONTAIN THE CORRUPTED PORTION OF 

DATA.

NOTE: THERE MAY BE POTENTIAL DATA 
LOSS AS CORRUPTED DATA IS 
EXCLUDED FROM RESTORE.

Primary partition Because hard disks are limited to four 
primary partitions, this option is appropriate if 
the drive has four or fewer partitions.

Logical partition This option is appropriate if you need more 
than four partitions. You can have up to three 
primary partitions, plus any number of logical 
partitions, up to the maximum size of your 
hard disk.

Drive letter Lets you assign a drive letter to the partition.

The options that are available depend on the restore destination that you have selected.

Click Next , and then review your selections.

Click Finish, then clickYes.

Sometime the wizard cannot lock the drive to perform the recovery in Windows (typically, because 

the drive is in use by a program). In such cases, make sure that the drive is not in use. For 

example, close any files or applications that may be in use, and then click Retry.

If the Retryoption fails, clickIgnoreto attempt a forced lock on the drive. IfIgnore fails, you might be 

prompted to insert the Veritas System Recovery Disk. You must then manually start the recovery 

environment so that you can complete the recovery. When the recovery is finished, the computer 

restarts automatically.

More Information

Recovering a secondary drive
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Exploring files and folders on your computer by using Veritas 
System Recovery Disk
You can explore the files and folders on your computer from Veritas System Recovery Disk by 

using the Explore My Computer feature.

This feature uses the Recovery Point Browser and functions similar to Windows Explorer. You can 

browse the file structure of any drive that is attached to your computer from Veritas System 

Recovery Disk.

To explore files and folders on your computer by using Veritas System Recovery Disk

Start the computer by using the Veritas System Recovery Disk.

See Booting a computer by using the Veritas System Recovery Disk.

In the Analyze panel, click Explore My Computer.

See Recovering files and folders by using Veritas System Recovery Disk.

Recovering files and folders by using Veritas System Recovery 
Disk
You can use the Veritas System Recovery Disk to start your computer and to restore files and 

folders from within a recovery point.

To recover files and folders by using Veritas System Recovery Disk

Start the computer by using the Veritas System Recovery Disk.

See Booting a computer by using the Veritas System Recovery Disk.

Click Recover, and then clickRecover My Files.

Do one of the following:

If Veritas System Recovery Disk cannot locate any recovery points, you are prompted to 

locate one. In the Select Recovery Point dialog box, navigate to a recovery point, select 

one, and then click OK.

Select Recovery Point options when you view recovery points by date
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VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

IF NO RECOVERY POINTS WERE 
DISCOVERED, THE TABLE IS EMPTY. IN 
SUCH CASES, YOU CAN SEARCH ALL 

LOCAL DRIVES ON THE COMPUTER OR 
BROWSE TO FIND A RECOVERY POINT.

Select source folder Lets you view a list of all available recovery 
points that may exist on your computer's local 
drives or on a specific drive.

Map a network drive Specifies a shared network folder path and 
assign it a drive letter. You can then browse the 
folder location for the recovery point file you 
want.

Browse Lets you locate a recovery point on a local 
drive or a network folder.

Select the Show hidden drives check box to 
see a

list of the hidden drives along with the list of 
the other

drives.

You can select a hidden drive as a location 
where

you want to store the recovery points.

The hidden drives are displayed in the 
following

format:

DiskNo-PartitionNo\
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VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

IF NO RECOVERY POINTS WERE 
DISCOVERED, THE TABLE IS EMPTY. IN 
SUCH CASES, YOU CAN SEARCH ALL 

LOCAL DRIVES ON THE COMPUTER OR 
BROWSE TO FIND A RECOVERY POINT.

For example, a hidden drive is displayed as: 
2-3\. Where 2 is the disk number and 3 is the 
partition

number

Note: By default, this check box is not 
selected.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
backups .

Select a recovery point Lets you select the recovery point to restore.

Recovery point details Gives you additional information about the 
recovery point you want to restore.

Select Recovery Point options when you view recovery points by file name

VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

Recovery point folder and file name Specifies a path and a file name of a recovery 
point.

Map a network drive Specifies a shared network folder path and 
assign it a drive letter. You can then browse the 
folder location for the recovery point file you 
want.
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VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

Browse Lets you locate a recovery point on a local 
drive or a network folder.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.v2i  or 
DiskNo-PartitionNo\Filename.iv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.v2i. Where 2 is the disk number and 3 
is the partition number.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

Recovery point details Gives you additional information about the 
recovery point you want to restore.

If Veritas System Recovery Disk finds recovery points, select a recovery point from the list, and 

then click OK.

“ ”
Note: If you cannot find the recovery points in a network location, type the name of the 

computer and the share that holds your recovery points. For example, \\

\computer_name\share_name. If you still have trouble, try entering the computer's IP address. 

SeeAbout using the networking tools in Veritas System Recovery Disk.

“ ”
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In the tree view pane of the Recovery Point Browser, double-click the drive that contains the 

files or folders that you want to restore.

In the content pane of the Recovery Point Browser, select the files or folders that you want to 

restore.

Click Recover Files.

In the Recover Items dialog box, the Restore to this folder field may already contain the original 

path from which the files originated.

If the original location does not include a drive letter, you must type the drive letter at the beginning 

of the path.

“ ”
Note: While in the recovery environment, drive letters and labels might not match what appears in 

Windows. You might have to identify the correct drive based on its label, which is the name 

assigned to it.

“ ”
If the original path is unknown or you want to restore the selected files to a different location, 

click Browse to locate the destination.

Click Recover to restore the files.

Click OK to finish.

See Recovering a computer.

See Recovering a computer from a virtual disk file.
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Recovering a computer

This section includes the following topics:

About recovering a Unified Extensible Firmware Interface (UEFI)-based computer

Booting a computer by using the Veritas System Recovery Disk

Preparing to recover a computer by checking the hard disk for errors

Recovering a computer

Recovering a computer from a virtual disk file

Recovering a computer with different hardware

About using the networking tools in Veritas System Recovery Disk

Viewing the properties of a recovery point in the Veritas System Recovery Disk

Viewing the properties of a drive within a recovery point in the Veritas System Recovery Disk

About the Support Utilities

About recovering a Unified Extensible Firmware Interface 
(UEFI)-based computer
Veritas System Recovery Disk lets you recover the computers that use the Unified Extensible 

Firmware Interface (UEFI) standard. However, consider the following points when you recover 

UEFI-based computers:

You must start UEFI-based computers using the 64-bit version of Veritas System Recovery 

Disk.

When you boot a UEFI-based computer, ensure that the system drive and the boot drive are 

located on a GPT disk. Similarly, when you boot a BIOS-based computer, your system drive 

and boot drive must be located on an MBR disk.

You cannot restore backups of the boot partition and the system partition of UEFI-based 

computers to BIOS-based computers. Backups of UEFI-based computers must be restored to 

GPT disks. Similarly, you cannot restore backups of the boot partition and the system partition 

of BIOS-based computers to UEFI-based computers. Backups of BIOS-based computers must 

be restored to MBR disks.
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“ ”
Note: While you recover your computer using Veritas System Recovery Disk, the firmware type 

of the backup is displayed. Depending on the firmware type of the backup, restore the backups 

to the appropriate disks, either GPT or MBR.

“ ”
If your computer supports both UEFI and BIOS firmware, and you backed it up in UEFI mode, 

you must start the computer using UEFI firmware.

When you recover UEFI-based computers, do not select the following options on the Edit target 

drive and Options panel in the Recover My Computer wizard:

Set drive active (for booting OS)

Restore master boot record

These options are applicable only for MBR-style disks. They are not applicable to GPT-style disks.

When you recover UEFI-based computers, you must restore the EFI System Partition first if it 

does not exist.

When you recover UEFI-based computers, an empty MSR partition is created if it does not 

exist.

You cannot recover the boot volumes and the system volumes of UEFI-based computers to 

dynamic disks.

See Recovering a computer.

Booting a computer by using the Veritas System Recovery Disk
The Veritas System Recovery Disk lets you boot a computer that can no longer run the Windows 

operating system. You can create a recovery disk using Veritas System Recovery. When you boot 

your computer using the Veritas System Recovery Disk, a simplified version of Windows starts that 

runs a recovery environment. In the recovery environment, you can access the recovery features 

of Veritas System Recovery.

“ ”



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

396

1.

2.

1.

1.

Note: Veritas System Recovery Disk requires a minimum of 1 GB of RAM to run. If your 

computer's video card is configured to share your computer's RAM, you might need more than 1 

GB of RAM.

“ ”
To boot a computer by using the Veritas System Recovery Disk

If you store your recovery points on a USB device, attach the device now (for example, an 

external hard drive).

“ ”
Note: You should attach the device before you restart the computer. Otherwise, Veritas System 

Recovery Disk might not detect it.

“ ”
Attach the Veritas System Recovery Disk that is on a USB Device, into the media drive. If your 

Veritas System Recovery Disk is on a DVD, insert it into the media drive of the computer.

If a computer manufacturer installed Veritas System Recovery, the recovery environment already 

could be installed on your computer's hard drive. Either watch your computer monitor after the 

computer restarts for on-screen instructions, or refer to your manufacturer's documentation.

Restart the computer.

If you cannot start the computer from the USB device or DVD, you might need to change the 

startup settings on your computer.

See Configuring a computer to start from a USB device or DVD.

As soon as you see the prompt Press any key to boot from DVD or USB device, press a key to 

start Veritas System Recovery Disk.

“ ”
Note: You must watch for this prompt. It can come and go quickly. If you miss the prompt, you 

must restart your computer again.
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“ ”
Read the license agreement, and then click Accept.

If you decline, you cannot start Veritas System Recovery Disk, and your computer restarts.

See Recovering a computer.

Configuring a computer to start from a USB device or DVD
Your Veritas System Recovery Disk might be on a USB device or DVD. Accordingly, to run Veritas 

System Recovery Disk, you must be able to start your computer using a USB device or DVD.

See Booting a computer by using the Veritas System Recovery Disk.

To configure a computer to start from a USB device or DVD

Turn on your computer.

As the computer starts, watch the bottom of the screen for a prompt that tells you how to 

access the BIOS/UEFI setup.

Generally, you need to press the Delete key or a function key to start your computer's BIOS/UEFI 

program.

In the BIOS/UEFI setup window, select Boot Sequence, and then pressEnter.

Follow the on-screen instructions to set the USB device or DVD to be the first startup device in 

the list.

Attach the Veritas System Recovery Disk that is on a USB Device, into the media drive. If your 

Veritas System Recovery Disk is on a DVD, insert it into the media drive.

Save the changes and exit the BIOS/UEFI setup to restart the computer with the new settings.

Press any key to start Veritas System Recovery Disk.

When you start your computer with the Veritas System Recovery Disk USB device or DVD in the 

drive, you see a prompt to Press any key to boot from DVD or USB device. If you do not press a 

key within five seconds, your computer attempts to start from the next startup device.

“ ”
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Note: Watch carefully as the computer starts. If you miss the prompt, you must restart the 

computer again.

“ ”
See Recovering a computer.

Preparing to recover a computer by checking the hard disk for 
errors
If you suspect that your hard disk is damaged, you can examine it for errors.

To prepare to recover a computer by checking the hard disk for errors

Boot the computer by using the Veritas System Recovery Disk.

See Booting a computer by using the Veritas System Recovery Disk.

In the Analyze panel of Veritas System Recovery Disk, click Check Hard Disks for Errors.

Select the drive that you want to check.

Select any of the following options.

Automatically fix file system errors

Fixes the errors on the selected disk. If you do not select this option, errors are displayed but are 

not fixed.

Find and correct bad sectors

Locates the bad sectors and recovers readable information.

Click Start.

See Recovering a computer.

Recovering a computer
If Windows fails to start or does not run normally, you can still recover your computer. You can use 

the Veritas System Recovery Disk and an available recovery point or a virtual disk that you created 

from a recovery point.
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“ ”
Note: If you can start Windows and the drive that you want to restore is a non-operating system 

drive, you can restore the drive within Windows.

“ ”
The Veritas System Recovery Disk lets you run a recovery environment that provides temporary 

access to Veritas System Recovery recovery features. For example, you can access the recovery 

features of Veritas System Recovery to restart the computer into its previous, usable state.

“ ”
Note: If you purchased Veritas System Recovery from your computer manufacturer, some features 

in the recovery environment might not be available. For example, if the manufacturer installed the 

recovery environment on your computer's hard disk. Your manufacturer might also assign a 

keyboard key for the purpose of starting the recovery environment. When you restart your 

computer, watch for instructions on your computer monitor, or refer to your manufacturer's 

instructions.

“ ”
If you have a recovery point for the hard drives that you want to recover, you can fully restore your 

computer. Or, you can recover another hard drive back to the state it was in when the recovery 

point was created.

“ ”
Note: If you restore a recovery point to a computer that uses different hardware, the Restore 

Anyware feature is automatically enabled for you.

“ ”
See Recovering a computer with different hardware.
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Veritas System Recovery 23 does not create a dynamic disk or storage pool layout. To restore a 

volume, you need to manually create a dynamic disk or a storage pool configuration. Boot the 

computer using the Veritas System Recovery Disk and on the Analyze panel click Open Command 

Shell Window.

If you want to create a dynamic disk configuration, run the DISKPART  utility.

The following technote provides information about restoring dynamic disks.

http://www.veritas.com/docs/000037965

If you want to create a storage pool configuration, use PowerShell commandlets.

“ ”
Note: For the PowerShell commandlets configuration, create a recovery disk using 

theAdvancedoption.

“ ”
After you create the required configuration, you can continue with the steps to recover a computer.

To recover a computer

Boot the computer by using the Veritas System Recovery Disk.

Check the hard disk for errors.

See Preparing to recover a computer by checking the hard disk for errors.

On the Home panel of Veritas System Recovery Disk, click Recover My Computer.

If your recovery points are stored on media and you only have one media drive, you can eject the 

Veritas System Recovery Disk now. Attach the USB device or insert the DVD that contains your 

recovery points.

On the Welcome page of the wizard, click Next.

On the Select a Recovery Point to Restore panel, select a recovery point to restore, and then 

click Next.

Select Recovery Point to Restore options when you view recovery points by Date

http://www.veritas.com/docs/000037965
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VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

IF NO RECOVERY POINTS WERE 
DISCOVERED, THE TABLE IS EMPTY. IN 
SUCH CASES, YOU CAN SEARCH ALL 

LOCAL DRIVES ON THE COMPUTER OR 
BROWSE TO FIND A RECOVERY POINT.

Select source folder Lets you view a list of all available recovery 
points that may exist on your computer's local 
drives or on a specific drive.

Map a network drive Specifies a shared network folder path and 
assign it a drive letter. You can then browse the 
folder location for the recovery point file you 
want.

Browse Locates a recovery point on a local drive or a 
network folder.

Select the Show hidden drives check box to 
see a

list of the hidden drives along with the list of 
the other

drives.

You can select a hidden drive as a location 
where

you want to store the recovery points.

The hidden drives are displayed in the 
following

format:

DiskNo-PartitionNo\
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VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

IF NO RECOVERY POINTS WERE 
DISCOVERED, THE TABLE IS EMPTY. IN 
SUCH CASES, YOU CAN SEARCH ALL 

LOCAL DRIVES ON THE COMPUTER OR 
BROWSE TO FIND A RECOVERY POINT.

For example, a hidden drive is displayed as: 
2-3\. Where 2 is the disk number and 3 is the 
partition

number

Note: By default, this check box is not 
selected.

Select a recovery point Lets you select the recovery point to restore.

Recovery point details Gives you additional information about the 
recovery point you want to restore.

Select Recovery Point to Restore options when you view recovery points by File name

VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

Recovery point folder and file name Specifies a path and a file name of a recovery 
point.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.v2i  or 
DiskNo-PartitionNo\Filename.iv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.v2i. Where 2 is the disk number and 3 
is the partition number.
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VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

Map a network drive Specifies a shared network folder path and 
assign it a drive letter. You can then browse the 
folder location for the recovery point file you 
want.

Browse Locates a recovery point on a local drive or a 
network folder.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

Recovery point details Gives you additional information about the 
recovery point you want to restore.

Select Recovery Point to Restore options when you view recovery points by System

VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

System index folder and filename Specifies a path and a file name of a system 
index file that you want to use for recovery.
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VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.sv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.sv2i. Where 2 is the disk number and 3 
is the partition number.

Map a network drive Specifies a shared network folder path and 
assign it a drive letter. You can then browse the 
folder location for the system index file (.sv2i) 
you want.

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index file.
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VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

If disks with no layout structures are detected, you are prompted to initialize the disk layout. A list of 

disks without layout structures is displayed. The list shows the default disk layout type, either GPT, 

or MBR. If required, you can change the layout type for the disks, and then click OK to initialize 

layouts on them.

“ ”
Note: If you are recovering a UEFI-based computer, you must restore its system partitions to a 

GPT disk.

“ ”
On the Drives to Recover panel, select each drive that you want to recover and set the options 

that you want, and then click Next.
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SELECT DRIVES TO RECOVER LETS YOU SELECT THE DRIVES THAT 
YOU WANT TO RECOVER.

Add Adds the additional drives that you want to 
recover.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.v2i  or 
DiskNo-PartitionNo\Filename.iv2i

For example, if the hidden drive location is 
on Disk 2 and Partition 3, you must enter 
2-3\file.v2i. Where 2 is the disk number and 
3 is the partition number.

Remove Removes the selected drives from the list of 
drives to recover.

Edit Lets you edit the recovery options for a 
selected drive.

Ignore recovery point corruption during 
restore (potential data loss)

Automatically excludes the corrupted data 
and continues to restore the recovery point.

The restored data does not contain the 
corrupted portion of data.

Note: There may be potential data loss as 
corrupted data is excluded from restore.

Verify recovery point before restore Verifies whether a recovery point is valid or 
corrupt before it is restored. If the recovery 
point is invalid, the recovery is discontinued.

This option can significantly increase the 
time that is required for the recovery to 
complete.

Do not verify recovery point before restore Does not verify whether a recovery point is 
valid or corrupt before it is restored. During 
restore, if there is corrupted data on the 
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SELECT DRIVES TO RECOVER LETS YOU SELECT THE DRIVES THAT 
YOU WANT TO RECOVER.

recovery point, an error message is 
displayed and you cannot restore the 
recovery point.

Use Restore Anyware to recover to different 
hardware

Selected automatically if any of the following 
are true\:

- You recover a non-operating system drive 
to new or to different computer hardware. Or, 
you can recover both an operating system 
drive and one or more data drives to new or 
to different computer hardware.

- You upgrade to new or to different computer 
hardware from an older computer.

- The motherboard on the computer has 
failed.

If you recover a data drive only to new or to 
different computer hardware, this option is 
not selected for you.

When you recover your computer, select the drive on which Windows is installed. On most 

computer systems, this drive is the C drive. In the recovery environment, the drive letters and 

labels might not match what appears in Windows. You might need to identify the correct drive 

based on its label. Or, you can identify the drive by its name, or by browsing the files and folders in 

the recovery point.

Optionally, select a drive that you want to recover, and then click Edit.

Select the options that you want to perform during the recovery process, and then click OK to 

return to the Drives to Recover panel.
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DELETE DRIVE DELETES A SELECTED DRIVE IN THE LIST 
TO MAKE SPACE AVAILABLE TO RESTORE 

YOUR RECOVERY POINT.

WHEN YOU USE THIS OPTION, THE DRIVE IS 
ONLY MARKED FOR DELETION. THE 

ACTUAL DELETION OF THE DRIVE TAKES 
PLACE AFTER YOU CLICK FINISH IN THE 

WIZARD.

Undo Delete Returns a deleted drive to the list of drives.

Resize drive after recover (unallocated space 
only)

Resizes a disk after the recovery point is 
restored. After you select this option, you can 
specify the new size in megabytes. The size 
must be greater than the identified size of the 
disk that you selected in the list.

Primary partition Because hard disks are limited to four primary 
partitions, this option is appropriate if the drive 
has four or fewer partitions.

Logical partition This option is appropriate if you need more 
than four partitions. You can have up to three 
primary partitions, plus any number of logical 
partitions, up to the maximum size of your hard 
disk.

Check for file system errors after recovery Checks the restored drive for errors after the 
recovery point is restored.

Set drive active (for booting OS) Makes the restored drive the active partition 
(for example, the drive from which the 
computer starts).

You should select this option if you restore the 
drive on which your operating system is 
installed.

Note: Do not select this option if you are 
restoring system partition or boot partition of a 
UEFI-based computer. This option is 
applicable only for MBR-style disks.
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DELETE DRIVE DELETES A SELECTED DRIVE IN THE LIST 
TO MAKE SPACE AVAILABLE TO RESTORE 

YOUR RECOVERY POINT.

WHEN YOU USE THIS OPTION, THE DRIVE IS 
ONLY MARKED FOR DELETION. THE 

ACTUAL DELETION OF THE DRIVE TAKES 
PLACE AFTER YOU CLICK FINISH IN THE 

WIZARD.

Restore original disk signature Restores the original, physical disk signature of 
the hard drive.

Disk signatures are part of all Windows 
operating systems that Veritas System 
Recovery supports. Disk signatures are 
required to use the hard drive.

Select this option if either of the following 
situations are true:

- Your computer's drive letters are atypical (for 
example, assigned letters other than C, D, E, 
and so forth).

- You restore a recovery point to a new, empty 
hard disk.

Restore master boot record Restores the master boot record. The master 
boot record is contained in the first sector of a 
physical hard disk. The master boot record 
consists of a master boot program and a 
partition table that describes the disk partitions. 
The master boot program analyzes the 
partition table of the first hard disk to see which 
primary partition is active. It then starts the 
boot program from the boot sector of the active 
partition.

This option is recommended only for advanced 
users and is available only if you restore a 
whole drive in the recovery environment.
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DELETE DRIVE DELETES A SELECTED DRIVE IN THE LIST 
TO MAKE SPACE AVAILABLE TO RESTORE 

YOUR RECOVERY POINT.

WHEN YOU USE THIS OPTION, THE DRIVE IS 
ONLY MARKED FOR DELETION. THE 

ACTUAL DELETION OF THE DRIVE TAKES 
PLACE AFTER YOU CLICK FINISH IN THE 

WIZARD.

Select this option if any of the following 
situations are true:

- You restore a recovery point to a new, empty 
hard disk.

- You restore a recovery point to the original 
drive, but the drive's partitions were modified 
since the recovery point was created.

- You suspect that a virus or some other 
problem has corrupted your drive's master 
boot record.

Note: Do not select this option if you are 
restoring system partition or boot partition of a 
UEFI-based computer. This option is 
applicable only for MBR-style disks.

Click Next to review the recovery options that you selected.

Select Reboot when finished if you want the computer to restart automatically after the 

recovery process finishes.

Click Finish.

Click Yes to begin the recovery process.

See Recovering a computer from a virtual disk file.

More Information

Booting a computer by using the Veritas System Recovery Disk

Recovering files and folders by using Veritas System Recovery Disk
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Recovering a computer from a virtual disk file
Using the recovery environment, you can recover your computer from within a virtual disk file 

(.vmdk or .vhd). If you have a virtual disk for the hard drives that you want to recover, you can fully 

recover your computer. Or, you can recover another hard drive back to the state it was in when the 

original virtual disk was created.

“ ”
Note: You cannot recover a UEFI-based computer from a virtual disk file.

“ ”
See Defining a virtual conversion job.

See Running a one-time conversion of a physical recovery point to a virtual disk.

“ ”
Note: If you restore a virtual disk to a computer that uses different hardware, the Restore Anyware 

feature is automatically enabled for you.

“ ”
To recover a computer from a virtual disk file

Boot the computer by using the Veritas System Recovery Disk.

See Booting a computer by using the Veritas System Recovery Disk.

On the Home panel of Veritas System Recovery Disk, click Recover My Computer.

On the Welcome panel of the wizard, click Next.

On the Select a Recovery Point to Restore panel, in the View recovery points bylist, 

selectFilename.

If disks with no layout structures are detected, you are prompted to initialize the disk layout. A list of 

disks without layout structures is displayed. The list shows the default disk layout type, either GPT, 
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or MBR. If required, you can change the layout type for the disks, and then click OK to initialize 

layouts on them.

On the Select a Recovery Point to Restore panel, click Browse to locate, select, and open a 

virtual disk file (.vmdk or .vhd).

If necessary, click Map a network drive. Specify a shared network folder path and assign it a drive 

letter. You can then browse the folder location for the virtual disk file you want.

If the recovery point is located in a hidden drive, you must specify the location of the hidden drive 

in the following format:

DiskNo-PartitionNo\Filename.vmdk  or DiskNo-PartitionNo\Filename.vhd

For example, if the hidden drive location is on Disk 2 and Partition 3, you must enter 2-3\file.vmdk. 

Where 2 is the disk number and 3 is the partition number.

Click Next.

In the Target Drive panel, select the target drive where you want to restore the virtual disk.

Optionally, do any of the following:

Click Delete Drive.

Delete a selected drive in the list to make space available to restore your virtual disk.

When you click Delete Drive, the drive is only marked for deletion. The actual deletion of the drive 

takes place after you clickFinish in the wizard.

Click Undo Delete.

If you delete a drive and then change your mind, click Undo Delete to return the drive to the list.

Click Next.Use Restore Anyware to recover to different hardware is already selected for 

you if you recover an operating system drive (the drive on which Windows is installed; usually 

the C drive).

This option is not selected if the virtual disk already contains the necessary drivers for the target 

computer. Or, if you restore a virtual disk that contains a data drive.

If necessary, enter the product license key.

A license key is required to use Restore Anyware when you recover a system from a virtual disk 

file.
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If you choose, you can add a license key directly to a custom Veritas System Recovery Disk by 

using the Create Custom Recovery Disk wizard. When you restore a virtual disk and Restore 

Anyware is enabled in Veritas System Recovery Disk, you are not prompted to enter the license 

key. It is already a part of the custom Veritas System Recovery Disk.

See Customizing an existing Veritas System Recovery Disk.

Click Next.

In the Recovery Options panel, select the options that you want to perform during the recovery 

process.

VERIFY RECOVERY POINT BEFORE 
RECOVERY

VERIFIES WHETHER A RECOVERY POINT 
IS VALID OR CORRUPT BEFORE IT IS 

RESTORED. IF THE RECOVERY POINT IS 
INVALID, THE RECOVERY IS 

DISCONTINUED.

THIS OPTION CAN SIGNIFICANTLY 
INCREASE THE TIME THAT IS REQUIRED 

FOR THE RECOVERY TO COMPLETE.

Check for file system errors after recovery Checks the restored drive for errors after the 
recovery point is restored.

Resize drive after recover (unallocated 
space only)

Specifies the new drive size in megabytes.

Primary partition Because hard disks are limited to four 
primary partitions, this option is appropriate if 
the drive has four or fewer partitions.

Logical partition This option is appropriate if you need more 
than four partitions. You can have up to three 
primary partitions, plus any number of logical 
partitions, up to the maximum size of your 
hard disk.

Set drive active (for booting OS) Makes the restored drive the active partition 
(for example, the drive from which the 
computer starts).
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VERIFY RECOVERY POINT BEFORE 
RECOVERY

VERIFIES WHETHER A RECOVERY POINT 
IS VALID OR CORRUPT BEFORE IT IS 

RESTORED. IF THE RECOVERY POINT IS 
INVALID, THE RECOVERY IS 

DISCONTINUED.

THIS OPTION CAN SIGNIFICANTLY 
INCREASE THE TIME THAT IS REQUIRED 

FOR THE RECOVERY TO COMPLETE.

You should select this option if you restore 
the drive on which your operating system is 
installed.

Restore original disk signature Restores the original, physical disk signature 
of the hard drive.

Disk signatures are part of all Windows 
operating systems that Veritas System 
Recovery supports. Disk signatures are 
required to use the hard drive.

Select this option if either of the following 
situations are true:

- Your computer's drive letters are atypical 
(for example, assigned letters other than C, 
D, E, and so forth).

- You are restore a recovery point to a new, 
empty hard disk.

Restore master boot record Restores the master boot record. The master 
boot record is contained in the first sector of 
a physical hard disk. The master boot record 
consists of a master boot program and a 
partition table that describes the disk 
partitions. The master boot program 
analyzes the partition table of the first hard 
disk to see which primary partition is active. 
It then starts the boot program from the boot 
sector of the active partition.
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VERIFY RECOVERY POINT BEFORE 
RECOVERY

VERIFIES WHETHER A RECOVERY POINT 
IS VALID OR CORRUPT BEFORE IT IS 

RESTORED. IF THE RECOVERY POINT IS 
INVALID, THE RECOVERY IS 

DISCONTINUED.

THIS OPTION CAN SIGNIFICANTLY 
INCREASE THE TIME THAT IS REQUIRED 

FOR THE RECOVERY TO COMPLETE.

This option is recommended only for 
advanced users and is available only if you 
restore a whole drive in the recovery 
environment.

Select this option if any of the following 
situations are true:

- You restore a recovery point to a new, 
empty hard disk.

- You restore a recovery point to the original 
drive, but the drive's partitions were modified 
since the recovery point was created.

- You suspect that a virus or some other 
problem has corrupted your drive's master 
boot record.

The options that are available depend on the target drive that you selected earlier.

Click Next to review the recovery options that you selected.

Select Reboot when finished if you want the computer to restart automatically after the 

recovery process finishes.

Click Finish.

Click Yes to begin the recovery process.

See Recovering a computer.

See Recovering a computer with different hardware.
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Recovering a computer with different hardware
The Veritas System Recovery Restore Anyware feature lets administrators restore a system drive 

of a supported Windows platform computer. You can restore the system even if it has different 

hardware than was found in the original computer from which the recovery point was made.

Restore Anyware lets you make the necessary changes for the system to be able to start. 

Depending on your configuration, you may need to make additional changes for the computer to 

run exactly as it did previously.

Restore Anyware lets you restore a recovery point onto new hardware. For example, Restore 

Anyware is automatically used for you in the following scenarios:

Your computer's motherboard has failed and you replaced it with a new or a different 

motherboard.

You want to upgrade to new hardware from an older computer.

You want to restore a virtual disk file back to a physical computer.

This feature is used to recover drives only; it cannot be used to recover at a more granular level 

such as files and folders.

“ ”
Note: You can obtain more information about domain controller support. Seehttps://

www.veritas.com/content/support/en_US Warning: If you have an OEM license from your 

hardware vendor or a single-user license, you might be prompted to reactivate your Windows 

software. You can reactivate by using your Windows license key. Be aware that OEM and single-

user licenses might have a limited number of activations. Verify that using Restore Anyware does 

not violate your operating system or application license agreements.

“ ”
Keep in mind the following when Restore Anyware is used:

Performing a Restore Anyware to hardware that is significantly different might require you to do 

the following:

Add mass storage device drivers.

Install hot fixes for the Windows operating system that you restore.
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Reactivate your Windows operating system when the system restarts.

Provide your license key when the system restarts.

Provide a local user name and password when the system restarts.

When you restore a recovery point with Restore Anyware, you might be prompted for the local 

administrator name and password. You should have this information ready before you perform 

the restore. Technical support cannot restore a lost password.

Restore Anyware is not used to restore a single recovery point to multiple computers. The 

product does not generate a unique SID (security identifier) for every computer.

When you use Restore Anyware with a computer that uses a static IP address, you must 

manually reconfigure the computer after the restore is complete.

Veritas System Recovery supports one NIC on a system. If you have a dual NIC system, you 

might need to manually configure the additional NICs to perform a restore through Restore 

Anyware.

If you restore to identical (or very similar) hardware on which the recovery point was originally 

made, the Restore Anyware feature is deselected for you.

Before you restore a computer with Restore Anyware, you must save the recovery point or virtual 

disk file to an accessible location. During the recovery, you might also be prompted to supply disk 

drivers, service packs, hot fixes, and so forth. You should have your Windows media CD available.

For more information about getting Restore Anyware drivers, go to the Veritas Knowledge Base at 

the following URL:

https://www.veritas.com/content/support/en_US

“ ”
Warning: Before you restore a computer through Restore Anyware, test your access to the 

recovery points or virtual disk in the recovery environment. You should ensure that you have 

access to SAN volumes and that you can connect to the network.

“ ”
To recover a computer through Restore Anyware

Start the computer by using the Veritas System Recovery Disk.

https://www.veritas.com/support/en_US/search-results.html?keyword=V-269-15*
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See Booting a computer by using the Veritas System Recovery Disk.

On the Home panel, click Recover My Computer.

Your recovery points or virtual disks may be stored on media. In such cases, if you only have one 

USB drive, you can eject the Veritas System Recovery Disk now. Attach the USB device that 

contains your recovery points or virtual disks.

On the Welcome panel of the wizard, click Next.

Do one of the following:

If Veritas System Recovery Disk located recovery points, proceed to step 7.

If Veritas System Recovery Disk does not locate any recovery points, proceed to the next 

step.

On the Select a Recovery Point to Restore panel, select a recovery point to restore.

Select Recovery Point to Restore options when you view recovery points by Date

VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

IF NO RECOVERY POINTS WERE 
DISCOVERED, THE TABLE IS EMPTY. IN 
SUCH CASES, YOU CAN SEARCH ALL 

LOCAL DRIVES ON THE COMPUTER OR 
BROWSE TO FIND A RECOVERY POINT.

Select source folder Lets you view a list of all available recovery 
points that may exist on your computer's local 
drives or on a specific drive.

Map a network drive Specifies a shared network folder path and 
assign it a drive letter. You can then browse the 
folder location for the recovery point file you 
want.

Browse Locates a recovery point on a local drive or a 
network folder.

Select the Show hidden drives check box to 
see a
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VIEW BY - DATE DISPLAYS ALL OF THE DISCOVERED 
RECOVERY POINTS IN THE ORDER IN 

WHICH THEY WERE CREATED.

IF NO RECOVERY POINTS WERE 
DISCOVERED, THE TABLE IS EMPTY. IN 
SUCH CASES, YOU CAN SEARCH ALL 

LOCAL DRIVES ON THE COMPUTER OR 
BROWSE TO FIND A RECOVERY POINT.

list of the hidden drives along with the list of 
the other

drives.

You can select a hidden drive as a location 
where

you want to store the recovery points.

The hidden drives are displayed in the 
following

format:

DiskNo-PartitionNo\

For example, a hidden drive is displayed as: 
2-3\. Where 2 is the disk number and 3 is the 
partition

number

Note: By default, this check box is not 
selected.

Select a recovery point Lets you select the recovery point to restore.

Recovery point details Gives you additional information about the 
recovery point you want to restore.

Select Recovery Point to Restore options when you view recovery points by File name
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VIEW BY - FILE NAME LETS YOU VIEW RECOVERY POINTS BY 
THEIR FILE NAME.

Recovery point folder and file name Specifies a path and a file name of a recovery 
point.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.v2i  or 
DiskNo-PartitionNo\Filename.iv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.v2i. Where 2 is the disk number and 3 
is the partition number.

Map a network drive Specifies a shared network folder path and 
assign it a drive letter. You can then browse the 
folder location for the recovery point file you 
want.

Browse Locates a recovery point on a local drive or a 
network folder.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

Recovery point details Gives you additional information about the 
recovery point you want to restore.

Select Recovery Point to Restore options when you view recovery points by System
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VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

System index folder and filename Specifies a path and a file name of a system 
index file that you want to use for recovery.

If the recovery point is located in a hidden 
drive, you must specify the location of the 
hidden drive in the following format:

DiskNo-PartitionNo\Filename.sv2i

For example, if the hidden drive location is on 
Disk 2 and Partition 3, you must enter 
2-3\file.sv2i. Where 2 is the disk number and 3 
is the partition number.

Map a network drive Specifies a shared network folder path and 
assign it a drive letter. You can then browse the 
folder location for the system index file (.sv2i) 
you want.

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index file.
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VIEW BY - SYSTEM LETS YOU USE THE CURRENT SYSTEM 
INDEX FILE THAT IS LOCATED IN THE 

RECOVERY POINT STORAGE LOCATION. 
THE SYSTEM INDEX FILE DISPLAYS A LIST 

OF ALL OF THE DRIVES ON YOUR 
COMPUTER AND ANY ASSOCIATED 

RECOVERY POINTS FROM WHICH YOU CAN 
SELECT.

THE USE OF A SYSTEM INDEX FILE 
REDUCES THE TIME IT TAKES TO CONVERT 

MULTIPLE RECOVERY POINTS. WHEN A 
RECOVERY POINT IS CREATED, A SYSTEM 

INDEX FILE IS SAVED WITH IT. THE SYSTEM 
INDEX FILE CONTAINS A LIST OF THE MOST 

RECENT RECOVERY POINTS, WHICH 
INCLUDES THE ORIGINAL DRIVE LOCATION 

OF EACH RECOVERY POINT.

OpenStorage Destination Lets you select an OpenStorage storage 
destination that you want to use for restoring 
the recovery points.

See OpenStorage destination options for 
recovery .

If disks with no layout structures are detected, you are prompted to initialize the disk layout. A list of 

disks without layout structures is displayed. The list shows the default disk layout type, either GPT, 

or MBR. If required, you can change the layout type for the disks, and then click OK to initialize 

layouts on them.

“ ”
Note: If you are recovering a UEFI-based computer, you must restore its system partitions to a 

GPT disk.

“ ”
Click Next.

On the Drives to Recover panel, select each drive that you want to recover and set the options 

that you want, and then click Next.
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SELECT DRIVES TO RECOVER LETS YOU SELECT THE DRIVES THAT 
YOU WANT TO RECOVER.

Add Adds the additional drives that you want to 
recover.

Remove Removes the selected drives from the list of 
drives to recover.

Edit Lets you edit the recovery options for a 
selected drive.

Ignore recovery point corruption during 
restore (potential data loss)

Automatically excludes the corrupted data 
and continues to restore the recovery point.

The restored data does not contain the 
corrupted portion of data.

Note: There may be potential data loss as 
corrupted data is excluded from restore.

Verify recovery point before restore Verifies whether a recovery point is valid or 
corrupt before it is restored. If the recovery 
point is invalid, the recovery is discontinued.

This option can significantly increase the 
time that is required for the recovery to 
complete.

Do not verify recovery point before restore Does not verify whether a recovery point is 
valid or corrupt before it is restored. During 
restore, if there is corrupted data on the 
recovery point, an error message is 
displayed and you cannot restore the 
recovery point.

Use Restore Anyware to recover to different 
hardware

Selected automatically if any of the following 
are true\:

- You recover a non-operating system drive 
to new or to different computer hardware. Or, 
you can recover both an operating system 
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SELECT DRIVES TO RECOVER LETS YOU SELECT THE DRIVES THAT 
YOU WANT TO RECOVER.

drive and one or more data drives to new or 
to different computer hardware.

- You upgrade to new or to different computer 
hardware from an older computer.

- The motherboard on the computer has 
failed.

If you recover a data drive only to new or to 
different computer hardware, this option is 
not selected for you.

When you recover your computer, select the drive on which Windows is installed. On most 

computer systems, this drive is the C drive. In the recovery environment, the drive letters and 

labels might not match what appears in Windows. You might need to identify the correct drive 

based on its label. Or, you can identify the drive based on the name that is assigned to it. Or, you 

can browse the files and folders in the recovery point.

See Recovering files and folders by using Veritas System Recovery Disk.

Optionally, select a drive that you want to recover, and then click Edit.

Select the options that you want to perform during the recovery process, and then click OK to 

return to the Drives to Recover panel.

DELETE DRIVE DELETES A SELECTED DRIVE IN THE LIST 
TO MAKE SPACE AVAILABLE TO RESTORE 

YOUR RECOVERY POINT.

WHEN YOU USE THIS OPTION, THE DRIVE IS 
ONLY MARKED FOR DELETION. THE 

ACTUAL DELETION OF THE DRIVE TAKES 
PLACE AFTER YOU CLICK FINISH IN THE 

WIZARD.

Undo Delete Returns a deleted drive to the list of drives.

Resize drive after recover (unallocated space 
only)

Resizes a disk after the recovery point is 
restored. After you select this option, you can 
specify the new size in megabytes. The size 
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DELETE DRIVE DELETES A SELECTED DRIVE IN THE LIST 
TO MAKE SPACE AVAILABLE TO RESTORE 

YOUR RECOVERY POINT.

WHEN YOU USE THIS OPTION, THE DRIVE IS 
ONLY MARKED FOR DELETION. THE 

ACTUAL DELETION OF THE DRIVE TAKES 
PLACE AFTER YOU CLICK FINISH IN THE 

WIZARD.

must be greater than the identified size of the 
disk that you selected in the list.

Primary partition Because hard disks are limited to four primary 
partitions, this option is appropriate if the drive 
has four or fewer partitions.

Logical partition This option is appropriate if you need more 
than four partitions. You can have up to three 
primary partitions, plus any number of logical 
partitions, up to the maximum size of your hard 
disk.

Check for file system errors after recovery Checks the restored drive for errors after the 
recovery point is restored.

Set drive active (for booting OS) Makes the restored drive the active partition 
(for example, the drive from which the 
computer starts).

You should select this option if you restore the 
drive on which your operating system is 
installed.

Note: Do not select this option if you are 
restoring system partition or boot partition of a 
UEFI-based computer. This option is 
applicable only for MBR-style disks.

Restore original disk signature Restores the original, physical disk signature of 
the hard drive.

Disk signatures are part of all Windows 
operating systems that Veritas System 
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DELETE DRIVE DELETES A SELECTED DRIVE IN THE LIST 
TO MAKE SPACE AVAILABLE TO RESTORE 

YOUR RECOVERY POINT.

WHEN YOU USE THIS OPTION, THE DRIVE IS 
ONLY MARKED FOR DELETION. THE 

ACTUAL DELETION OF THE DRIVE TAKES 
PLACE AFTER YOU CLICK FINISH IN THE 

WIZARD.

Recovery supports. Disk signatures are 
required to use the hard drive.

Select this option if either of the following 
situations are true:

- Your computer's drive letters are atypical (for 
example, assigned letters other than C, D, E, 
and so forth).

- You restore a recovery point to a new, empty 
hard disk.

Restore master boot record Restores the master boot record. The master 
boot record is contained in the first sector of a 
physical hard disk. The master boot record 
consists of a master boot program and a 
partition table that describes the disk partitions. 
The master boot program analyzes the 
partition table of the first hard disk to see which 
primary partition is active. It then starts the 
boot program from the boot sector of the active 
partition.

This option is recommended only for advanced 
users and is available only if you restore a 
whole drive in the recovery environment.

Select this option if any of the following 
situations are true:

- You restore a recovery point to a new, empty 
hard disk.
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DELETE DRIVE DELETES A SELECTED DRIVE IN THE LIST 
TO MAKE SPACE AVAILABLE TO RESTORE 

YOUR RECOVERY POINT.

WHEN YOU USE THIS OPTION, THE DRIVE IS 
ONLY MARKED FOR DELETION. THE 

ACTUAL DELETION OF THE DRIVE TAKES 
PLACE AFTER YOU CLICK FINISH IN THE 

WIZARD.

- You restore a recovery point to the original 
drive, but the drive's partitions were modified 
since the recovery point was created.

- You suspect that a virus or some other 
problem has corrupted your drive's master 
boot record.

Note: Do not select this option if you are 
restoring system partition or boot partition of a 
UEFI-based computer. This option is 
applicable only for MBR-style disks.

Click Next to review the recovery options you have selected.

Select Reboot when finished if you want the computer to restart automatically when the 

recovery process finishes.

Click Finish.

Click Yes to begin the recovery process.

See Recovering a computer.

See Recovering a computer from a virtual disk file.

About using the networking tools in Veritas System Recovery 
Disk
If you store your recovery points on a network, you need access to the network. This access lets 

you restore your computer or your files and folders from Veritas System Recovery Disk. The 

Veritas System Recovery Disk includes a variety of networking tools that you can use to assist you 

with recovery.
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“ ”
Note: Additional computer memory might be required to recover your computer or files across a 

network.

“ ”
See Starting networking services.

See Mapping a network drive from within Veritas System Recovery Disk.

See Configuring network connection settings.

Starting networking services
You can start networking services manually.

To start networking services

On the Network panel in Veritas System Recovery Disk, click Start My Networking Services.

To verify the connection to the network, you can map a network drive.

See About using the networking tools in Veritas System Recovery Disk.

More Information

Mapping a network drive from within Veritas System Recovery Disk

Mapping a network drive from within Veritas System Recovery Disk
If you started the networking services after you started the recovery environment, you can map a 

network drive. This mapping lets you browse to that drive and select the recovery point that you 

want to restore. Or, if you create backups from the recovery environment, you can select a 

destination that resides on a network location.

See About using the networking tools in Veritas System Recovery Disk.

If there is no DHCP server or the DHCP server is unavailable, you must provide a static IP 

address. You must also provide a subnet mask address for the computer on which you are running 

Veritas System Recovery Disk.

See Configuring network connection settings.
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After you provide the static IP address and subnet mask address, you can enter the recovery 

environment. However, there is no way to resolve computer names. When you run the Recover My 

Computer wizard or the Recovery Point Browser, you can only browse the network by using the IP 

addresses to locate a recovery point. You can map a network drive so that you can locate the 

recovery points more effectively. Or, you can use the mapped network drive as a destination for 

recovery points that you create from within the recovery environment.

To map a network drive from within Veritas System Recovery Disk

In Veritas System Recovery Disk, on the Network panel, click Map a Network Drive.

Map a network drive by using the UNC path of the computer on which the recovery point is 

located.

For example: \\computer_name\share_name or \\IP_address\share_name

You can also map a network drive from within the Recover My Computer wizard or the Back Up My 

Computer wizard in Veritas System Recovery Disk.

Configuring network connection settings
You can access the Network Configuration window to configure network settings while running in 

the Veritas System Recovery Disk environment.

To configure network connection settings

In the Veritas System Recovery Disk environment, click Network, and then clickConfigure 

Network Connection Settings.

You can configure settings such as, IP address (static and dynamic), subnet mask, DNS server, 

and default gateway.

If you are prompted to start networking services, click Yes.

See About using the networking tools in Veritas System Recovery Disk.

Setting a status IP address to enable recovery from a recovery point on a network 

share or drive

You can restore a recovery point that is located on a network drive or share. Sometimes, however, 

you cannot map a drive or browse to the drive or share on the network to access the recovery 

point. The lack of an available DHCP service can cause such a failure. In such cases, you can 



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

430

1.

2.

3.

1.

2.

3.

4.

5.

assign a unique static IP address to the computer that is running the recovery environment. You 

can then map to the network drive or share.

See Configuring network connection settings.

See About using the networking tools in Veritas System Recovery Disk.

To get a static IP address

In the Veritas System Recovery Disk environment, click Network, and then clickConfigure 

Network Connection Settings.

In the Network Adapter Configuration dialog box, click Use the following IP address.

Specify a unique IP address and subnet mask for the computer that you want to restore.

Be sure that the subnet mask matches the subnet mask of the network segment.

Click OK.

Click Close to return to the recovery environment's main menu.

In the Network panel, click Ping a Remote Computer.

Type the address of the computer that you want to ping on the network segment.

Click OK.

If you specified a computer name or a computer name and domain as the address method, make 

note of the IP address that is returned.

If communication to the storage computer operates as expected, you can use the Map Network 

Drive utility to map a drive to the recovery point location.

See Recovering a computer.

Getting a static IP address if pinging is unsuccessful

If you ping an address and the address does not respond, you can use the ipconfig /all

command to determine the correct IP address.

See Configuring network connection settings.

See About using the networking tools in Veritas System Recovery Disk.

To get an IP address if the ping is unsuccessful
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On the computer that contains the recovery point that you want to restore, at a DOS prompt, 

type the following command, and then press Enter. ipconfig /all

Write down the IP address that is displayed.

Return to the computer that is running the Veritas System Recovery Disk environment.

In the Network panel of the Veritas System Recovery Disk environment, click Ping a Remote 

Computer and use the IP address you wrote down.

See Recovering a computer.

Viewing the properties of a recovery point in the Veritas System 
Recovery Disk
You can view various properties of a recovery point by using the Recovery Point Browser.

See Viewing the properties of a drive within a recovery point in the Veritas System Recovery Disk.

To view the properties of a recovery point in the Veritas System Recovery Disk

Start the computer by using the Veritas System Recovery Disk.

See Booting a computer by using the Veritas System Recovery Disk.

Do one of the following:

In Veritas System Recovery, on the View menu, click Tools. ClickRun Recovery Point 

Browser.

On the Windows Start menu, click Programs > Veritas System Recovery > Recovery 

Point Browser.

In the Recovery Point Browser, in the tree panel, select the recovery point file name that you 

want to view.

Do one of the following:

On the File menu, click Properties.

Right-click on the recovery point file name, and then click Properties.
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DESCRIPTION DISPLAYS A USER-ASSIGNED COMMENT 
THAT IS ASSOCIATED WITH THE 

RECOVERY POINT.

Size Displays the total size (in megabytes) of 
the recovery point.

Created Displays the date and time that the 
recovery point file was created.

Compression Displays the compression level that is used 
in the recovery point.

Split across multiple files Identifies whether the entire recovery point 
file is spanned over several files.

Password protected Displays the password protection status of 
the selected drive.

Encryption Displays the encryption strength that is 
used with the recovery point.

Version Displays the version number that is 
associated with the recovery point.

Computer name Displays the name of the computer on 
which the recovery point was created.

Restore Anyware Identifies whether Restore Anyware was 
enabled for the recovery point.

Search engine support Identifies whether you enabled search 
engine support for the recovery point.

Created by Identifies the application (Veritas System 
Recovery) that was used to create the 
recovery point.

Viewing the properties of a drive within a recovery point in the 
Veritas System Recovery Disk
You can view the properties of a drive within a recovery point in the Veritas System Recovery Disk.
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See Viewing the properties of a recovery point in the Veritas System Recovery Disk.

To view the properties of a drive within a recovery point in the Veritas System Recovery Disk

Start the computer by using the Veritas System Recovery Disk.

See Booting a computer by using the Veritas System Recovery Disk.

Click Recover, and then click Recover My Files.

Do one of the following:

In Veritas System Recovery, on the View menu, click Tools. ClickRun Recovery Point 

Browser.

On the Windows Start menu, click Programs > Veritas System Recovery > Recovery 

Point Browser.

In the Recovery Point Browser, in the tree panel, double-click the recovery point file name that 

contains the drive that you want to view.

Select the name of the drive.

Do one of the following:

On the File menu, click Properties.

Right-click on the drive name within the recovery point, and then click Properties.

DESCRIPTION DISPLAYS A USER-ASSIGNED COMMENT 
THAT IS ASSOCIATED WITH THE 

RECOVERY POINT.

Original drive letter Displays the original drive letter that was 
assigned to the drive.

Cluster size Displays the cluster size (in bytes) that is 
used in a FAT, FAT32, or NTFS drive.

File system Displays the file system type that is used 
within the drive.

Primary/Logical Displays the selected drive's drive status 
as either the primary partition or the logical 
partition.
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DESCRIPTION DISPLAYS A USER-ASSIGNED COMMENT 
THAT IS ASSOCIATED WITH THE 

RECOVERY POINT.

Size Displays the total size (in megabytes) of 
the drive.

This total includes used and unused space.

Used space Displays the amount of used space (in 
megabytes) within the drive.

Unused space Displays the amount of unused space (in 
megabytes) within the drive.

Contains bad sectors Identifies whether there are any bad 
sectors on the drive.

Cleanly quiesced Identifies whether the database application 
quiesced properly when a recovery point 
was

created.

About the Support Utilities
The Veritas System Recovery Disk environment has several support utilities. Veritas Technical 

Support might ask you to use these utilities to troubleshoot any hardware issues that you 

encounter.

You might be required to supply the information that these utilities generate if you call Veritas 

Technical Support for help resolving problems.

“ ”
Note: You should only use these tools as directed by Veritas Technical Support.

“ ”
More Information
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Recovering files and folders by using Veritas System Recovery Disk
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Copying a hard drive

This section includes the following topics:

Preparing to copy a hard drive

Copying one hard drive to another hard drive

Preparing to copy a hard drive
Before you begin, make sure that you delete all the partitions on the destination drive and make it 

unallocated. Do not format the destination drive. You can use Windows Disk Management utility or 

any other disk utility to delete the partitions on the destination drive. You must have the hardware 

configured correctly to copy the hard drives. Perform the following steps to prepare the hardware.

To prepare to copy a drive

Do all of the following:

Get the manufacturer's directions for installing the drive.

Shut down the computer, and then disconnect the power cord.

Discharge electricity by touching a grounded metal object.

Remove the computer cover.

Change the jumper settings on the new hard drive to make it secondary and attach the data 

cable. If you use cable select settings for the hard drive, attach it as secondary.

If you use Serial ATA drives (SATA), skip to next step.

Attach the power connector to the new hard drive.

Anchor the drive in the bay area according to the manufacturer's instructions.

Start your computer.

Change the BIOS settings to recognize the new hard disk.

If you use SATA drives, make sure that the boot settings are configured to boot from your old drive.

Save the BIOS settings and restart the computer.

See Copying one hard drive to another hard drive.
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Copying one hard drive to another hard drive
You can use the Copy My Hard Drive feature to copy your operating system, applications, and data 

to a new had disk. If the hard disk that you want to copy contains multiple partitions, you must copy 

the partitions one at a time.

You can use the Copy My Hard Drive feature to do the following:

Upgrade to a larger hard disk.

Add a second hard disk and keep the original.

If the power or other hardware fails when you copy data, no data is lost from the source drive. You 

can start the process again after the failure is resolved.

“ ”
Note: You should not use theCopy My Hard Drivefeature to set up a hard disk that would be used 

in another computer.

“ ”
Perform the following steps to copy one hard drive to another hard drive.

To copy one hard drive to another hard drive

On the View menu, click Tools.

Click Copy My Hard Drive.

In the Welcome panel, click Next.

In the Source Drive panel, select the drive that you want to copy, and then click Next.

If the drive that you want to copy is not listed, check the Show Hidden Drives option.

In the Destination panel, select the destination drive for the copy, and then click Next.

“ ”
Note: When you select the destination, theSector Sizefor the source drive that you want to 

copy and the destination drive must be the same.
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In the Advanced Options panel, set the copy options you want, and then click Next.

CHECK SOURCE FOR FILE SYSTEM 
ERRORS

CHECKS THE SOURCE DRIVE FOR 
ERRORS BEFORE YOU COPY IT. THE 

SOURCE DRIVE IS THE ORIGINAL DRIVE.

Check destination for file system errors Checks the destination drive for errors after 
you copy the drive. The destination drive is 
the new drive.

Resize drive to fill unallocated space. Expands the drive to occupy the destination 
drive's remaining unallocated space.

Set drive active (for booting OS) Makes the destination drive the active 
partition (the drive from which the computer 
starts). Only one drive can be active at a 
time. To boot the computer, it must be on the 
first hard disk, and it must contain an 
operating system. When the computer boots, 
it reads the partition table of the first hard 
disk to find out which drive is active. It then 
boots from that location. If you cannot start 
the computer from the drive, have a boot 
disk ready. You can use the Veritas System 
Recovery Disk.

The Set drive active option is valid for basic 
disks only (not dynamic disks).

Disable SmartSector copying Speeds up the copying process by only 
copying the clusters and sectors containing 
data.

In high-security environments, you might 
want to copy all clusters and sectors in their 
original layout, regardless of whether they 
contain data. In such cases, this option 
should be deselected.
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CHECK SOURCE FOR FILE SYSTEM 
ERRORS

CHECKS THE SOURCE DRIVE FOR 
ERRORS BEFORE YOU COPY IT. THE 

SOURCE DRIVE IS THE ORIGINAL DRIVE.

Ignore bad sectors during copy Copies the drive even if there are errors on 
the disk.

Copy MBR Copies the master boot record from the 
source drive to the destination drive. Select 
this option if you intend to copy the C:\ drive 
to a new, empty hard drive.

You should not select this option if you want 
to copy a drive to another space on the same 
hard drive as a backup.

You should also not select this option if the 
destination drive has partitions and you do 
not want to overwrite them.

Primary partition Lets you make the destination (new) drive a 
primary partition.

Logical partition Lets you make the destination (new) drive a 
logical partition inside an extended partition.

Drive letter Lets you select the drive letter you want 
assigned to the partition.

Click Finish to begin the copy.

Repeat the same steps to copy other partitions on the hard drive.

After you are done copying the hard drive, disconnect the old drive, and then boot up the 

destination drive.

“ ”
Note: After you successfully boot your computer using the destination drive, you can reconnect 

the old drive to your computer.

“ ”
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See Preparing to copy a hard drive.
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Using the Veritas System Recovery Granular 
Restore Option

This section includes the following topics:

About the Veritas System Recovery Granular Restore Option

Best practices when you create recovery points for use with the Granular Restore Option

Starting the Granular Restore Option

Starting Granular Restore Option and opening a specific recovery point

Restoring a Microsoft Exchange mailbox

Restoring a Microsoft Exchange email folder

Restoring a Microsoft Exchange email message

Restoring files and folders using Granular Restore Option

About the Veritas System Recovery Granular Restore Option
The Granular Restore Option is an administrative tool that works with Veritas System Recovery to 

provide granular restore capabilities for the following applications:

Microsoft Exchange™ 2007, 2010, and 2013

If you want to be able to restore emails using the Granular Restore Option, you must have 

Microsoft Outlook 2007, 2010, or 2013 installed. Outlook 2013 can be installed in combination with 

Outlook 2007 or 2010. Using Granular Restore Option, you cannot view, forward, or restore an 

email folder or a mailbox (.pst file)with Outlook 2013. If you have Outlook 2013 and 2010 installed, 

you cannot restore an email folder or a mailbox for either of the Outlook versions.

You can only restore email messages of Exchange 2013 when Outlook 2013 is installed (or 

Outlook 2013 with 2010 or 2007). To import messages to your Outlook mailbox, you can import the 

restored messages to Outlook, and they are then added to your mailbox (.pst file)

To use all features of Granular Restore Option, you can install Outlook 2007 or 2010.

File and folder data

What you can do with the Granular Restore Option
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Veritas System Recovery is used to create volume-level recovery points. Using theGranular 

Restore Option, you can open these recovery points and restore Microsoft Exchange mailboxes, 

folders, and individual messages. You can also restore unstructured files and folders.

You can do the following tasks with the Granular Restore Option.

Table: Granular Restore Option tasks

TASK MORE INFORMATION

- Restore Exchange mail. Open a specific 
recovery point. Restore a mailbox. Restore an 
email folder. Restore or forward an email 
message.

See Restoring a Microsoft Exchange mailbox .

See Restoring a Microsoft Exchange email 
folder .

See Restoring a Microsoft Exchange email 
message .

- Restore unstructured files and folders. Open 
one or more recovery points. Search or browse 
for a lost file or folder. Restore lost files and 
folders. Restore a version of a file.

See Restoring files and folders using Granular 
Restore Option .

See Starting Granular Restore Option and opening a specific recovery point.

See Restoring a Microsoft Exchange mailbox.

See Restoring a Microsoft Exchange email folder.

See Restoring a Microsoft Exchange email message.

More Information

Best practices when you create recovery points for use with the Granular Restore Option

Best practices when you create recovery points for use with the 
Granular Restore Option
When creating a recovery point, you should use the following guidelines:
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•

•

Select the option to back up your computer, not the option to back up selected files and folders.

See Defining a drive-based backup.

When you select which drives to back up, make sure that you select all of the drives on the 

system.

See Protecting your Microsoft Exchange server for successful backups.

When you select the type of recovery point to create, you should select Recovery Point Set 

instead of Independent Recovery Point. This selection makes subsequent recovery points 

much smaller.

RECOVERY POINT SET (RECOMMENDED) SCHEDULES A BASE RECOVERY POINT 
WITH ADDITIONAL RECOVERY POINTS 

THAT CONTAIN ONLY THE INCREMENTAL 
CHANGES THAT WERE MADE TO YOUR 

COMPUTER SINCE THE PREVIOUS 
RECOVERY POINT.

INCREMENTAL RECOVERY POINTS ARE 
CREATED FASTER THAN THE BASE 

RECOVERY POINT. THEY ALSO USE LESS 
STORAGE SPACE THAN AN INDEPENDENT 

RECOVERY POINT.

NOTE: YOU CAN ONLY HAVE ONE 
RECOVERY POINT SET DEFINED FOR 
EACH DRIVE. THERECOVERY POINT 

SETOPTION IS NOT AVAILABLE IF YOU 
HAVE ALREADY ASSIGNED A SELECTED 

DRIVE TO AN EXISTING BACKUP AND 
SPECIFIEDRECOVERY POINT SETAS THE 

RECOVERY POINT TYPE. THIS OPTION 
ALSO IS UNAVAILABLE IF YOU SELECT 

AN UNMOUNTED DRIVE THAT CANNOT BE 
PART OF A RECOVERY POINT SET.

Independent recovery point Creates a complete, independent copy of the 
drives that you select. This backup type 
typically requires more storage space, 
especially if you run the backup multiple 
times.
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The Exchange server does not need to be turned off for a backup to run successfully. However, 

you should schedule the backup at a time when the server is less busy (for example, after 

midnight).

SCHEDULE LETS YOU SELECT THE DAYS AND A 
START TIME FOR WHEN THE BACKUP 

SHOULD RUN.

Run more than once per day Indicates that you can run the backup more 
than once a day to protect data that you edit 
or change frequently.

Time between backups Specifies the maximum time that should 
occur between backups.

Number of times Specifies the number of times per day that 
the backup should run.

Automatically optimize Lets you select how often optimization 
should occur to help manage the disk space 
that is used by your backup destination.

Start a new recovery point set Indicates how frequently a new recovery 
point set should be started.

Custom Lets you customize the start time, and the 
days of the week or month to run the backup.

Event Triggers - General Lets you select the type of events that 
automatically starts a backup.

If you use mount points, make sure that you select them for backup.

More Information

About the Veritas System Recovery Granular Restore Option

Protecting your Microsoft Exchange server for successful backups
The recommended way to protect your Exchange server is to create a single backup job that 

contains all of the drives on your server. However, you can choose to run your backups at the 

storage group and message store levels. You should consider the following to ensure a successful 

backup:
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INCLUDE THE DRIVE THAT CONTAINS YOUR 
EXCHANGE INSTALLATION

GRANULAR RESTORE OPTION USES THE 
RECOVERY POINT OF THE EXCHANGE 
SERVER TO PERFORM THE RESTORE 

OPERATION. THEREFORE, YOU SHOULD 
ROUTINELY BACK UP YOUR EXCHANGE 

SERVER. WHEN YOU CREATE THE 
RECOVERY POINT, YOU SHOULD SELECT 

THE DRIVE THAT CONTAINS YOUR 
EXCHANGE INSTALLATION DIRECTORY.

FOR EXAMPLE, IF YOU INSTALLED 
EXCHANGE IN THE C:\PROGRAM 

FILE\EXCHSRVR DIRECTORY, MAKE SURE 
THAT YOU INCLUDE THE ENTIRE C DRIVE IN 

YOUR RECOVERY POINT.

Include the storage group for the message 
store that you want to back up

A storage group is a collection of message 
stores. Each storage group contains a 
transaction log that is used to buffer writes to 
the message stores. You must back up the 
drive that contains the storage group's log files 
for the message store that you want to protect.

For example, suppose you have a storage 
group named First Storage Group . If the 
storage group contains a transaction logon E:
\Exchsrvr\mdbdata, you should include the 
entire E drive as part of the recovery point. If 
you have multiple storage groups, you should 
back them up at the same time. If you want to 
back up your storage groups on different 
schedules, you still need to include Exchange 
in your backups.

Include the message stores that you want to 
protect

A message store is a database file that stores 
email. Message stores are subgroups of 
storage groups. When you create a recovery 
point for a message store, you must also 
include its storage group.

For example, if you have a message store 
named Message Store (myserver) that is 
located on F:\Exchsrvr\mdbdata\Message 
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◦

◦

1.

INCLUDE THE DRIVE THAT CONTAINS YOUR 
EXCHANGE INSTALLATION

GRANULAR RESTORE OPTION USES THE 
RECOVERY POINT OF THE EXCHANGE 
SERVER TO PERFORM THE RESTORE 

OPERATION. THEREFORE, YOU SHOULD 
ROUTINELY BACK UP YOUR EXCHANGE 

SERVER. WHEN YOU CREATE THE 
RECOVERY POINT, YOU SHOULD SELECT 

THE DRIVE THAT CONTAINS YOUR 
EXCHANGE INSTALLATION DIRECTORY.

FOR EXAMPLE, IF YOU INSTALLED 
EXCHANGE IN THE C:\PROGRAM 

FILE\EXCHSRVR DIRECTORY, MAKE SURE 
THAT YOU INCLUDE THE ENTIRE C DRIVE IN 

YOUR RECOVERY POINT.

Store (myserver).stm, you should include the 
entire F drive in your recovery point.

See Best practices when you create recovery points for use with the Granular Restore Option.

Starting the Granular Restore Option
How you start Granular Restore Option depends on the version of Windows you use.

To start the Granular Restore Option

Do one of the following:

In Veritas System Recovery, on the Tools page, click Run Granular Restore Option.

On the classic Windows taskbar, click Start > Programs > Veritas System Recovery > 

Granular Restore Option.

See Starting Granular Restore Option and opening a specific recovery point.

Starting Granular Restore Option and opening a specific 
recovery point
You open recovery points so you can restore mailboxes, email folders and messages, and files and 

folders.

To open a specific recovery point

Do one of the following:
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•

2.

3.

In Veritas System Recovery, on the Tools page, click Run Granular Restore Option.

On the classic Windows taskbar, click Start > Programs > Veritas System Recovery > 

Granular Restore Option.

In the Open Recovery Points dialog box, select the option you want and then click OK.

USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

Use alternate system index (.sv2i) file Opens a recovery point using its system 
index file.

System index file name Lets you specify a path and a file name of a 
system index file that you want to use for 
recovery.

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index 
file.

Use recovery points for another computer . Opens a recovery point that resides on 
another computer.

Browse Lets you browse to a path that contains 
recovery points.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select recovery points.

Computer Name Identifies the names of recovery point files 
and virtual disk files in the specified path of 
another computer.

You can change the backup date that you view by selecting a different date in the upper right-

hand corner.

You can now restore exchange mail, or files and folders.
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1.

2.

3.

See Restoring a Microsoft Exchange mailbox.

See Restoring a Microsoft Exchange email folder.

See Restoring a Microsoft Exchange email message.

See Restoring files and folders using Granular Restore Option.

Restoring a Microsoft Exchange mailbox
A restored mailbox consists of all of the email that was contained in a user's mailbox when the 

recovery point was created. A recover mailbox is saved on the disk as a PST file.

You can use Microsoft Outlook to open and view the contents of the file. After a restored mailbox 

has been opened in Outlook, you can then drag email or folders back to their original locations.

“ ”
Note: In many cases, it is easier to restore a user's entire mailbox than find a single message.

“ ”
To restore a mailbox

On the View menu, click Tools.

Click Run Granular Restore Option.

In the Open Recovery Points dialog box, open the recovery point for the last known time that 

the mail was present on the Exchange server.

USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

Use alternate system index (.sv2i) file Opens a recovery point using its system 
index file.

System index file name Lets you specify a path and a file name of a 
system index file that you want to use for 
recovery.
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4.

5.

6.

7.

USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index 
file.

Use recovery points for another computer . Opens a recovery point that resides on 
another computer.

Browse Lets you browse to a path that contains 
recovery points.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select recovery points.

Computer Name Identifies the names of recovery point files 
and virtual disk files in the specified path of 
another computer.

Click OK.

On the Exchange Mail tab, from the list of mailboxes, select the mailbox you want to restore.

Right-click the mailbox, and then click Recover Mailbox.

Select the folder where you want to place the restored mailbox, and then click Save.

“ ”
Note: If the size of the mailbox is large, you may want to copy it to a shared folder.

“ ”
See Restoring a Microsoft Exchange email folder.

See Restoring a Microsoft Exchange email message.
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1.

2.

3.

Restoring a Microsoft Exchange email folder
You can restore a single folder instead of an entire mailbox. For example, if a user needs a copy of 

a sent message, it may be quicker to restore only the Sent Items folder.

A restored folder is saved on the disk as PST file. You can use Microsoft Outlook to open and view 

the contents of the folder. After a restored email folder has been opened in Outlook, you can drag 

email or folders back to their original locations.

To restore an email folder

On the View menu, click Tools.

Click Run Granular Restore Option.

In the Open Recovery Points dialog box, open the recovery point for the last known time that 

the mail was present on the Exchange server.

USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

Use alternate system index (.sv2i) file Opens a recovery point using its system 
index file.

System index file name Lets you specify a path and a file name of a 
system index file that you want to use for 
recovery.

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index 
file.

Use recovery points for another computer . Opens a recovery point that resides on 
another computer.

Browse Lets you browse to a path that contains 
recovery points.
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5.

6.

7.

1.

2.

3.

USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select recovery points.

Computer Name Identifies the names of recovery point files 
and virtual disk files in the specified path of 
another computer.

Click OK.

On the Exchange Mail tab, select the mailbox for the user who requested the restore.

In the folder list, right-click the folder you want to restore, and then click Recover Folder.

Select the folder where you want to place the restored folder, and then click Save.

See Restoring a Microsoft Exchange email folder.

See Restoring a Microsoft Exchange email message.

Restoring a Microsoft Exchange email message
You can use the Granular Restore Option to restore individual email messages. You can save 

individual messages in an .msg file format on the disk, or you can forward them directly to a user. 

Use Microsoft Outlook to open and view the contents of a saved message file.

To restore an email message

On the View menu, click Tools.

Click Run Granular Restore Option.

In the Open Recovery Points dialog box, open the recovery point for the last known time that 

the mail was present on the Exchange server.

USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

Use alternate system index (.sv2i) file Opens a recovery point using its system 
index file.
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USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

System index file name Lets you specify a path and a file name of a 
system index file that you want to use for 
recovery.

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index 
file.

Use recovery points for another computer . Opens a recovery point that resides on 
another computer.

Browse Lets you browse to a path that contains 
recovery points.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select recovery points.

Computer Name Identifies the names of recovery point files 
and virtual disk files in the specified path of 
another computer.

Click OK.

Click the Exchange Mail tab, select the mailbox for the user who requested the restore.

Select the folder that contains the message you want to restore.

Select the message to restore.

“ ”
Note: You can sort the list by clicking the column headers. You can also search the subject 

lines of the messages by entering a search term in the search field (near the message list). 

When you add or delete characters in the search box, it automatically changes the results.
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•

1.

2.

3.

“ ”
To return the email message to the user, do one of the following:

If you have Microsoft Outlook installed, double-click the message to open it in Outlook. You 

can use Outlook to send the message back to its owner.

To forward the message in Outlook, right-click the message, and then click Forward.

Outlook opens a new message. The message that you want to forward is included as an 

attachment. You can then forward the message to the original owner.

To save the message to a disk, right-click the message, and then click Recover Message. 

Type the file name, and then clickSave.

The email message is saved on the disk. You can use Outlook to open the message.

See Restoring a Microsoft Exchange mailbox.

See Restoring a Microsoft Exchange email folder.

Restoring files and folders using Granular Restore Option
Granular Restore Option can be used to restore unstructured files and folders. This feature is 

particularly useful if you need to search more than one recovery point (multiple backup dates) to 

find a missing file or folder.

To restore a file or folder

On the View menu, click Tools.

Click Run Granular Restore Option.

In the Open Recovery Points dialog box, open the recovery point for the last known time that 

the mail was present on the Exchange server.

USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

Use alternate system index (.sv2i) file Opens a recovery point using its system 
index file.
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6.

1.
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USE LATEST RECOVERY POINTS FOR 
THIS COMPUTER

OPENS A RECOVERY POINT USING THE 
LATEST RECOVERY POINTS FROM THE 

COMPUTER ON WHICH YOU WORK.

System index file name Lets you specify a path and a file name of a 
system index file that you want to use for 
recovery.

Browse Lets you browse to a path that contains a 
system index file.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select a system index 
file.

Use recovery points for another computer . Opens a recovery point that resides on 
another computer.

Browse Lets you browse to a path that contains 
recovery points.

For example, you can browse to an external 
(USB) drive, a network location, or to 
removable media to select recovery points.

Computer Name Identifies the names of recovery point files 
and virtual disk files in the specified path of 
another computer.

Click OK.

On the Files and Folders tab, browse or search for the file that you want to restore.

You can view more than one recovery point at a time. To see a view of the file system that 

contains multiple recovery points, click Versions. Now select the versions that you want to view 

by checking them in the list.

You can sort the list by clicking the column headers. You can enter a search term in the search field 

(near the documents list). When you add or delete characters in the search box, the results change 

automatically.

Click the file to view its contents or to restore it, and then select the check box beside it.

On the Tasks menu, click Restore Files , and then select the destination for the restore.



VERITAS™ SYSTEM RECOVERY 23 USER'S GUIDE - V23.0 

455

“ ”
Note: If you view multiple recovery points and more than one version of a file is available, you 

can expand the list of versions. Click the plus sign next to each file. After you select a file for 

restore, choose the version of the file that you want.

“ ”
See Restoring a Microsoft Exchange mailbox.

See Restoring a Microsoft Exchange email folder.

See Restoring a Microsoft Exchange email message.
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Appendix A. Backing up databases using 
Veritas System Recovery

This section includes the following topics:

About backing up databases using Veritas System Recovery

Creating a manual cold (offline) backup

Creating an automatic warm backup

Creating a hot (online) backup using Veritas System Recovery

About backing up databases using Veritas System Recovery
Veritas System Recovery enables you to back up both, Microsoft's Volume Shadow Copy Service 

(VSS)-aware and non-VSS aware databases. For backing up VSS-aware databases, Veritas 

System Recovery integrates with VSS to automate the backup process. While, for backing up non-

VSS-aware databases, you can create manual or automatic cold or hot recovery points of the 

databases.

VSS-aware databases

Veritas System Recovery integrates with Microsoft's VSS to automate the process of backing up 

VSS-aware databases, such as the following:

Exchange Server 2007 or later

SQL Server 2005 or later

Windows Server 2008-based domain controller or later

VSS-aware databases are auto-enabled and cannot be turned off. VSS lets administrators create a 

shadow copy backup of volumes on a server. The shadow copy includes all files and includes open 

files.

When it creates a recovery point, Veritas System Recovery alerts the Volume Shadow Copy 

Service. VSS then puts the VSS-aware databases into a temporary sleep state. While in this 

quiesced state, the database continues to write to transaction logs during the backup. After the 

databases are quiesced, Veritas System Recovery takes the snapshot. VSS is then notified that a 

snapshot is completed. The databases are awakened, and the transaction logs continue to be 
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committed to the database. Meanwhile, the recovery point is created. The databases are only 

quiesced for the snapshot, and are active for the rest of the recovery point creation.

Veritas System Recovery supports Exchange Server 2007 or later, which implements VSS 

technology. However, if the database load is heavy, the VSS request might be ignored. Create 

recovery points at the lightest load time.

Be sure that you have installed the latest service packs for your given database.

“ ”
Note: For backing up Exchange databases, additional backup applications are not needed to run 

with Veritas System Recovery.

“ ”
Non VSS-aware databases

With Veritas System Recovery, you can create manual cold backups, automatic warm backups, or 

hot backups of non-VSS-aware databases.

Creating a manual cold (offline) backup
A manual cold (or offline) backup ensures that all database transactions are committed to the hard 

disk. You can then use either Veritas System Recovery or the Veritas System Recovery Disk to 

create the recovery point, and then restart the database.

The following table summarizes the steps for creating a cold backup manually using Veritas 

System Recovery or Veritas System Recovery Disk.

Table: Creating a cold back manually

STEP ACTION DESCRIPTION

Step 1 Stop the database Manually stop the database 
you want to back up.

Step 2 Create a recovery point Create a recovery point using 
either Veritas System 
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STEP ACTION DESCRIPTION

Recovery or the Veritas 
System Recovery Disk.

Do one of the following:

- Use Veritas System 
Recovery to run a backup 
immediately using the Run 
Backup or One-time Backup 
feature.

- Use the Veritas System 
Recovery Disk to create a 
one time cold backup.

Step 3 Restart the database Manually restart the database 
anytime after the recovery 
point progress bar appears in 
the Monitor page of the 
console.

While the database is 
restarted, the actual recovery 
point is immediately created 
from the virtual volume 
recovery point.

See About backing up databases using Veritas System Recovery.

More Information

Running a one-time backup from Veritas System Recovery

Running a backup from Veritas System Recovery Disk

Creating an automatic warm backup
You can automate the creation of a warm backup of a non-VSS-aware database by running a 

command file in the backup job. Run this command file before data capture to stop (quiesce) the 
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database momentarily and commit all transaction logs to the hard disk. Veritas System Recovery 

instantaneously snaps a virtual volume recovery point.

Run a second command file in the backup job to restart the database while the recovery point is 

created from the virtual volume recovery point.

Because the virtual volume snapshot takes only a few seconds to create, the database is in the 

recovery point state momentarily. As a result, there is a minimal number of log files created.

The following table summarizes the steps for creating a warm backup automatically using Veritas 

System Recovery.

Table: Creating a warm backup automatically

STEP ACTION DESCRIPTION

Step 1 Define a backup Define a backup that includes 
the command files that you 
have created for the following 
stages of the recovery point\:

- Before data capture: A 
command file that stops the 
database.

- After data capture: A 
command file that restarts the 
database.

Step 2 Run the backup job Using Veritas System 
Recovery, run the backup job 
that includes the command 
files.

See Running command files during a backup.

See About backing up databases using Veritas System Recovery.

Creating a hot (online) backup using Veritas System Recovery
If a cold or a warm backup is not possible in your organization, create a hot (or online) backup for 

backing up non-VSS-aware databases.
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•

Veritas System Recovery takes a crash consistent recovery point. Such a recovery point is 

equivalent to the state of a system that was running when the power failed. A database that can 

recover from this type of failure can be recovered from a crash consistent recovery point.

To create a hot backup

Use Veritas System Recovery to create a recovery point without the need to stop or restart the 

database.

Veritas System Recovery instantaneously snaps a virtual volume recovery point from which the 

recovery point is created.

See About backing up databases using Veritas System Recovery.
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Appendix B. Backing up Active Directory

This section includes the following topics:

Tips for protecting a domain controller in Active Directory

Tips for protecting a domain controller in Active Directory
When protecting a domain controller with Veritas System Recovery, be aware of the following:

If your domain controller supports Microsoft Volume Shadow Copy Service (VSS), Veritas 

System Recovery automatically calls VSS to prepare the Active Directory database for backup.

To participate on a domain, every domain computer must negotiate a trust token with a domain 

controller. This token is refreshed every 30 days by default. This time frame can be changed, 

and is referred to as a secure channel trust. But a trust token that is contained in a recovery 

point is not updated automatically by the domain controller. Therefore, a computer that is 

recovered using a recovery point containing an outdated token cannot participate in the 

domain. For such a computer to participate in the domain it must be re-added to the domain by 

someone who has the proper credentials.

In Veritas System Recovery, this trust token can be re-established automatically if the computer 

participates in the domain when the recovery process is started.

In most cases, domain controllers should be restored non-authoritatively. Restoring domain 

controllers non-authoritatively prevents outdated objects in the Active Directory from being 

restored. Outdated objects are referred to as tombstones. Active Directory does not restore 

data older than the limits it sets. Restoring a valid recovery point of a domain controller is the 

equivalent of a non-authoritative restore. To determine which type of restore you want to 

perform, please refer to the Microsoft documentation. A non-authoritative restore prevents 

tombstone conflicts.

For additional details about protecting non-VSS aware domain controllers, see the white paper 

titled "Protecting Active Directory," located on the Web.

http://eval.veritas.com/mktginfo/enterprise/white_papers/ent-

whitepaper_protecting_active_directory.pdf

You can also refer to the Veritas Knowledge Base:

http://eval.veritas.com/mktginfo/enterprise/white_papers/ent-whitepaper_protecting_active_directory.pdf
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https://www.veritas.com/content/support/en_US

https://www.veritas.com/support/en_US/search-results.html?keyword=V-269-16*
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Appendix C. Backing up Microsoft virtual 
environments

This section includes the following topics:

About backing up Microsoft virtual hard disks

About backing up and restoring Microsoft Hyper-V virtual machines

About backing up Microsoft virtual hard disks
Microsoft Windows 7/Server 2008 R2 onwards support the use of Virtual Hard Disks (VHDs). 

Microsoft does not support backing up a physical disk and a VHD on that physical disk in the same 

backup job. This limitation also applies to Veritas System Recovery. You cannot back up a physical 

disk and its VHD counterpart in the same backup job using Veritas System Recovery. Also not 

supported is the ability to back up a VHD that is hosted on or "nested" within another VHD. If you 

want to back up a physical disk and a VHD on that disk, you must create separate backup jobs for 

each disk.

Backing up a physical disk that hosts a VHD is supported as long as it is not included as another 

volume in the same backup. When a physical disk hosting a VHD is backed up, the VHD is treated 

as another file that is part of the physical disk backup.

VHDs can be attached and detached from their physical disk hosts (volumes). Microsoft 

recommends that you detach a VHD that is stored on a host volume before you back up. Not 

detaching a VHD before you back up a host volume can result in an inconsistent copy of the VHD 

in the backup. After you restore a host volume, you can re-attach the VHD file.

You can find more information on backing up VHDs on the Microsoft website.

http://technet.microsoft.com/en-us/library/dd440865(WS.10).aspx

Find information about backing up and restoring Microsoft Hyper-V virtual machines:

See About backing up and restoring Microsoft Hyper-V virtual machines.

http://technet.microsoft.com/en-us/library/dd440865(WS.10).aspx
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About backing up and restoring Microsoft Hyper-V virtual 
machines
To create a backup of a Microsoft Hyper-V virtual machine, you must back up the volumes of the 

computer where the virtual machine is hosted. Create either a live backup or a system state 

backup of the host machine. You cannot back up or restore a specific virtual machine. A live 

backup is created while the virtual machine is running (hot backup).

A system state backup is created in any of the following conditions:

The guest operating system on the virtual machine is not running (cold backup).

The Hyper-V VSS integration component is not installed in the virtual machine.

“ ”
Note: Veritas System Recovery is unable to back up cluster shared volumes. Because volumes 

in such a configuration are accessible to each of the clustered Hyper-V host computers, a given 

volume cannot be locked for backup . However, clustered disks can be backed up by Veritas 

System Recovery because one host has exclusive access to the disk.

“ ”
To create a backup of a running virtual machine, the following conditions must be met:

The guest operating system must be running.

The guest computer must be running Windows Server 2012 or later.

If the guest computer is running Windows 2000, you can only create a system state backup (cold 

backup).

The Hyper-V VSS integration component must be installed on each virtual machine to be 

backed up.

If you move a virtual machine from Virtual Server 2005 to Hyper-V, first uninstall the Virtual Server 

2005 integration component from the virtual machine. After you Virtual Server 2005 integration 

component, you can install the Hyper-V VSS integration component.

The guest virtual machine should be configured to only use basic disks, not dynamic disks.

This configuration is the default for installing a Windows virtual machine.
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• All the volumes on the fixed disks must support the creation of snapshots.

If you perform a backup when these conditions are not met, Veritas System Recovery creates a 

system state recovery point that is crash-consistent. A crash-consistent recovery point captures the 

virtual machine as if it had experienced a system failure or power outage.

You can restore a specific virtual machine from the recovery point of the host computer using the 

Recovery Point Browser. Use the Recovery Point Browser to extract the files that make up the 

virtual machine. The host computer recovery point must include the volume that holds the virtual 

machine that you want to restore.

To know about the limitations of Hyper-V when backing up databases on virtual machines, refer to 

the Veritas Knowledge Base:

https://www.veritas.com/content/support/en_US

Find information about backing up Microsoft virtual hard disks:

See About backing up Microsoft virtual hard disks.

https://www.veritas.com/support/en_US/search-results.html?keyword=V-306-2*
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Appendix D. Using Veritas System Recovery 
23 and Windows Server Core

This section includes the following topics:

About Veritas System Recovery 23 and Windows Server Core

Installing Veritas System Recovery 23 on Windows Server Core using commands

About Veritas System Recovery 23 and Windows Server Core
Windows Server Core does not include the traditional graphical user interface (GUI) that is 

available with other versions of Windows. It is installed and managed primarily using commands at 

the command line interface.

Although Veritas System Recovery 23 can be installed on Windows Server Core, it is an agent only 

install. Windows Server Core does not support Microsoft .NET. Therefore, the Veritas System 

Recovery GUI cannot be installed. Veritas System Recovery is supported on Windows Server Core 

by a headless agent only. You can install Veritas System Recovery 23 using commands at the 

command line. You can also install (push) the agent from a remote machine.

One-to-one management is the only supported method for backing up and restoring a Windows 

Server Core computer. This means, after you install the agent on a Windows Server Core 

computer, connect to it from a remote machine running Veritas System Recovery 23

Before installing the agent remotely on a Windows Server Core computer, you must configure the 

firewall to allow access to the server. By default, the firewall is configured to allow no access to the 

server.

For more information on configuring the firewall on a Windows Server Core computer, see the 

Microsoft website.

Windows-on-Windows 64-bit (WoW64) is a subsystem of the Windows operating system and is 

required for running 32-bit applications on 64-bit versions of Windows. It is installed by default and 

is included on all 64-bit versions of Windows. If you have uninstalled WoW64 on a Windows Server 

Core computer, you must reinstall it before installing Veritas System Recovery 23.

See Installing Veritas System Recovery 23 on Windows Server Core using commands.
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Installing Veritas System Recovery 23 on Windows Server Core 
using commands
The following options exist for installing Veritas System Recovery 23 on a Windows Server Core 

system. They are

Full install with GUI support

Full silent install with logging

Agent-only silent install with logging

Installing Veritas System Recovery 23 using the option for full install with GUI support

On the Veritas System Recovery 23 DVD, browse to and run Browser.exe .

A graphical environment (GUI) is launched where you complete remaining installation.

Complete the installation by following the steps in the installation wizard.

Even though the full Veritas System Recovery is installed, only the agent is needed and used on 

Windows Server Core.

To install Veritas System Recovery 23 using the option for full silent install with logging

On the Veritas System Recovery 23 DVD, change to the Install directory.

Run the following command:

Setup.exe /S: /FULL:

Even though the full Veritas System Recovery is installed, only the agent is needed and used on 

Windows Server Core.

To install Veritas System Recovery 23 using the option for agent-only silent install with logging

On the Veritas System Recovery 23 DVD, change to the Install directory.

Run the following command:

Setup.exe /S: /SERVICE:
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